End User License Agreement

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT. THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU, AND DIAGNOSTIC INSTRUMENTS, CONCERNING THE USE OF THE ENCLOSED SOFTWARE. THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND DIAGNOSTIC INSTRUMENTS.

BY OPENING THE SOFTWARE PACKAGE OR USING THE CD, YOU ARE CONSENTING TO BE BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE PACKAGE OR USE THE CD. PROMPTLY RETURN THE CD, INCLUDING THE WRITTEN MATERIALS, THE BINDER, AND ALL OTHER EQUIPMENT/CONTAINERS TO THE DEALER FROM WHOM YOU PURCHASED THEM. YOU WILL RECEIVE A FULL REFUND.

License Grant

The package contains software ("Software") and related explanatory written materials ("Documentation"). "Software" includes any upgrades, modified versions, updates, additions and copies of the Software. "You" means the person or company who is being licensed to use the Software or Documentation. "We" and "us" means Diagnostic Instruments, Inc.

We hereby grant you a nonexclusive, limited license to use one copy of the Software on any single computer, provided the Software is in use on only one computer at any time. This software is licensed for use with one camera serial number only of one Diagnostic Instruments/SPOT camera. The Software is "in use" on a computer when it is loaded into temporary memory (RAM) or installed into the permanent memory of a computer—for example, a hard disk, CD-ROM or other storage device.

If the Software is permanently installed on the hard disk or other storage device of a desktop or portable computer (other than a network server) and one person uses that computer more than 80% of the time, then that person may also use the Software on a 2nd computer for the purpose of viewing and post-processing images.

Title

We remain the owner of all right, title and interest in the Software and Documentation. You will agree to use your best efforts to protect the software from unauthorized use, illegal reproduction, or illicit distribution.

Copyrights and Trade Secrets

Diagnostic Instruments owns all rights to the Software. This agreement does not convey ownership of the software to you, but only the right to use a copy of the software strictly in accordance with this agreement. The unauthorized duplication or distribution of the software or the documentation is an infringement of Diagnostic Instruments' rights to the software and may be subject to criminal and/or civil penalties.

Archival or Backup Copies

You may either:

- Make one copy of the Software solely for backup or archival purposes, provided that the original copyright notice and/or other legend is reproduced on each copy, or

- Transfer the Software to a single hard disk, provided you keep the original solely for backup or archival purposes, and provided that the original copyright notice and/or other legend is reproduced on each copy.
Things You May Not Do
United States copyright laws and international treaties protect the software and documentation. You must treat the software and documentation like any other copyrighted material—for example a book. You may not:

- Copy the Documentation (although you may print one working copy from a downloaded version from our website),
- Copy the Software except to make archival or backup copies as provided above,
- Modify, translate, or adapt the Software or merge it into another program,
- Make any attempt to discover the source code of the Software through reverse engineering,
- Place the Software onto a server so that it is accessible via a public network such as the Internet,
- Sublicense, rent, lease or lend any portion of the Software or Documentation.

Transfers
You may transfer all your rights to use the Software and Documentation to another person or legal entity provided you transfer this Agreement, the Software and Documentation, including all copies, updates and prior versions to such person or entity and that you retain no copies, including copies stored on computer.

Software Limited Warranty
We warrant that for a period of 30 days after delivery of this copy of the Software to you:

- The physical media (if any) on which this copy of the Software is distributed will be free from defects in materials and workmanship under normal use, and
- The Software will perform in substantial accordance with the Documentation.

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE DISCLAIM ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY IMPLIED WARRANTY OF TITLE, NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, regardless of whether we know or had reason to know of your particular needs. No employee, agent, dealer or distributor of ours is authorized to modify this limited warranty, or to make any additional warranties.

Limited Remedy
Our entire liability and your exclusive remedy shall be:

- The replacement of any CD(s) or other media not meeting our Limited Warranty which is returned to us or to an authorized Dealer or Distributor with a copy of your receipt, or
- If we or an authorized Dealer or Distributor are unable to deliver a replacement CD(s) or other media that is free of defects in materials or workmanship, you may terminate this Agreement by returning the Software and Documentation and your money will be refunded.

IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OF OR THE INABILITY TO USE THE SOFTWARE (EVEN IF WE OR AN AUTHORIZED DEALER OR DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF THESE DAMAGES), OR FOR ANY CLAIM BY ANY OTHER PARTY.
**Term and Termination**

This license agreement takes effect upon your use of the software and remains effective until terminated. You may terminate it at any time by destroying all copies of the Software and Documentation in your possession. It will also automatically terminate if you fail to comply with any term or condition of this license agreement. You agree on termination of this license to either return to us or destroy all copies of the Software and Documentation in your possession.

**Confidentiality**

The Software contains trade secrets and proprietary know-how that belong to us and it is being made available to you in strict confidence. ANY USE OR DISCLOSURE OF THE SOFTWARE, OR OF ITS ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN STRICT ACCORDANCE WITH THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A VIOLATION OF OUR TRADE SECRET RIGHTS.

**General Provisions**

- This written license agreement is the exclusive agreement between you and us concerning the Software and Documentation and supersedes any and all prior oral or written agreements, negotiations or other dealings between us concerning the Software.
- This license agreement may be modified only by a written agreement signed by you and us that specifically supersedes this agreement.
- The laws of the State of Michigan govern this license agreement.
- You agree that the Software will not be shipped, transferred or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions or regulations.

**Trademarks**

Adobe Photoshop is a registered trademark of Adobe Systems Incorporated. Image Pro and Image Pro Plus are registered trademarks of Media Cybernetics. SPOT, Insight, RT-KE, RT-SE, Flex, Xplorer, Pursuit, Correct Color Technology, and Enhanced are trademarks of Diagnostic Instruments, Inc. Windows 95, Windows 98, Windows 98SE, Windows NT, Windows 2000, Windows ME, and Windows XP, Windows Office are registered trademarks of Microsoft, Inc. Mac OS is a registered trademark of Apple Computer, Inc. FireWire is a registered trademark of Apple Computer, Inc. and a licensed trademark of the 1394 Trade Association. All other product names mentioned in this document are the property of their respective trademark holders.

**Camera Warranty Information**

LIMITED WARRANTY: Diagnostic Instruments, Inc. (henceforth referred to as Diagnostic) warrants to the original purchaser, that the camera will be free of defects in material and workmanship for a period of two (2) years from the date of purchase. Refurbished cameras may offer a different term of warranty. Please refer to the warranty associated with refurbished equipment at the Diagnostic Instruments website and/or enclosed in the shipping container.

Diagnostic shall, at its choice, repair or replace, free of charge, any product that, upon inspection by Diagnostic, is found to be defective. Abuse, misuse, or improper maintenance and/or repair during the warranty period invalidate this warranty. This warranty does not cover defects due to ordinary wear and tear.

In no event shall Diagnostic be liable for any consequential, indirect, incidental, or special damages of any nature arising from the sale or use of this product.
In no event, and under no circumstance shall Diagnostic be liable to the Dealer or to any other individual or entity for any indirect, special, consequential, or incidental losses or damages, including without limitation, lost profits.

EXCEPT, AS EXPRESSLY SET FORTH IN THIS AGREEMENT, DIAGNOSTIC INSTRUMENTS, INC., MAKES NO WARRANTIES OR REPRESENTATIONS TO THE DEALER OR USER, EITHER EXPRESS OR IMPLIED. THIS INCLUDES, WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR THE VALIDITY, NON-INFRINGEMENT, OR OWNERSHIP OF ANY PATENTS OR TECHNOLOGY IN OR CONCERNING THE CAMERA. DIAGNOSTIC INSTRUMENTS INC., HEREBY EXPRESSLY DISCLAIMS ALL SUCH WARRANTIES, GUARANTIES, REPRESENTATIONS, OR CONDITIONS.

Diagnostic Instruments reserves the right to change any or all of this policy at any time.

Copyright 2005, Diagnostic Instruments, Inc. All rights reserved.
# Table of Contents

End User License Agreement .................................................................................................................. 1
Table of Contents ...................................................................................................................................... 5
About This Manual .................................................................................................................................... 11
  Introduction ............................................................................................................................................. 11
  Document Conventions ....................................................................................................................... 11
  Organization of the Manual ................................................................................................................ 12
Quick Start ................................................................................................................................................ 15
  Taking Your First Picture .................................................................................................................. 15
    Preparing the Microscope and Camera ....................................................................................... 15
    Capturing the Image .................................................................................................................... 15
Ch. 1 - New Features ................................................................................................................................ 19
Ch. 2 - Basic and Advanced Program Modes ......................................................................................... 21
  Introduction ........................................................................................................................................... 21
  Basic vs. Advanced Features ........................................................................................................... 21
Ch. 3 - The Basic Program Mode ........................................................................................................... 23
  Introduction: Using the Basic Program .......................................................................................... 23
  Navigating in Basic Program Mode .................................................................................................. 23
    The Viewing and Editing Window ............................................................................................... 23
    Opening and Saving Files ........................................................................................................... 25
    Setup ............................................................................................................................................... 27
  Preparing to Take a Picture ............................................................................................................. 30
    Profile ............................................................................................................................................. 30
    Exposure/Brightness Window ....................................................................................................... 31
    Area/Orientation Window ............................................................................................................ 34
    Image Processing Window ........................................................................................................... 36
  Taking a Picture ................................................................................................................................... 37
    Initialize Camera .......................................................................................................................... 38
    Computing White Balance Values [Color Cameras] ...................................................................... 39
    Capturing the Final Image ........................................................................................................... 40
    Get Sequential Images ................................................................................................................. 41
  Viewing, Editing, and Annotating Images ......................................................................................... 41
    View ............................................................................................................................................... 41
    Edit ................................................................................................................................................. 44
  Working with Image Sequences .......................................................................................................... 48
  Creating a Report ............................................................................................................................... 49
    Creating a New Report .................................................................................................................. 49
    Working in Report Mode .............................................................................................................. 49
    Defining View Options .................................................................................................................. 50
    Defining Report Attributes .......................................................................................................... 51
    Defining Report Objects ............................................................................................................... 53
    Editing Report Objects .................................................................................................................. 55
    Saving Reports ............................................................................................................................... 56
    Printing and Distributing Reports ................................................................................................. 57
  Image Printing ...................................................................................................................................... 57
Ch. 4 - The Advanced Program Mode .................................................................................................... 59
  The Viewing and Editing Window ...................................................................................................... 59
    Menus ............................................................................................................................................. 59
    The Toolbar .................................................................................................................................... 60
  The Status Bar .................................................................................................................................... 61
  Working with Image Files .................................................................................................................. 62
  Setup .................................................................................................................................................. 64
  Image Setups ....................................................................................................................................... 64
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ch. 5</td>
<td>Preparing to Take a Picture</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Accessing the Image Setup Window</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Image Setup Options</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>General</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Exposure Window</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Auto-Exposure Window</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Manual Exposure Window</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>TTL Output</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>TTL Output/Trigger</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Chip Imaging Area</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Image Orientation</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Sensor Temperature</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Image Readout</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Post-Processing</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Calibration</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td>Auto-Save</td>
<td>103</td>
</tr>
<tr>
<td>Ch. 6</td>
<td>Using Live Images</td>
<td>105</td>
</tr>
<tr>
<td></td>
<td>Using Live Images</td>
<td>105</td>
</tr>
<tr>
<td></td>
<td>The Live Image View</td>
<td>106</td>
</tr>
<tr>
<td></td>
<td>Live Image Controls</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Live Image Controls – Auto Exposure Options</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Live Image Controls – Manual Exposure Options</td>
<td>110</td>
</tr>
<tr>
<td>Ch. 7</td>
<td>Taking a Picture</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Introduction: Three Ways to Take a Picture</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Basic Image Captures</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Get Image (exposure from setup)</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Get Image (last used exposure)</td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>Get Sequential Images</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>Image Captures in Other Procedures</td>
<td>114</td>
</tr>
<tr>
<td></td>
<td>Set Chip Imaging Area</td>
<td>114</td>
</tr>
<tr>
<td></td>
<td>Set Spot Metering Area</td>
<td>115</td>
</tr>
<tr>
<td></td>
<td>Compute Exposure</td>
<td>116</td>
</tr>
<tr>
<td></td>
<td>Recall Previous Exposure</td>
<td>116</td>
</tr>
<tr>
<td></td>
<td>Compute White Balance Values (Color Cameras)</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td>Get Bias Frame (Bias Frame Subtraction)</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td>Get Background Image</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td>Get Flatfield Image</td>
<td>118</td>
</tr>
<tr>
<td></td>
<td>Set Exposure Conversion Factor (RT Cameras Only)</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Set TTL Output Active</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Set TTL Output Inactive</td>
<td>119</td>
</tr>
<tr>
<td>Ch. 8</td>
<td>Viewing, Editing, and Annotating Images</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Viewing Captured Images</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Fit to Window</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Set Zoom Mode</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Set Zoom Level</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Show Grid Lines</td>
<td>123</td>
</tr>
<tr>
<td></td>
<td>Show Pan Window</td>
<td>123</td>
</tr>
<tr>
<td></td>
<td>Show Sequence Controls</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Show Image Date/Time</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Show Image Acquisition Settings</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Show Annotations</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Show Calibration Marks</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>Show Measurements</td>
<td>124</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
<td>Start Page</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>9</td>
<td>Using SPOT Databases</td>
<td>125</td>
</tr>
<tr>
<td>10</td>
<td>Reporting</td>
<td>181</td>
</tr>
<tr>
<td>11</td>
<td>Printing Images</td>
<td>203</td>
</tr>
<tr>
<td>Table of Contents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing a Single Image .................................................. 204</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing Multiple Images on a Page .................................... 204</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing Sequential Images ................................................ 206</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. 12 – Taskbars .................................................................... 207</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introduction ........................................................................... 207</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Developing a Taskbar ............................................................. 207</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modifying Taskbar Appearance .............................................. 208</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taskbar Size and Location ...................................................... 209</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Importing/Exporting Taskbars ................................................. 210</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 13 - Macro Scripting .................................................. 211</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introduction ........................................................................... 211</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benefits .................................................................................. 211</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creating a Macro ...................................................................... 211</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accessing and Navigating the Macro Window ......................... 211</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New ....................................................................................... 212</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record ..................................................................................... 220</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit ......................................................................................... 221</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play ........................................................................................ 222</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Macro-specific Commands .............................................. 223</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conditional Commands ............................................................. 224</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable Commands ................................................................. 233</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timing Commands ................................................................. 235</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication Commands ..................................................... 238</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. 14 – Using Other Windows Imaging Applications in Advanced Mode .................................................. 247</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introduction ........................................................................... 247</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preparing to Take a Picture ..................................................... 247</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establishing the TWAIN Interface .......................................... 247</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defining Live Image Preferences ............................................ 248</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Capture Section .......................................................... 248</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live Images Section ............................................................... 249</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bus Section (Firewire cameras only) ....................................... 250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature Readout Section (Xplorer and Pursuit cameras only) 250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device ...................................................................................... 250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Palettes option (Monochrome and Slider cameras only) ........ 250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defining Image Setups ............................................................ 251</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taking a Picture ..................................................................... 251</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capturing Initial Images ....................................................... 251</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capturing Final Images .......................................................... 252</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. 15 – Using Other Windows Imaging Applications in Basic Mode .................................................. 253</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introduction ........................................................................... 253</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establishing the TWAIN Interface .......................................... 253</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Working in the Basic TWAIN Interface ................................... 253</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defining Preferences .............................................................. 255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Capture Section .......................................................... 256</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live Images Section ............................................................... 257</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bus Section (Firewire cameras only) ....................................... 257</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature Readout Section (Pursuit and Xplorer cameras only) 257</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F-Keys .................................................................................. 258</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using the Live Image to Define Image Capture Settings .......... 258</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile ...................................................................................... 258</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exposure/Brightness Window ................................................. 259</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area/Orientation Window ...................................................... 262</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Processing Window ...................................................... 264</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White Balance (Color cameras only) ...................................... 266</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Match Color ............................................................................ 267</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill to Window .......................................................... 267</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device ..................................................................................... 268</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taking a Picture ................................................................. 268</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About This Manual

Introduction

This software user guide contains instructions for using the 4.5 version of the Spot software with the following camera lines: Insight, RT, Pursuit, Flex, and Xplorer. Some features described in this manual apply only to specific camera lines, or to specific types of cameras within those lines. In these cases, the camera line or type of camera is listed in parentheses after the feature name.

A PDF (portable document format) version of this document is also included on the CD that contains the SPOT software. Refer to your installation manual for installation procedures and technical specifications specific to your particular camera line.

Document Conventions

The following is a list of the textual conventions used in this manual:

<table>
<thead>
<tr>
<th>Notes</th>
<th>Note: This is an example of a note. Notes appear within the text to indicate information for further consideration or reference.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cautions</td>
<td>CAUTION! This is an example of a cautionary note. Cautionary notes appear to indicate that you should carefully consider the implications of an action.</td>
</tr>
<tr>
<td>Warnings</td>
<td>WARNING THIS IS AN EXAMPLE OF A WARNING. WARNINGS INDICATE THAT THE ACTION YOU ARE TAKING COULD EITHER CAUSE INJURY TO YOURSELF OR COULD HARM YOUR SYSTEM</td>
</tr>
<tr>
<td>Software Development</td>
<td>Software Development informational notes indicate special circumstances related to the current release of the SPOT software. These notes also describe how to obtain free updates from Diagnostic Instruments.</td>
</tr>
</tbody>
</table>
# Organization of the Manual

The *Spot Software User Guide* is structured as shown in the table below. In addition to the chapter names and descriptions, the table indicates whether the chapter applies to the Basic program mode, the Advanced program mode, or both:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
<th>Basic or Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Manual</td>
<td>Describes document conventions, manual structure.</td>
<td>Both</td>
</tr>
<tr>
<td>Quick Start</td>
<td>Steps for immediately capturing your first image in the Basic Program Mode.</td>
<td>Basic</td>
</tr>
<tr>
<td>Ch. 1 – New Features</td>
<td>Describes the software enhancements for version 4.0 (Windows and Mac editions) of the SPOT software.</td>
<td>Both</td>
</tr>
<tr>
<td>Ch. 2 – Basic and Advanced Program Modes</td>
<td>Compares the features of the Basic and Advanced program modes.</td>
<td>Both</td>
</tr>
<tr>
<td>Ch. 3 – The Basic Program Mode</td>
<td>Details the SPOT Basic program mode, which is designed for beginning users who want to start taking pictures immediately without having to make a lot of processing decisions.</td>
<td>Basic</td>
</tr>
<tr>
<td>Ch. 4 – The Advanced Program Mode</td>
<td>Describes the SPOT Advanced program environment, including basic file commands and preliminary setup instructions.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 5 – Preparing to Take a Picture</td>
<td>Describes the different procedures involved in setting up the software for image captures.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 6 – Using Live Images</td>
<td>Describes SPOT software’s real-time imaging functionality.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 7 – Taking a Picture</td>
<td>Describes the image capture process.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 8 – Viewing, Editing, and Annotating Images</td>
<td>Describes the rich set of image editing and customization features in the SPOT software.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 9 – Using SPOT Databases</td>
<td>Describes the procedures for creating and working with SPOT image databases.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 10 – Reporting</td>
<td>Describes the Advanced mode reporting functionality in the SPOT software.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 11 – Printing Images</td>
<td>Describes the procedures for printing images from the SPOT program.</td>
<td>Both</td>
</tr>
<tr>
<td>Chapter 12 – Taskbars</td>
<td>Describes how to develop and utilize the floating taskbar feature.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Chapter 13 – Macros</td>
<td>Describes the Macro Scripting feature including how to develop and implement Macro programs to automate your work</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 14 – Using Other Windows Imaging Applications in Advanced Mode</td>
<td>Describes how to capture images (via an Advanced Mode TWAIN interface) with the SPOT camera using other Windows-based imaging programs such as Photoshop or Image-Pro Plus.</td>
<td>Advanced</td>
</tr>
</tbody>
</table>

*This functionality is not yet available for Mac users. Refer to the Free Software Updates section below for details on obtaining updated versions of the software.*

(continues)
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
<th>Basic or Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ch. 15 – Using Other Windows Imaging Applications in Basic Mode</td>
<td>Describes how to capture images (via a Basic Mode TWAIN interface) with the SPOT camera using other Windows-based imaging programs such as Photoshop or Image-Pro Plus.</td>
<td>Basic</td>
</tr>
<tr>
<td>Ch. 16– Using Other Mac Imaging Applications – 3rd Party Interface Adv</td>
<td>Describes how to capture images with the SPOT camera using other Mac imaging programs such as Photoshop or Image-Pro Plus.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Ch. 17– Using Other Mac Imaging Applications in Basic Mode – 3rd Party Interface</td>
<td>Describes how to capture images (via a Basic Mode 3rd party interface) with the SPOT camera using other Mac imaging programs such as Photoshop or Image-Pro Plus.</td>
<td>Basic</td>
</tr>
<tr>
<td>Appendix A: Electronic Imaging Theory and SPOT Cameras</td>
<td>An introduction to the theory behind SPOT cameras.</td>
<td>Both</td>
</tr>
<tr>
<td>Appendix B: Keyboard and Toolbar Button Commands</td>
<td>A table of menu commands and their keystroke and button equivalents.</td>
<td>Both</td>
</tr>
<tr>
<td>Appendix C: Converting Previous Version SPOT Databases</td>
<td>Instructions for performing a one-time conversion of SPOT databases from earlier versions of the software.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Appendix D: Third Party Software</td>
<td>A list of imaging software systems and their levels of compatibility with various SPOT cameras lines.</td>
<td>Both</td>
</tr>
<tr>
<td>Appendix E: Correct Color Technology™</td>
<td>Instructions for setting up the computer and microscope for correct color technology™.</td>
<td>Both</td>
</tr>
</tbody>
</table>
Quick Start

Taking Your First Picture

The following sections list the basic steps for setting up your microscope and camera to immediately begin capturing images in the Basic program mode.

The picture taking process consists of two multi-part steps:

• Preparing the microscope, specimen, and camera.
• Capturing the image.

These steps assume that you have already installed the SPOT software and connected the camera to your computer. If you have not done so, refer back to the previous part of this manual, Installation Guidelines.

Preparing the Microscope and Camera

1. Select the specimen that you want to photograph, and set up the microscope for Koehler illumination.
2. Ensure that the specimen is in focus.
3. Using a daylight filter set the lamp voltage to the photo setting (or the rated lamp voltage).

Keep an assortment of ND (neutral density) filters on hand to use for images that are too bright (i.e., you receive the Exposure time too short for Camera error message).

Capturing the Image

To capture an image, follow these steps:

1. Open the SPOT Basic Program Mode.
   From the desktop click on the SPOT Basic icon.

   SPOT Basic
2. **View a real-time preview of your image capture.**
   Click on the Live toolbar button. The Live Image window appears. As the camera computes the optimal auto-exposure sequence, the title bar displays **Computing Exposure**. When the program finishes the exposure computation sequence, the title bar displays **Running**, as shown at right.

3. Use the microscope’s controls to focus and frame the image as needed.
4. **Click on the Image Settings toolbar button.**
The Image Settings window appears. Check to ensure that you are using the Profile named ‘Default’ and that the settings are as listed below. You can change between sections of the Image Settings dialogue by selecting them from the drop-down menu.

**Exposure/Brightness Section:**
- Exposure - Auto
- Image Type – (Your type of microscopy)
- Brightness – 1.00
- Gamma – 1.00
- Quality/Speed – Quality (Left-most position)
- Chip Imaging Area – Full Chip
- Live Image Auto Brightness – Selected
- Minimum Exposure- Unselected
- Live Image Maximum- 10 seconds
- Binning - None
- Filter Color (3-Shot Color and Slider cameras only)- Color
- Display Images in Grayscale (3-Shot Color and Slider cameras only) - Unchecked.

**Area/Orientation Section:**
- Chip Imaging Area- Full Chip
- Flip – As needed
- Rotate – As needed

**Image Processing Section:**
- Gamma - 1.00
- Noise Filter – Selected
- Flatfield – None

The suggested settings are designed to give you quality image captures in most, but not all cases.

If your work involves fluorescence techniques, for example, you will need to adjust the Image Type, brightness, gamma and Quality/Speed settings accordingly.
5. Click on the Get Image toolbar button.

The Get Image dialog box displays the status of the capture as it is downloaded to your screen.
Version 4.5 of the SPOT software includes the following new features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Find in Chapter(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Naming</td>
<td>If more than one SPOT camera is installed, individual cameras can be given user-selectable names. This will allow the user to call each camera separately in macro scripts.</td>
<td>Installation Guidelines</td>
</tr>
<tr>
<td>Auto-Save</td>
<td>The Auto-Save feature has been added to the Image Setup and includes the ability to append numbers to the images saved. Images can now be auto-saved to existing images or image sequences.</td>
<td>Ch. 5- Preparing to Take a Picture</td>
</tr>
<tr>
<td>View Image Acquisition</td>
<td>The user name and image setup name are now recorded with each image.</td>
<td>Ch. 8- Viewing, Editing, and Annotating Images</td>
</tr>
<tr>
<td>Support for Mouse Wheel</td>
<td>Scrolling the mouse wheel enables scrolling through document windows and edit controls.</td>
<td>Appendix C: keyboard and Toolbar Button Commands</td>
</tr>
<tr>
<td>Annotation</td>
<td>Annotations are now saved in separate layers from the image pixel data and can now be displayed or hidden as desired. The annotation attributes can now be saved as defaults.</td>
<td>Ch. 8- Viewing, Editing, and Annotating Images</td>
</tr>
<tr>
<td>Calibration Marks</td>
<td>Calibration marks are now saved in separate layers from the image pixel data and can now be displayed or hidden as desired. Calibrations are now selectable within the Image Setup.</td>
<td>Ch. 8- Viewing, Editing, and Annotating Images</td>
</tr>
<tr>
<td>Measurements</td>
<td>Measurements are now saved in separate layers from the image pixel data and can now be displayed or hidden as desired.</td>
<td>Ch. 8- Viewing, Editing, and Annotating Images</td>
</tr>
<tr>
<td><strong>Feature</strong></td>
<td><strong>Description</strong></td>
<td><strong>Find in Chapter(s)</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>TTL Output</td>
<td>The TTL output can now be raised or lowered before each sequential image acquisition.</td>
<td>Ch. 7 – Taking a Picture</td>
</tr>
<tr>
<td>Macros</td>
<td>The ability to copy and paste macro commands has been added. An option to play sounds during user prompts is also now available. Macro record and play dialogue boxes can now be rolled up and down, and the macro play dialogue box can be set to close when the macro is finished.</td>
<td>Ch. 13 - Macros</td>
</tr>
<tr>
<td>Show Variables</td>
<td>A variable display and editor dialogue has been added.</td>
<td>Ch. 8 - Viewing, Editing, and Annotating Images</td>
</tr>
<tr>
<td>Basic Mode Image Settings</td>
<td>The image settings dialogue has been divided into three sections for greater ease of use.</td>
<td>Ch. 3 - The Basic Program Mode</td>
</tr>
<tr>
<td>Taskbars</td>
<td>Multiple taskbars can now be created and displayed. Df</td>
<td>Ch. 12 - Taskbars</td>
</tr>
<tr>
<td>Import/Export</td>
<td>A feature to import and export image setups, calibrations, palettes, peripheral devices, and taskbars has been added.</td>
<td>Ch. 5 – Preparing to Take a Picture, Ch. 8 – Viewing, Editing and Annotating Images, Ch. 12 - Taskbars</td>
</tr>
<tr>
<td>Annotation/Report Objects</td>
<td>The circle has been added as a new annotation and report object.</td>
<td>Ch. 8 - Viewing, Editing, and Annotating Images, Ch. 10 - Reporting</td>
</tr>
<tr>
<td>Reports</td>
<td>The functionality of run-time text objects has been changed.</td>
<td>Ch. 10 - Reporting</td>
</tr>
<tr>
<td>Selectable Resolution</td>
<td>Shifting the CCD in sub-pixel increments can increase the resolution.</td>
<td>Ch. 5- Preparing to Take a Picture</td>
</tr>
<tr>
<td>Regulated Cooling</td>
<td>It is now possible to keep the CCD sensor temperature constant so that repeated images will have similar dark noise characteristics.</td>
<td>Ch. 5- Preparing to Take a Picture</td>
</tr>
</tbody>
</table>
Ch. 2 – Basic and Advanced Program Modes

Introduction

With the SPOT software you can work in either a Basic or an Advanced program mode.

- The Basic program mode is a simplified version of the SPOT program that enables new users to quickly start capturing images without having to go through the entire decision making processes associated with the Advanced version of the program. The Basic program mode is also ideal for users who simply need “snapshots” of their specimens. Refer to Ch. 3 – The Basic Program Mode for more details.

- The Advanced program mode is an enhanced version of the SPOT software. It is designed for more advanced users who want both greater control over the way images are captured and edited, as well as access to non-image capture functions such as database image archiving and reporting. Refer to Chapters 4 – 13 for more information on working in the Advanced program mode.

When you install the SPOT software, the installation process adds the Basic and Advanced program modes to your menu structure as well as two icons to the desktop. The following section briefly compares the two program modes.

Basic vs. Advanced Features

The Basic SPOT program includes only basic image capture and editing functionality. The following table compares the general features of the Basic and Advanced SPOT programs.

<table>
<thead>
<tr>
<th>Features</th>
<th>Advanced</th>
<th>Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>automated post-processing adjustments</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>calibration and measurement functions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>customizable (user-defined) image setups</td>
<td></td>
<td></td>
</tr>
<tr>
<td>customizable printing</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>database (Windows only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>exposure adjustment</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>image annotation</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>image editing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>image editing in multiple color spaces</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>macro scripting</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>pre-defined image setups</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>recall of exposure values used in previous images</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>reporting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sequential imaging</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>taskbars</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Introduction: Using the Basic Program

The Basic SPOT program allows you to quickly and conveniently capture and edit images, without having to make decisions related to the numerous processing and editing options available in the Advanced program.

This chapter is divided into the following sections:

• Navigating in Basic Program Mode
• Preparing to Take a Picture
• Taking a Picture
• Viewing, Editing, and Annotating Images
• Creating Reports
• Printing Options

Navigating in Basic Program Mode

The following sections are an introduction to the SPOT Basic mode operating environment. They include:

• The Viewing and Editing Window - The primary window for all image capture and editing functions.
• Opening and Saving Files - Standard file save and open features, as well as those that are unique to SPOT.
• Setup - Initial settings to customize your software.

The Viewing and Editing Window

When you open or capture an image, it appears in the main viewing and editing window. All of the image save, view, edit, and annotation functions are accessed from this window, which consists of three areas:

• The Menu Bar
• The Toolbar
• The Status Bar

The Menu Bar

The Menu Bar in the Basic program varies according to whether an image is open.

If you have not yet either captured a new image or opened an existing image, the following menus are available:

File
View
Camera
Setup
Help

If you have either captured a new image or opened an existing image, the following menus are available:

File
Edit
View
Camera
Setup
Window
Help
• The **File** menu contains file open and save options, which for the most part, are identical to the standard file open and save options. Refer to Opening and Saving Files (below) for details. In addition, the File menu contains the report creation and viewing options. Refer to the Basic Mode Reporting section of this chapter for more details.

• The **Camera** menu contains initialization, image capture, white balance, flatfield correction, and live imaging options.

• The **View** menu contains different options for viewing captured images. Refer to Viewing, Editing, and Annotating Images (below) for details. View selections are limited to “Full Screen” when an image has not yet been captured.

• The **Setup** menu contains options used to define operating preferences. Refer to Setup (below) for details.

• The **Edit** menu contains image-editing options.

• The **Window** menu contains standard Windows display options. Refer to Viewing, Editing, and Annotating Images (below) for details.

• The **Help** menu contains information about the SPOT software and enables you to access the on-line help system.

**The Toolbar**

The Toolbar appears underneath the Menu Bar and contains all of the image capture, editing, and annotation functions in the Basic program. The following diagram illustrates the Basic program Toolbar, as it appears for an open image:

![Basic Program Toolbar Diagram](image)

**The Status Bar**

The status bar at the bottom of your screen displays information about the on-screen image. The following is an illustration of the status bar, as it appears for an open image:

![Status Bar Example](image)

Each of the above call-outs is described in the following list:

• **Auto-Save ON** – If Auto-Save is enabled in the Image Setup, Auto-Save ON will be displayed. If Auto-Save is not enabled the first section of the status bar will be empty.

• **Temperature** – The current temperature of the CCD. This value will only be displayed when using an Xplorer or Pursuit camera.

• **Image size** – (Columns, rows) in pixels [e.g., (1600, 1200)].
• **Pixel bit depth** (bits per pixel) - The pixel bit depth at which the image was captured. This value reflects the pixel bit depth for the image setup that was used to capture the image. All images captured in Basic mode are 24 bpp.

• **X Y pixel coordinates** - As you move your cursor over an image, the status bar displays the x y coordinates of the cursor in pixels.

• **Brightness values** - As you move your cursor over an image, the view status bar indicates the brightness values of the pixel coordinates. The status bar displays separate red, green, and blue brightness values for each part of the image.

• **Size Settings** - In the illustration above, the view status bar displays **Fit to Win** (Fit to Window), the default image capture setting.

  - If the Fit to Window option has been deselected, this area displays the word **Normal**.
  - If you are in zoom mode, this area displays the magnification level (e.g., **Mag:x1, Mag:x1/4** etc…).

• **Modified Status** - The section to the right of the size settings remains blank until you modify an image. Once an image has been modified from the original status, the word **Modified** appears here.

---

**Note:** When the camera is on, but no image has been captured or loaded from an image file, only a limited number of toolbar icons will be functional.

**Note:** When the camera is off or not connected, only five toolbar icons will be present on the toolbar.

---

### Opening and Saving Files

All of the file open and save options in the Basic SPOT program are accessed from the File menu. These options are described below.

#### Open Image File

Open image files of a specified format (i.e., JPEG, TIFF, BMP, etc.). In addition to using this menu option, you can open images by dragging an image file from the Windows 98SE/2000/XP Desktop or Explorer onto the SPOT program window.

#### Show Image File Thumbnails

Display thumbnail previews of specified files and open images from the preview screen. To show file thumbnails, follow these steps:

1. From the File menu, select the Show Image File Thumbnails option. The Thumbnail File Spec window displays all of the image files in the directory.
2. Navigate to the directory for the image files that you want to display.
3. Use the **Files of type** drop down box, to specify the file type.
4. Select the file or files for which you want to display thumbnails. If you do not select a file or files, the program displays thumbnails for all files of the specified type in the directory.
5. Click on Open. The Thumbnails preview window appears. For each thumbnail, you can:
   - **Double-click** (Mac and Windows) on a thumbnail to open an image for viewing or modification.
   - **Right-click** (Windows) / [⌘] Click (Mac) on a thumbnail to display a list of options. The right-click menu enables you to perform a variety of actions directly from the thumbnail window:
     - Select Image
     - Open Image
     - Delete Image
     - Print Image
     - Move/Rename Image File
     - Copy Image
     - Add Image to Image Sequence (see below)
     - Add Image to Report (see below)
     - Select All Images in the thumbnail view. When you use this option, the right-click menu expands to include the above options for multiple images
6. Click and drag with the mouse to select two or more images.
Open Image Sequence File

Opens an image sequence file. An image sequence file is a single TIFF format file that contains multiple images. Refer to the Taking a Picture section of this chapter for more information on capturing image sequence files.

New Image Sequence

Create a new image sequence file. This option enables you to specify the first image in a new image sequence. This image can come from an open image or an image on disk (from file). Subsequent images can be added to the sequence in one of two ways:

- Via the Add Image to Image Sequence File menu option (see below). This option allows you either to add an open, non-sequence image to a sequence or to create a new image sequence from the image.
- Via the Sequence menu options. Here you can add any image to any point in a sequence. Refer to Working with Image Sequences in Ch. 8 for more details.

New Report

Create a new Basic Mode report. Refer to the Creating Reports section of this chapter for more details.

Open Report

Open a Basic Mode report. Refer to the Creating Reports section of this chapter for more details.

Reload

Reload the image from the hard drive (or other media). All changes made since opening the image file are lost. This option appears only when a saved image is open.

Save

Save a previously unsaved image to new file, or update the changes to an existing file. This option appears only when an image is open.

Save As

Save an image to a new file and/or file location. This option appears only when an image is open.

Save All

Save all open image files. The program prompts you for the name and file location of each image.

Close

Close an image. The program prompts you to specify a location to save the file. This option appears only when an image is open.

Move/Rename

Move and/or rename an image file. This option differs from the Save As option in that it does not retain a copy of the original file in the original location: using Move/Rename is comparable to cutting and pasting a file.

Delete

Delete an open image. The program prompts you to verify the deletion.

Export Movie File (available only when image sequence is open)

Export a SPOT image sequence file to AVI format. Follow these steps:

1. Open a SPOT image sequence. Refer to Ch. 7 – Taking a Picture, for details on capturing image sequences.
3. Enter the File Name for the avi file.
4. Specify the location where you want to save the avi file.
5. Specify which images in the sequence that you want to Export. Select either:
   - All Images – the avi file will contain all of the images in the sequence.
   - Specified Images - the avi file will contain only the images that you specify (i.e., below the radio button).
6. Specify the Frame Rate in frames per second.
7. Specify the Compression Settings. When you click on the Compression Settings button, the Video Compression dialog displays the compression application(s) available on your computer. Because each computer will have different installed applications, the Video Compression options will vary.
8. After you have entered all of the desired settings, click on Save. The program displays a status message as it exports the file.
Add Image to Image Sequence
Add an open, non-sequence image to an open image sequence, or create a new image sequence from an open image. To use this option, the non-sequence image must be the active window and the image sequence must be open in the background.

When you click on Add Image to Image Sequence, SPOT prompts you to specify either the Image Sequence or a new image sequence. If more than one image sequence is open, select the sequence from the drop-down list.

Add Image to Report
Add a selected open image to an open SPOT report. When you select this option, SPOT prompts you to select from a list of reports. If you have not defined a report, SPOT automatically creates a new report for you and inserts the image as a Static Image object. Refer to the Creating Reports section of this chapter for more details.

Duplicate Image
Create a copy of the open image.

Print
Print an open image. Refer to Chapter 11 – Printing Images for information on standard Windows and SPOT custom printing features.

Printer Setup
Define the page setup parameters. Refer to Ch. 11 – Printing Images for information on SPOT’s custom printing features.

Exit (Windows) Quit (Mac)
Exit the SPOT program.

Setup
The Basic program mode Setup menu options are as follows:

- Show Image Settings
- Calibration Setup
- Image Auto-Save
- Select Device
- Preferences

Show Image Settings
Use this option to display the Image Settings window. In the SPOT Basic Program Mode, the Image Settings window is used to define the settings for both the live image view and the final image capture. This means that you can use the Image Settings window in one of two ways:

- As a stand-alone dialog to pre-define the settings that the SPOT camera uses for capture images.
- In conjunction with the Live Image window. When using the Image Settings dialog to define the live image view, the live image settings also serve as the image capture settings. In other words, the live image view can be used as a guide to how the final image will appear.

Refer to the Preparing to Take a Picture section below for a description of the options on the Image Settings window.

Calibrations
With the SPOT program, you can use a stage micrometer to calibrate each objective on your microscope. Once calibrated, you can use the SPOT program to perform basic measurements on an image.

- For details on calibrating objectives...
  refer to the Calibration Setups section of Ch. 4.

- For details on adding measurements and/or calibration marks to your images...
  refer to the Annotation – Calibration and Measurement Marks section of Ch. 8.
**Select Camera Device**
If you have multiple cameras connected to your computer, you can select the camera to use for your imaging using this window.

**Image Auto-Save**
Use the **Image Auto-Save** feature to automatically save images as part of the capture process. To enable SPOT’s auto-save feature, select **Setup>Image Auto-Save**, and check the **Auto-Save Images** box. For details on auto-saving images, refer to the Auto-Save section of Chapter 5.

**Preferences**
Use the Preferences option to specify:
- Size of the onscreen toolbar
- Sequential imaging memory settings
- Thumbnail appearance
- Image capture settings
- Live image viewing settings
- The relative bus width used during image capture (Firewire cameras only)
- Display settings
- Temperature readout interval (Xplorer and Pursuit cameras only)

To open the Preferences window, select **Preferences** from the Setup menu. Each preference is discussed below.

**Toolbar**
Allows the user to specify whether the onscreen toolbar icons in the SPOT program should be displayed in large or small format.

**Image Sequences**

**Memory Usage Limit**
Specify how much memory is allocated for image acquisition. Note that the entry parameters are system dependent.

**Cache Images During Play**
When “playing” an image sequence (see Ch. 8), the SPOT program allows you to select how it loads the displayed images:

- If **Cache Images During Play is selected**… The program pre-loads as many images from the sequence as your computer’s RAM allows. This enables a faster display of the image sequence. But, if you have a sequence with many images, the size of the combined images could exceed the RAM, and in this case, the SPOT program will load as much of the sequence as possible, play that part of the sequence, and then pause to load the remaining images.
- If **Cache Images During Play is not selected**… The program loads each image in the sequence individually. In cases where you have a large sequence with many files, this allows you to work without being restricted by RAM limitations. The display of images will be somewhat slower than a display where images are cached.

**Thumbnails**
Specify the size of thumbnails for the Show Image File Thumbnails option.
Select from one of the following options:

- Small (60 x 60 pixels)
- Medium (90 x 90 pixels)
- Large (120 x 120 pixels)
- User Defined
  - Minimum width and height = 20 pixels
  - Maximum width and height = 200 pixels
Specify the resolution of image thumbnails (Show Image File Thumbnails option).
Select from one of the following options:

- Small (54 pixels)
- Medium (84 pixels)
- Large (114 pixels)
- User Defined
  - Minimum resolution = 16 pixels
  - Maximum resolution = 200 pixels

Specify the pixel bit depth for captured images. The Captured Image Bit Depth option enables you to specify a different image bit depth when saving an image captured in the SPOT program. The options vary depending on the camera used:

- **8 Bits per Channel** – The 8 bits per channel option provides 256 gray levels per color:
  With monochrome cameras, captured images are 8 bits per pixel monochrome.
  With color cameras, captured images are 24 bits per pixel RGB color. This option results in smaller, more manageable image sizes, and is best for images that do not require extensive modification.

- **12 Bits per Channel** – The 12 Bits per channel option provides 4,096 gray levels per color:
  With monochrome cameras, captured images are 12 bits per pixel monochrome.
  With color cameras, captured images are 36 bits per pixel RGB color. This option reduces banding problems that can result with modified images, but also results in larger file sizes. When saving 12 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 bits per channel. If you use Adobe’s Photoshop for image editing, you should select the 16 bit per channel option because Photoshop cannot read 12 bit per channel images.

- **14 Bits per Channel** – The 14 bits per channel option provides 16,384 gray levels per color:
  With monochrome cameras, captured images are 14 bits per pixel monochrome. With color cameras, captured images are 42 bits per pixel RGB color. This option further reduces banding problems that can result with modified images, but also results in even larger file sizes.

Specify whether you would like to utilize a shutter sound on image capture.
The Make Shutter Sound option, when checked, will provide a “click” sound during the camera exposure sequence, confirming that the image capture is complete. If the image capture is relatively quick, you will hear a single click. If the exposure is longer (i.e. greater than one second) you may hear a “beginning exposure” click and an “ending exposure” click.

Monitor Color Filter Position (Slider cameras only)
If this option is selected the SPOT software will produce an error message if the color filter isn’t in the proper position. The Monitor Camera Color Filter Position box is checked by default.

Live Images

Always Show Full Chip in Live Image
Ensures that you will always see the Full Chip view when viewing a live image. Keep in mind that the selection that you make here determines how the live image displays when viewing a region of the chip. Refer to the Chip Imaging Area section for details.

Temperature Readout (Xplorer and Pursuit only)
This option enables the user to specify the time interval between sensor temperature readings in seconds.

Bus (Firewire cameras only)
This allows the user to specify the relative bandwidth to be utilized when the camera is capturing and transferring data to the computer. The three choices are High, Medium, and Low.

Image Display

Open Images in Fit to Window Mode
The Fit to Window option, a program default, automatically sizes images to fit the available screen space when you open or capture an image. Thus, you can immediately see the entire image without having to zoom out. This is especially useful with smaller monitors. Open images in Fit to Window Mode is checked as a default. If you do not want images to open in the Fit to Window mode, deselect the box.
When Opening Images, Show

- **Annotations** - When selected, any annotations previously added to the image will be displayed opening it.
- **Calibration Marks** - When selected, any calibration marks previously added to the image will be displayed upon opening it.
- **Measurements** - When selected, any measurements previously added to the image will be displayed upon opening it.

When selected, the **Add Extensions to File Names on Save** option automatically appends the file type extension (e.g., JPG, tiff, bmp, etc…) to your image file. This enables cross platform file sharing, because Windows based programs require a file type extension, while Mac based programs do not. Once the file type extension is added, Windows based programs can recognize the Mac file.

### Preparing to Take a Picture

The **Image Settings** dialog is the central point for defining both live image and image capture settings. The Image Settings window enables you to optimize the live image view, and then capture an image using these settings. To open the Image Settings dialog, either click on the **Image Settings** toolbar button, or select **Show Image Settings** from the Setup menu. Each image capture/live image view option is discussed in the sections below.

#### Profile

The **Profile** option allows you to create and re-use sets of live image/image capture settings. When you make changes to any of the live image/image capture settings, these changes can be saved to a Profile – either the Default or one that you have defined. For example, if you gamma adjust a live image and then decide that the result is ideal for the type of specimen you are working with, you could create a new Profile with the gamma and exposure values and name it for that type of specimen – i.e., “Diseased Cells.”

When you close the Image Settings window, the new settings will be preserved until you close the SPOT software program or until you open the Image Settings window again and reset the values (in the same session). If you want to save the settings to the profile of interest, modify the settings, right click on the Profile name (Windows) and choose save from the menu options that are listed below. Mac users should hold the Control key while mouse clicking on the Profile name.

To add, edit, or delete Profiles, **right-click** on the Profile box. Right clicking gives the following options:

- **Add** – Add a new Profile. When you add a new Profile, the program prompts you to name it.
- **Save** – Save a Profile that you have modified.
- **Rename** – Rename an existing Profile.
- **Delete** – Delete a Profile. This option appears only if there is more than one Profile.
Each profile is divided into three windows:
- Exposure/Brightness
- Area/Orientation
- Image Processing
- The options available in these windows are detailed below.

**Exposure/Brightness Window**

**Exposure: Auto or Manual**

The Exposure option gives you the choice of having the camera calculate exposure time (Auto), or setting the exposure on your own (Manual). The exposure options will vary according to whether you select Auto or Manual, as illustrated below. When you enter one of the above exposure settings, note that it applies both to the live image that you are viewing and the captured image.

**Auto Exposure-specific options**

**Image Type**

An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 available Image Types (see below) corresponds to a microscopy technique: select the Image Type that matches the technique you are using. The camera will capture the image accordingly. The table below describes typical situations for each image type.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-reflected light</td>
<td>Polished metallurgical specimens and semi-conductors using a microscope with a vertical illuminator.</td>
</tr>
<tr>
<td>Brightfield-transmitted light</td>
<td>Stained specimens on glass slides using transmitted light microscopes.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Bright areas of specimens being viewed with darkfield, reflected light techniques.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Bright specimens on dark backgrounds using transmitted light darkfield technique.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Fluorescence specimens not fluorescing in a single red, green, or blue primary color</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>Specimens being viewed with either Nomarski DIC or Hoffman techniques.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Specimens being viewed using the phase contrast technique.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Specimens being viewed with polarized light techniques.</td>
</tr>
<tr>
<td>Stereo/macro-metallic glints</td>
<td>Metallic specimens with intense glints.</td>
</tr>
<tr>
<td>Stereo/macro–no glints</td>
<td>Matte specimens without bright glints.</td>
</tr>
<tr>
<td>Stereo/macro–shiny glints</td>
<td>Shiny specimens with bright glints.</td>
</tr>
</tbody>
</table>
Brightness

Enter a Brightness value between 0.24 and 34. A brightness value of 1, the default value, gives you the correct image brightness for most images. The Brightness control allows you to overexpose or underexpose (darken or lighten) the image area. In many cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or darken the image. When using the Brightness control, the SPOT camera uses an algorithm that combines gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode:

- When overexposing images to make them brighter (i.e., entering values greater than one), the camera first selects the highest possible gain before lengthening the exposure time. Because gain also brightens an image, less exposure time is needed.
- When underexposing images to make them darker (i.e., entering values less then one) the camera uses the lowest possible exposure time before lowering the gain.

Quality/Speed (Auto)

Use the slider to balance speed and quality when previewing dim images.

- Moving the slider toward the Quality side increases image quality and decreases frame rates.
- Moving the slider toward the Speed side increases frame rates and decreases image quality.

The Quality/Speed measurement corresponds to the Auto-Gain limit setting that allows you to set an upper limit on the gain options that will be available during the Auto-Exposure process.

- When the slider is at the left-most point, the Auto-Gain Limit gives you higher quality pictures, but lengthier exposure times.
- When the slider is at the right-most point, the Auto-Gain Limit allows the camera to select from all available gain options. This shortens exposure times, but decreases image quality.

Refer to the “Auto-Gain Limit” section in Ch. 5 – Preparing to Take a Picture for a detailed explanation of gain and exposure.

Live Image Auto-Brightness

Available only when you are using Auto exposure and viewing a live image, the Live Image Auto-Brightness option enables you to maintain a consistent brightness level for changing specimens.

Manual Exposure-Specific Options

Exposure Time(s)

Use the slider-bar to specify an exposure time (or times). When you specify an exposure time, the camera skips the automated exposure sequence that takes place when you open the live image view. This is very useful in cases where exposure times are lengthy, as with fluorescence samples.

Gain

Use the slider-bar to select one of the gain options. The gain value displays to the right of the slider-bar. Refer to the “Auto-Gain Limit” and “Gain” sections of Ch. 5 – Preparing to Take a Picture for details on gain and exposure.
Other Exposure/Brightness Options

Binning

Binning combines adjacent pixels on the CCD chip, thereby reducing the number of pixels used in the image capture. Binning is useful when you have dim images and want to increase sensitivity and reduce download time. This gives you higher frame rates and less noisy images. But, as binning level increases, image resolution decreases. All of these factors should be considered when you select a binning option.

There are different binning options, depending on the camera model. Here are some of the possible choices:

- None \(1 \text{ pixel} = 1 \text{ pixel}\)
- 2 x 2 \(4 \text{ pixels} = 1 \text{ pixel}\)
- 3 x 3 \(9 \text{ pixels} = 1 \text{ pixel}\)
- 4 x 4 \(16 \text{ pixels} = 1 \text{ pixel}\)
- 8 x 8 \(64 \text{ pixels} = 1 \text{ pixel}\)

Note: If your camera is a color mosaic version, binning will collapse the color data, resulting in a monochrome image.

Filter Color (3-Shot Color and Slider models only)

The Filter Color option specifies the color or colors that will be exposed in the live image preview/image capture.

- Red – Preview/capture a monochrome preview of your specimen using the red state of the LCD filter.
- Green – Preview/capture a monochrome preview of your specimen using the green state of the LCD filter.
- Blue - Preview/capture a monochrome preview of your specimen using the blue state of the LCD filter.
- Clear – Preview/capture a monochrome preview of your specimen using the clear state of the LCD filter. Selecting the Clear option does not provide the entirely unfiltered image that is possible with the slider cameras. Although all three colors are transmitted, the polarizing filter, which is part of the liquid crystal filter, and the IR filter remain in the light path, blocking some of the light. When using the Live Image window to focus or position dim images, slider users can slide the filter out to provide higher frame rates and less noisy images.
- None (Slider models only) – Preview capture a completely unfiltered image.

Display Images in Grayscale (3-Shot Color and Slider models only)

To counter the difficulty of viewing, focusing, and adjusting monochrome images in live mode, the Display Images in Grayscale option enables you to view a monochrome image in grayscale, as opposed to with the red, green, or blue filter. This option applies only when the Filter Color (see above) is set to Red, Green, or Blue.
Exposure Limits - Minimum

Because SPOT cameras are capable of extremely short exposure times, light sources with intensities that vary with the waveform of the 60 Hz line supply (e.g., fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps) can cause the Live Image window to flicker and result in incorrect brightness and color balance readings in captured images. The Minimum Exposure option allows you to correct for these problems by limiting the camera to a minimum exposure time that is greater than the pulse interval of the light source.

Exposure Limits – Live Image Maximum

The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing a live image. Consider the following situation: When you change from a lower resolution objective to a higher resolution objective, the camera detects a brief interval of blackness. When the Auto-Brightness option (see above) is enabled, it compensates by modifying the exposure time to maintain a constant brightness level. This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the Live Image Maximum option, you can limit this exposure time. For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path selector is incorrectly set.

Area/Orientation Window

Chip Imaging Area

SPOT allows you to use any rectangular portion of the CCD chip for image capture. Using a portion of the chip is helpful in cases where you want to:

- Keep file sizes small.
- Shorten download times.
- Avoid areas of the image with optical problems (e.g., vignette areas).

There are three image area options:

- **Full Chip** – Capture the entire area of the CCD chip.
- **Center** – Capture a rectangular part of the CCD chip’s area that has the same height - to - width ratio as the full chip, and is centered on the center of the full chip. The percentage that you enter is the percentage of full chip width that the new area’s width will be. To capture a centered proportion of an image, follow these steps:
  a) Check the Center option.
  b) Enter the percentage of the image that you want to capture. The minimum percentage is 10 and the maximum is 100.
  c) Capture the image.
- **Selection** – Capture a specific part of the CCD chip. Check the Selection option. Close the Image Settings window and open the Live Image dialog (click on the Live toolbar button). Use the mouse to select a region for capture. Click and drag to define the selection. Capture the image.
When you are viewing a live image Selection, how this selection is displayed, depends on whether the Open Images in Fit to Window Mode and Always Show Full Chip in Live Image preferences (see the Preferences section above) are checked. The following table illustrates the possibilities:

<table>
<thead>
<tr>
<th>Fit to Window Checked?</th>
<th>Always Show Full Chip in Live Image Checked?</th>
<th>Selection Display</th>
<th>Live or Captured Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a <strong>yellow rectangle</strong>.</td>
<td>LIVE</td>
</tr>
<tr>
<td>YES</td>
<td>NO</td>
<td>When you select a portion of the chip the cursor is a <strong>zoom tool</strong>. To zoom in on a portion of a live or captured image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the <strong>Full Chip</strong> option.</td>
<td>BOTH</td>
</tr>
<tr>
<td>NO</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a yellow rectangle. However, because <strong>Fit to Window</strong> is not checked, you will not see the entire chip in the window.</td>
<td>LIVE</td>
</tr>
<tr>
<td>NO</td>
<td>NO</td>
<td>When you select a portion of the image, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the <strong>Full Chip</strong> option.</td>
<td>BOTH</td>
</tr>
</tbody>
</table>

**Flip**

Specify whether images will be flipped during the image capture/live image viewing process.

- Select **Horizontal** to flip the image from left to right.
- Select **Vertical** to flip the image from top to bottom.
- Select both options to flip the image from left to right and from top to bottom.

**Rotate 90°**

Specify whether images will be rotated during the image capture/live image viewing process.

- Select **None** if you do not want the image to be rotated.
- Select **Left 90°** to rotate the image counterclockwise 90 degrees
- Select **Right 90°** to rotate the image clockwise 90 degrees.

**Resolution (Flex cameras only)**

The Flex camera has the ability to shift its CCD sensor. Moving the CCD sensor provides the user with several different resolution options.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal</strong></td>
<td>The Normal setting takes a picture without shifting the CCD sensor. Each pixel on the CCD measures one color; red, green or blue, and the other two colors are interpolated based on neighboring pixels. The Normal setting is suggested for situations where a fast image capture is needed, such as when the specimen is moving or when a fluorescent dye is quenching rapidly.</td>
</tr>
</tbody>
</table>
Ch. 3 – The Basic Program Mode

4-Shot
The 4-shot setting takes four consecutive images as the piezoelectric carriage moves the whole sensor in one-pixel increments in a 2x2 matrix so that each pixel location in the image will have each of the sensor's colors shifted through it. This mode provides full color sampling. Shifting the CCD increases the time needed to capture the image. The 4-shot setting is suggested for non-moving, non-quenching specimens and when very accurate color is required.

16-Shot
The 16-shot setting moves the sensor 16 half pixel moves in a 4x4 matrix providing full color sampling at twice the CCD resolution. This increases the time needed to capture the image. Taking sub-pixel shots also doubles the resulting file size. The 16-shot setting is suggested for non-moving, non-quenching specimens and when very accurate color and high resolution is required.

Image Processing Window

Gamma
Enter a Gamma value between .1 and 4. Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for capturing/editing images with a wide range of brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., printed circuitry).

- Values between 1 and 4 lighten the darker areas of the image.
- Values between .1 and 1 darken the mid-tones of the image.
- Gamma adjustments on live images are made in the RGB color space, the only color space where adjustments can be made quickly enough to keep up with live imaging. Refer to Ch. 5 – Preparing to Take a Picture for more details on gamma adjustment and color spaces.

Correct Color Enhancement (Correct Color Technology™) (Color Cameras Only)
The Correct Color Enhancement option utilizes camera dependent color correction profiles that optimize the matching of colors between your microscope specimen, the live image you view on the screen of your monitor, and the image you capture with your SPOT camera. This is done by transforming the raw camera color data allowing it to be adjusted to display the closest approximation of the same color on your monitor.

In order to get the best results using this feature, you should make sure you set up your imaging system including your computer monitor appropriately. See Appendix F: Correct Color Technology for more information on system set-up.

Be aware that the color correction transformations that occur when you use Correct Color Enhancement will be applied to the raw image data, leaving a modified image file. If you will require the raw data for further analysis of your image, you should uncheck the Correct Color Enhancement checkbox.

Noise Filter
The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with lengthy exposure times, the noise filter acts as a “virtual cooler” for the Insight camera, eliminating “hot pixels.”

The Noise Filter checks each pixel on the CCD chip as described below:
1. The program compares the value of each red pixel with the values of the eight neighboring red pixels.
2. If none of the eight neighboring red pixels has a value within ±15% (i.e., the threshold value that the SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being checked is replaced with the average value of the eight neighboring red pixels.

3. The program repeats this procedure for the values of the green and blue pixels being checked.

To activate the Noise Filter, check the Noise Filter box. The program runs the noise filter each time an image is captured.

**Flatfield**

The Flatfield option is used to correct for display problems associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system.

*Note: Flatfield correction with the SPOT camera refers only to the correction of uneven lighting. It should not be confused with the correction of optical field flatness.*

To use Flatfield Correct, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.
2. From the Camera menu, select Get Flatfield Image. The Get Flatfield dialog box appears.
3. Choose a number of frames to average. Larger numbers of frames will increase the accuracy of the flatfield correction, but will also increase the length of time it takes to create the flatfield image. The default number of frames to average is 3.
4. Select a name for the flatfield image file. Because flatfield image files are different for each objective, you might want to name the file according to the objective's magnification (e.g., 10x).
5. Remove the slide from the field of view.
6. Click on Begin. The program will acquire the number of frames that you specified.
7. When the program finishes acquiring the frames, it will prompt you to block all of the light to the camera. This can be accomplished by installing the dust cap that was supplied with the camera or by adjusting the microscope’s optical path. After the light is blocked, click on OK. The program computes another frame.
8. Click on the Live toolbar button.
9. Open the Image Settings window, and select the Flatfield box. The name of the flatfield file that you defined in step four should appear in the drop-down list of flatfield files.

Perform the image capture. SPOT automatically uses the flatfield image to correct the capture.

**Taking a Picture**

The actual capture of a digital image (taking the picture) is similar to traditional photographic techniques. In digital photography, however, it is possible to continually capture, refine, and recapture images until you have an optimal representation: the first image that you capture might be only one of several that you use to produce a publishable product. A sample image capture process, from start to finish might proceed as follows:

1. Adjust the Preferences as needed (see above).
2. Open the Live Image window.
3. Frame and focus the image as needed.
4. Click on the Image Settings toolbar button to access the Image Settings window and adjust the live image view settings.

5. Click on the Get Image toolbar button to capture the final image.

In the Basic program mode, image captures settings and live image view settings are defined from the same source - the Image Settings window. This gives you the convenience of being able to view a live image, adjust the settings in real-time, and then capture the image with the live image view settings.

Note: Except for the Captured Image Bit Depth, which is defined on the Preferences window, all image capture/live image settings are defined from the Image Settings window.

Initialize Camera

If you turned on the SPOT power supply after you opened the program, you need to initialize the camera in order to activate all of the capture and editing options. To do so, select the Initialize option from the Camera menu.

Viewing a Live Image

The Live Image option enables you to see a real time preview of your specimen/image capture. For instance, you can use the Live Image window to:

- Scan the image for an area of interest.
- Zoom in on an area of interest.
- Focus on an area of interest.
- Frame an area of interest.
- Define image capture settings – see Preparing to Take a Picture above for more details

Note: With some video cards, you might experience system crashes or display problems when working with live images. To correct these problems, lower the Graphics Acceleration setting in Windows, as described in the Video Card Related Problems section of the Installation Guidelines chapter.

To open the Live Image window, either click on the Live Image toolbar button, or select the Live Image option from the Camera menu.

Note: Occasionally, when viewing a dim live image, you might notice that the right half of the image is brighter or dimmer than the left half. To display images in real time, the camera uses two separate amplifiers to simultaneously read the right and left halves of the CCD chip. With some images, particularly dimmer samples, the brightness of the two halves may not match. This results in a “split” appearance. To avoid this problem with captured images, the camera reads the whole CCD through a single amplifier. A “split” Live Image view is not indicative of what your image capture will look like. Refer to Appendix A: Electronic Imaging Theory and SPOT Cameras for more details.
• The title bar at the top of the Live Image window displays the status of the live image view - **Running**, **Computing Exposure**, or **Paused**. Double-click on the title bar to “roll up” the live image display. This pauses the live image display. Double-click again to display the whole window and resume the live image display.

• When the **Fit to Window** option is checked, the live image window cursor becomes a **zoom tool**. To zoom in on a portion of a live image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the **Reset Area** button on the bottom of the window.

• When the **Fit to Window** option is not checked, the cursor is a **cropping tool**. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the **Reset Area** button on the bottom of the window.

**Note**: Due to a flaw in the Windows operating system, monitors that are set to higher resolutions cannot zoom to very high magnification levels. If zoomed in to a high magnification, the monitor displays white instead of the zoomed image.

• The **Full Screen** option (accessed via the View menu or [F 7]) can be used with live images. To access live image viewing options in the full screen view, right click on the live image.

To exit the full screen view, either press [F 7], or move the cursor to the top of the screen and click on the **Exit Full Screen Mode** button that appears.

• There are six **view/exposure options** at the bottom of the Live Image window:

  - **Restart**: Resample the brightness of the image, compute new exposure times, and restart the live image display. This is useful for updating exposure times when specimen brightness has changed.
  - **Pause/Resume**: Freeze the live image window. This is useful when you are changing a specimen and want to preserve the last view. In addition, to use the Transfer option (see below), you must first Pause the live image view. Click on Resume to restart the live image view.
  - **Close**: Close the Live Image window.
  - **Fit to Window**: Size images to automatically fit the resizable display window.
  - **Reset Area**: Return to the non-zoomed view of the live image.
  - **Faster Readout/Acceleration**: Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

### Computing White Balance Values (Color Cameras)

White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for an image. Many factors impact the coloration of an image capture, including lamp voltage, the coloration of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s objectives. To minimize the impact of these factors, use the Compute White Balance feature. When you perform a white balance calculation, SPOT samples the color of the light from your light source after it has passed through the slide and the objective, and then calculates the red, green, and blue gains needed to produce images where the white areas are white and the color areas are true.

You should perform a new white balance calculation when:

- Starting a new image capture session.
- Changing the lamp voltage.
- Switching to a different objective on the microscope.

To compute new white balance values, follow these steps:
1. Set the illumination and the objective that you will use for the image capture.

2. If you have not done so, select your Image Type (see above). Each Image Type has its own set of white balance values. Any white balance values that you compute for an image type remain linked to that image type until you compute new values. When selecting a new image type, remember that you will be using the white balance values linked to that image type.

3. Click on the White Balance button.

4. Show the camera a sample of white light. This step varies according to microscopy technique and Image Type (sample), as shown in the table below:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>White Balance Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Perform the white balance using the brightfield mode on your microscope.  See Brightfield –transmitted light above.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Use the Match Color feature</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the “gray scale” view. For Hoffman: Perform the white balance directly on the Hoffman image.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Pull all polarizers and compensators out of the light path and then position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Brightfield-reflected light</td>
<td>Replace your sample with a mirror.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Perform the white balance using the brightfield mode on your microscope.  See Brightfield –reflected light above.</td>
</tr>
<tr>
<td>Stereo/Macro (all three options)</td>
<td>Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace your sample with a white sheet of paper.</td>
</tr>
</tbody>
</table>

Click on Begin to start the calculation. The camera computes the white balance values, and they are automatically saved to the image settings for the image type that you selected.

Capturing the Final Image

Get Image captures an image according to the Image Settings that you defined (see previous sections). To capture an image, click on the Get Image button; select Get Image from the Camera menu, or press [F 9].

The Get Image status dialog box appears. Status messages display as the camera computes the gain and exposure times. If the live image window is open, the image capture uses the gain and exposure times calculated for the live image and skips the exposure computation (step 1 below). The status messages are as follows:

1. Computing Exposure – The camera is sampling brightness levels in the image in order to determine proper gain and exposure time.

2. Exposing – A countdown clock displays when the exposure will last longer than 2 seconds. This informs the user that the electronic shutter is open and counts down the minutes: seconds remaining until it closes.

3. Getting Image – The camera is downloading the image to the computer.
4. **Processing** – The camera is preparing to display the image.

The newly captured image appears on screen. If the live image screen is open, the captured image will appear behind the live image screen. To view it, simply close the live image window.

### Get Sequential Images

The Get Sequential Images option allows you to capture a sequence of images. SPOT’s sequential image capture process enables you to save an image sequence in two different ways:

- You can save a sequence as a group of individual image files.
- You can save a sequence as a single (TIF format), “sequence image file” that is composed of multiple images. Refer to the Viewing, Editing, and Annotating Images section for details on viewing and modifying image sequence files.
- Refer to Ch. 7 – Taking a Picture for details on capturing sequential images.

### Viewing, Editing, and Annotating Images

After capturing an image, you can adjust viewing options, and edit/annotate the captured image.

#### View

All of the image viewing options are accessible from two menus:

- **View** – Contains options specifically designed for viewing microscopic specimens
- **Window** – Contains standard Windows options that enable you to work with and view multiple images.

Note: The Window menu options include Cascade, Arrange Horizontally, Arrange Vertically, Arrange Icons, and Close All. For descriptions of these features, refer to the standard Windows help.

To help you view and analyze your image captures, the View menu contains seven options – **Fit to Window**, **Set Zoom Mode**, **Zoom Level**, **Show Grid Lines**, **Show Pan Window**, **Show Image Date/Time**, **Show Annotations**, **Show Calibration Marks**, **Show Measurements** and **Full Screen**.

Note: The Show Grid Lines option is available only when you zoom in on an image.

#### Fit to Window

Fit to Window allows you to view the whole image, regardless of the window size. Typically, reducing the size of a window also cuts off part of the image. The Fit to Window option solves this problem by resizing the image so that it is always the same size as the window.

#### Set Zoom Mode

1. Either select Zoom Mode from the View menu, or click on the Zoom toolbar button:
2. The cursor changes to a magnifying glass, and the Zoom toolbar button becomes active. The precise reference point for the zoom location is indicated by the white dot in the center of the magnifying glass. The row and column numbers at the bottom of the screen indicate the exact position of the white dot as you move the magnifying glass over the image.

3. Use the mouse to zoom in or zoom out:
   a) Position the mouse over the center of the area that you want to zoom in on.
   b) Either left click to zoom in 2x, or right click to zoom out 2x.
   c) To return to the normal view mode, de-select the Zoom option.

The Zoom feature works in conjunction with the pan window (see Show Pan Window below), which allows you to see where you are in relation to the larger image while zoomed in.

| Note: All of the standard save, view, and edit options, with three exceptions – Add/Edit Calibration Mark, Add/Edit Measurement, and Annotate – can be used while the program is in zoom mode. If you need to annotate a zoomed image, use the Zoom Level option (see below). |

**Zoom Level**

The *Zoom Level* option, like the *Zoom Mode* option enables you to view zoomed images. However, unlike the Zoom Mode option, the Zoom Level feature gives you the option to add annotations, including text, calibration marks, and measurements, to the zoomed image. To use the Zoom Level option, select *Zoom Level* from the View menu and select a percentage option from the list.

Like the Zoom Mode option, the Zoom Level option can be used in conjunction with the pan window (see Show Pan Window below), which allows you to see where you are in relation to the larger image while zoomed in.

| Note: With some video cards, you might experience display problems when zooming in on captured images. To correct these problems, lower the Graphics Acceleration setting in Windows, as described in the Video Card Related Problems section of the Installation Guidelines chapter. |

**Show Grid Lines**

Show Grid Lines clearly defines pixel borders, which are often invisible in low contrast areas of an image. Clearly defined borders help in positioning the cursor at an exact row and column location (i.e., using the readouts at the bottom of the screen), which then allows you to view the brightness value for the individual pixel.

To show the grid lines on an image, follow these steps:

1. Position the magnifying glass in the center of the area that you want to zoom in on.
2. Zoom to either 8x or 16x. If you are using the *Zoom Level* option, select a percentage of 800 or greater.
3. From the View menu, select the Show Grid Lines option. Grid lines appear around each pixel.

**Show Pan Window**

Show Pan Window enables you to navigate around an image while zoomed in at high magnifications. When you select the Show Pan Window option, the program highlights your location in relation to the whole image, and, by dragging the highlighted area around the pan window; you can explore the image, piece by piece. Without the Show Pan Window option, the process of moving to a new point while in high magnification would involve several steps:

1. Zooming in to the first area of interest.
2. Zooming out to determine where you are.
3. Determining a new area of interest.
4. Re-zooming in to the new area of interest.

   The pan window replaces this tedious process. When you select Show Pan Window, a smaller version of
   the image appears with a color negative over the zoomed area of the image.

To use the pan window, follow these steps:

1. Either select Show Pan Window from the View menu, or
   click on the Show Pan Window toolbar button.

   ![Show Pan Window Icon]

   Note: The pan window can be opened at any level of magnification; however the panning
   “window within the window” feature is only functional when the level of magnification exceeds
   the “fit to window” size for the captured image.

2. Position the cursor on the image in the pan window: it changes from a magnifying glass to a four-
   arrow pointer.

3. To move to a different area of the image, either left click on the rectangle and drag it to the new
   location, or left click on the new location.

### Image Date/Time

   The Image Date/Time feature pulls up the date and time associated with the capture of an image. When you
   capture an image, the SPOT software remembers the date and time of the image capture. When you save
   the image, even if this is many hours later, the program sets the *Created* date and time of the image file to
   the date and time of the original image capture.

   ![Image Date/Time Icon]

   Note: The date/time feature is synchronized to the date and time setting in your computer.

When image files are transferred over networks, the *Created* date and time is sometimes reset to the date
and time of the transfer, making it an unreliable indicator of the image capture time. Because TIFF and
JPEG format images have tags both for the Created date and the original capture date and time, network
transfers do not affect them. If reliable image capture date and time information is important to your work,
you should save images in either TIFF or JPEG format.

When you select the Image Date/Time option from the View menu, a dialog box displays the date and time
associated with the capture.

- For non-TIFF, non-JPEG format image files, this is the *Created* date/time, as explained above.
- For TIFF and JPEG format image files, this is the TIFF/JPEG tag date and time.
- For SPOT Database images (PCs only) this is the original date and time that was stored in the database
  file.

### Show Annotations

   When Show Annotations is selected, any annotations that have been added to the image will be shown.
   The Show Annotations option is inactive if no annotations have been added to the image.
Show Calibration Marks
When Show Calibration Marks is selected, any calibration marks that have been added to the image will be shown. The Show Calibration Marks option is inactive if no calibration marks have been added to the image.

Show Measurements
When Show Measurements is selected, any measurements that have been added to the image will be shown. The Show Measurements option is inactive if no measurements have been added to the image.

Full Screen
View a full screen version of an image – i.e., without the SPOT menus or toolbars or the Windows navigation bar. This option allows you to utilize the entire window for previewing images. Press [F 7] to view a full screen image or click on the Full Screen toolbar button. Press [F 7] again to exit the full screen view. Alternatively, Windows users can exit the full screen view by moving the cursor to the top of the window and clicking on the Exit Full Screen Mode button that appears.

While working in Full Screen mode, Windows users can access SPOT menu options using standard keystroke combinations, as illustrated in the table below:

<table>
<thead>
<tr>
<th>Keystroke Combination</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Alt] + A</td>
<td>Attributes (Report mode)</td>
</tr>
<tr>
<td>[Alt] + C</td>
<td>Camera</td>
</tr>
<tr>
<td>[Alt] + D</td>
<td>Database (Advanced mode)</td>
</tr>
<tr>
<td>[Alt] + E</td>
<td>Edit</td>
</tr>
<tr>
<td>[Alt] + F</td>
<td>File</td>
</tr>
<tr>
<td>[Alt] + H</td>
<td>Help</td>
</tr>
<tr>
<td>[Alt] + O</td>
<td>Object (Report mode)</td>
</tr>
<tr>
<td>[Alt] + Q</td>
<td>Sequence</td>
</tr>
<tr>
<td>[Alt] + S</td>
<td>Setup</td>
</tr>
<tr>
<td>[Alt] + V</td>
<td>View</td>
</tr>
<tr>
<td>[Alt] + W</td>
<td>Window</td>
</tr>
</tbody>
</table>

Edit
All of the editing options in the Basic program mode are accessed via the Edit menu. There are five editing categories in the Basic program mode:

- Basic editing
- Image position
- Image quality
- Calibration and Measurement
- Annotation
- Memos

The options associated with each category are described below. In some cases, where the options are identical to those in the Advanced program mode, the manual refers you to the appropriate chapter and section.
Basic Editing

The Edit menu contains several functions that are common to most operating systems.

**Undo**
Undo the last edit that you made. The Undo option only allows for one level of edits: in other words, you can only undo the immediately preceding edit. To Undo an action, select Undo from the Edit menu.

**Cut (Mac)**
Cut text fields within the SPOT program.

**Copy to Clipboard (PC)/Copy (Mac)**
Copy all or part of an image onto the clipboard for insertion into another program. These options are identical to the Windows [Ctrl C] command and the Mac [⌘ C] command.

1. Press and hold the left mouse button (PC)/mouse button (Mac).
2. Drag the cursor over the image until the dotted rectangle covers the area of the image that you want to copy. If you copy without "cutting out" a specific portion of the image, SPOT selects the entire image.
3. Either select the Copy to Clipboard/Copy option from the Edit menu, or press [Ctrl C] (PC)/[⌘ C] (Mac). The image is now ready to be pasted into another application.
4. Open the application that you want to paste the image into, and select from the available pasting options.

**Paste (Mac)**
Paste text fields in the SPOT program. The Paste field is grayed when editing images.

**Clear (Mac)**
Clear a text field in the SPOT program. The Clear field is grayed when editing images.

**Select All (Mac)**
Select an image for copying into another application.

Image Position

From the Edit menu, you can:
- Reposition images
- Match the on-screen orientation of a specimen to the microscopic view
- Crop an image to better reflect the area of interest

**Rotate Right**
Rotate an image clockwise in 90-degree increments.

**Rotate Left**
Rotate an image counter-clockwise in 90-degree increments.

**Flip Horizontal**
Flip an image from right to left

**Flip Vertical**
Flip an image from top to bottom.

**Crop**
Cut out a portion of an image. To crop an image, follow these steps:
1. Press and hold the left mouse button.
2. Drag the cursor over the image until the dotted rectangle covers the area of the image that you want to crop.
3. From the Edit menu, select Crop. The Crop Area window displays the pixel coordinates of the rectangle that you selected. From this window you can fine-tune the crop area by modifying the pixel coordinates. If you select the Crop option directly from the menu (i.e., without specifying a crop area), the Crop Area window displays the values for the entire image.
4. Click on OK to crop the image. The cropped image appears on-screen.
5. When you crop an unsaved image, the program automatically discards the area of the
image outside the crop. To give yourself the opportunity to change the crop area, you should save the image before you crop it.

Image Quality (Adjust Image)

The Adjust Image options allow you to correct images that are overly bright or dark, or to modify areas of interest that are too light or too dark to see important details. To access these editing options, select Adjust Image from the Edit menu. The Adjust Image window appears, as shown at right. Adjust images either by entering a value in the box or by moving the slider bar.

The Adjust Image window provides three adjustment parameters:

- **Color Space** – This option enables you to select the color space that is best suited to the type of image that you are editing:
  - RGB (Red Green Blue) – Use for monochrome images
  - HSL (Hue Saturation Luminance) – Use for all color images except fluorescence
  - HSV (Hue Saturation Value) – Use for fluorescence images
  
Refer to the Image Editing and the Concept of Color Space section of Ch. 8 for more detailed descriptions of the three color spaces.

- **Modify Main Image** - When this box is checked (the default), both the thumbnail image and the main image change as you are adjusting the image. If you want the main image to change after you have made the adjustments – and thereby speed the editing process - deselect the Modify Main Image box.

- **Reset** – Click on the Reset button to return the image to its pre-adjustment appearance.

The following sections describe the effect of each of the four adjustments.

**Dark Level**

The Dark Level adjustment lightens or darkens an entire image by adding the value that you specify to all of the pixels in the image.

To adjust Dark Level, enter a number between -100 and 100.3

- Numbers between zero and –100 darken the image.
- Numbers between zero and 100 lighten the image.

**Brightness**

The Brightness adjustment lightens or darkens the bright areas in an image. For example, if you used the Dark Level adjustment to modify an image, but the new bright areas are either too dark or too light to see the details, you can you use the Brightness feature to correct this. Because the Brightness adjustment is multiplicative (as opposed to the Dark Level adjustment which is additive), it multiplies the pixel values in the image by the value that you specify. A multiplicative process affects bright areas more than dark areas. Before adjustment an image's Brightness value is always one.

To adjust Brightness, enter a number between 0 and 5.

- Numbers between zero and one darken the image.
- Numbers between one and five lighten the image.

**Gamma**

The Gamma adjustment lightens the darker (mid-tone) areas of an image without burning out bright areas or lightening black areas. This is useful when modifying images with a wide dynamic range, (i.e., the range of brightness values recorded by the CCD chip. Before adjustment, the Gamma value is always one.

To adjust Gamma, enter a number between .1 and 4.

- Numbers above one lighten the mid-tone areas in the image.
- Numbers below one darken the mid-tone areas in the image.

**Contrast**

The Contrast adjustment exaggerates or subdues the difference between the bright and dark areas in an image. Before adjustment, the Contrast value is always one.

To adjust Contrast, enter a number between 0.10 and 5.

- Numbers above one exaggerate the contrast between bright and dark areas.
- Numbers below one subdue the contrast between bright and dark areas.
Match Color

The Match Color feature is typically used in two situations:

- You want to change the colors of an image on the screen to match the way that you think the specimen looks.
- You want to set the white balance for pictures taken with a microscopic technique that never has white in its images. A prime example of this situation is fluorescence microscopy.

To use the Match Color feature, follow these steps:

1. From the Edit menu, select **Match Color**. The cursor becomes an eyedropper.

2. Use the mouse to move the eyedropper to the pixel location of the color that you want to match. Refer to the status bar at the bottom of the window to ensure that each of the R, G, and B values are less than 255 (8 bit), 4095 (12 bit), or 16,383 (14 bit).

3. Click on the pixel. The Match Color window appears.

   ![Match Color Window](image)

   **Note:** The Set White Balance button appears only for image captures that have not yet been saved and closed.

   The window displays information about the pixel that you selected:

   - **Hue** – The actual color, as distinguished from others in the color spectrum. Hue is derived from a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees).
   - **Saturation** - The proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 equals pure hue (e.g., “day glow”).
   - **Original Color** – A sample “swatch” of the color that you selected. The cross hairs on the color wheel (e.g., in the center of the window) indicate the relative position of the selected color.

   The **Modify Main Image** box is checked as a default.

   Set the new color. This can be done in one of two ways, depending on whether the image should contain white:

   - If you are trying to make the selected pixel in your image appear as white (or gray if the pixel is darker), click on the **Make White/Gray** button.
   - If you are working with an image that does not have any white, modify the Hue and Saturation values so that the **New Color** “swatch” shows up as the color that you want. You can do this either by entering specific Hue and Saturation values, or dragging the cross hairs on the color wheel to the desired location.

Calibration and Measurement

The **Set Calibration**, **Add/Edit Calibration Mark** and **Add/Edit Measurement** options enable you to add calibration and measurement references to SPOT images. Refer to the **Annotation – Calibration and Measurement Marks** section of Ch. 8 for detailed steps.
Annotate

Image annotation is useful when you want to prepare captures for formal presentation, or inclusion in an article or reference work. Using SPOT’s image annotation features, you can:

- Add text to an image.
- Use an arrow, line, rectangle, or ellipse to emphasize a particular area in an image.
- Add a graphic stamp such as a company logo to an image.
- Add freehand lines to an image.
- Number objects in an image.
- Add the current user name to an image.

Other annotations are also available. To annotate an image, select Annotation from the Edit menu. Several changes take place in the SPOT image-editing environment:

- The Edit menu options change to reflect annotation editing. Refer to Editing Annotation Objects (Ch. 8) for descriptions of each option.
- The Object menu appears with options for inserting drawing objects, text, images, and image related information onto an image. Cursor functionality in SPOT reports varies according to which Object menu option is selected.
  
  If None is selected, the cursor is an editing tool for selecting, sizing, and positioning objects. When creating new reports, None is the default option.
  
  If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects on the grid. Refer to Adding Annotation Objects to SPOT Images (Ch. 8) for descriptions of each object.

- The View menu changes to reflect annotation mode:
  
  The two zoom options and the Show Grid Lines options are no longer displayed.
  
  The Show Tools option is present – this option displays the Tools dialog box, which contains shortcuts for inserting annotation-drawing objects.

  Refer to Adding Annotation Objects to SPOT Images (Ch. 8) for more details on using the Tools dialog box.
- The Attributes menu appears with options for specifying annotation qualities. Refer to Defining Annotation Attributes (Ch. 8) for descriptions of each option.
- The Done! Menu allows you to switch back to the image capture/edit mode. The Done! Menu has only one option, End Annotation Mode. When you select this option the SPOT program reverts back to the standard SPOT image-editing environment.

Memos

In the SPOT software, you can attach a memo to image files. To use the Memo option, follow these steps.

1. From the Edit menu, select Memo. The Image Memo window appears for you to enter a new memo or edit an existing memo.
2. Enter the message.
3. Click on OK to attach the memo to the image.

Working with Image Sequences

Image sequence files can be edited in the following ways, as described below:

- The Sequence menu – Rearrange the order of a sequence, add and/or remove images to and from the sequence, extract images from the sequence, and play the sequence. Refer to the Sequence Menu Options section of Ch.8 – Viewing, Editing, and Annotating Images for details.
• The **Sequence Controls (Image Sequence)** dialog – Set view options and “play” the sequence. Refer to the **Image Sequence Controls** section of Ch.8 – Viewing, Editing, and Annotating Images for details.

### Creating a Report

Using the Basic mode’s built-in reporting functionality, you can collect, organize, and present information related to your image captures. This chapter discusses the process of creating and printing reports. It is divided into the following sections:

- **Creating a New Report**
- **Working in Report Mode** – general reporting features and functionality
- **Defining View Options** – the view of the report definition screen
- **Defining Report Attributes** – the style and appearance of the report
- **Defining Report Objects** – the text, field, and image information that appears in the report
- **Editing Report Objects** – edit options for the report objects
- **Saving a Report**
- **Printing and Distributing Reports**

### Creating a New Report

To create a new SPOT report, select **New Report** from the File menu. The following changes take place in the main window:

- The report definition window appears as a separate window. If an image or image(s) were open, they remain open. When you move between an image window and the report definition window, the menu options change accordingly.
- The **Object** menu appears. Use these options to specify the fields, text, and images that appear in the report.
- The **Attributes** menu appears. Use these options to define the appearance and style of the report.
- The **View** menu options change to reflect report definition function.
- The **Edit** menu options change to reflect report-editing functions. These options are available only after one or more report objects have been added to the New Report window.

### Working in Report Mode

The report mode contains functionality that differs from the image capture and editing functionality. The following is a brief overview of these features.

### Cursor Functionality

Cursor functionality in SPOT reports varies according to which **Object** menu option is selected.

- If **None** is selected, the cursor is an editing tool for selecting, sizing, and positioning objects. When creating new reports, **None** is the default option.
- If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects to the grid.
Sizing and Positioning Report Objects

When sizing and positioning a report object in the report window, you must first select the object by single clicking on it. When an object has been selected, handles appear at the corners; for line objects, the handles appear at each end. You can select multiple report objects by holding the mouse button down and dragging the cursor around both objects. Handles appear around both objects. When selected, report objects can be sized or positioned as needed.

- To size objects, move the cursor either to a point on the object’s border or to one of the handles. The cursor changes to a two pointed arrow.
  
  To resize one dimension of a box, position the cursor on a vertical or horizontal line; click and drag the side to the new size.

- To proportionally resize a box, position the cursor on a handle; click and drag the box to the new size.

- To position objects, move the cursor over the selected object. The cursor changes to a four-point arrow. Click and drag the object to a new location. In addition, if an object is selected, you can use the arrow keys to fine-tune its position.

Note: When multiple objects are selected, they can be sized and positioned as a single object.

Using Right/\text{Ctrl}-click and Double-click Functionality

When creating a report, you can use the right-click and double-click mouse functions as editing shortcuts.

- Double clicking on a report object enables you to edit the object’s attributes – e.g., the thickness of a line.

- Right clicking (Windows)/[\text{Ctrl}] clicking (Mac) on a report object calls an object specific edit menu that contains both general editing options and attribute editing options specific to that object. Right clicking on an Image object, for example, gives you a list of editing options, as shown at right.

- Right clicking (Windows)/[\text{Ctrl}] clicking (Mac) on the report grid gives you three options: Select All objects, Paste an object that you copied or cut; or Delete All of the objects on the grid.

Refer to the Defining Report Attributes and Editing Report Objects sections for more details.

Defining View Options

The \textit{View} menu provides you with nine options:

- **Zoom**: Go to the first page in the report.
Set Display Grid Size

The report definition window includes an adjustable grid (i.e., the dots on the screen) to assist you in placing and aligning report objects on the report page. By default, the grid is turned on. To turn off or modify the grid, follow these steps:

1. From the View menu, select Set Display Grid Size.
   To turn off the display grid, deselect the Show Grid box.
   To modify the spacing follow steps two through four.
2. Select either inches or millimeters.
3. Enter the spacing for the display grid. The number that you enter represents the space in inches or millimeters between the dots on the grid.
   If the measurement is inches, enter a number between .04 and 10.
   If the measurement is in millimeters, enter a number between 1 and 25.
4. Click on OK. The display grid appears.

Set Object Grid Size

In addition to the display grid, you can define a second grid specific to report objects. The object grid controls the movement of objects as you work with them on the display grid. When you select a report object and move it, the object automatically “snaps” to the nearest line in the object grid, allowing you to more precisely align and arrange the objects on your report page.

1. From the View menu, select Set Object Grid Size.
2. If desired, check the Snap to Grid option.
3. Define the spacing for the object grid. In many cases, the object grid and the display grid will have the same spacing. In other cases, you might not want the display grid to be as finely spaced as the object grid (i.e., so the dots do not interfere with the view of the report definition window).
   If the measurement is inches, enter a number between .04 and 10.
   If the measurement is in millimeters, enter a number between 1 and 25.
4. Click on OK.

Show Tools

Click on the Show Tools option to display a floating palette of navigation buttons and report objects, as shown. Refer to the Defining Report Objects section of this chapter for more details.

Full Screen

This option allows you to use the entire screen to view a live image, without the SPOT menus/toolbar and the Windows navigation bar.

Defining Report Attributes

All of the general style and appearance options (report attributes) can be accessed from the Attributes menu. Report attributes can be defined for an entire report or on an object-by-object basis (see the Defining Report Objects section below).
When a report object is selected, the attribute is defined for the selected object(s) only.

When nothing is selected, the attribute is defined for all future, relevant objects.

The following sections detail each of the report attributes and the report objects that they affect.

**Colors**

Define the foreground and background colors for all objects. Follow these steps:

1. From the Attributes menu, select Colors.
2. Define the **Text/Lines** color. This is the color of the text, the line, or the border around a text/image box. The default foreground color is black. To select a color click on Color.
3. The next window varies, depending on whether you are using a Windows or a Mac system.
   - Windows allows you to select from a palette of colors or enter specific HSL or RGB color values.
   - Mac OS allows you to select from a palette of colors, enter specific RGB, CMYK, HLS, or HSV values, and enter Internet specific colors.
   - Define the **Background/Fill** color. This is the color that appears behind text and in boxes. Lines and images do not display a background color.

**Line Thickness**

Determine line thickness for the following report objects: **Line**, **Horizontal Line**, **Vertical Line**, **Arrow**, **Box**, **Rounded Box**, **Ellipse**, **Freehand**, **Polygon**, and **Polyline**.

1. From the Attributes menu, select Line Thickness.
2. Enter a Thickness value between .05 and 10 points.
3. Click on OK.

**Image Border and Justification**

Determine the line thickness for image borders and define the justification of the image within the display box. This option applies only to the **Image** report object.

1. To create a border around the image, click on the Border box, and enter a Thickness value between .05 and 10.
2. Select the **Justification** for the image. This value is the justification of the image within its display box, not the justification on the report page.
3. Click on OK.

**Arrow Size and Direction**

Specify the size of the arrow head and define the direction that the arrow points.

1. To specify the size of the arrow head, enter a value between 1 and 10.
2. Specify the direction of the arrow:
   - To draw an arrow starting tail first and finishing with the point (head), select **Tail to Head**.
   - To draw an arrow starting point (head) first and finishing with the tail, select **Head to Tail**.
3. Click on OK.

**Box/Ellipse Fill**

Define the appearance of the Box, Rounded Box, and Ellipse objects.

1. Specify whether you want a fill for the object.
   - If you do not want the box to be filled (i.e., you want a transparent box), click on OK.
   - If you want to specify a fill pattern for the box, check the Fill Box/Ellipse. The **Pattern** options appear.
2. Specify a pattern by clicking on one of the seven options.
3. Click on OK.
Text Font

Define the appearance of the text for the Text, Date, and Time objects.

1. Select a Font, a Font Style, and a point Size. The Sample box displays a preview of the font.
2. Define any Strikeout or Underline effects.
3. Click on OK.

Text Border, Justification, and Background

Define the appearance of the text boxes for the Text, Date, and Time objects

1. Specify whether the text box should have a border. To add a border, click on the Border box, and enter a Thickness value between .05 and 10.
2. Define the Justification of the text. This justification applies to the position of the text in the box, not the position of the text on the page.
3. Define the Background. Select either Transparent or Opaque.
4. Click on OK.

Defining Report Objects

All of the components of your report, including the formatting, text, images, and fields are known as objects. Using the objects, you can specify the information that your report will contain. Before discussing the individual report objects, review the following general procedure for inserting an object into a report:

• From the Object menu, select the type of item (i.e., Lines, Connected Lines, etc…) that you want to add to the image. The cursor’s functionality varies according to whether a report object type (i.e., line, text) is selected.

If a report object type is selected, the cursor changes to a cross-hair icon that is used to add new report objects to the grid.
If None is selected, the cursor is an editing tool that is used to select and position objects.

• Use the mouse to drag the cross hair to the location where you want to insert the object.

• Left-click at the insertion point.

If you selected a line or a box, hold down the mouse button and drag the line/box to the desired size.
If you selected any of the other report objects, the object will appear and you will be prompted to enter the associated information (e.g., static text, the location of an image file, the database field, etc…).

• Once it appears on screen, you can resize, reposition, and edit an object as needed.

Resize - Select (click on) the object and drag the handles in the direction of the resize.
Reposition – Left click and drag the object the new area.
Edit – Select the object and choose an option from either the Edit menu or the Attributes menu. You can also edit an object by right clicking (Windows)/ [Ctrl] clicking (Mac) on it.

The following table describes the Basic program mode report objects:

<table>
<thead>
<tr>
<th>None</th>
<th>Select None when you want to use the cursor to edit and position the objects.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Unconstrained Line – Add a straight-line annotation to the report.</td>
</tr>
<tr>
<td></td>
<td>Horizontal Line - Add a horizontal line annotation to the report.</td>
</tr>
<tr>
<td></td>
<td>Vertical Line – Add a vertical line annotation to the report.</td>
</tr>
</tbody>
</table>
**Arrow** - Add an arrow to the report. Either select Arrow from the Object menu, or click on the Tools box button. Left click on the report and drag toward the area that the arrowhead will point to.

**Connected Lines**

**Polygon** – Add a closed polygon to the report. Either select Connected Lines>Polygon from the Object menu, or click on the Tools box button. Left click and release, and then drag the mouse to create a side. Left click again to start a new side. Double click to finish the polygon. The program automatically adds any additional lines needed to close the figure.

**Polyline** – Add an open polygon to the report. Either select Connected Lines>Polyline from the Object menu, or click on the Tools box button. Left click and release, and then drag the mouse to create a side. Left click again to start a new side. Double click to finish the polyline.

**Freehand** - Add a freehand line to the report.

**Shapes**

**Rectangular Box** – Add a square cornered box to the report.

**Rounded Box** – Add a round cornered box to the report.

**Ellipse** - Add an elliptical object to the report. Ellipses are drawn inside of the rectangular area that you define. Ellipses touch the top, bottom, right and left sides of this rectangle.

Either select Shapes>Ellipse from the Object menu, or click on the Tools box button. To draw an ellipse, left click at the point where you want to position one vertex of the rectangle and drag the cursor to the point of the opposite vertex.

**Circle** – Add a circle to the report.

**Image**

Add an image to the report.

1. From the Object menu, select Image.
2. Left click at the point on the display grid where you want to insert the Image box, and holding down the mouse button, drag the cursor to create the desired shape and size for the image (it can also be resized/re-positioned at a later point). When you release the mouse button, the Image dialog box appears.
3. Specify the file source for the image:
   - **Currently Open Image** – Add a currently open image to the report. If you have one or more open images, SPOT lists the file name(s) and path(s) in the drop-down box. Select from the list.
   - **Image File** – Add an image from disk to the report. Specify the file name and location either by entering the path in the Name box, or clicking on the selection box to the right.
4. Click on OK. The image appears on your report grid.

**Text**

**Add text to the report.**

**Date**

Add a date text box to the report. The current date is the default.

**Time**

Add a time text box to the report. The current time is the default.

**Current User Name**

Add a user name to the report. The user currently logged on to the computer appears as the default.

**Image User Name**

Add the name of the person who was logged on when the report image was captured.
Editing Report Objects

Once you have created a report, you can edit the report objects as needed. There are three basic ways to edit a report object:

- **Use the Attributes menu** - The Attributes menu, as noted in the Defining Report Attributes section of this chapter, allows you to either set the attributes for adding specific types of objects, or to select existing objects and modify them as needed. Refer to the Defining Report Attributes section (above) for more details.

- **Use the Edit menu** - The Edit menu contains general editing features such as Undo, Copy, Cut, Send to Back, etc…

- **Right-click (Windows)/[Ctrl] click (Mac) on the report object** – Right/[Ctrl] clicking on a report object brings up a customized editing menu that contains both general editing commands and the attributes that can be edited for that object. Refer to the Working in the Report Mode section for more information on the right click function.

**The Edit Menu**

The Edit menu provides general editing features for arranging, copying, and sizing report objects. Edit menu options are active only when a report object is selected.

- **Undo**
  
  Undo the last action. The Undo feature allows you to undo up to ten actions.

- **Bring to Front**
  
  Bring a selected object in front of all other objects.

- **Move Forward**
  
  Bring a selected object one layer forward.

- **Move Backward**
  
  Send the selected object one layer back.

- **Send to Back**
  
  Send a selected object behind all other objects.

- **Select All**
  
  Select all of the objects in the report.

- **Unselect All**
  
  Removes the effect of select all or multiple highlights.

- **Delete**
  
  Delete the selected object(s).

- **Delete All**
  
  Delete all of the objects in the report.

- **Copy to Clipboard**
  
  Copy the selected object(s) to the Windows clipboard. You can then paste the object(s) into:
  
  - A new SPOT report
  - A different location in the same report
  
  This feature is particularly useful when you are creating a new report and want to use objects from an existing report.

- **Cut**
  
  Cut the selected object(s) for pasting into a new report or to a new location in the existing report.

- **Paste**
  
  Paste the object that you cut or copied to its new location.

- **Duplicate**
  
  Create additional copies of a report object. To duplicate a report object, follow these steps:
  
  1. Select the object(s) that you want to duplicate.
  2. Select Duplicate from the Edit menu. The program prompts you to enter the number of
duplicate copies.
3. Enter the number of copies, and click on OK.
4. The duplicate object(s) appear at the top of report window.

Set Position, Alignment, and Size

The Set Position, Alignment, and Size option allows you to specify precise sizing and position values for single or multiple selected report and annotation objects.

The Position options enable you to:
- Align top/bottom edges of multiple objects.
- Align left/right edges of multiple objects.
- Align the centers of multiple objects.
- Center an object(s) on the page.
- Enter exact values in inches or millimeters to position the object.

The Size options enable you to enter:
- Exact width/height in inches or millimeters for one or more objects.
- Set the width/height dimension for multiple objects the to smallest or largest object’s value in inches or millimeters.

Add Page

Add a page to your report. When you add a page, the program prompts you with the Add Page dialog box:
1. Specify whether the page that you want to add will be inserted Before or After a specified page.
2. Specify the Page Number that the additional page will precede or follow.
3. Click on OK.

SPOT reports can have a maximum of ten pages.

Delete Page

Delete a page from your report. When you select the Delete Page option, the program prompts you to specify the page number.

Add Images

Add a static image to your report.

Saving Reports

- To save a newly created report, select the Save option from the File menu.
- When saving a new report (.rpb file type), SPOT prompts you with the default file location – i.e., C:\SpotCam\Reports folder (Windows) or Users\Shared\SPOT Files\Reports (Mac). Either save to the default location or specify a new location. If you plan to save many reports without compressing the image files, you should save them to a Jaz drive or to a network drive.

Note: Mac users will see the .rpb file type extension only if the Add Extensions to File Names on Save option is selected on the Preferences window.

- Enter a file name for the report.
- Define the Compression for the image(s) in the report by selecting from None, JPEG and JPEG 2000. The JPEG 2000 Compression box is checked as a default. If you are using JPEG 2000 Compression, select either lossless or lossy from the checkbox associated with JPEG 2000. A value of from 1 to 1000 must be entered in the value box is lossy is selected.
• To turn on JPEG compression, select that box. If you are using JPEG Compression, enter a number between one and 100. A value of 1 is the most compressed. File size and image resolution are decreased to the maximum extent. A value of 100 is non-compressed. File size remains large and the image resolution remains high.

• Click on Save. You can now use the SPOT program to open and view the report at a later time.

Printing and Distributing Reports
To print a report, follow these steps:

1. Open the report.
2. Select the printer. If you have Adobe Acrobat, you can create a PDF version of your report by selecting Adobe PDF Writer as the printer of choice: select the Printer from the Page Setup dialog – i.e., File>Printer Setup>Printer. PDF files can be distributed to anyone with the Acrobat Reader software, which, as described below, is available from Adobe as a free download.
3. Click on Properties to define the printer’s properties, if needed.
4. Specify the page range if you are not printing an entire report.
5. Specify the number of copies.
6. Click on OK.

If you intend to distribute SPOT image reports to people who do not have the SPOT program, we recommend that you purchase Adobe Acrobat. Using Acrobat, you can convert the SPOT report (.rpb) files to PDF files, which can be distributed to users who do not have the SPOT software. They can view the reports with the free Acrobat Reader software, which is included on the SPOT software CD. The latest version of the Acrobat Reader can also be downloaded from the Adobe’s web site www.Adobe.com.

Image Printing
Image printing features in the SPOT basic program and the SPOT advanced program are identical. Refer to Ch. 11 – Printing Images for details.
Ch. 4 - The Advanced Program Mode

The Advanced Program Mode is an enhanced version of the SPOT software. It is designed for more advanced users who want greater control over the way images are captured and edited, and who want to make use of the image archiving database, the report generator, and the calibration mark imprinting and measuring functions. Additionally, it includes Macro Scripting allowing the user to automate image capture and post-processing procedures. Furthermore, a Taskbar feature allows the user to customize an onscreen taskbar with one touch initiation of virtually any function found in the SPOT Advanced Software program.

This chapter is an introduction to the operating environment of the Advanced SPOT program mode. Detailed discussions of the features of this mode are found in chapters 5-13. This introduction is divided into three sections:

- **The Viewing and Editing Window** - Describes the primary window for all image capture and editing functions.
- **Working With Image Files** - Discusses file save and open features.
- **Setup** - Describes the initial Setup options.

The Viewing and Editing Window

When you open or capture an image, it appears in the main viewing and editing window. All of the image save, view, edit, and annotation functions are accessed from this window, which consists of three areas:

- Menus
- The Toolbar
- The Status Bar

Menus

The menu bar in the Advanced program varies according to whether an image is open. The table below briefly describes each menu, indicates whether an image must be open in order to see it, and provides a reference to the chapter that discusses the menu options in more detail:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Functions</th>
<th>Image Must be Open?</th>
<th>Ch. Ref.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open, save, and print files. Create and run reports.</td>
<td>No</td>
<td>4, 10</td>
</tr>
<tr>
<td>Database</td>
<td>Create, access, and modify SPOT image databases.</td>
<td>No</td>
<td>9</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit and annotate images.</td>
<td>Yes</td>
<td>8</td>
</tr>
<tr>
<td>Sequence</td>
<td>Viewing/play options for image sequences.</td>
<td>Yes (image sequence file)</td>
<td>8</td>
</tr>
<tr>
<td>View</td>
<td>Viewing options for captured images</td>
<td>Yes</td>
<td>4</td>
</tr>
<tr>
<td>Camera</td>
<td>Initialize the camera, view live preview images, capture images, and perform white balances.</td>
<td>No</td>
<td>6, 7</td>
</tr>
<tr>
<td>Setup</td>
<td>Define image setups, image capture preferences, calibration setups, and Taskbars.</td>
<td>No</td>
<td>5, 12</td>
</tr>
<tr>
<td>Macro</td>
<td>Create, Edit, and Play automated image acquisition routines</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Window</td>
<td>Standard Windows display options.</td>
<td>Yes</td>
<td>4</td>
</tr>
<tr>
<td>Help</td>
<td>Information about the SPOT software and an on-line help system.</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
The Toolbar

The Toolbar provides shortcut buttons to frequently used menu items. Dragging the cursor over the Toolbar displays information about each button.

- The name of the button (and the associated menu option) displays on the toolbar.
- The function that the button performs displays on the left of the status bar.

Refer to Appendix C: Keyboard and Toolbar Button Commands for a complete listing of command equivalents in the SPOT program.

Like the menus, the Toolbar options vary according to whether an image is open, and what you are doing. The toolbar displays the options necessary in each of the following situations:

- When you first open the SPOT program…
- After you have captured or opened an image…

**When You First Open the SPOT Program…**

When you first open the program, the toolbar displays only the image capture options:

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Image</td>
<td>Show/hide live image window</td>
</tr>
<tr>
<td>Get Image (exposure from setup)</td>
<td>Take a picture</td>
</tr>
<tr>
<td>Get Image (last used exposure)</td>
<td>Take a picture using the last used exposure</td>
</tr>
<tr>
<td>Compute White Balance Values</td>
<td>Compute RGB white-balance ratios</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Toggle full screen mode</td>
</tr>
<tr>
<td>Search Database</td>
<td>Search the database</td>
</tr>
</tbody>
</table>

*(The Search Database option is active only when a database is open.)*

Refer to Ch. 6 – Working with Live Images, Ch. 7 - Taking a Picture, and Ch. 8 - Viewing, Editing, and Annotating Images for more details.

**After You Have Captured or Opened an Image…**

After you have either captured a new image or opened an existing image, the toolbar expands to include several options:
Ch. 4 – The Advanced Program Mode

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Turn on/off zoom mode</td>
</tr>
<tr>
<td>Show Pan Window</td>
<td>Show/hide the pan window (useful for navigating when zoomed)</td>
</tr>
<tr>
<td>Save As</td>
<td>Save the image to disk with a new name and/or type</td>
</tr>
<tr>
<td>Save to Database (Windows)</td>
<td>Save the image to the database (this option is active only when a database is open)</td>
</tr>
<tr>
<td>Reload</td>
<td>Reload the image from disk</td>
</tr>
<tr>
<td>Print</td>
<td>Print the image</td>
</tr>
</tbody>
</table>

Refer to Ch. 8 – Viewing, Editing, and Annotating Images and Ch. 11 - Printing Images, for more details.

The Status Bar

The status bar, which appears at the bottom of your screen, displays information about the image that is on-screen. The following is an illustration of the view status bar, as it appears for an open image:

| Auto-Save ON | -21.7C | 2048x2048 24bpp | (865,545) | 162,95,73 | Fit to Win | Modified |

Note: The status bar displays values for captured images, not for live images.

Each of the call-outs is described below.

- **Auto-Save ON** – If Auto-Save is enabled in the Image Setup, Auto-Save ON will be displayed. If Auto-Save is not enabled the first section of the status bar will be empty.

- **Temperature** – The current temperature of the CCD. This value will only be displayed when using an Xplorer or Pursuit camera.

- **Image size** – The number of columns by the number of rows of pixels in the image.

- **Pixel bit depth (bits per pixel - bpp)** - The pixel bit depth of the image. The options depend on the camera model being used.
  
  - 8 bpp (monochrome)
  - 12 bpp (monochrome)
  - 14 bpp (monochrome)
  - 24 bpp (RGB color)
  - 36 bpp (RGB color)
  - 42 bpp (RGB color)

For a detailed discussion of pixel bit depth, refer to Ch. 5 - Preparing to Take a Picture.
• **XY pixel coordinates** - As you move your cursor over an image, the status bar displays the XY coordinates of the cursor in pixels. For example, the values for the upper left corner pixel would be (0, 0).

• **Brightness values** - As you move your cursor over an image, the status bar indicates the pixel brightness values at the indicated XY pixel coordinates. The values depend on the pixel bit depth (see Ch. 5 – Preparing to Take a Picture) for the image. For example, if a color image is open, the status bar displays separate red, green, and blue brightness values [e.g., (226, 193, 174)]. If a monochrome image is open, the status bar displays only one brightness value [e.g., (176)].

• **Size Settings** - In the illustration above, the view status bar displays **Fit to Win** (Fit to Window), the default image capture setting.

If the Fit to Window option has been deselected, this area displays the word **Normal**.

If you are in zoom mode, this area displays the magnification level (e.g., 100%, 200%…)

• **Modified Status** - If you open an image file or take a picture, the section to the right of the magnification setting will read “**New**” until you modify that image. Once that image has been modified, the word **Modified** appears here. Use the Undo command to return to the New state.

**Image Setup** - The far right end of the view status bar displays the currently active Image Setup (e.g., Factory Defaults). This is the image setup that the program uses to capture images. From this part of the view status bar, you can:

- Change the currently active image setup.
- Modify an existing image setup.
- Add a new image setup to the list.

Refer to Ch. 5 - Preparing to Take a Picture, for more information on image setups.

### Working with Image Files

The File menu contains the following options:

**Open Image File**

Open image files of a specified format (i.e., JPEG, GIF, BMP, etc.). In addition to using this menu option, you can open images by dragging the image file from the Windows Explorer onto the SPOT program window.

**Show Image File Thumbnails**

Display thumbnail previews of specified files. From the thumbnail display window, there are a variety of options. To view image file thumbnails, follow these steps:

1. From the File menu, select the Show Image File Thumbnails option. The Thumbnail File Spec window displays all of the image files in the directory.
2. Navigate to the directory for the image files that you want to display.
3. Use the **Files of type** drop down box, to specify the file type.
4. Select the file or files for which you want to display thumbnails. If you do not select a file or files, the program displays thumbnails for all files of the specified type in the directory.
5. Click on Open. The Thumbnails preview window appears. For each thumbnail, you can:
   - **Double-click** (Mac and Windows) on a thumbnail to open an image for viewing or modification.
   - **Right-click** (Windows) / [Ctrl] Click (Mac) on a thumbnail to display a list of options. The right-click menu enables you to perform a variety of actions directly from the thumbnail window.
   - Click and drag with the mouse to select two or more images.

**Open Image Sequence File**

Open an image sequence file. An image sequence file is a single TIFF format file that contains multiple images:

1. Refer to Ch. 7 – Taking a Picture for information on capturing an image sequence file.
2. Refer to Ch. 8 – Viewing, Editing, and Annotating Images for information on viewing and editing image sequences.
Open Database Image
Open images from a SPOT database. The database must be open in order to use this feature. Refer to Ch. 9 – Using SPOT Databases for details on working with databases and database images.

New Image Sequence
Create a new image sequence file. This option enables you to specify the first image in a new image sequence. This image can come from an open image, an image on disk (from file), or a SPOT database. Subsequent images can be added to the sequence in one of two ways:

- Via the Add Image to Image Sequence File menu option (see below). This option allows you either to add an open, non-sequence image to a sequence or to create a new image sequence from the image.
- Via the Sequence menu options. Here you can add any image to any point in a sequence. Refer to Working with Image Sequences in Ch. 8 for more details.

New Report
Create a new Advanced mode report. Refer to Ch. 10 – Reporting for details.

Open Report
Open an Advanced mode report. Refer to Ch. 10 – Reporting for details.

Run Report
Run a report. Reports can be run in three ways - previewed, printed, or saved to file. Refer to Ch. 10 – Reporting for details.

Reload
Reload the image from the hard drive (or other media). All changes made since opening the image file are lost. This option displays only when a saved image is open.

Save
Save a previously unsaved image to new file, or update the changes to an existing file. This option appears only when an image is open.

Save As
Save an image to a new file and/or file location. This option appears only when an image is open.

Save to Database
Save an image to a database file. This option appears only when a database is open.

Save All
Save all open image files. The program prompts you for a name, file location, and image file format for each image.

Close
Close an image. The program prompts you to specify a location to save the file. This option appears only when an image is open.

Move/Rename
Move and/or rename an image file. This option differs from the Save As option in that it does not retain a copy of the original file in the original location: using Move/Rename is comparable to cutting and pasting a file.

Delete
Delete an open image. The program prompts you to verify the deletion.

Export Movie File (option available only when image sequence is open)
Export a SPOT image sequence file to AVI format. Follow these steps:

1. Open a SPOT image sequence. Refer to Ch. 7 – Taking a Picture, for details on capturing image sequences.
3. Enter the File Name for the avi file.
4. Specify the location where you want to save the avi file.
5. Specify which images in the sequence that you want to Export. Select either:
   - All Images – the avi file will contain all of the images in the sequence.
   - Specified Images - the avi file will contain only the images that you specify (i.e., below the radio button).
6. Specify the Frame Rate in frames per second.
7. Specify the Compression Settings. When you click on the Compression Settings button, the Video Compression dialog displays the compression application(s) available on your computer. Because each computer will have different installed
applications, the Video Compression options will vary.

8. After you have entered all of the desired settings, click on **Save**. The program displays a status message as it exports the file.

**Add Image to Image Sequence**

(available only when an image is open)

Add an open, non-sequence image to an open image sequence, or create a new image sequence from an open image. To use this option, the non-sequence image must be the active window and the image sequence must be open in the background.

When you click on **Add Image to Image Sequence**, SPOT prompts you to specify either the **Image Sequence** or a new image sequence. If more than one image sequence is open, select the sequence from the drop-down list.

**Add Image to Report**

(available only when an image is open)

Add a selected open image to an open SPOT report template. When you select this option, SPOT prompts you to select from a list of report templates. If you have not defined a report template, SPOT automatically creates a new report for you and inserts the image as a **Static Image** object. Refer to Ch. 10 – Reporting for details on working with SPOT reports.

**Duplicate Image**

(available only when an image is open)

Duplicate a selected open image.

**Merge Images**

Merge multiple images together. Refer to Ch. 8 – Viewing, Editing and Annotating Images for details.

**Print**

(available only when an image is open)

Print an open image. Refer to Ch. 11 – Printing Images for details.

**Print Setup**

Define the page setup parameters. Refer to Ch. 11 - Printing Images for details.

**Exit (Windows)/ Quit (Mac)**

Exit the SPOT program.

## Setup

The Setup menu options allow you to define operational standards used for image capture and editing. Refer to the sections below for descriptions of each option.

### Image Setups

In the SPOT software, an image setup serves two purposes:

- It defines the way a picture will be taken.
- It defines the way the program will automatically modify a picture after it is taken.

Pre-configured image setups for standard microscope techniques (e.g., brightfield, fluorescence, etc.) help novice users to take good pictures the first time. Experienced users can modify these pre-configured setups as needed. Refer to Ch. 5 - Preparing to Take a Picture for details.
Calibration Setups

With the SPOT program, you can use a stage micrometer to calibrate each objective on your microscope. Once calibrated, you can use the SPOT program to perform basic measurements on an image. Refer to Ch. 8, Viewing, Editing, and Annotating Images for more information on using the measurement functions.

To calibrate an objective, follow these steps:
1. Place the stage micrometer under the objective.
2. Adjust the microscope to display as much of the stage micrometer as possible. You can use the Live Image option, as described in Ch. 6 – Using Live Images, to help position the micrometer.
3. Focus on it. Use the Live Image option.
4. Capture an image of the stage micrometer. Refer to Ch. 7 – Taking a Picture for details.
5. From the Setup menu, select Calibrations. The Calibration Setups window appears (see right).
6. Click on Add. The Calibration Setup window appears.
7. Enter the name of the calibration setup. Typically this corresponds to the magnification of the objective (e.g., 4x).
8. Using the mouse, draw the calibration line along the length of the stage micrometer image. When you draw the line, keep these guidelines in mind:
   - Keep the line as straight as possible.
   - Make the line as long as possible.
   - Use the largest unit of measurement that the micrometer allows for.
To draw the line, follow these steps:
   - Position the crosshair cursor over the stage micrometer mark that represents the start point of your calibration line. In the illustration below, this is the 20 mm mark.
   - Left click on the mouse.
   - Position the crosshair cursor at the stage micrometer mark that represents the end point of your calibration line. In the illustration below, this is the 23 mm mark.
   - Left click on the mouse again. The length of the line in pixels appears on the Calibration Setup window. To re-draw a line, double click anywhere on the image. This clears the previously drawn calibration line from the screen.
9. Enter the length and units of the line that you drew (e.g., 3 mm).
10. Click on OK. The 4x objective is now calibrated to perform measurements. Repeat steps one through ten for each objective.

You can move your calibration setups to and from another computer. To import calibration setups, follow these steps:
1. Choose Calibrations from the Setup menu.
2. Click on Import.
3. Select the calibration export that you would like to import. This will be a file of type SPOT Export (spx).
4. Choose Open. The calibration export will appear in the Import menu.
5. Select the calibration export and choose Import. The calibration setup will now be ready for you to use.

To export calibration setups, follow these steps:
1. Choose Calibrations from the Setup menu.
2. Select the calibration setups that you would like to export. To select multiple calibration setups, hold down the Control button while selecting them.
3. Click on Export.
4. Select a File name and location and choose Save.

Palettes

The Palettes option on the Setup menu allows you to define new palettes and edit existing palettes. SPOT color palettes allow you to apply specific hue and saturation values to monochrome images. Palettes are useful in fluorescence applications where a sample is fluorescing at a single wavelength, and you want the acquired image to have the correct color. For such a case, you could create a palette to represent the color of the fluorescent dye and then apply that palette to the captured image. There are two ways to apply a palette to an image:

• You can associate a palette with an Image Setup, as discussed in Ch. 5 - Preparing to Take a Picture.

• You can apply a palette to a captured image by selecting the Set Palette option from the Edit menu. Refer to Ch. 8 – Viewing, Editing, and Annotating Images for more details.

To define a new palette, follow these steps:
1. From the Setup menu, select Palettes.
2. Click on Add. The Color Palette dialog appears as shown here:
3. Either use the Wavelength or Hue and Saturation selection lists or move the cross-hairs on the color wheel to enter the values

Wavelength allows the user to specify the exact wavelength ranging in value from 400nm to 700 nm. Wavelengths will automatically correspond to various Hues at full (100%) saturation.

Hue is the designation for the actual color, as distinguished from others in the color spectrum. Hue is derived from the color wheel and is expressed in the color's angular location (in degrees) on the wheel. (e.g., 0° to 360°).
**Saturation** is the proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero is pure gray and 100 is pure hue (e.g., day glow).

4. Click on **OK**.

You can move your palettes to and from another computer. To import palettes, follow these steps:

1. Choose Palettes from the Setup menu.
2. Click on Import.
3. Select the palette export that you would like to import. This will be a file of type SPOT Export (spx).
4. Choose Open. The palette export will appear in the Import menu.
5. Select the palette export and choose Import. The palette will now be ready for you to use.

To export palettes, follow these steps:

1. Choose Palettes from the Setup menu.
2. Select the palettes that you would like to export. To select multiple palettes, hold down the Control button while selecting them.
3. Click on Export.
4. Select a File name and location and choose Save.

---

**Peripheral Devices – (Peripheral Device Controller)**

**What is the Peripheral Device Controller?**

The peripheral device controller allows the SPOT program to communicate with external devices. This provides a means for directing the external device to obey simple commands. As most external devices (filter wheels, shutters, etc.) will have their own unique set of commands that they obey, you will need to access the reference documentation of the external device in order to make use of this function in SPOT software.

**Why and when would I use this feature?**

One of the powerful uses of the peripheral device controller is to automatically change the condition of the external device while you carry out an experimental process. This is most powerful when the peripheral device control commands are placed in a Macro (see chapter 13 – Macro Scripting to learn or review the use of the Macro feature).

---

**WARNING**

Note: External Devices are typically electromechanical devices that may have their own hazards of use. Before you attempt to use any external device alone or in conjunction with SPOT software, refer and abide by all instructions and warnings that accompany that external device.

Particularly note the potential hazards associated with the use of that device and do not attempt to control that device without being able to view its operation from the control location, including the computer running the SPOT software.

Additionally, note the limitations of the device you are controlling. Do not set the SPOT software to exceed those limitations as doing so could result in damage to the external device or a hazardous situation to the user.
Developing Peripheral Device Commands

Once you have the external device’s documentation and then locate its command list, you are ready to begin.

Access the peripheral device set-up editor by selecting it from the Setup dropdown menu on the menu bar.

The Peripheral Devices window will appear and will initially be empty. Push the Add button to begin.

Naming the External Device - Start by giving the device you are controlling a name that you will recognize. For example, if you are developing commands for a Sutter filter wheel, you might want to name the device as such. Be as general or specific as you need to be depending upon the number and type of external devices you could connect to your computer.
Specifying the Device’s Communication Settings - Before you push the add button, you may specify the communication information of your external device. To begin, specify the output port that the communication cable is connected from at your computer (The other end will be attached to the external device controller). Select this from the dropdown menu in the PORT box.

You will often find the other communication information in the external device reference manual, in the same section as the external command list or in the specification section. As an example, the following excerpt is from the Uniblitz VMM-D1 Shutter’s User Manual.

| RS-232C (DB-9 female) | Baud rate 9600, 8 Data bits, 1 Stop bit, No parity, No flow control, command acquisition time 0.94 msec; 6 commands available; 1 global, 8 local address locations for commands (see "ADDRESS Select" specification for switch settings of local address locations). |

Note that the specification tells you the type of communication mode (RS232C) and gives you communication specifications including Baud rate, the number of data bits, the number of stop bits, whether there is a parity bit or not and what type it is.

Select the matching information from one of the drop down menus for each Baud Rate, Parity, Data Bits, and Stop Bits.

Alternatively, you can select the Use System Port Settings checkbox. The boxes for the technical information noted above will become inactive. The communication will default to the settings specified for that port on your computer.

Note: The communication information must match between that specified and that of the external device. Otherwise, information exchange may be flawed and the external device controller may not understand the external device commands.

Push the add button to add a command name to your library.

Naming the External Device Command - You will want to name the peripheral device command. You can name it whatever you choose without regard for the function that the command will send to the external device. Logically, however, you probably want it to be closely related to the function (i.e. “Open the shutter” might be better than “Bob’s eye-opening experience”) especially if other users may be accessing these commands.

Entering the Desired Command - Once you have named the command, you must enter the corresponding command string in that box that will be understood by the external control device.

The following special notation can be used in the command string:
Ch. 3 – The Basic Program Mode

$................. “Escape” character
^A-^Z ............ Control A through control Z
\$................ Dollar sign
\\.............. Backslash
\^............... “^^” character
\ddd............... Binary value “dd” expressed in decimal
\xddd............. Binary value “dd” expressed in hexadecimal

For example, the following command options would be available for the Uniblitz VMM-D1 shutter. Note that the Peripheral Device Command feature will not support the Octal and true binary command codes listed in the following table.

<table>
<thead>
<tr>
<th>RS232 Global Address Codes</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Commands</td>
<td>Decimal</td>
<td>HEX</td>
<td>Octal</td>
<td>Binary</td>
</tr>
<tr>
<td>Open</td>
<td>64</td>
<td>40</td>
<td>100</td>
<td>01000000</td>
</tr>
<tr>
<td>Close</td>
<td>65</td>
<td>41</td>
<td>101</td>
<td>01000001</td>
</tr>
<tr>
<td>Trigger</td>
<td>66</td>
<td>42</td>
<td>102</td>
<td>01000010</td>
</tr>
<tr>
<td>Reset</td>
<td>67</td>
<td>43</td>
<td>103</td>
<td>01000011</td>
</tr>
<tr>
<td>Open B</td>
<td>68</td>
<td>44</td>
<td>104</td>
<td>01000100</td>
</tr>
<tr>
<td>Close B</td>
<td>69</td>
<td>45</td>
<td>105</td>
<td>01000101</td>
</tr>
</tbody>
</table>

If you wanted to send the “Open” command in hexadecimal, you would type the following:

![Peripheral Device Command](image)

Note: In the case above, if you were to use a command in decimal, you would need to add a zero (0) in front of the command code 64 – (ex. \064). The command string \ddd requires 3 digits.
Setting a Response Command - You may elect to receive a response when the SPOT program has sent the command, and the external device has completed that command. Click on the Response String checkbox and type in the appropriate response command. This response command string will also be found, if available, in the external device documentation.

Using Variables - In the command string, you may insert variables. The variables will be expanded at the time that the command is sent to the device. If you insert a "RunTimeText" variable, the user will be prompted, with your supplied prompt text, at the time the command is sent, and the user's response will be inserted into the command string at the point where the variable appears. The "TextVar" and "NumVar" variables may be useful when the command is used from within a macro (see Chapter 13 – Macro Scripting).

Using Timeouts - You may also select a time limit between the time that the command is sent by SPOT and the time it takes for the command to be received and the action of the function is completed. This can be handy in letting you know that there is a communication problem between the computer and the external device, when you expect an action to take place within a prescribed length of time.

Testing the Peripheral Device Command - You may test the command immediately by selecting the Test button. If you have selected timeout duration, a response window will let you know if the command has not been received and carried out within the prescribed length of time.

Note: Make sure your external device is connected properly to the computer and that it is turned on before considering other potential communication problems.

Modifying and Deleting the Peripheral Device Command – Once you have created a command, you can modify its parameters or delete it. Select the command from the Peripheral Device Window and push the modify or delete button.

Using the Peripheral Devices Commands

From the Dropdown menu - Once you have created at least one peripheral device, a "Peripheral Devices" menu will appear in the application. You can send any of the commands you defined by selecting it from the appropriate submenu.
In a Taskbar - You can also add any of your peripheral device commands to your floating taskbar in the same way that you can add any other menu command (see screenshot below). Once placed on a taskbar, simply click on the Peripheral Device command and it will be carried out (For a review of taskbar development, see Chapter 12- Taskbars).

In a Macro - Finally, you can use any of these peripheral device commands as part of a Macro program that you develop. On playback of the Macro, the peripheral device commands will be carried out in the sequence and order specified in the Macro program (see Chapter 13 for a review of developing Macros).

You can move your peripheral device commands to and from another computer. To import peripheral device commands, follow these steps:

1. Choose Peripheral Devices from the Setup menu.
2. Click on Import.
3. Select the peripheral device export that you would like to import. This will be a file of type SPOT Export (spx).
4. Choose Open. The peripheral device export will appear in the Import menu.
5. Select the peripheral device export and choose Import. The peripheral device commands will now be ready for you to use.

To export peripheral device commands, follow these steps:

1. Choose Peripheral Devices from the Setup menu.
2. Select the peripheral devices you would like to export. To select multiple peripheral devices, hold down the Control button while selecting them.
3. Click on Export.
4. Select a File name and location and choose Save.
Taskbar

The taskbar option, when selected, will open a taskbar development window, allowing the user to add, modify, or delete taskbar buttons from the floating taskbar. Please see Chapter 12 for a detailed discussion regarding the development and use of the timesaving Taskbar feature.

Select Device

Selecting this option from the dropdown menu will allow the user to switch between SPOT cameras running on the same computer. When an alternate device is selected, for example from an Insight camera to an RT camera, the menu and toolbars will adjust to acknowledge the appropriate options and settings for the new device. The SPOT program, however, will not shut down. This on the fly device switching capability can be very convenient for the user with the need for multiple cameras during the day.

Preferences

Use the Preferences option to specify:

• Size of the onscreen toolbar
• Sequential imaging memory settings
• Thumbnail appearance
• Live image viewing settings
• The relative bus width used during image capture
• Captured Image Bit Depth and Fit to Window view settings
• File type extension setting (Macs only).
• Temperature Readout settings (Xplorer and Pursuit cameras only)
• Bus speed (Firewire cameras only)
• Display of annotations, calibration marks, and measurements

To open the Preferences window, select Preferences from the Setup menu. Each preference is discussed below.

**Toolbar**

Specify whether the onscreen toolbar icons in the SPOT program should be displayed in large or small format, and where the toolbar should be placed onscreen.

**Memory Usage Limit**

Specify how much memory is allocated for image acquisition. Note that the entry parameters are system dependent.

**Cache Images During Play**

When “playing” an image sequence (see Ch. 8), the SPOT program allows you to select how it loads the displayed images:

• **If Cache Images During Play is selected…** The program pre-loads as many images from the sequence as your computer’s RAM allows. This enables a faster display of the image sequence. But, if you have a sequence with many images, the size of the combined images could exceed the RAM, and in this case, the SPOT program will load as much of the sequence as possible, play that part of the sequence, and then pause to load the remaining images.

• **If Cache Images During Play is not selected…** The program loads each image in the sequence individually. In cases where you have a large sequence with many files, this allows you to work without being restricted by RAM limitations. The display of images will be somewhat slower.
than a display where images are cached.

Specify the size of thumbnails for the Show Image File Thumbnails option
Select from one of the following options:
- Small (60 x 60 pixels)
- Medium (90 x 90 pixels)
- Large (120 x 120 pixels)
- User Defined
  Minimum width and height = 20 pixels  Maximum width and height = 200 pixels

Specify the resolution of image thumbnails (Show Image File Thumbnails option)
Select from one of the following options:
- Small (54 pixels)
- Medium (84 pixels)
- Large (114 pixels)
- User Defined
  Minimum resolution = 16 pixels  Maximum resolution = 200 pixels

Specify whether you would like to utilize a shutter sound on image capture.
The Make Shutter Sound option, when checked, will provide a “click” sound during the camera
exposure sequence, confirming that the image capture is complete. If the image capture is relatively
quick, you will hear a single click. If the exposure is longer (i.e. greater than one second) you may
hear both a begin click and an end click.

Monitor Color Filter Position (slider cameras only)
If this option is selected the SPOT software will produce an error message if the color filter isn’t in the
proper position. The Monitor Camera Color Filter Position box is checked by default.

Always Show Full Chip
Selecting Always Show Full Chip ensures that you will always see the Full Chip view when viewing
a live image. Keep in mind that the selection that you make here determines how the live image
displays when viewing a region of the chip. Refer to the Chip Imaging Area section for details.

Maximum Exposure
The Maximum Exposure option helps you to avoid unnecessarily long exposures when viewing a live
image. Consider the following situation: When you change from a lower resolution objective to a
higher resolution objective, the camera detects a brief interval of blackness and compensates by
modifying the exposure time to maintain a constant brightness level. This results in you having to
wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the
Maximum Exposure option, you can limit this exposure time. For most cases, Diagnostic
Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can
also be used in cases where the microscope’s light path selector is incorrectly set.

Do Post-Processing on Snapped Images
Specify whether to apply the Post Processing options for the current Image Setup to images
captured using the Snap option. When selected, all of the Post Processing options from the current
Image Setup will be applied except for Background Subtraction and Flatfield Correction.

Close Window on Snap
Selecting this option will close the Live Image Window each time you capture an image using the
Snap button in that window. If this option is not selected, captured images from snap will “stack up”
behind the live image window.

Temperature Readout
(Xplorer and Pursuit only)
This option enables the user to specify the time interval between sensor temperature readings in
seconds.

Bus (Firewire cameras only)
This allows the user to specify the relative bandwidth to be utilized when the camera is capturing and
transferring data to the computer. The three choices are High, Medium, and Low.
Image Display

Open Images in Fit to Window Mode
The Fit to Window option, a program default, automatically sizes images to fit the available screen space when you open or capture an image. Thus, you can immediately see the entire image without having to zoom out. This is especially useful with smaller monitors. Open Images in Fit to Window Mode is checked as a default. If you do not want images to open in the Fit to Window mode, deselect the box.

When Opening Images, Show

- Annotations - When selected, any annotations previously added to the image will be displayed opening it.
- Calibration Marks - When selected, any calibration marks previously added to the image will be displayed upon opening it.
- Measurements - When selected, any measurements previously added to the image will be displayed upon opening it.

Add Extensions to File Names on Save (Mac)

When selected, the Add Extensions to File Names on Save option automatically appends the file type extension (e.g., JPG, tiff, bmp, etc…) to your image file. This enables cross platform file sharing, because Windows based programs require a file type extension, while Mac based programs do not. Once the file type extension is added, Windows based programs can recognize the Mac file.
Ch. 5 – Preparing to Take a Picture

Introduction: What is an Image Setup?

An image setup serves two crucial purposes:
• It defines the way a picture will be taken.
• It defines the way a picture will be modified after it is taken.

Image setups are defined to optimize the picture taking process for different types of images or microscopy techniques. They can be created, saved, and recalled as needed.

Accessing the Image Setup Window

To define a new image setup or to edit an existing setup, follow these steps:

From the Setup menu, select the Image Setups option. The Image Setups window appears. Either double-click on a setup to open it, or select one of the following options:

Add - To create a new image setup, click on Add. The New Image Setup dialog box appears with a list of templates (image types) that serve as the basis for the new image setup.

Modify - To edit an existing image setup, select a setup from the list, and click on Modify. The Image Setup window appears.

Delete - To delete an image setup, select a setup from the list and click on Delete.

Current – To make a setup the active setup, select the setup from the list and click on Current.

Import – To import an image setup, select Import and select a file of type SPOT Export (spx).

Export – To export an image setup, select the image setup and click on Export. Select a location and file name and click Save.

Close - To exit the dialog box, click on Close.

Note: Flatfield correction and background subtraction files cannot be imported or exported to a different computer. These will need to be copied over manually.

Shortcuts: You can quickly access the Image Setup window by right clicking the drop-down box in the bottom right corner of your screen. The box displays the name of the current (active) Image Setup.

To change the current (active) image setup, left click on the tab and select the new Image Setup.
– To define a new image setup or to modify an existing image setup, right click on the box, and select Add.
– To modify the current image setup, right click on the box and select modify.
– To access the current image setup, press [F12].
If you select the Add option (i.e. to create a new image setup), the New Image Setup window appears. The pre-defined templates (image types) are indicated by brackets < >, while user-defined setups appear without brackets.

1. **Select an image type from the list.**
The 11 pre-defined image types (in addition to the Factory Defaults setting) correspond to commonly used microscopy techniques. To define a new image setup, you must also select an image type as a template for defining the new setup. The image type provides a baseline set of values for that setup, according to the microscopy technique you are using. The following table describes SPOT’s pre-defined image types:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Stained specimens on glass slides using transmitted light microscopes.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Bright specimens on dark backgrounds using transmitted light darkfield technique.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Fluorescence specimens not fluorescing in a single red, green, or blue primary color. The camera exposes images using all three colors.</td>
</tr>
<tr>
<td>Fluorescence – red</td>
<td>Fluorescence specimens fluorescing in red. Exposure time is reduced because only one color is exposed.</td>
</tr>
<tr>
<td>Fluorescence – green</td>
<td>Fluorescence specimens fluorescing in green. Exposure time is reduced because only one color is exposed.</td>
</tr>
<tr>
<td>Fluorescence – blue</td>
<td>Fluorescence specimens fluorescing in blue. Exposure time is reduced because only one color is exposed.</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>Specimens being viewed using Nomarski DIC or Hoffman techniques.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Specimens being viewed using the phase contrast technique.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Specimens being viewed with a polarized light microscope.</td>
</tr>
<tr>
<td>Brightfield-reflected light</td>
<td>Polished metallurgical specimens and semi-conductors using a microscope with a vertical illuminator.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Bright areas of specimens being viewed with darkfield, reflected light techniques.</td>
</tr>
<tr>
<td>Stereo/macro–no glints</td>
<td>Matte specimens without bright glints.</td>
</tr>
<tr>
<td>Stereo/macro–shiny glints</td>
<td>Shiny specimens with bright glints.</td>
</tr>
<tr>
<td>Stereo/macro-metallic glints</td>
<td>Metallic specimens with intense glints.</td>
</tr>
</tbody>
</table>
2. Click on OK. The Image Setup window appears.

Image Setup Options
The Image Setup window consists of several options, each with a different window. Each window (above) has a menu on the left that allows you to navigate to any of the windows. The right side of the window includes options specific to that window. The windows available depend on the camera model being used.

General
You will note that the header provides a consistent reminder of the following information, no matter which of the windows you are in.

- Name
- Locked
- Acquired Image - Bits per Pixel

Name
Use this box to enter the name of a new image setup, or to modify the name of an existing setup. If you modify the name of an existing setup, the program prompts you (when you click OK) to save this as a new setup or overwrite the original setup.

Locked
The Locked option allows you freeze the settings for an Image Setup that you have defined. This is useful in cases where multiple users have access to the program and you want to preserve the settings that you defined.

To lock an Image Setup, click on the Locked box. When another user opens the Image Setup, the settings are unavailable for entry until the Locked box is unchecked. The Locked box, along with the appearance of the window, serves as a message that the settings should not be modified.

Acquired Image
The Acquired Image section options enable you to define the characteristics of captured images. This includes:
• Bits per Pixel
• Palette (Monochrome or Slider Cameras only)

**Bits per Pixel**

*Bits per pixel (or Pixel Bit Depth)* is the number of bits per pixel (bpp) that the camera uses to create an image. The SPOT program provides different options, depending on which camera model you are using.

---

**Note:** Users can use the Change Pixel Bit Depth option to convert the pixel bit depth for a captured image to a different setting.

For color camera users, the 24 bpp RGB color setting is the most common selection because it is an industry standard color format that is used by Windows and most printers. Most monitors cannot display more than 24 bpp. Select a Pixel Bit Depth by clicking on the Bits per Pixel drop-down box. In addition to specifying the bits per pixel of the image, your selection determines the Gain and Gain Limit choices (see appropriate sections in this chapter) as illustrated in the table below:

<table>
<thead>
<tr>
<th>Bits per Pixel</th>
<th>Camera</th>
<th>Available Gain/Gain Limit Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>All</td>
<td>1, 2, 4, 8, 16</td>
</tr>
<tr>
<td>12</td>
<td>All</td>
<td>1, 2</td>
</tr>
<tr>
<td>14</td>
<td>Some cameras</td>
<td>1,2,4,8,16,32</td>
</tr>
<tr>
<td>24</td>
<td>All color cameras</td>
<td>1, 2, 4, 8, 16</td>
</tr>
<tr>
<td>36</td>
<td>All color cameras</td>
<td>1, 2</td>
</tr>
<tr>
<td>42</td>
<td>Some color cameras</td>
<td>1,2,4,8,16,32</td>
</tr>
</tbody>
</table>

---

**Note:** When you select 8 or 24 bit, your options for saving a captured image include Bitmap, JPEG, JPEG 2000, Pict (Mac), TIFF (uncompressed) and TIFF-JPEG. When you select 12 or 36 bit, your options are limited to TIFF (12 or 16 bit uncompressed and JPEG 2000). When you select 14 or 42 bit, your options are limited to TIFF (16 bit uncompressed) and JPEG 2000.

The following table lists the available image depth options and describes some of the potential uses, advantages, and disadvantages associated with each setting.

<table>
<thead>
<tr>
<th>Pixel Bit Depth Settings</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 bpp (monochrome)</td>
<td>The 8 bit setting is often used in cases where 256 gray levels are adequate. The lower number of bits per pixel results in smaller, more manageable file sizes.</td>
</tr>
<tr>
<td>All cameras</td>
<td></td>
</tr>
<tr>
<td>12 bpp (monochrome)</td>
<td>The greater number of bits per pixel in the 12 bit setting provides users with 4096 gray levels. This provides a more accurate means of measuring brightness in a monochrome image, and helps to reduce banding problems that often appear when an image is modified.</td>
</tr>
<tr>
<td>All cameras</td>
<td></td>
</tr>
</tbody>
</table>
14 bpp (monochrome)  
Some cameras  
The number of bits per pixel in the 14 bit setting provides users with 16,384 gray levels. This provides even more accurate means of measuring brightness in a monochrome image, and helps to further reduce banding problems that often appear when an image is modified.

24 bpp (RGB color)  
All color cameras  
The 24 bit setting provides 8 bits per color, per pixel (i.e., 8 x 3 = 24). As noted, 24 bpp is the most common choice because it is an industry standard in terms of printing, the Windows operating system, and monitor display.

36 bpp (RGB color)  
All color cameras  
The 36 bit setting provides 12 bits per color, per pixel (i.e., 12 x 3 = 36). 36 bpp is used in cases where images are modified. The 36 bit setting provides users with 4096 brightness levels per color and thereby reduces banding problems when images are stretched.

42 bpp (RGB color)  
Some color cameras  
The 42 bit setting provides 14 bits per color, per pixel (i.e., 14 x 3 = 42). 42 bpp is used in cases where images are heavily modified. The 42 bit setting provides users with 16,384 brightness levels per color and thereby reduces banding problems significantly when images are stretched.

Palette (B/W; 3-Shot Color; Slider Cameras Only)  
SPOT color palettes allow you to apply specific hue and saturation values to monochrome images. Palettes are useful in fluorescence applications where a sample is fluorescing at a single wavelength, and you want the acquired image to have the correct color. For such a case, you could create a palette to represent the color of the fluorescent dye and then apply that palette to the captured image. The Palette option on the Image Setup window allows you to automatically apply a palette to a monochrome image capture.

Note: Applying a color palette to an image capture does not affect image data.

To apply a palette, select one from the drop down list. There are four pre-defined palettes: Red, Green, Blue, and Grayscale. Because the Palettes option applies only to monochrome images, it is available only when either an 8 bpp, 12 bpp, or 14 bpp Pixel Bit Depth is selected. You can define custom palettes using the Palettes option on the Setup menu. Refer to Ch. 4 – The Advanced Program Mode for more information.

Exposure Window  
The Exposure window selections tell the camera what settings to use when taking a picture. Carefully considered definition of these settings helps to ensure that your images come out as planned. The Exposure options vary according to two variables:

- The camera model that you have
- The Bits per pixel setting

Each Exposure option is described below. If an option is unique to a specific camera, this is indicated parenthetically.
**Type**

**Auto**

When you select **Auto** the camera samples light levels in the image plane (as the initial part of the image capture) and uses the values to calculate the final exposure time.

**Manual**

When you select **Manual**, you specify the exposure times. This can be done either by entering a value or values, using the Compute Exposure option, or by the Recall Previous Exposure option.

The sections that follow detail all of the Exposure options. If an option is available only for specific camera models, only at certain pixel bit depths, or only for either automated or user-defined exposure, this is indicated parenthetically next to the heading.

**Use Filter**

**(Slider cameras only)**

The Use Color Filter option specifies the position of the color filter for image captures, as well as the color that will be exposed in the image capture. The Use Filter option does not change the position of the filter: this must be done by physically sliding the filter to the desired position. If the Use Color Filter setting does not match the filter’s position, SPOT prompts you with an error message. However, this error message appears only if the Monitor Camera Color Filter Position option on the Preferences window (see Ch. 4) is selected.

To specify the Use Filter settings, follow these steps:

1. Ensure that the Bits per Pixel is set to either 8 bpp or 12 bpp.
2. Specify the position of the color filter:
   - To specify that the sliding color filter will be in the light path, ensure that the Use Color Filter box is selected. Go to step three.
   - To specify that the sliding color filter will be out of the light path, deselect the Use Color Filter box. Go to step four.
3. Specify the color that will be used.
4. Ensure that the color filter is in the correct position.
   - If you are using the filter, the slider knob should be in the **COLOR** position.
   - If you are capturing an unfiltered image, the slider knob should be in the **B/W** position.
Filter Color

(3-Shot Color and Slider cameras only)

Filter Color specifies the color of the filter that will be used when taking a monochrome picture.

To ensure a high image quality, SPOT users should select the color that is closest to the color of the specimen. For example, if you are looking at a single stained fluorescence, selecting the color filter that most closely matches the color of the stain shortens the time it takes to acquire the image. In addition, SPOT cameras feature a second generation liquid crystal filter that allows all three colors (e.g., red, green, and blue) to be transmitted. This is the Clear option.

Note: Selecting the Clear option does not provide the entirely unfiltered image that is possible with the slider camera. Although all three colors are transmitted, the polarizing filter, which is part of the liquid crystal filter, and the IR filter remain in the light path, blocking some of the light. When using the Live Image window to focus or position dim images, slider users can slide the filter out to provide higher frame rates and less noisy images.

To select a filter color for capturing a monochrome image, follow these steps:
1. Ensure that the Pixel Bit Depth is set to 8 (mono), 12 (mono), or 14 (mono).
2. Click on either the Auto-Exposure or the User-Defined Exposure option.
3. Select one of the following options:
   • Red
   • Green
   • Blue
   • Clear

Use: Red Green Blue

(3-Shot Color and Slider cameras only)

Use: Red Green Blue specifies the colors that will be exposed. For most situations, you should select all three colors. However, in situations where you know that your specimen lacks one or two of the colors, you can avoid the additional exposure and download time by “turning off” (deselecting) the missing colors. For example, if you have a pumpkin colored fluorescence sample with no blue in it, you can deselect the blue value. The camera only exposes the red and green values.

Note: When you add a new 24 bpp or 36 bpp image setup, all three colors are selected as the default.

To set the color filters for capturing a color (RGB) image, follow these steps:
1. Ensure that the Pixel Bit Depth is set to either 24 (color) or 36 (color).
2. Click on either the Auto-Exposure or the User-Defined Exposure option.
3. Deselect one or two of the color option boxes, or leave all three checked.
   • Red
   • Green
   • Blue

To save the image setup, at least one color must be selected.

Slider – If capturing an unfiltered image, it does not matter which color you select.
To recall the exposure time and gain from the previously captured image, follow these steps:

1. From the Camera menu, select the Recall Previous Exposure option. The Exposure window displays the exposure time and gain used for the previously captured image.

2. Select the setup that you want to save the exposure settings to, and click on OK. The settings are saved to the image setup that you specify.

Note: When you save the previously used exposure value to an image setup, it automatically changes the setup from Auto – Exposure to User Defined.

**Binning**

Binning is a pre-exposure option that tells the camera to combine adjacent pixels on the CCD chip. The camera treats each set of combined pixels as one large pixel. The large pixels accumulate electrons faster and are therefore more sensitive to light. Binning has three effects on image processing:

- Light sensitivity is increased.
- Download time is decreased.
- Resolution is decreased.

Binning is particularly helpful when you want to drastically reduce exposure and download times for dim images and you don’t mind a decreased resolution. This gives you higher frame rates and less noisy images. The SPOT camera offers different binning options depending on the model of the camera.

Note: If you bin with a color mosaic camera, the color information will be collapsed and the image will appear monochrome.

**Color Order (3-Shot Color and Slider cameras)**

In addition to allowing you to specify specific exposure colors, the SPOT camera allows you to specify the order in which the colors are exposed. This feature is particularly useful for triple stained fluorescence samples, where one color dye might fade before the others. For example, if a green dye fades first, you can set green to be the first exposure, thereby catching the green parts of the sample before they fade. To set the Color Order for an image capture, follow these steps:

1. Select the color or colors that you want to expose for the picture.
2. Click on the Color Order scroll bar.
3. Select the Color Order that you want to use.

Note: The default Color Order setting for a full color image is RGB.
Resolution (Flex cameras only)

The Flex camera has the ability to shift its CCD sensor. Moving the CCD sensor provides the user with several different resolution options.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The Normal setting takes a picture without shifting the CCD sensor. Each pixel on the CCD measures one color; red, green or blue, and the other two colors are interpolated based on neighboring pixels. The Normal setting is suggested for situations where a fast image capture is needed, such as when the specimen is moving or when a fluorescent dye is quenching rapidly.</td>
</tr>
<tr>
<td>4-Shot</td>
<td>In the 4-shot mode, the camera takes four consecutive images as the piezoelectric carriage moves the whole sensor in one-pixel increments in a 2x2 matrix so that each pixel location in the image will have each of the sensor’s colors shifted through it. In this way, the 4-shot setting avoids interpolation normally necessary in color mosaic CCD cameras and improves color fidelity. Shifting the CCD increases the time needed to capture the image. The 4-shot setting is suggested for non-moving, non-quenching specimens and when very accurate color is required.</td>
</tr>
<tr>
<td>16-Shot</td>
<td>The 16-shot setting moves the sensor 16 half-pixel moves in a 4x4 matrix providing full color sampling at twice the CCD resolution. Shifting the CCD increases the time needed to capture the image. Taking sub-pixel shots also doubles the resulting file size. The 16-shot setting is suggested for non-moving, non-quenching specimens and when very accurate color and high resolution is required.</td>
</tr>
</tbody>
</table>

Auto TTL Output Control

The SPOT cameras provide a TTL pulse that can trigger external devices like fluorescence shutters. When the Auto TTL Output Control checkbox is selected, the TTL pulse is enabled at the beginning of the exposure and is disabled after the exposure. It may be necessary to enable the TTL pulse before the exposure in order to properly synchronize the external device with the image capture. For example, typical external shutters take time to open fully. The external shutter should be opened fully before the exposure begins. If the shutter manufacturer states that it takes 1 millisecond to fully open the shutter, enter 1 millisecond in the Delay field. The TTL pulse will be enabled 1 millisecond before the exposure begins.

Auto-Exposure Window

The Auto-exposure window indicates and allows the user to modify further settings that will be used when auto-exposure imaging is selected in the Exposure window.
Image Type

When using Auto-Exposure, the SPOT software provides 11 image type settings that correspond to various types of microscopy. The image type that you enter when creating a new setup appears on the Image Setup window. You can enter a new Image Type from the Image Setup window. Refer to the Accessing the Image Setup Window section of this chapter for descriptions of the different image types.

Adjustment Factor

Use the Adjustment Factor option to modify the automated exposure settings determined by the SPOT camera. The Adjustment Factor defaults to a setting of 1 (i.e., 1x the exposure times determined by the Auto-Exposure setting). The Adjustment Factor is used to deliberately over-expose or under-expose an image.

• If an image that you captured (using the default Auto-Exposure settings) comes out too bright or too dark, you can re-capture the image using a different Adjustment Factor to compensate for the excess brightness or darkness.

• If you use the SPOT camera to take pictures of printed circuit boards or other metallic objects, the Adjustment Factor allows you to over-expose the image in order to burn out the glints that appear when capturing images of metallic objects. Over-exposing the glints is necessary to correctly expose the non-glinted areas.

To set the adjustment factor, enter a number between 0.25 and 32.

• Values greater than 1 overexpose the image.

• Values less than 1 underexpose the image.

CAUTION!

To avoid blooming problems in cases where you have entered an Adjustment Factor of 2 or higher, ensure that the Gain Limit is high.

Gain Limit

Normally an auto exposure routine in a digital camera sets the exposure time so that the brightest pixel on the CCD chip is completely “filled” with electrons, or is “full well”. This simple technique works well for bright images, but as an image gets dimmer, exposure times can get uncomfortably long. With the SPOT camera, you can shorten exposure times by filling the brightest pixel on the CCD to less than full well, and then using this lower level as full scale. The inverse fraction of full well that the brightest pixel on the CCD is filled to is known as the gain. For example, filling a pixel to half of full well cuts the exposure time in half. Since the exposure time is cut in half, we call this a gain of 2.

The Gain Limit feature allows you to set an upper limit on the gain options that will be available during the Auto-Exposure process.

For example, with a Gain Limit of 32 the camera can “choose” from a range of gain options. However, if you find that gains of 16 or 32 are too noisy for your images, you can prevent the camera from selecting these options by setting the Gain Limit to four. When the Gain Limit option is set to four, the camera is limited to the lower three gain options: 1, 2, or 4. The following table illustrates levels of gain, the fraction of full well that the brightest pixel is filled to for each level, and a sample exposure time for each level:

<table>
<thead>
<tr>
<th>Gain</th>
<th>Fraction of Full Well</th>
<th>Exposure Time (sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>80 seconds</td>
</tr>
<tr>
<td>2</td>
<td>1/2</td>
<td>40 seconds</td>
</tr>
<tr>
<td>4</td>
<td>1/4</td>
<td>20 seconds</td>
</tr>
<tr>
<td>8</td>
<td>1/8</td>
<td>10 seconds</td>
</tr>
</tbody>
</table>
The table below summarizes the relationship between exposure time, background noise, and gain.

<table>
<thead>
<tr>
<th>Gain Limit</th>
<th>Possible Auto – Gain Settings</th>
<th>Exposure Time (dim images)</th>
<th>Background Noise (dim images)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Longest</td>
<td>Lowest</td>
</tr>
<tr>
<td>2</td>
<td>1, 2</td>
<td>↑</td>
<td>↓</td>
</tr>
<tr>
<td>4</td>
<td>1, 2, 4</td>
<td>↑</td>
<td>↓</td>
</tr>
<tr>
<td>8</td>
<td>1, 2, 4, 8</td>
<td>↑</td>
<td>↓</td>
</tr>
<tr>
<td>16</td>
<td>1, 2, 4, 8, 16</td>
<td>↑</td>
<td>↓</td>
</tr>
<tr>
<td>32</td>
<td>1.2, 4, 8, 16, 32</td>
<td>↑</td>
<td>↓</td>
</tr>
<tr>
<td>64</td>
<td>1.2, 4, 8, 16, 32, 64</td>
<td>Shortest</td>
<td>Highest</td>
</tr>
</tbody>
</table>

To set the Gain Limit, follow these steps:

1. Ensure that the camera is set to use the Auto-Exposure option.
2. Click on the Gain Limit select list, and select the number that you want to limit the gain to.

For more information on the concept of gain, refer to Appendix A: Electronic Imaging Theory and the SPOT Camera.

**Minimum Exposure**

Because SPOT cameras are capable of extremely short exposure times, light sources with intensities that vary with the waveform of the 60 Hz line supply (e.g., fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps) can cause the Live Image window to flicker and result in incorrect brightness and color balance readings in captured images. The Minimum Exposure option allows you to correct for these problems by limiting the camera to a minimum exposure time that is greater than the pulse interval of the light source. Consider the illustration to the right. In this case, the pulse interval of the fluorescent light source is 8.3 ms. Entering a Minimum Exposure of 25 ms ensures that the camera’s exposure time is greater than the pulse interval of the light source and that any error is minimized. The greater the value above 25 ms, the more the error is reduced. Alternatively, you can enter any multiple of 8.333 ms. To enter a minimum exposure, check the Minimum box, and enter a value in milliseconds.

**White Balance (Color Cameras Only)**

The exposure window also indicates the white balance settings currently associated with the open image set-up. These values from Red, Green and Blue can be modified by using the increase/decrease arrow keys next to the value or by directly typing in the new value.

White balance is the ratio of red, green, and blue necessary to achieve the proper color rendition for an image. Many factors impact the coloration of an image capture, including lamp voltage, the coloration of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s objectives. To minimize the impact of these factors, use the Compute White Balance feature. When you perform a white balance calculation, SPOT samples the color of the light from your light source after it has passed through the slide and the objective, and then calculates the exposure values needed to produce images where the white areas are white and the color areas are true.
You should perform a new white balance calculation when:

- Starting a new image capture session.
- Changing the lamp voltage.
- Switching to a different objective on the microscope.

When you open an image setup, the Image Setup screen displays the white balance values that were last saved to the Image Setup. If you capture an image without computing a new white balance, SPOT uses these default values.

To compute new white balance values for an image setup, follow these steps:

1. Set the illumination and the objective that you will use for the image capture.
2. Show the camera a sample of white light. This step varies according to microscopy technique and sample type, as shown in the table below:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>White Balance Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Perform the white balance using the brightfield mode on your microscope. See Brightfield –transmitted light above.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Use the Match Color feature. Refer to Ch. 8 – Viewing, Editing, and Annotating Images for more information.</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td><strong>For Nomarski DIC:</strong> Adjust the Nomarski prism until the image is in either the “brightfield” or the “gray scale” view. <strong>For Hoffman:</strong> Perform the white balance directly on the Hoffman image.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Pull all polarizers and compensators out of the light path and then position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Brightfield-reflected light</td>
<td>Replace your sample with a mirror.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Perform the white balance using the brightfield mode on your microscope. See Brightfield –reflected light above.</td>
</tr>
<tr>
<td>Stereo/Macro</td>
<td>Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace your sample with a white sheet of paper.</td>
</tr>
</tbody>
</table>

3. From the Camera menu, select the Compute White Balance Values option, or use the toolbar and click on the Compute White Balance Values button. The Compute White Balance window appears.
4. Click on Begin to start the calculation. The message **Computing white balance values** displays, as the camera samples the light.
5. When the camera finishes calculating the white balance values, SPOT displays the computed white balance values.
6. To change the setup that the new white balance values are saved to, select a setup from the drop-down box.
7. Click on OK. The program returns to the main editing and viewing window.
8. To edit the white balance values that you saved, open the image setup (i.e., Brightfield from the previous example). The values should appear in the Red, Green, and Blue selection bars. Edit the values as needed.

Spot Metering Area
Similar to the way photographers spot meter their cameras on a particular location within their subject image plane, the SPOT user can do the same within the microscope’s imaging plane. The spot metering feature allows the user to best select an area of the image to be used as the region of interest for the automatic exposure level determined by the software.

Users may select any rectangular image area less than or equal to the full image area. This can be accomplished in one of two ways. The user may drag an area of interest on the captured window screen. This automatically will insert the four side pixel values in the spot metering area of the image setup window. Alternatively, the user can input the four side values directly.

For a further discussion of the step by step details of these procedures, please refer to Chapter 7.

Manual Exposure Window
When you select Manual Exposure, the following Window options are available.

External Trigger (Insight, Flex, Xplorer, and Pursuit Cameras Only)
SPOT gives you several options in the manual exposure window for setting an external trigger. The options available vary depending on the bits per pixel selection. If 8, 12, or 14 bits per pixel are selected, the choices are None or Edge. If 24, 36, or 42 bits per pixel are selected, the options available are None, Edge, or Bulb.

The Edge and Bulb Trigger features allow external devices to start an exposure directly in the camera without software intervention via a TTL input signal.

Typical benefits of using the external trigger mode include:

- higher accuracy of the start of the exposure, as potential interrupts on the computer bus are avoided (edge and bulb trigger)
- the ability of external devices to directly start exposures without a software interface (edge and bulb trigger)
- the ability to control both when the shutter opens and also when the shutter closes, again without use of a software interface (bulb trigger only).

Note: TTL stands for Transistor Transistor Logic and is a signaling I/O common to electronic devices.

The following discussion highlights the features and use of each external trigger mode.

**Edge Trigger** - In this mode, the exposure is initiated by the rising edge of a TTL signal and is terminated after a software-programmed duration.

To use the Edge Trigger feature in Manual Exposure mode, do the following:

Select Image Setups from the dropdown menu and open the desired Image Setup.

a) In the Manual Exposure Window, set External Trigger Mode to Edge Trigger.

b) In the Exposure Window, set the Exposure Type to Manual exposure.

c) If you choose the Sequential Imaging Function you will need to select whether you externally trigger only the first image exposure in the sequence or every image exposure in the sequence.

Initiation of start of sequence – If you select this option, you will be asked to input the time interval between the end of an image exposure and the automatic start of the next image exposure.
Trigger of each image in sequence – If you select this option, the time interval inputs will disappear. You will be prompted before each exposure to initiate the external trigger.

Pulse Characteristics:
- Minimum Pulse width: 500ns
- Minimum Exposure: 40 µs
- Delay to Exposure Start: 6.195 µs ±0.028 µs
- Exposure End: Software Determined
- Voltage Logical High Level: 3.3 – 5.0 volts
- Voltage Logical Low Level: 0.0 - 0.5 volt

Bulb Mode – In this mode, the exposure is initiated by the rising edge of the TTL signal. The exposure continues until the TTL signal falls. Exposure time is therefore determined by the pulse width (level trigger).

To use the Bulb Trigger feature in Manual Exposure mode, do the following:

Select Image Setups from the dropdown menu.

a) In the Manual Exposure Window, set External Trigger Mode to Bulb Trigger. Set the Gain (remember, the external TTL pulse controls the exposure, so no exposure setting options will be available in the window).

b) In the Exposure Window, set the Exposure Type to Manual exposure.

c) If you choose the Sequential Imaging Function you will need to use the external trigger to begin and terminate every exposure. No time interval options or other selections related to triggering will be functional in the Sequential Imaging Window.

Pulse Characteristics:
- Minimum Reliable Pulse width: 100 ns
- Minimum Exposure: 37.5 µs + Pulse Time
- Delay to Exposure Start: 6.195 µs ±0.028 µs
Delay to Exposure End: 0.195 µs ±0.028 µs
Voltage Logical High Level: 3.3 – 5.0 volts
Voltage Logical Low Level: 0.0 - 0.5 volts

**Edge Trigger**
Edge Trigger allows you to use an external TTL source to trigger an image capture according to the exposure time(s) that you enter on the Image Setup window.

**Bulb Trigger**
Bulb Trigger allows you to use an external TTL source to vary exposure time according to the TTL pulse width.

**Exposure Time**
There are three options for entering user-defined exposure times. With the SPOT camera, you can:

- Manually enter the value.
- Allow the camera to calculate the value.
- Recall the exposure time and the gain used for the previous image capture.

When you select the User-Defined option on the Image Setup, a default value appears for the Exposure Time.

**To manually enter new exposure value(s) follow these steps:**
1. Ensure that the User-Defined Exposure box is selected.
2. Select either the msec (milliseconds) option or the sec (seconds) button.
3. Either use the selection arrows or type in a value (in seconds) for the exposure time.
4. Click on OK to save the settings.

**To have the camera calculate the exposure time, follow these steps:**
2. Close the Image Setups dialog box.
3. From the Camera menu, select Compute Exposure.
4. The Exposure Settings for the current image setup appear. If you decide to change the settings, you can do so from the Compute Exposure window. Any changes that you make will be saved to the current setup.
5. Click on Begin. The Status message changes to Computing exposure... as the camera samples the light. When the camera finishes, the Exposure window displays the calculated exposure time and gain.
6. Select an image setup from the Save to Setup scroll bar. The current image setup is the default.
7. Click on OK. When you open the Image Setup window, the new exposure value(s) appear.

**Note:** When you save the calculated exposure value to an image setup, it automatically changes the setup from Auto – Exposure to User Defined.

**Gain**
When you define your own Exposure, you can enter the precise gain that the camera will use for an image capture. You can enter a specific gain in one of three ways:
• You can manually enter the gain by selecting one of the gain options from the selection list.
• You can let the camera compute the best gain (and exposure times) by using the Compute Exposure feature (see the previous section).
• You can use the Recall Previous Exposure feature to recall the gain from the previous image capture (see the previous section).
• To manually enter a gain, follow these steps:
  • Ensure that the User-Defined Exposure option is checked.
  • Select one of the gain options from the list.
• To use the gain that the camera selects, follow the steps (in the previous section) listed for computing exposure times. The Exposure window, in addition to the optimal exposure times, displays an optimal gain. This gain is automatically added to the image setup that you specify in the Save to Setup box.

Note: The Compute Exposure window displays the Gain limit defined for the current image setup. This limits the gain options that the camera can choose from. If you do not want to use the Gain Limit shown, it can be changed from the Compute Exposure window.

TTL Output

Note: This window is available if your camera model is an Insight, RT, or Flex camera.

The SPOT cameras produce a 5 volt TTL pulse when an image is captured to enable external device triggering timed with image captures. This TTL pulse can be used to open and close an external shutter, for example. The TTL Output section of the Image Setup allows you to specify the active state of the TTL output. There are two TTL level options:

• High – Set the active state of the TTL output to High.
• Low - Set the active state of the TTL output to Low.

TTL Output/Trigger

Note: This window is available if your camera model is a Pursuit or Xplorer.

With some SPOT cameras, you can set the active state of the external trigger in this window. There are two options:

• High – Set the active state of the external trigger to High.
• Low - Set the active state of the external trigger to Low.

Chip Imaging Area

SPOT allows you to use any rectangular portion of the CCD chip for image capture. Using a portion of the chip is helpful in cases where you want to:

• Keep file sizes small.
• Shorten download times.
• Avoid areas of the image with optical problems (e.g., vignette areas).
There are three image area options:

- **Full Chip** – Capture the entire area of the CCD chip.
- **Center** – Capture a rectangular part of the CCD chip’s area that has the same height - to - width ratio as the full chip, and is centered on the center of the full chip.

The percentage that you enter is the percentage of full chip width that the new area’s width will be.

To capture a centered proportion of an image, follow these steps:

1. On the Image Setup window, check the Center option.
2. Enter the percentage of the image that you want to capture. The minimum percentage is 10 and the maximum is 100.
3. Click on OK to save the image setup.

**Region** – Capture a specific part of the CCD chip.

If you have pre-determined the exact pixel values of the area that you want capture, follow these steps:

- On the Image Setup window, check Region.
- Enter the pixel values for the Left and Right columns and the Top and Bottom rows that form the boundaries of the region that you want to define.
- Click on OK. The camera captures the region that you selected.

If you do not know the exact pixel values of the area that you want to capture, do the following:

- Click on the Full Chip option.
- From the Camera menu, select the Get Image (exposure from setup) option. The image capture appears on the screen.
- Position the cursor at the upper left edge of the image region that you want to define.
- Press and hold the left mouse button, and drag the cursor across the screen. SPOT highlights the area that you selected with a dotted border.
- From the Camera menu, select the Set Chip Imaging Region option. The Chip Imaging Region window displays the pixel values for the region that you selected.
- Either click OK to save the region values to the current image setup, or select a different image setup.
Image Orientation

**Rotate**

The Rotate option allows you to define an image capture’s on-screen orientation. There are two options:

- **Right** – The image is rotated clockwise 90 degrees.
- **Left** – The image is rotated counterclockwise 90 degrees.

**Horizontal Flip**

To flip an image display from left to right, check the Horizontal Flip box.

*Note: Horizontal Flip is also available as an Edit menu option – Flip Horizontal.*

**Vertical Flip**

To flip an image from top to bottom, check the Vertical Flip box.

*Note: Vertical Flip is also available as an Edit menu option – Flip Vertical.*

**Sensor Temperature**

*Note: This window is available only if your camera model is Pursuit or Xplorer.*

This window allows you to regulate the temperature of the CCD in your camera. Since the dark current noise increases as the temperature of the CCD rises, keeping the temperature of the CCD constant will ensure that each image taken has similar dark current characteristics.

Temperature regulation also increases the accuracy of the background subtraction. The temperature should be the same when creating background subtraction files as when using them. Please refer to the section “Get Background Subtraction” in this chapter for more details.

To begin regulating, check the Regulate Temperature box, and input the desired temperature in Celsius. The thermoelectric cooler will immediately begin cooling (or heating) the CCD to the target temperature. The temperature of the CCD is displayed on the status bar across the bottom of your screen. The temperature is read out and updated on the screen every 30 seconds by default. If you wish to view the changes in temperature more regularly, you can change this in the Temperature Readout section of the Preferences in the Setup menu.
When regulating temperature, the temperature should be kept more than 3 degrees C from the maximum cooling temperature possible. This will ensure that the thermoelectric cooler can compensate for typical room temperature changes.

**Image Readout**

*Note: This window is available only if your camera model is Pursuit or Xplorer.*

The image readout window allows the user to specify the rate at which data is read off from the CCD. The faster the sensor is read out, the noisier the image will be. The available sensor readout options will vary depending on the camera model.

To select the speed to read out the CCD sensor, select a horizontal readout frequency from the drop-down list.

**Post-Processing**

The final aspect of defining an image setup is to determine the post-processing adjustments (corrections) that you want the SPOT camera/software to make. Each option is described in the sections that follow.
Black Level Subtract (Monochrome and Slider cameras in 12 or 14 bpp only)

The amplifier in the SPOT camera has been adjusted so that the average black (no light) pixel value is between 20 and 25, rather than zero for 12/14 bit downloads. This offset is called the black level (sometimes referred to as the “pedestal”). Before each picture, the camera samples the black level by taking a picture with the shutter closed. The software then downloads the pixel values in the first row of the CCD chip, averages them, and stores this value as the black level. When capturing 8-bit monochrome, 24-bit RGB and 36-bit RGB images, the software automatically subtracts the black level from all pixel values so that black pixels are 0 (black) rather than 20-25 (dark gray), and colors are represented accurately.

When capturing 12-bit monochrome images, you can turn off the automatic Black Level Subtract. This is a useful option in cases where you need high accuracy brightness measurements. For example, you may want to adjust the black level of an image on a pixel-by-pixel basis by subtracting a second picture, taken with no light (a “dark frame”), from the original image. When high accuracy measurements are needed, the automatic Black Level Subtract is a problematic because the Black Level is an average of a sampling of black pixel values. Some values are higher, and some values are lower than the average. Subtracting this average value from a black pixel value that is lower than average would normally result in a negative value. But, since there are no negative values, the result is arbitrarily set to zero and the actual value is lost. This diminishes the accuracy of measurements.

Correct Color Enhancement (Color Cameras only)

The Correct Color Enhancement option utilizes camera dependent color correction profiles that optimize the matching of colors between your microscope specimen, the live image you view on the screen of your monitor, and the image you capture with your SPOT camera. This is done by transforming the raw camera color data allowing it to be adjusted to display the closest approximation of the same color on your monitor.

Correct Color Enhancement has been developed based on color profiling specifications develop by the ICC (International Color Consortium®).

To use the Correct Color Enhancement feature in Advanced Mode, simply make sure the Correct Color Enhancement checkbox is checked in the image setup window (under post processing) and then in the live image controls. In Basic Mode, simply check the checkbox in the image settings window. In TWAIN or Mac 3rd party mode, select the checkbox for Correct Color Enhancement.

In order to get the best results using this feature, you should make sure you set up your imaging system including your computer monitor appropriately. See Appendix F for more information on system set-up.

Be aware that the color correction transformations that occur when you use Correct Color Enhancement will be applied to the raw image data, leaving a modified image file. If you will require the raw data for further analysis of your image, you should uncheck the Color Enhancement checkbox.

Chip Defect Correction

When you capture an image, the SPOT program automatically compensates for CCD chip defects, so that they do not appear on your images. The Chip Defect Correction option allows you to turn off this automatic correction. This can be useful in cases when you are performing quantitative measurements of pixel brightness values and need to see precisely where chip defects are.

The Chip Defect Correction box is, as a default, checked when you define a new image setup. To turn off the program's automatic chip correction, deselect the Chip Defect Correction box.

Noise Filter

The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with lengthy exposure times, the noise filter acts as a “virtual cooler” for the Insight camera, eliminating “hot pixels.”
The Noise Filter checks each pixel on the CCD chip as described below:

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels.
2. If none of the eight neighboring red pixels has a value within ±50 % (i.e., the threshold value that the SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being checked is replaced with the average value of the eight neighboring red pixels.
3. The program repeats this procedure for the values of the green and blue pixels being checked.

To use the Noise Filter, follow these steps:

To filter noise, follow these steps:

1. Check the Noise Filter box.
2. Enter a value between 10% and 100%. The Threshold value is set to a default of 50%. Refer to the procedure described above for an explanation of the Threshold value.
3. When you capture an image, the program automatically adjusts the image using the Noise Filter value that you entered.

Note: You can also use the Filter Noise Edit menu option to adjust captured images, as described in Ch. 8 – Viewing, Editing, and Annotating Images.

Gamma Adjust

Gamma Adjust smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for capturing/editing images with a wide range of brightness values (dynamic range) such as:

• Fluorescence specimens
• Macroscopic objects with glints, such as printed circuitry

When the bright areas of these types of images are correctly exposed, the darker areas can be so dark that they are in effect invisible. Gamma Adjust can remedy this problem. The figures below illustrate the effect of a gamma adjust on a fluorescent image. The image on the left is the original image prior to the gamma adjust. The image on the right has been gamma adjusted to a value of 1.75. In this instance, the gamma adjustment results in a better display of detail by lightening the darker areas without burning out bright areas or lightening black areas:

Fluorescence image, no gamma adjustment  
Fluorescence image, gamma adjusted to 1.75
Gamma adjustment corrects an image by creating a new version of the original. To create the new image, the Gamma Adjust function reassigns the RGB values of each pixel in the image according to the curve in the graph at right. This graph demonstrates the basic principles of gamma adjustment:

• Black (pixel value = 0) remains black at all gamma values.
• White (pixel value = full scale) remains white at all gamma values.
• Gamma values greater than one lift the darker areas of the original image into the brighter areas of the new image.
• A gamma curve is smooth - there are no unexpected jumps or cutoffs. This means that when viewing a gamma-adjusted image, you will be able to see the details (intensity differences) in both the black and white areas of the image.

On the Image Setup window, you can specify whether or not to automatically apply gamma adjustment to an image capture. This process works well if you know in advance which gamma value works well for a specific class of images. If you are not certain of the best gamma value, you can acquire non-gamma adjusted images, and then use the HSL, HSV, or RGB gamma adjust options on the Edit menu and experiment with the gamma adjust options to find an optimal value. Refer to Chapter 8 - Viewing, Editing, and Annotating Images for details on using the gamma adjust options.

To automatically gamma adjust an image after it is captured, follow these steps:

1. Check the Gamma Adjust box on the Image Setup window.
2. Enter a gamma value between .1 and 4.0. Although there is no formula for determining a gamma value, gamma values are typically between 1.3 and 1.7

   Note: Although the gamma adjust option is typically used to lighten the mid-tones of an image, entering a value between .1 and 1 will darken the mid-tones.

3. Select one of the following options: HSL, HSV, or RGB.

   B/W If you are using a B/W camera, the color space options are not available. Gamma adjustment is automatically set to use RGB, the recommended color space for monochrome image editing.

HSL (Hue Saturation Luminance), HSV (Hue Saturation Value), and RGB (Red Green Blue) are three different color spaces. A color space is any coordinate system that is used to mathematically represent color.

• The HSL color space is an intuitive model based on the three attributes that are common to all colors: hue, saturation, and luminance. The HSL color space assigns a value for each color attribute (e.g., hue, saturation, and luminance). In this color space the brightest saturated color is considered to be 50 % luminance. Above 50 % luminance, saturated colors transition through pastel shades before reaching pure white at 100 % luminance. This process mimics the natural perception of objects illuminated by broadband light sources.

• The HSV color space is similar to the HSL color space except that it uses value instead of luminance. In this color space, the brightest saturated color is considered to be 100 % value. This allows you to modify images that contain only saturated colors (e.g., fluorescence) without changing the bright, saturated areas to pastel or white.

• The RGB color space assigns a red, green, and blue value to each pixel in an image. This is the method that color computer monitors use to display images.
The process by which the program applies gamma to an image capture differs according to the color space that you select. The following table briefly describes how gamma is applied in each of the three color spaces and lists situations where the use of one color space would be preferable to another.

<table>
<thead>
<tr>
<th>Color Space</th>
<th>Gamma Adjustment Process</th>
<th>Recommended Usage</th>
</tr>
</thead>
</table>
| HSL         | 1. RGB pixel values are translated to HSL (hue, saturation, and luminance) values.  
               2. Gamma is applied to the luminance. 
               The HSL values are translated back to the RGB pixels. | The HSL option is ideal for all color images except fluorescence images. |
| HSV         | 1. RGB pixel values are translated to HSV (hue, saturation, and value) values.  
               2. Gamma is applied to the value. 
               The HSV values are translated back to the RGB pixels. | The HSV option is ideal for fluorescence images. |
| RGB         | Gamma is applied separately to the red, green, and blue pixel values. | The RGB option is ideal for monochrome images. |

Click on OK to save the Gamma Adjust settings to the Image Setup. When you capture an image using the setup, the program automatically gamma adjusts the image according to the settings that you defined.

**Image Size Double**

When you select the Image Size Double feature, the camera interpolates between pixels to create an image that is twice as large. The program reads the red, green, and blue brightness values for the original image and interpolates those values to create a new image that has double the number of columns and rows. The red, green, and blue values for the additional pixels are calculated based on the RGB values of the original pixels.

The Image Size Double feature helps to reduce the pixellation of fine detail that often results when you use lower magnification objectives. When used with low magnification images, the additional pixels created via the Image Size Double feature help to smooth out details; this results in a higher resolution appearance.

**Dark Current, System Offset, and Scientific Imaging**

Dark Current is a component of any image captured with a CCD.

**What it is:** Dark current is the rate of accumulation of electrons in a pixel due to thermal action. Dark current is related to the temperature of the camera CCD. Dark current is higher at higher CCD temperatures. The level and type of impurities in the silicon of each pixel will affect the dark current for that pixel. Pixels with pure silicon will have lower dark current. Pixels with impurities will have higher dark current.

**What it is not:** Dark current is not the result of photons (light) from the target specimen striking the CCD and therefore, does not represent true data related to the target image.

The accumulation of electrons in each pixel due to dark current is repeatable and predictable for any combination of time and CCD temperature.

In scientific imaging, the goal is to capture image data strictly related to the light gathered from the target specimen. Dark current is additional unwanted data (electrons) that can degrade the image data desired. Get Bias Frame and Get Background Image are features that can eliminate the effect of this unwanted dark current, leaving the user with a better representation of the true data associated with the target specimen.

In scientific imaging, pixel values of zero are not desired. Therefore, the camera electronics add an “offset” to all pixel values so that a pixel value that would normally be zero (no light) is offset to a higher positive number. The amount of this offset is referred to as the “system offset”.

Dark Frames, Bias Frames and Background Images: Definitions

A dark frame is any image taken with no light hitting the CCD.

A bias frame is a short exposure dark frame. Each pixel in the bias frame has a value equal to the system offset plus any dark current electrons accumulated by the pixel in the time between the end of exposure and when that pixel’s charge is measured by the camera’s electronics. Since the pixels are read one at a time, the first pixel read would have the least amount of dark current electrons and the last pixel read would have the most.

Subtracting a bias frame from any image will subtract the system offset and the dark current electrons that accumulated in each pixel while it was waiting to be read out.

A background image is a longer exposure dark frame with the bias frame subtracted. All that is left after subtraction of the bias frame is the accumulation of dark current electrons in each pixel that happened during the exposure time of the dark frame.

Subtracting a background image from any image of the same exposure time will remove the dark current electrons that accumulated during the exposure time. Since the accumulation of dark current electrons is directly proportional to exposure time (twice the exposure time results in twice as many dark current electrons) the background subtraction frame is “scalable”. This means that one background image (at a known exposure time) can be scaled up or down to predict the amount of dark current electrons that will accumulate in each pixel of an image of ANY exposure time.

Subtracting both a bias frame and a (scaled) background image should erase the system offset and eliminate all electrons due to dark current and leave an image that has pixel values due only to light striking the CCD. This is a highly useful way to “clean up” an image.

Get Bias Frame (Bias Frame Subtraction)

Get Bias Frame allows you to collect and store a bias frame. Bias frame subtraction is a process that uses the stored bias frame, subtracting it from a captured image to remove both the system offset and the dark current electrons that accumulated in each pixel while it was waiting to be read out. When this subtraction process has been applied to a short exposure image, the remaining data (and image) is mostly representative of the true image data being captured.

You may select a bias frame to use in the subtraction process within the image set-up post-processing window. Select the checkbox for Bias Frame and then browse to select a Bias Frame correction file from those that have been previously developed and stored.

For a step-by-step explanation for acquiring bias frames, refer to Ch. 7 – Taking a Picture.

Get Background Image

Get Background Image is a function that allows you to collect data to eliminate the dark current accumulated during the exposure time of your captured image. By determining the rate of dark current accumulation in each pixel, we can scale the quantitative effect of the dark current for each pixel in the image plane (the Background Image) based on the time of image exposure and subtract it from the final image. The end result is a processed image that more closely reflects the true data that is collected from the specimen during the image capture.

The SPOT program accomplishes this method of background image characterization by collecting one, or an average of a series of images that reflect the electrons accumulated due to the temperature of the CCD. This information is then stored as the Background Image. For a given experimental condition (i.e. temperature in the room), normally only one set of Background images must be collected, with its data later scaled to correspond to the time of the exposure.
Note: If your camera an Insight, RT, or Flex, the temperature of the CCD may vary over time. This variation will also change the dark current characteristics of the CCD. Because background subtraction frames capture the dark current rate at a certain CCD temperature, background images should be collected as close to the image capture period as possible.

If your camera is a Pursuit or Xplorer, ensure that the background subtraction file is taken with the CCD at the same temperature as it is when you capture pictures.

The Background Image correction data is stored as a file. The user must select it in the Image Setups options prior to image captures. Select the checkbox for Background Subtract and then browse to select a Background Image correction file from those that have been previously developed and stored.

You may select a background image to use in the subtraction process within the image set-up post-processing window. For a detailed description of the steps involved in acquiring a Background Subtraction Frame, refer to Ch. 7 – Taking a Picture.

Get Flatfield Image (Flatfield Correction)

Flatfield correction is used to correct for display problems associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system. For the SPOT cameras that use a color mosaic chip, flatfield correction serves another purpose. In the production process for color mosaic CCD chips, the RGB colors are applied directly to the pixels on the chip. This process often results in an uneven color density around the outer 30-40 rows of the CCD chip, causing a “halo” appearance in some image captures, particularly those with low contrast. The Flatfield option can be used to correct this problem.

Note: Flatfield correction with the SPOT camera refers only to the correction of uneven lighting. It should not be confused with the correction of optical field flatness.

Flatfield correction works by sampling the brightfield background without the specimen in the field of view. This lets the SPOT software know, on a pixel-by-pixel basis, which areas in the field of view are receiving less illumination than the brightest areas. The flatfield correction function also samples the system offset and dark current by taking a bias frame. After the flatfield correction file is created and saved to the Image Setup, the software uses this information to accurately increase the brightness of each pixel in the dimly illuminated areas. The resulting image gives the appearance of an even illumination.

For a detailed description of the steps involved in the flatfield correction process, refer to Ch. 7 – Taking a Picture.

Calibration

The calibration window allows you to select a calibration setup to be saved with the image or image sequence being captured. This enables you to choose a calibration setup for the objective you’re using so that calibration marks or measurements added to the image or image sequence will be accurate.

To select the calibration setup, follow these steps:

1. Check the Save Calibration with Image box.

2. Select the calibration setup specific to the objective that you’re using from the drop-down list.

If there are no calibration setups available in the drop-down list, or if your objective magnification is not listed, refer to Chapter 4 – Advanced Program Mode for instructions on calibrating your objectives. If you don’t save a calibration setup with the image but subsequently choose to add calibration marks or measurements to the image, you can set the calibration setup to be used with the image using the Set Calibration option from the Edit menu. The Set Calibration option can also be used to select a different calibration setup if you would like to modify your selection.
Auto-Save

The **Auto-Save** feature is used to automatically save images as part of the capture process. To enable SPOT’s auto-save feature, check the **Auto-Save Images** box. You can choose to save the images as separate files or in an image sequence. You can also save the images into existing image sequences or into existing TIFF image files.

Save to

- Individually – Save each image as a separate file.
- An Image Sequence – Save all images in a single file.
- The available save and name options depend on this selection.

File Name Prefix

This prefix appears before the number of each image capture in the sequence. To enter the File Name Prefix, you can:

- Type only the name (e.g., **Cell**) in the box. The program automatically saves the image to the last used directory. If you specify the prefix only, you cannot see exactly where the files are being saved. Thus, to avoid having to search for your files, you should verify the location of the last save.

- Type the full path and file name (e.g., **C:\Spotcam\T-cells**) in the box to specify the location of the image. When entering the file path and name, you can also specify a new directory simply by entering it in the path (e.g., **C:\Spotcam\Cells\T-Cells**).

- Click on the browse button to select a new file location and file name (prefix). All of the image files are saved with the prefix that you enter. Thus, if your Suffix Begin Number (see below) is one, the file name for the image would be **T-Cells0001**.

- Click in the file name prefix box to activate the Insert Variable option. This will enable you to use a set variable as the file name or as part of the file name.

- Click on the browse button to select an existing image sequence or an existing individual TIFF image that you would like to add subsequently images to.
Format
Select the file format.

- For individual 8 bit/channel files, there are six options: Windows Bitmap, JPEG, Mac PICT, TIFF Uncompressed TIFF JPEG, or JPEG2000. For individual 12 bit/channel files, there are three options: JPEG 2000, TIFF Uncompressed (12-bit/chan), TIFF Uncompressed (16-bit/chan).
- For individual 16 bit/channel files there are two options: JPEG 2000 and TIFF Uncompressed (16-bit/chan).
- For image sequences of 8 bit/channel files, there are two options: TIFF Uncompressed or TIFF JPEG. For image sequences of 12 bit/channel files, you can save the sequence only as TIFF Uncompressed. For image sequences of 16 bit/channel files, you can save the sequence only as TIFF Uncompressed.

Append Number
When Append Number is selected, the individual images will be numbered, beginning with the append number chosen. The append number will be automatically incremented by one for each subsequent image. Choose the number of zeroes to appear before the append number in the Digits field.

JPEG Quality (1-100)
JPEG quality is the level of compression for JPEG images: this option is available only when JPEG or TIFF JPEG is selected as the image file format. Enter an integer between 1 and 100 to set the JPEG quality for images. A value of one is the most compressed (and lowest image quality), while a value of 100 is the least compressed (and highest image quality).

Compression (JPEG2000)
When the JPEG2000 file format is selected, the Image Auto-Save Setup dialog displays compression options:

- Lossless – Information is not lost when the image is compressed.
- Lossy – Information is lost according to the ratio that you enter: the higher the ratio that you enter, the smaller the file size and the lower the quality of the image.

Save Thumbnails
Save thumbnails of each image capture. This option is available only when JPEG, TIFF JPEG, or TIFF Uncompressed is selected as the image file format.

File Name Conflict Action
Determine how the program will respond if it finds an image file with the same name as an image from the current session. Select one of the following options:

- Overwrite Existing File – The program overwrites the existing file with the new image capture.
- Display Warning – The program displays a warning message indicating that a file of the same name already exists, and stops the image capture.

Image Display
Determine how image captures will be displayed. Select one of the following options:

- Display Each Image in a New Window – The program opens a window for each new image capture. This option works well if you plan to capture a limited number of images in the session. If you plan to capture many images, however, displaying numerous windows uses up memory and could interfere with use of other programs.
- Display Only Current Image – The program sequentally displays each image in the same window. Each image displays only until the next image is captured. This is useful when you have numerous captures where you do not want to be concerned with running out of memory.
- Don’t Display Images – The program automatically saves all of the image files to the specified location without displaying them.

Display Images
Select this box to open an image sequence immediately after the capture. To save the image sequence to file without opening it, deselect the box.
Using Live Images

The SPOT software allows you to view real-time black and white or color previews of your specimens – i.e., your potential image captures. Using the Live Image preview, you can scan, zoom, focus, and frame images so that they are optimally adjusted for the image capture. After focusing and positioning the image, you can then capture it using one of five options, generating one of three types of images:

• **Get Image (exposure from Setup)** - Capture the image using the settings from the current Image Setup and ignore the Live Image Controls values. This allows you to use one set of values for framing and focusing an image and a different set of values for capturing the image. Get Image can be accomplished in one of three ways: from the dropdown menu (under Camera), from the toolbar, or by creating and using a Taskbar button (Chapter 12) for Get Image.

• **Snap** - Capture the image using the area and exposure values from the Live Image Controls dialog (see below). The Snap feature is handy because it enables you to adjust the live image until you see what you want, and then use those settings to capture the image – “what you see is what you get.” Also because the Snap option uses Live Image exposure values, it allows you to avoid the exposure computation that typically precedes image captures.

• Depending on how Live Image Preferences (see Ch. 4) are defined, the Snap option either uses or disregards the Post Processing options from the current Image Setup (see Ch. 5).

  If the **Snapped Images** box is selected, the Snap option uses all of the Post Processing options from the current Image Setup, except for Background Subtraction and Flatfield Correction.

  If the **Snapped Images** box is unselected, the Snap option ignores the Post Processing options for the current Image Setup, with one exception: if the Chip Defect Correction option is selected for the current image setup, the corrections will appear in the image capture, regardless of the Snapped Images preference.

• **Transfer** - You can Pause the live image view and Transfer (see below) the preview directly to the SPOT editing window. This option is helpful in situations with rapidly changing samples. If you see something that you like, you can pause the live image preview before it changes. Then, you can transfer the paused image to a SPOT editing window and save it to file. Images saved in this way have two restrictions. First, all transferred images are 8 bit per channel (color). Second, because live images are read out via two amplifiers, the right and left sides of the image might not be perfectly matched.

Note also the following:

• Image orientation adjustments (i.e., flipping and rotating) specified on the Image Setup are always reflected in the live image view and Snap capture.

• If you crop or zoom in on an image, Snaps and Transfers capture only the cropped or zoomed portion.

---

*Note: With some video cards, you might experience system crashes or display problems in live image mode. To correct these problems, lower the Graphics Acceleration setting in Windows, as described in the Video Card Related Problems section of the Installation Guidelines chapter.*
Note: Occasionally, when viewing a dim live image, you might notice that the right half of the image is brighter or dimmer than the left half. To display images in real time, some cameras use two separate amplifiers to simultaneously read the right and left halves of the CCD chip. With some images, particularly dimmer samples, the brightness of the two halves may not match. This results in a “split” appearance. To avoid this problem with captured images, the cameras read the whole CCD through a single amplifier. A “split” Live Image view is not indicative of what your image capture will look like. Refer to Appendix A: Electronic Imaging Theory and SPOT Cameras for details.

The Live Image View

To open the Live Image window, either click on the Live Image toolbar button, or select the Live Image option from the Camera menu.

- The title bar at the top of the Live Image window displays the status of the live image view - Running, Computing Exposure, or Paused. Double-click on the title bar to “roll up” the live image display. This pauses the live image display. Double-click again to display the whole window and resume the live image display.

- When the Fit to Window option is checked, the live image window cursor becomes a zoom tool. To zoom in on a portion of a live image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the Reset Area button on the bottom of the window.

- When the Fit to Window option is not checked, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the Reset Area button on the bottom of the window.

Note: Due to a flaw in the Windows operating system, monitors that are set to higher resolutions cannot zoom to very high magnification levels. If zoomed in to a high magnification, the monitor displays white instead of the zoomed image.

- The Full Screen option (accessed via the View menu or [F7]) can be used with live images. This option allows you to use the entire screen to view a live image, without the SPOT menus/toolbar and the Windows navigation bar.

To access live image viewing options in the full screen view, right click on the live image. To exit the full screen view, either press [F7] or move the cursor to the top of the screen and click on the Exit Full Screen Mode button that appears.
Restart

Resample the brightness of the image, compute new exposure times, and restart the live image display. This is useful for updating exposure times when specimen brightness has changed.

Pause/Resume

Freeze the live image window. This is useful when you are changing specimens and want to preserve the last view. In addition, to use the Transfer option (see below), you must first Pause the live image view. Click on Resume to restart the live image view.

Close

Close the Live Image window.

Controls

Open the Live Image Controls dialog box (see below). From this dialog box, you can define the viewing/capture area, and adjust gamma, brightness level, and dim image quality. You can also elect to display either the full chip or a region of interest. Refer to the steps below for more details on the Live Image Controls window.

Fit to Window

Size images to automatically fit the resizable display window.

Reset Area

Return to the non-zoomed view of the live image.

Transfer

Transfer the live image directly to the SPOT viewing window, where it can be edited and/or saved to file. The Transfer button is inactive until you Pause the real-time view. The Transfer option is limited in that all images are 8 bits per channel (i.e., because they are from live mode). The Transfer option should not be used for image captures that require highly accurate brightness measurements.

Snap

Capture the live image using the settings from the Live Image Controls dialog. When you click on the Snap button, the Get Image status dialogs appear, just as they do when you select Get Image (exposure from setup) from the Camera menu. When you use the Snap option to capture an image, you avoid the exposure computation sequence that typically precedes image captures.

Faster Readout

Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

Acceleration

Acceleration enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate. Moving the slider towards the right increases the acceleration.

Live Image Controls

To adjust the live image view settings, click on the Controls button at the bottom of the Live Image window. The Live Image Controls dialog appears. Depending upon whether your image settings for exposure (Chapter 5) are set to Auto or Manual, one of two windows will appear, each slightly different. Each window, however, will have a common section including the following options.

Filter Color (3-Shot Color and Slider cameras only)

Your selection should provide the highest level of contrast for the image. Because different colors provide different levels of contrast, the best way to determine a color is to preview it by clicking on the color and seeing how it affects the view of the specimen.

- **RGB** – View a color preview of your specimen
- **Red** – View a monochrome preview of your specimen using the red state of the LCD filter.
- **Green** – View a monochrome preview of your specimen using the green state of the LCD filter.
• **Blue** - View a monochrome preview of your specimen using the blue state of the LCD filter.

• **Clear** – View a monochrome preview of your specimen using the clear state of the LCD filter.

The available Filter Color options on the Live Image Controls dialog are dependent on the settings defined on the Image Setup.

### Display Images in Grayscale (3-Shot Color and Slider cameras only)

To counter the difficulty of viewing, focusing, and adjusting monochrome images in live mode, the **Display Images in Grayscale** option enables you to view a monochrome image in grayscale, as opposed to with the red, green, or blue filter. This option applies if the following are true:

- The **Bits per Pixel** option on the Image Setup is set to either 8 bpp, 12 bpp or 14 bpp.
- The **Filter Color** (see above) on the Live Image Controls dialog is set to Red, Green, or Blue.

### Binning

Binning, as described in Ch. 5 - Preparing to Take a Picture, combines adjacent pixels on the CCD chip, thereby reducing the number of pixels used in the image capture. Binning is useful when you have dim images and want to increase sensitivity and reduce download time. This gives you higher frame rates and less noisy images. But, as binning level increases, image resolution decreases. All of these factors should be considered when you select a binning option.

**Note:** When 2x2 or 4x4 binning is selected with a color mosaic camera, the live image window will convert to monochrome.

### Area

The Live Image Controls window allows you to view any rectangular portion of the CCD chip.

- **Full Chip** - View the entire chip.
- **Selection** - View a selection that you made with the cursor.
- **Region (from Setup)** - View the region (if any) that is defined for the current image setup.
- Use the **Reset Area** button at the bottom of the Live Image window to return to the full chip view.

When you are viewing a live image **Selection**, how this selection is displayed depends on whether the **Open Images in Fit to Window Mode** and **Always Show Full Chip in Live Image** preferences (see the Preferences section in Ch. 4) are checked. The following table illustrates the possibilities:

<table>
<thead>
<tr>
<th>Fit to Window Checked?</th>
<th>Always Show Full Chip in Live Image Checked?</th>
<th>Selection Display</th>
<th>Live or Captured Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a <strong>yellow rectangle</strong>.</td>
<td>LIVE</td>
</tr>
<tr>
<td>YES</td>
<td>NO</td>
<td>When you select a portion of the chip the cursor is a <strong>zoom tool</strong>. To zoom in on a portion of a live or captured image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the Full Chip option.</td>
<td>BOTH</td>
</tr>
<tr>
<td><strong>NO</strong></td>
<td><strong>YES</strong></td>
<td>When you select a portion of the chip, the selection is outlined with a yellow rectangle. However, because <strong>Fit to Window</strong> is not checked, you will not see the entire chip in the window.</td>
<td>LIVE</td>
</tr>
</tbody>
</table>
When you select a portion of the image, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the Full Chip option.

Correct Color Enhancement (Color cameras only)

The Correct Color Enhancement option utilizes camera dependent color correction profiles that optimize the matching of colors between your microscope specimen, the live image you view on the screen of your monitor, and the image you capture with your SPOT camera. This is done by transforming the raw camera color data, allowing it to be adjusted to display the closest approximation of the same color on your monitor.

This option is only available if the Color Enhancement checkbox is selected in the Image Setup Post Processing section.

Gamma

Enter a Gamma value between .1 and 4. Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for capturing/editing images with a wide range of brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., printed circuitry).
- Values between 1 and 4 lighten the mid-tones of the image.
- Values between .1 and 1 darken the mid-tones of the image.

Because images update very quickly in Live Image mode, gamma adjustments are only displayed in the RGB color space. Gamma adjustments made in the HSL or HSV color spaces would be too slow for live imaging display. Refer to Ch. 5 – Preparing to Take a Picture for more details on color spaces and gamma adjustment.

Live Image Controls – Auto Exposure Options

When you have selected auto-exposure in your image set-up, the Live Image Controls window will feature the following options.

Brightness

Enter a Brightness value between .25 and 32. A brightness value of 1, the default value, gives you the correct image brightness for most images. The Brightness Adjustment control allows you to overexpose or underexpose (darken or lighten) the image area. In many cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or darken the image. When using the Brightness control, the SPOT camera uses an algorithm that combines gain and exposure time to provide the fastest possible image update rate (shutter speed) in live preview mode:
- When overexposing images to make them brighter (i.e., entering values greater than one), the camera first selects the highest possible gain before lengthening the exposure time. Because gain also brightens an image, less exposure time is needed.
- When underexposing images to make them darker (i.e., entering values less then one) the camera uses the lowest possible exposure time before lowering the gain.

Quality/Speed

Use the slider to balance speed and quality when previewing dim images.
- Moving the slider toward the Quality side increases image quality and decreases frame rates.
• Moving the slider toward the **Speed** side increases frame rates and decreases image quality.

The Quality/Speed measurement corresponds to the Gain limit setting (see Ch. 5) on the Image Setup window, which allows you to set an upper limit on the gain options that will be available during the Auto-Exposure process.

• When the slider is at the left-most point, the Gain Limit is 1, which restricts the camera to a gain of 1, giving you higher quality pictures, but lengthier exposure times.

• When the slider is at the right-most point, the Gain Limit is at maximum, which allows the camera to select from all of the gain options available in Live Image Mode. This shortens exposure times, but decreases image quality.

For more details on setting a Gain Limit, refer to Ch. 5 –Preparing to Take a Picture. For more information on the concept of gain, refer to Appendix A: Electronic Imaging Theory and SPOT Cameras.

**Auto-Brightness**

Available only when you are using Auto exposure, the **Auto-Brightness** option enables you to maintain a consistent brightness level for changing specimens.

**Live Image Controls – Manual Exposure Options**

When you have selected manual exposure in your image set-up, the Live Image Controls window will feature the following options.

**Time**

From the Live Image Controls window, you can enter a specific exposure time or times for the image. When you use a specific exposure time, the camera skips the auto-exposure sequence (Computing Exposure) that takes place when you open the Live Image window. This is very useful in cases where exposure times are lengthy, as with fluorescence samples.

**To enter new exposure value(s) on the Live Image Controls window, follow these steps:**

4. Ensure that the Manual Exposure box for the current image setup is selected.

5. Either use the selection arrows or type in a value in milliseconds for the exposure time.

**Gain**

From the Live Image Controls window, you can enter the precise gain that the camera will use for an image capture. Use the drop-down list to select one of the gain options. The gain options available depend on the camera model and bit depth selection. While high gain is usually too grainy for captured images, it can be helpful in speeding the display of dim images in live image mode.
Ch. 7 – Taking a Picture

Introduction: Three Ways to Take a Picture

There are three ways to take a picture with the SPOT camera:

• **Live Image Pause/Transfer**
  After pausing a live image, pressing the Transfer button saves the image to a window. This is useful for capturing rapidly changing samples. Images captured in this way are essentially “frozen” live images. As such, the right and left sides of the images are read out via separate amplifiers and are limited to 8 bit monochrome/24 bit color.

• **Snap**
  Pressing the Snap button when viewing a live image initiates an image capture where the entire image is read out via a single amplifier. Snap image captures avoid the time dedicated to computing exposure by using the exposure time and gain calculated for the live image.

• **Get Image (Toolbar button)**
  Pressing the Get Image toolbar button initiates an image capture where the entire image is read out via a single amplifier using only the parameters from the current image setup. This allows you to use the live image window purely as an aid to framing and focusing the image. You may also access Get Image from the dropdown menu (under Camera), from the toolbar, or by creating and using a Taskbar button (Chapter 12) for Get Image Adjustments made to the live image have no impact on the image capture.

These three types of image captures were designed to give you greater flexibility in working with different types of specimens and in how you use live images.

• For more details on the Live Image Pause/Transfer and Snap options, refer to Ch. 6 – Using Live Images.

• For more details on the Get Image option, refer to the **Get Image (exposure from Setup)** section below.

• This chapter discusses the Get Image type of capture as used in a variety of different procedures. The chapter is divided into two sections:
  • **Basic Image Captures** – Standard and sequential image captures.
  • **Image Captures in Other Procedures** – Image captures where one capture is used to prepare for another capture.

**Basic Image Captures**

The SPOT software offers three primary image capture options:

• Get Image (exposure from setup)
• Get Image (last used exposure)
• Get Sequential Images

**Get Image (exposure from setup)**

Get Image (exposure from setup) captures an image according to the specifications in the Current image setup. Press [F12] to view the current image setup or select it from the dropdown menu under Setup.
To capture an image using the current image setup, follow these steps:

1. Determine or define the image setup that you want to use, and set it as the Current setting (i.e., select the Current option from the Image Setups dialog box).

2. From the Camera menu, select the Get Image (exposure from setup option), or click on the Get Image (exposure from setup) button on the toolbar:

   The Get Image window, which indicates capture status and gain, appears. The Status messages are as follows:

   **Computing Exposure** – The camera is sampling brightness levels in the image in order to determine proper gain and exposure time.

   **Getting Image** – The camera is downloading the image to the computer.

   **Exposing** – A countdown clock displays when the exposure will last longer than 2 seconds. This informs the user that the electronic shutter is open and counts down the minutes: seconds remaining until it closes.

   **Processing** – The camera is preparing to display the image.

   The newly captured image appears on screen. Following an image capture, several noticeable changes take place in the appearance of the main SPOT screen:

   - The Edit and Windows menus become available.
   - The Toolbar expands to offer more buttons and the zoom, pan window, save, and print related toolbar buttons become functional (available).
   - The Get Image (last used exposure), Set Chip Image Area, Set Spot Metering Area, and Recall Previous Exposures options on the Camera menu are functional (available).

**Get Image (last used exposure)**

The Get Image (last used exposure) option captures an image using the exposure times and gain from the previous exposure. In all other respects, it works in exactly the same way as the Get Image (exposure from setup) option. This option shortens the time required to capture an image because it skips the initial auto-exposure sequence. This is convenient when you are satisfied with the appearance of an image and want to use the same settings to capture a similar image in the same session. If you close the software, and re-open it, the Get Image (last used exposure) option is unavailable until you capture an image using the Get Image (exposure from setup) option.

To use the Get Image (last used exposure) option, follow these steps:

1. Prepare the microscope and specimen for the next image capture.

2. Either select Get Image (last used exposure) from the Camera menu, or click on the toolbar button.

3. The Get Image status window appears, and the camera captures the image using the last used exposure times. It only displays the exposure time and the gain because the camera no longer needs to sample image brightness.

   *Note: This feature will retain the image settings from the previous capture even if you delete the previously captured image from the screen.*
Get Sequential Images

The Get Sequential Images option allows you to capture a sequence of images over time. The images can be saved into a sequence or as individual files. If saved into a sequence, the sequence can then be exported for use in other applications.

To use the Get Sequential Images option, follow these steps:

1. Select the image setup that you want to use for the sequential image captures. Either define a new image setup, or select an existing setup from the drop down list on the status bar (bottom right corner).

2. From the Camera menu, select the Get Sequential Images option. The Get Sequential Images window appears. The following table explains each option.

<table>
<thead>
<tr>
<th>Number/Timing Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Images</td>
<td>Enter the number of images in the sequence of captures.</td>
</tr>
<tr>
<td>Compute Exposure before Each Image</td>
<td>Select this option if you would like the SPOT software to recalculate the exposure before each image capture. Please note that this option is unavailable if your current image setup is set to Manual Exposure.</td>
</tr>
<tr>
<td>Raise/Lower TTL Output for Each Image</td>
<td>Select this option if you would like the TTL output to be raised or lowered for each sequential image capture. This option is only available when the Auto TTL Output Control box is selected in the current Image Setup.</td>
</tr>
<tr>
<td>Time Interval</td>
<td>Enter the time interval between the start of one image capture to the start of the next image capture in hours, minutes, and seconds or select as short as possible. If you select as short as possible, the camera will begin exposing the next image as soon as the previous image data has been downloaded. With Xplorer and Pursuit cameras only, selecting as short as possible will enable the camera to begin exposing the next image while downloading image data from the first image. This enables these cameras to capture sequential images very quickly. However, if your computer doesn’t have enough memory to support this, your images may be overexposed. If this occurs, unselect the as short as possible checkbox and type in 0 as the time interval. This will prevent the camera from beginning the next exposure until the image data download has finished.</td>
</tr>
<tr>
<td>Place Images in an Image Sequence</td>
<td>If this box is selected, the SPOT software will automatically add the captured images into an image sequence as they are being captured. If your current Image Setup has Auto-Save selected and images are already being saved into a sequence, this option will be inactive.</td>
</tr>
<tr>
<td>Defer Image Processing until Done</td>
<td>Wait until the entire sequence is completed before displaying or saving the images.</td>
</tr>
</tbody>
</table>

After you have entered all of the options, click on Begin to start the image capture sequence. Refer to Ch. 8 – Viewing, Editing, and Annotating Images for details on viewing and modifying image sequence files.
Image Captures in Other Procedures

In addition to the basic image captures, the Camera menu contains options in which one image capture is used to prepare the camera for the final image capture. They include:

- Set Chip Imaging Area
- Set Spot Metering Area
- Compute Exposure
- Recall Previous Exposure
- Compute White Balance Values
- Get Bias Frame
- Get Background Subtraction
- Get Flatfield Image
- Set Exposure Conversion Factor (RT Cameras only)
- Set TTL Output Active
- Set TTL Output Inactive

B/W Cameras

Monochrome camera users will not see Compute White Balance Values option (or the corresponding toolbar button).

Because they are used prior to a final image capture, several of these options are discussed as a part of the image setup process. In such cases, the text of the manual refers back to the appropriate section of Chapter 5 - Preparing to Take a Picture.

Set Chip Imaging Area

The Set Chip Imaging Area selects a specific portion of the CCD chip. This option is available once an image has been captured. Using just a small portion of the available area on the CCD chip is useful because:

- The download time will be shorter.
- The file size will be smaller and easier to manage.

To avoid confusion when defining the region of the image that you want to capture, it is important to realize that there are two separate coordinate systems in use:

- The coordinate system of the CCD chip
- The coordinate system of the displayed image

- The coordinates displayed on the Status Bar as the cursor is moved over a displayed image are always “displayed image” coordinates. The coordinates displayed in the Set Chip Imaging Area dialog box are always CCD chip coordinates. These coordinate systems match only if the orientation of an image has not changed (i.e., it has not been flipped or rotated).
- Because the SPOT software tracks orientation changes, you can select a Chip Imaging Area on any displayed image, regardless of whether the orientation has changed: the Set Chip Imaging Area dialog box will correctly display the region of the CCD chip that you designated as the imaging region. However, because of the different coordinate systems, the coordinates that you see on the Status Bar (i.e., when moving the cursor over the displayed image) may not match the coordinates that appear in the Set Chip Imaging Area dialog box if the image was flipped or rotated.
To set an image region, follow these steps:

1. Position the cursor at the upper left edge of the image region that you want to capture.
2. Press and hold the mouse button (left mouse for PC users) and drag the cursor across the screen. A dotted border appears around the region that you select.
3. From the Camera menu, select Set Chip Imaging Area. The Chip Imaging Area window displays the pixel locations for the borders of the region that you selected.
4. Click OK to save the region values to the current image setup, or select a different image setup. The region values are now saved to the designated image setup.
5. Recapture the image using either Get Image (exposure from setup) or the Get Image (last used exposure) option. The new image capture displays only the region that you selected.

Set Spot Metering Area

Spot metering is a method for selecting a region of interest on a desired image and then allowing the SPOT camera to automatically set the exposure time to allow for the best possible balance of image quality and contrast. This can be useful when the default auto-exposure settings (full image sampling) do not provide a captured image that provides the detail you need for a particular region of your subject being viewed.

The Set Spot metering area feature in the SPOT software allows you to zero in on a rectangular region of the live image. There are two ways of setting the Spot Metering Area.

Method One – Drag the Area

1. Start by opening the live image window.
2. Select the area of the image by setting and then dragging the mouse across an area on the image.
3. Acquire that image using Snap.
4. Select Set Spot Metering Area from the Camera dropdown menu.
5. Save it to an Image Setup file for future image captures.

Method Two

1. Open the Image Setup Window from the Set-up dropdown menu.
2. Select the desired image setup file.
3. Select Auto-exposure from the menu selection window.
4. Select Region from the Set Metering Area box.
5. Type in or scale to the desired pixel points that will define the Spot Metering Area rectangle.
6. Save the Image Set-up modification.
You may also select the **Same as Imaging Area** option. That way, the camera will meter off of the entire image frame that you have selected (this is the default for auto-exposure). You will also note that once you completed Method One, if you open the Auto-exposure box and choose region, the values defining the rectangle determined by the drop and drag method are resident in the Region values.

### Compute Exposure

Compute Exposure determines the correct exposure time and gain for an image. By calculating exposure times and gain ahead of time, you can avoid the auto-exposure sequence that takes place each time that you use Get Image (exposure from setup). Using Compute Exposure also changes your current image setup:

- The computed exposure values are added to your current image setup.
- The current image setup, if set to Auto-Exposure, is changed to User-Defined.

To compute exposure, follow these steps:

1. Select Compute Exposure from the Camera menu. The Status message changes to **Computing exposure...**
   When the camera finishes sampling the light, the Exposure window displays the values.
2. Select an image setup from the Save to Setup drop-down box. The current image setup is the default.
3. Click on OK. When you open the Image Setup window, the new exposure value displays.
4. Select Get Image (exposure from setup) to capture the image using the new exposure values.

### Recall Previous Exposure

Recall Previous Exposure assigns the exposure time and gain from your last image capture to an image setup. The Recall Previous Exposure feature is available only after you have taken a picture.

To recall previous exposure values, follow these steps:

1. Capture an image.
2. From the Camera menu, select Recall Previous Exposure. The Exposure window displays the value from the last image capture (see above).
3. Select an image setup from the drop-down box.
4. Click OK.
5. Use Get Image (exposure from setup) to capture an image with the new exposure and gain values.
Compute White Balance Values (Color Cameras)

White balance is the ratio of red, green, and blue exposure times necessary to achieve the proper color rendition for an image. Many factors impact the coloration of an image capture, including the lamp voltage, the coloration of the glass in the slide, and the coloration of the lenses in the microscope’s objectives. To minimize the impact of these factors, use the Compute White Balance feature. When you perform a white balance calculation, SPOT samples the color of the light from your light source after it has passed through the slide and the objective, and then calculates the exposure values needed to produce images where the white areas are white and the color areas are true.

You should perform a new white balance calculation when you:

- Start a new image capture session.
- Change the lamp voltage.
- Switch to a different objective on the microscope.

When you open an image setup, the Image Setup screen displays the default white balance values for that Setup, which are the values that were last saved to the Image Setup. If you capture an image without computing a new white balance, SPOT uses these default values. Refer to Ch. 5 – Preparing to Take a Picture for a step-by-step description of how to compute a white balance.

Get Bias Frame (Bias Frame Subtraction)

Get Bias Frame allows you to collect data used to reduce the effect of noise in your captured image, specifically noise related to the bias (offset) used to adjust for the readout electronics. For a more detailed discussion of Bias Frame Subtractions, refer to Chapter 5, Preparing to Take a Picture.

To useBias Frame Subtraction, follow these steps:

1. From the Camera menu, select Get Bias Frame. The Get Bias Frame dialog box appears.
2. The program will ask for the number of image frames to capture to determine the Bias Frame reference noise level. You may select a number from 1-50 frames. The more frames you choose, the more accurate the result should be, however, the process will take a longer time.
3. Select Bias Frame File Name.
4. Select an Image Setup to save the Bias Frame to.
5. Cover the optical train or find another method to block light to the camera’s CCD. Click on OK. The program will acquire the number of short dark frame exposures required to calculate the Bias Frame.
6. The program will acquire the bias frames and save the file to the image setup you selected.
7. Move the specimen back into the field of view, and perform the image capture.

Get Background Image

Get Background Image is a function that allows you to collect data to minimize the effect of thermal noise in your captured image or to remove any background glow from fluorescence images. For a more detailed discussion of the theory and benefits of the Dark Noise Subtraction process, refer to Chapter 5, Preparing to Take a Picture.
To use Get Background Image, follow these steps:

1. From the Camera menu, select Get Background Image. The Get Background Image dialog box appears.

2. The program will ask for the number of image frames to capture to determine the Background Image reference noise level. You may select a number from 1-50 frames. The more frames you choose, the more accurate the result should be, however, the process will take longer.

3. Select the Background Image File Name.

4. Select the Image Setup to save the Background Image to.

5. The Get Background Image window will direct you to “Move to Background or block light”. If you are performing the background subtraction to minimize the effect of thermal noise, block all of the light to the camera. If you are performing the background subtraction to remove the background glow in fluorescence images, move to the background. Click on Begin. The program will acquire the number of exposures required to calculate the Background Image.

6. The Get Background Image window will direct you to “Block all light from the camera”. If you already blocked the light to the camera in step #5, click OK. If you moved to the

7. The program will finish creating the Background Image.

8. Move the specimen back into the field of view, and perform the image capture.

Get Flatfield Image

The Flatfield option can be used to correct for display problems associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system. For a more detailed discussion of the theory and benefits of the Flatfield correction process, refer to Chapter 5, Preparing to Take a Picture.

Note: Flatfield correction with the SPOT camera refers only to the correction of uneven lighting. It should not be confused with the correction of optical field flatness.

To use Flatfield Correct, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.

2. From the Camera menu, select Get Flatfield Image. The Get Flatfield dialog box appears.

3. Choose a number of frames to average. Larger numbers of frames will increase the accuracy of the flatfield correction, but will also increase the length of time it takes to create the flatfield image. The default number of frames to average is 3.

4. Choose a flatfield file name. Because flatfield image files are different for each objective, you might want to name the file according to the objective’s magnification (e.g. 10x).

5. Specify the image setup that will be associated with this flatfield image file when using the Flatfield Correct option.

Get Flatfield

Number of Frames to Average: 3
Flatfield File Name: ...
Save to Image Setup: Brightfield
Status:
Begin Abort
6. Remove the slide from the field of view.

7. When the program finishes acquiring the frames, it will prompt you to block all of the light to the camera. This can be accomplished by installing the dust cap that was supplied with the camera or by adjusting the microscope’s optical path. After the light is blocked, click on OK. The program computes another frame.

8. Move the specimen back into the field of view, and perform the image capture. Refer to Ch. 7 – Taking a Picture, for more details on the image capture process.

Set Exposure Conversion Factor (RT Cameras Only)

The Set Exposure Conversion Factor function enables you to match the light intensity in the live mode with what is present in the capture mode. This compensates for the differences due to the use of different electronic circuitry in the live mode as compared to the capture mode. To use Set Exposure Conversion Factor, follow these steps:

1. From the Camera menu, select Set Exposure Conversion Factor. The Set Exposure Conversion Factor dialogue box appears with a default conversion factor displayed.

2. Select Compute. A dialogue box will prompt you to “Move to sample for exposure computation”. Ensure that your sample is in field of view and click OK.

3. The SPOT software will compute the appropriate conversion factor. Click OK to finish.

Set TTL Output Active

The Set TTL Output Active option enables a TTL pulse manually. This pulse can be used to trigger external devices, like fluorescence shutters. There are options for automatically triggering the device when an exposure begins and for setting the active state of the TTL output in the image setup. See Chapter 5 – Preparing to Take a Picture for more details.

Set TTL Output Inactive

The Set TTL Output Inactive option disables the TTL pulse manually
Ch. 8 - Viewing, Editing, and Annotating Images

Introduction

After capturing an image, you can choose from a variety of viewing, editing, and annotation options that allow you to customize the appearance of the final image. These features are described in the following sections:

- Viewing Captured Images
- Working with Image Sequences
- Editing Captured Images

Note: These menus are available only when an image is on-screen.

Viewing Captured Images

The View menu options include:

- Fit to Window
- Set Zoom Mode
- Set Zoom Level
- Show Grid Lines
- Show Pan Window
- Show Sequence Controls (when an image sequence is open)
- Show Image Date/Time
- Show Image Acquisition Settings
- Show Annotations (when annotations are added)
- Show Calibration Marks (when calibration marks are added)
- Show Measurements (when measurements are added)
- Show Taskbars
- Show Variables
- Full Screen

Note: The Show Grid Lines option is available only after you have zoomed in (8x or 16x) on an image.

Fit to Window

Fit to Window allows you to view the whole image, regardless of the window size. Typically, reducing the size of a window also cuts off part of the image. The Fit to Window option solves this problem by resizing the image so that it is always the same size as the window.
Note: The View menu options supplement the standard Windows viewing options (e.g., Cascade, Tile Horizontal, etc.) that are found on the Window menu. Refer to the Windows on-line help for more information on these options.

To use Fit to Window, select (i.e., click on) the image that you want to modify and, from the View window, select Fit to Window.

Set Zoom Mode

1. Either select Zoom Mode From the View menu, or click on the Zoom toolbar button:

2. The cursor changes to a magnifying glass, and the Zoom toolbar button becomes active. The precise reference point for the zoom location is indicated by the white dot in the center of the magnifying glass. The row and column numbers at the bottom of the screen indicate the exact position of the white dot as you move the magnifying glass over the image. Use the mouse to zoom in or zoom out:
   - Position the mouse over the center of the area that you want to zoom in on.
   - Either left click to zoom in 2x, or right click to zoom out 2x.
   - To return to the normal view mode, de-select the Zoom option.

The Zoom feature works in conjunction with the pan window (see Show Pan Window below), which allows you to see where you are in relation to the larger image while zoomed in.

Note: All of the standard save, view, and edit options, with three exceptions – Add Calibration Mark, Add Measurement, and Annotate – can be used while the program is in zoom mode. If you need to annotate a zoomed image, use the Zoom Level option (see below).

Note: With some video cards, you might experience display problems when zooming in on captured images. To correct these problems, lower the Graphics Acceleration setting in Windows, as described in the Video Card Related Problems section of the Installation Guidelines chapter.

Set Zoom Level

The Zoom Level option, like the Zoom Mode option enables you to view zoomed images. However, unlike the Zoom Mode option, you have the option to add annotations, including text, calibration marks, and measurements, to the zoomed image. To use the Zoom Level option, select Zoom Level from the View menu and select a percentage option from the list.

Like the Zoom Mode option, the Zoom Level option can be used in conjunction with the pan window (see Show Pan Window below), which allows you to see where you are in relation to the larger image while zoomed in.

Note: Zoom Level values are always referenced to the original image capture. The original image, however, does not always equal 100%. It will be 100% if you don’t select the Fit to Window option in the Preferences window.

Note: With some video cards, you might experience display problems when zooming in on captured images. To correct these problems, lower the Graphics Acceleration setting in Windows, as described in the Video Card Related Problems section of the Installation Guidelines chapter.
Show Grid Lines

Show Grid Lines clearly defines pixel borders, which are often invisible in low contrast areas of an image. Clearly defined borders help in positioning the cursor at an exact row and column location (i.e., using the readouts at the bottom of the screen), which then allows you to view the brightness value for the individual pixel.

Note: When using the Zoom Mode option, all of the standard save, view, and edit options, with three exceptions – Add Calibration Mark, Add Measurement, and Annotate – can be used while the program is in zoom mode. If you want to annotate a zoomed image, use the Zoom Level option (see above).

To show the grid lines on an image, follow these steps:

1. Position the magnifying glass in the center of the area that you want to zoom in on.
2. Zoom to either 8x or 16x. If you are using the Zoom Level option, select a percentage of 800 or greater.
3. From the View menu, select the Show Grid Lines option. Grid lines appear around each pixel.

Show Pan Window

Show Pan Window enables you to navigate around an image while zoomed in at high magnifications. When you select the Show Pan Window option, the program highlights your location in relation to the whole image. A “color negative” area represents the zoomed-in area of the image over the smaller version of the image in the Pan Window. By moving the highlighted area around the pan window, you can explore the image, piece by piece.

Without the Show Pan Window option, the process of moving to a new point while in high magnification would involve several steps:

1. Zooming in to the first area of interest.
2. Zooming out to determine where you are.
3. Determining a new area of interest.
4. Re-zooming in to the new area of interest.

To use the pan window, follow these steps:

1. From the View menu, select Show Pan Window:

   The pan window appears, superimposed upon the image. The illustration to the right shows the pan window as it is used when zoomed in on an image.

2. Position the cursor on the image in the pan window: it changes from a magnifying glass to a four arrow pointer.

3. To move to a different area of the image, either left click on the rectangle and drag it to the new location, or left click on the new location.
Show Sequence Controls

The Show Sequence Controls option displays the play controls for image sequences. This option appears only when an image sequence is open. Using the Image Sequence dialog you can:

• Play all or part of an image sequence in forward or reverse order.
• Set the display interval between images.
• Set the action that takes when the image sequence finishes playing – i.e., stop, restart, or reverse.

Refer to the Working with Image Sequences section for details.

Show Image Date/Time

The Image Date/Time feature pulls up the date and time associated with the capture of an image. When you capture an image, the SPOT software remembers the date and time of the image capture. When you save the image, even if this is many hours later, the program sets the Created date and time of the image file to the date and time of the original image capture.

When image files are transferred over networks, the Created date and time is sometimes reset to the date and time of the transfer, making it an unreliable indicator of the image capture time. Because TIFF and JPEG format images have tags both for the Created date and the original capture date and time, they are not affected by network transfers. If reliable image capture date and time information is important to your work, you should save images in either TIFF or JPEG format.

When you select the Image Date/Time option from the View menu, a dialog box displays the date and time associated with the capture.

• For non-TIFF, non-JPEG format image files, this is the Created date/time, as explained above.
• For TIFF and JPEG format image files, this is the TIFF/JPEG tag date and time.
• For SPOT Database images this is the original date and time that was stored in the database file.

Show Image Acquisition Settings

The Show Image Acquisition Settings feature, when selected from the dropdown menu, will display the image capture settings that were associated with the open image file. The information displayed will include such settings as exposure time, user name, image setup name, gain setting, filter color (color cameras), binning setting, chip area, gamma setting, etc.

Show Annotations

When Show Annotations is selected, any annotations that have been added to the image will be shown. The Show Annotations option is inactive if no annotations have been added to the image.

Show Calibration Marks

When Show Calibration Marks is selected, any calibration marks that have been added to the image will be shown. The Show Calibration Marks option is inactive if no calibration marks have been added to the image.

Show Measurements

When Show Measurements is selected, any measurements that have been added to the image will be shown. The Show Measurements option is inactive if no measurements have been added to the image.
Show Taskbar

When you select this command from the dropdown menu, you can choose which taskbar(s) to display. If you choose to display more than one taskbar they will be positioned on top of each other. To re-position them so that you can view multiple taskbars simultaneously, place the cursor over the taskbar, hold the mouse button down, and drag the taskbar to the location you desire. If you have not yet developed a taskbar, these can be created by choosing Taskbars from the Setup menu. See Chapter 12 – Taskbars for a complete discussion regarding taskbar development and use.

Show Variables

The Show Variables dialogue displays the current values of 5 text and numeric variables that can be called in other parts of the SPOT software. The values can be added, modified or deleted from this dialogue. If numbers are entered as text variables, they will be treated as text. Text cannot be entered as numeric variables.

Full Screen

View a full screen version of an image – i.e., without the SPOT menus or toolbars or the Windows navigation bar. This option allows you to utilize the entire window for previewing images. Press [F 7] to view a full screen image. Press [F 7] again to exit the full screen view. Alternatively, you can exit the full screen view by moving the cursor to the top of the window and clicking on the Exit Full Screen Mode button that appears. While working in Full Screen mode, Windows users can access SPOT menu options using standard keystroke combinations, as illustrated in the table below:

- [Alt] + A [Attributes (Report mode)]
- [Alt] + C [Camera]
- [Alt] + D [Database (Advanced mode)]
- [Alt] + E [Edit]
- [Alt] + F [File]
- [Alt] + H [Help]
- [Alt] + O [Object (Report mode)]
- [Alt] + Q [Sequence]
- [Alt] + S [Setup]
- [Alt] + V [View]
- [Alt] + W [Window]

Working with Image Sequences

There are three places from which you can edit and play image sequence files:

- The Sequence menu – Rearrange the order of a sequence, add and/or remove images to and from the sequence, extract images from the sequence, and play the sequence.
- The Sequence Controls (Image Sequence) dialog – Set view options and play the sequence.
- The Edit menu - Modify/enhance image sequences using the options on SPOT’s Edit menu. Refer to Editing Images in a Sequence (below) for more information.

Refer to the following sections for details.
Sequence Menu Options

Image sequences are editable. The **Sequence** menu, which is available only when an image sequence is open, displays the available options. They are as follows:

- **Extract Images**
  
  Extract an image or images from a sequence file. Extracting creates new image(s), leaving the original sequence intact. Click on **Extract Images** and enter the number(s) of the image(s) that you want to extract. To extract multiple images from a sequence, separate numbers with commas and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9.

- **Insert Image**
  
  Add an image to the sequence. Using **Insert Image**, you can add an image to a sequence from one of three sources:
  
  - **Currently Open Document** – Add an image from the currently open sequence file. Make sure to specify the **Sequence Index** – i.e., the number of the image in the sequence.
  
  - **File** – Add an image from disk. If the image comes from a sequence file, make sure to specify the Sequence Index.
  
  - **Database (Windows)** – Add an image from a SPOT database. To determine the Image ID, open the database and use the **Search** option. The search results table displays the Image ID for each record.
    
    - When you click on **OK**, a dialog prompts you to specify the point in the sequence where you want to insert the image.

- **Append Image**
  
  Add an image to the end of the sequence. Using **Append Image**, you can add an image to a sequence from one of three sources:
  
  - **Currently Open Document** – Add an image from the currently open sequence file. Make sure to specify the **Sequence Index** – i.e., the number of the image in the sequence.
  
  - **File** – Add an image from disk. If the image comes from a sequence file, make sure to specify the Sequence Index.
  
  - **Database (Windows)** – Add an image from a SPOT database. To determine the Image ID, open the database and use the **Search** option. The search results table displays the Image ID for each record.

- **Remove Images**
  
  Remove an image or images from a sequence file. Removing an image deletes the image from the sequence, which is automatically reordered. Click on **Remove Images** and enter the number of the image(s) that you want to extract. To extract multiple images from a sequence, separate numbers with commas and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9.

- **Move Images**
  
  Move an image or image(s) to a different point in the sequence. Click on **Move Image** and enter the number(s) of the image(s) that you want to move. To move multiple images from a sequence, separate numbers
with commas and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9.

**Image Sequence Controls**

The **Sequence Controls (Image Sequence)** enables you to play image sequences and set the play options.

**Image Index**

Use the **Image Index** options to specify the view parameters of the sequence.

- **First** - Enter the number of the image that should be the sequence.
- **Current** – This field displays the number of the image you are currently viewing. Enter a new number to view a different image.
- **Last** – Enter the number of the image that should be last in the sequence

**Play Options**

Use the **Play Options** to control how the image sequence displays when playing.

- **Interval** – The time interval between each image when the sequence is playing. Enter a number in milliseconds or seconds.
- **At End** – The action that takes place when the sequence finishes playing.
  - **Stop**: The sequence stops at the last image in the sequence.
  - **Restart**: The sequence begins playing from the beginning.
  - **Reverse**: The sequence reverses play when it reaches the end.
**Editing Images in a Sequence**

Images from a sequential image file can be edited using the *Edit* menu options. This allows you to specify the individual image or images (including the entire sequence) to which the edits are applied.

- In some cases – e.g., *Combine Images* – the dialog prompts you to specify the *Sequence Index* – i.e., the number of the image within the sequence.

- In other cases, as with the *Adjust RGB* options, SPOT prompts you to specify whether the edit applies only to the current image in the sequence, all of the images in the sequence, or a specific subset of images in the sequence. For example, when editing an image sequence, if you select *Edit > Adjust RGB > Adjust Brightness (additive)*, the *Additive Brightness Adjust* dialog appears. After you make your edits and click on *OK*, the *Edit Images* window prompts you to specify the image or images that the edit will apply to, as shown at right.

  - **No Other Images** – The edit applies only to the current image – i.e., the on-screen image.
  - **All Other Images in Sequence** – The edit applies to all of the images in the sequence.
  - **Specified Image Sequence** – The edit applies to the images that you specify. Enter the number(s) of the image(s) in the box at the bottom of the dialog. To specify multiple images, separate numbers with commas and/or dashes - e.g., 5, 6, 7; or 5-7; or 1 – 5, 6, 9.

**Edit**

The *Edit* menu contains six categories of editing options, as illustrated in the following table:

<table>
<thead>
<tr>
<th>Editing Category</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Editing Functions</strong></td>
<td><em>Undo</em></td>
</tr>
<tr>
<td></td>
<td><em>Copy to Clipboard</em></td>
</tr>
<tr>
<td><strong>Image Sizing and Position</strong></td>
<td><em>Resize</em></td>
</tr>
<tr>
<td></td>
<td><em>Rotate Right</em></td>
</tr>
<tr>
<td></td>
<td><em>Rotate Left</em></td>
</tr>
<tr>
<td></td>
<td><em>Flip Horizontal</em></td>
</tr>
<tr>
<td></td>
<td><em>Flip Vertical</em></td>
</tr>
<tr>
<td></td>
<td><em>Crop</em></td>
</tr>
<tr>
<td><strong>Image Quality</strong></td>
<td><em>Adjust RGB</em></td>
</tr>
<tr>
<td></td>
<td><em>Adjust HSL</em></td>
</tr>
<tr>
<td></td>
<td><em>Adjust HSV</em></td>
</tr>
<tr>
<td></td>
<td><em>Filter</em></td>
</tr>
<tr>
<td></td>
<td><em>Make Negative</em></td>
</tr>
<tr>
<td></td>
<td><em>Convert to Gray Scale</em></td>
</tr>
<tr>
<td></td>
<td><em>Set Palette (monochrome)</em></td>
</tr>
<tr>
<td></td>
<td><em>Match Color (RGB)</em></td>
</tr>
<tr>
<td><strong>Customization</strong></td>
<td><em>Change Pixel Bit Depth</em></td>
</tr>
<tr>
<td></td>
<td><em>Subtract Image</em></td>
</tr>
<tr>
<td></td>
<td><em>Merge Images</em></td>
</tr>
<tr>
<td></td>
<td><em>Duplicate Images</em></td>
</tr>
<tr>
<td><strong>Annotation</strong></td>
<td><em>Add/Edit Calibration Mark</em></td>
</tr>
<tr>
<td></td>
<td><em>Add/Edit Measurement</em></td>
</tr>
<tr>
<td><strong>Calibration and Measurement Marks</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

**Spot Software User Guide**
Custom Image Annotation | Annotate
--------------------------|--------------------------
Image Memos | Memo

Basic Editing Functions

The Edit menu contains several functions that are common to most operating systems.

**Undo**

Undo the last edit that you made. The Undo option only allows for one level of edits: in other words, you can only undo the immediately preceding edit. To Undo an action, select Undo from the Edit menu.

**Copy to Clipboard (PC)**

Copy all or part of an image onto the clipboard for insertion into another program. These options are identical to the Windows [Ctrl C] command and the Mac [⌘ C] command.

1. Press and hold the left mouse button (PC)/mouse button (Mac).
2. Drag the cursor over the image until the dotted rectangle covers the area of the image that you want to copy. If you copy without "cutting out" a specific portion of the image, SPOT selects the entire image.
3. Either select the Copy to Clipboard/Copy option from the Edit menu, or press [Ctrl C] (PC)/[⌘ C] (Mac). The image is now ready to be pasted into another application.
4. Open the application that you want to paste the image into, and select from the available pasting options.

**Cut (Mac)**

Cut text fields within the SPOT program.

**Paste (Mac)**

Paste text fields in the SPOT program. The Paste option is unavailable (grayed out) for image editing.

**Clear (Mac)**

Clear a text field in the SPOT program. The Clear option is unavailable (grayed out) for image editing.

**Select All (Mac)**

Select text for copying. The Select All option is unavailable (grayed out) for image editing.

Image Sizing and Position

From the Edit menu, you can:

- Re-size images
- Re-position images
- Match the on-screen orientation of a specimen to the microscopic view
- Crop an image to better reflect the area of interest

### Resize

Use the Resize option to reduce or enlarge an image. When you reduce or enlarge an image, the resolution and file size change accordingly. The SPOT program maintains aspect ratio so enlarged and reduced images will not be distorted. When you reduce or enlarge an image, keep the following in mind:

- Reduction - Resolution (number of pixels) and file size decrease.
- Enlargement - Resolution (number of pixels) and file size increase.
The trade off for higher resolution images is increased file size. The Resize option lets you specify the percentage by which you want to increase or decrease the linear dimensions of the image.

The program reads the red, green, and blue brightness values for the pixels in the original image and uses those values to create a new image where the number of rows and columns is reduced or enlarged by the percentage that you specify.

Two circumstances where you might want to enlarge or reduce an image are listed here:

- **You captured an image using a low magnification objective (e.g., 5x or below)** - In this case, enlarging the image adds pixels, which helps to smooth out the pixellation of high contrast, fine details. This makes it easier to view and interpret the structure of these details. Enlarging also makes large format prints appear smoother and less pixellated.

- **You want to save file space and resolution is not the primary concern** - In this case, reducing the image reduces the file size.

To resize an image, follow these steps:

1. From the Edit menu, select the resize option. The Resize Image window appears.
2. Do one of the following:
   - If you want to change the size of an image by a specific percentage, type in a value between 10% and 200%, or move the slider bar accordingly. The linear dimensions (width or height) of the image will change by this percentage factor.
   - If you want to specify the dimension in pixels, enter a number in either the Width or the Height box. The SPOT program automatically calculates the dimension not entered in order to maintain the proper aspect ratio.
3. Click on OK. The newly sized image replaces the original image on the screen.

Note: If you want to create two differently sized images of an image for comparison purposes, use the Save As [Ctrl A] command to save the resized image with a different file name.

**Rotate Right**

Rotate an image clockwise in 90 degree increments.

**Rotate Left**

Rotate an image counter-clockwise in 90 degree increments.

**Flip Horizontal**

Flip an image from right to left.

**Flip Vertical**

Flip an image from top to bottom.

**Crop**

Cut out a portion of an image. To crop an image, follow these steps:

1. Press and hold the left mouse button.
2. Drag the cursor over the image until the dotted rectangle covers the area of the image that you want to crop.

3. From the Edit menu, select Crop. The Crop Area window displays the pixel coordinates of the rectangle that you selected. From this window you can fine tune the crop area by modifying the pixel coordinates. If you select the Crop option directly from the menu (i.e., without specifying a crop area), the Crop Area window displays the values for the entire image.

4. Click on OK to crop the image. The cropped image appears on-screen.

Note: When you crop an unsaved image, the program automatically discards the area of the image outside the crop. To give yourself the opportunity to change the crop area, you should save the image before you crop it.

Image Quality

The image quality editing options provide you with a wide array of powerful and easy to use tools for changing the appearance of an image after it has been captured. These tools enable you to enhance the appearance of an image in ways that are not possible with conventional photography.

Before using the SPOT editing features, review the following two sections:

• Functional Features – This section explains how thumbnail images work in the SPOT image editing windows.

• Image Editing and the Concept of Color Space – This section introduces the concept of color space and describes how it applies to the SPOT software.

Functional Features

With the exception of Make Negative and Convert to Gray Scale, all of the image quality editing options utilize thumbnail images to preview the edits being made to the main image. As illustrated at right, a thumbnail of the image capture appears in the adjustment window, and the Modify Main Image box is checked as the default.

• If you leave the box selected… As you make editing adjustments, the changes appear in both the main image and the thumbnail.

• If you deselect the box… As you make editing adjustments, the changes appear only in the thumbnail image. After you click on OK, the changes appear in the main image.

Properly utilized, thumbnail images can be very helpful as part of the image editing process. Consider the following:

• You can use thumbnails to speed the editing process. The SPOT software often cannot update all the pixels in the main image as quickly as you can adjust the edit controls. In cases where the thumbnail image is sufficient to judge the effect of the edits, you can save time by deselecting Modify Main Image, so that the main image is updated only after you close the editing window. Deselecting Modify Main Image also makes the editing feel more “real time.”
The thumbnail can be used to display a smaller, magnified section of an image. When you select a specific image area (i.e., by dragging the cursor) before selecting an edit function, only the selected area appears in the thumbnail. This is useful for Sharpen, an edit function that affects only the fine structure of an image. This is also useful when you are analyzing histograms, and want the histogram to represent only the section of the image that interests you.

Image Editing and the Concept of Color Space

A color space is a coordinate system that is used to mathematically represent color. In order to satisfy the imaging requirements of different microscopy techniques, the SPOT program allows you to adjust brightness, color, and contrast in three color spaces: RGB, HSL, and HSV.

The color space options and their suggested uses are as follows:

- **Adjust RGB** (Red Green Blue) – Use for monochrome images
- **Adjust HSL** (Hue Saturation Luminance) – Use for all color images except fluorescence
- **Adjust HSV** (Hue Saturation Value) – Use for fluorescence images

Each color space is described below.

**RGB**
The RGB color space operates by assigning a red, green, and blue value to each pixel in an image. Because red, green and blue are the primary colors for emissive light, this is the method that color computer monitors use to display images. However, the RGB color space is not intuitive to users.

**HSL**
The HSL color space is a more intuitive model based on the three attributes that are common to all colors: hue, saturation, and luminance. Instead of assigning a red, blue, and green value to each pixel, the HSL color space assigns a value for each color attribute (e.g., hue, saturation, and luminance). These attributes are defined as follows:

- **Hue** – Hue is the designation for the actual color, as distinguished from others in the color spectrum. Hue is derived from a color wheel and is expressed in the color's angular location (in degrees) on the wheel. (e.g., +180° to –180° for the SPOT software).
- **Saturation** – Saturation is the proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero is pure gray and 100 is pure hue (e.g., day glow).
- **Luminance** – Luminance is the relative brightness or darkness of a hue. Luminance (in the SPOT software) is measured on a numerical scale of 0 to 100. A saturated color starts out as black at a luminance of 0, reaches full brightness as a saturated color at a luminance of 50, and then transitions through lighter pastel shades to white at a luminance of 100. This mimics the human perception of increasing brightness for images that are illuminated with light that contains a broad spectrum of wavelengths.

**HSV**
The HSV color space was added to the SPOT software to optimize fluorescence image editing. Both the RGB and the HSL color spaces are problematic when used to edit color fluorescence images. Increasing gamma in RGB can cause dimmer sections of the image to lose saturation (look “washed out”) and change hue. Increasing gamma or brightness in HSL causes the brighter areas of an image to look unnaturally pastel or even white. The HSV color space avoids both problems. The HSV color space is similar to the HSL color space in that it also uses the intuitive concepts of hue and saturation. However, instead of luminance for brightness, it uses Value. Value is like Luminance in that a value of 0 is black. Value differs from Luminance in that a Value of 100 (in the HSV color space) is the brightest version of the original hue whereas a Luminance of 100 (in the HSL color space) is always white. For example, a dim cherry red changes to a bright cherry red when its Value is increased from 30 to 100. When its Luminance is increased from 30 to 100, a dim cherry red turns white. HSV works well for fluorescence images because the dyes in fluorescence images emit single wavelength light. This light is, by definition, highly saturated. Editing in the HSV color space ensures that all areas of the image retain their saturated colors. Thus, using the HSV color space, images can be modified without causing the bright areas to look unnaturally pastel or white.
**Adjust RGB/Adjust HSL/Adjust HSV**

The process by which the program applies edits to an image capture differs according to the color space that you select. The following table briefly describes the edit process in each of the three color spaces and lists the recommended usage for each color space.

<table>
<thead>
<tr>
<th>Color Space</th>
<th>Editing Process</th>
<th>Recommended Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB</td>
<td>Adjustments are applied separately to the red, green, and blue pixel values.</td>
<td>The RGB option is ideal for monochrome images.</td>
</tr>
<tr>
<td>HSL</td>
<td>3. RGB pixel values are translated to HSL (hue, saturation, and luminance) values. 4. Adjustments are applied to the hue, saturation, or luminance. The HSL values are translated back to the RGB pixels.</td>
<td>The HSL option is ideal for all color images except fluorescence images.</td>
</tr>
<tr>
<td>HSV</td>
<td>3. RGB pixel values are translated to HSV (hue, saturation, and value) values. 4. Adjustments are applied to the hue, saturation, or value. The HSV values are translated back to the RGB pixels.</td>
<td>The HSV option is ideal for fluorescence images.</td>
</tr>
</tbody>
</table>

The Adjust RGB, Adjust HSL, and Adjust HSV options are each made up of several image-editing functions. The table below lists the parallel RGB, HSL, and HSV functions:

<table>
<thead>
<tr>
<th>Adjust RGB</th>
<th>Adjust HSL</th>
<th>Adjust HSV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Brightness (additive)</td>
<td>Adjust Hue, Saturation, and Luminance</td>
<td>Adjust Hue, Saturation and Value</td>
</tr>
<tr>
<td>Adjust Brightness (multiplicative)</td>
<td>Adjust Luminance (multiplicative)</td>
<td>Adjust Value (multiplicative)</td>
</tr>
<tr>
<td>Adjust Contrast</td>
<td>Adjust Contrast</td>
<td>Adjust Contrast</td>
</tr>
<tr>
<td>Adjust Gamma</td>
<td>Adjust Gamma</td>
<td>Adjust Gamma</td>
</tr>
<tr>
<td>Stretch Bright and Dark Level</td>
<td>Stretch Bright and Dark Level</td>
<td>Stretch Bright and Dark Level</td>
</tr>
<tr>
<td>Adjust Histogram</td>
<td>Adjust Histogram</td>
<td>Adjust Histogram</td>
</tr>
</tbody>
</table>

Many of the Adjust edit functions are duplicated in all three color spaces. To avoid unnecessary repetition, we have grouped together discussions of edit functions that are the same in different color spaces. The color space associated with the option appears parenthetically in the heading.
**Adjust Brightness (additive) (RGB)**

Use Adjust Brightness (additive) to lighten or darken an entire image. This function adds or subtracts the specified number(s) from the red, green, and blue values every pixel in the image. Because this is an additive function, it affects bright and dark areas equally. You can change an image's brightness either by adjusting all three values (e.g., red, green, and blue) together, or adjusting each value individually.

To Adjust Brightness (additive), follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Brightness (additive). The Additive Brightness Adjust window appears, with a thumbnail preview of the open image. The Lock RGB and Modify Main Image boxes are checked as defaults. To adjust the RGB values individually, deselect the Lock RGB box.

2. Change the brightness of the image.
   - To modify an image's brightness equally for red, green, and blue values, ensure that the Lock RGB box is checked, and either enter a number in any one of the three boxes, or use one of the slider bars to specify a number between -255 and 255 (8 bit), -4095 and 4095 (12 bit), and -16,383 and 16,383 (14 bit).
   - To modify an image's brightness by specifying separate red, green, and blue values, deselect the Lock RGB box, and enter a value for each color.

3. Click on OK. The new image appears on-screen.

**Adjust Hue, Saturation, and Luminance (HSL)**

**Adjust Hue, Saturation, and Value (HSV)**

Use the Adjust Hue, Saturation, and Luminance and the Adjust Hue, Saturation, and Value options to make additive changes to the HSL or HSV values in an image. This process converts the RGB values for each pixel in the image to HSL or HSV values. After you make the adjustments, the program converts the HSL/HSV values back to RGB color space values.

To change the HSL or HSV values for an image, follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Hue, Saturation, and Luminance or Adjust HSV, Adjust Hue, Saturation, and Value:

2. Either type in the HSL/HSV values, or use the slider bars to select the values. Each value uses its own scale, and must be entered separately.
   - **Hue** - Enter an angle value between -180° and 180°. This number represents the amount that the color wheel is rotated for each pixel in the image.
   - **Saturation** - Enter a number between -100 and 100. This number is added to the saturation value (e.g., a number between 0 - pure gray and 100 - day glow) of each pixel in the image.
• **Luminance or Value** - Enter a number between -100 and 100. This number is added to the Luminance/Value value (e.g., a number between 0 - pure black and 100 - pure white for Luminance/brightest version of hue if Value) of each pixel in the image.

*Note: The scales used to measure HSL/HSV values are not standardized. Thus, the scales used by the SPOT software might differ from those of other programs.*

3. Click on OK. The new image appears on-screen.

**Adjust Brightness (multiplicative) (RGB)**

Use Adjust Brightness (multiplicative) to make the bright areas of an image brighter or darker. This function multiplies the red, green, and blue values for every pixel in the image by the number(s) that you specify. Because this option is multiplicative, it affects bright areas more than dark areas: black areas tend to stay black while lighter areas get brighter. Like the Adjust Brightness (additive) option, the multiplicative option enables you to either adjust the RGB values together or as individual units.

To use the Adjust Brightness (multiplicative) function, follow these steps:

1. From the Edit menu, select **Adjust RGB > Adjust Brightness (multiplicative)**. The Multiplicative Brightness Adjust window appears, with a thumbnail preview of the open image.

   The Lock RGB and Modify Main Image boxes are checked as defaults. To adjust the RGB values individually, deselect the Lock RGB box.

2. Change the brightness of the image.

   To modify an image's brightness equally for red, green, and blue values, ensure that the Lock RGB box is checked, and either enter a number in any one of the three boxes, or use one of the slider bars to specify a number between 0 (darkest) and 5 (brightest).

   To modify an image's brightness by specifying separate red, green, and blue values, deselect the Lock RGB box, and enter a value for each color.

3. Click on OK. The new image appears on-screen.

**Adjust Luminance (multiplicative) (HSL)**

**Adjust Value (multiplicative) (HSV)**

Adjust Luminance (multiplicative) and Adjust Value (multiplicative) make the bright areas of an image brighter or darker when editing in the HSL and HSV color spaces. These functions multiply the Luminance or Value values for every pixel in the image by the number that you specify. Because these options are multiplicative, they affect bright areas more than dark areas.

To Adjust Luminance (multiplicative) (HSL) or Adjust Value (multiplicative) (HSV), follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Luminance (multiplicative) or Adjust HSV, Adjust Value (multiplicative):
Ch. 8 – Viewing, Editing, and Annotating Images

The Modify Main Image box is checked as a default.

2. Change the Luminance or Value of the image. Use the slider bar to specify a number between 0 (darkest) and 5 (brightest).

3. Click on OK. The new image appears on-screen.

Adjust Contrast (RGB)

Use Adjust Contrast to exaggerate or subdue the differences between the bright and dark areas in an image. The Adjust Contrast option, when accessed from the Adjust RGB menu item, enables you to make adjustments to the red, green, and blue values either together, or as individual units.

To adjust the contrast in an image, follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Contrast. The Contrast Adjust window appears.

   The Lock RGB and Modify Main Image boxes are checked as defaults. To adjust the RGB values individually, deselect the Lock RGB box.

2. Change the contrast of the image.

   To change the contrast equally for red, green, and blue values, ensure that the Lock RGB box is checked, and either enter a number in any one of the three boxes, or use a slider bar to specify a number between 0 (pure gray - no contrast) and 5 (maximum contrast).

   To modify an image's contrast by specifying separate red, green, and blue values, deselect the Lock RGB box, and enter a value for each color.

3. Click on OK. The new image appears on-screen.
**Adjust Contrast (HSL)**
**Adjust Contrast (HSV)**

The Adjust Contrast (HSL) and Adjust Contrast (HSV) options, like the Adjust Contrast (RGB) option, exaggerate or subdue the differences between the bright and dark areas in an image. Unlike the Adjust Contrast (RGB) process, the Adjust Contrast (HSL/HSV) process works only on the Luminance/Value values for an image as opposed to the specific red, green, and blue values.

To use Adjust Contrast (HSL/HSV), follow these steps:

1. From the Edit menu, select Adjust HSL and Adjust Contrast or Adjust HSV and Adjust Contrast.

1. Enter a value between .1 and 4, or use the slider bar to select a value. The thumbnail changes as you adjust the value.

   To exaggerate the contrast of an image, enter a value above one (the base value).
   To subdue the contrast of an image, enter a value below one (the base value).
   Click on OK. The new image appears on-screen.

**Adjust Gamma (RGB)**

Gamma Adjust smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for editing images with a wide range of brightness values (dynamic range). Gamma adjustment corrects an image by creating a new version of the original. Refer to Ch. 5 – Preparing to Take a Picture for a more detailed explanation of gamma adjustment.

To adjust gamma, follow these steps:

1. From the Edit menu, select Adjust RGB and Adjust Gamma. The Gamma Adjust window appears. The Lock RGB and Modify Main Image boxes are checked as defaults.

2. Adjust the gamma.

   To adjust the gamma equally for red, green, and blue values, ensure that the Lock RGB box is checked, and either enter a number in any one of the three boxes, or use a slider bar to specify a number between .1 and 4.
   To gamma adjust an image by specifying separate red, green, and blue values, deselect the Lock RGB box, and enter a value for each color.

   Note: The ability to deselect the Lock RGB box and enter specific RGB values distinguishes the use of the Adjust Gamma menu option from the Gamma Adjust option on the Image Setup window (see Ch. 5 – Preparing to Take a Picture).

3. Click on OK. The new image appears on screen.
**Adjust Gamma (HSL)**

**Adjust Gamma (HSV)**

Like the Adjust Gamma (RGB) option, the Adjust Gamma (HSL) and Adjust Gamma (HSV) options allow you to smoothly lighten darker areas of an image without burning out bright areas or lightening black areas. This is useful when modifying images with a wide *dynamic range*, meaning the range of brightness values recorded by the CCD chip. Unlike the Adjust Gamma (RGB) option, Adjust Gamma (HSL) and Adjust Gamma (HSV) work only on the luminance or value values (respectively) for an image as opposed to the specific red, green, and blue values. Refer to Ch. 5 – Preparing to Take a Picture for a more detailed explanation of gamma adjustment.

To Adjust Gamma (HSL/HSV), follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Gamma or Adjust HSV, Adjust Gamma.

   ![](image1.png) ![](image2.png)

2. Enter a value between .1 and 4, or use the slider bar to select a value. The thumbnail preview of the image changes as you adjust the value.

   To lighten the mid-tones of an image, enter a gamma value above one.
   To darken the mid-tones of an image, enter a gamma value below one.

3. Click on OK. The new image appears on-screen.

**Stretch Bright and Dark Level (RGB)**

The Stretch Bright and Dark Level (RGB) option stretches the darkest level in an image to 0 (black) and the brightest level to full scale. Full scale is 255 for 8 bit monochrome and 24 bit RGB images, 4,095 for 12 bit monochrome and 36 bit RGB images, and 16,384 for 14 bit monochrome and 42 bit RGB images.

Stretching the bright and dark level (RGB) for a 24 bit RGB image with a range of brightness values between 50 and 150 has the following effects:

- The lowest value pixels (50) are stretched down to 0.
- The highest value pixels (150) are stretched up to 255.

This one-step process provides a quick and easy way to increase image contrast in low contrast specimens. To use Stretch Bright and Dark Level (RGB), select Adjust RGB, Stretch Bright and Dark Level from the Edit menu. The picture automatically adjusts itself.
**Stretch Bright and Dark Level (HSL)**

**Stretch Bright and Dark Level (HSV)**

Like Stretch Bright and Dark Level (RGB), the Stretch Bright and Dark Level options in the HSL and HSV color spaces stretch the darkest luminance or value level in an image to 0 (black) and the brightest luminance or value level to 100 (pure white if Luminance/brightest version of hue if Value). Using the HSL or HSV (for fluorescence images) color space to stretch images, as opposed to the RGB color space, reduces the potential for washed out images and color shifts.

To stretch bright and dark level HSL or HSV, select Adjust HSL, Stretch Bright and Dark Level or Adjust HSV, Stretch Bright and Dark Level from the Edit menu. The picture automatically adjusts itself.

**Adjust Histogram (RGB)**

A histogram is a graphical representation of the number of pixels at each brightness level in an image. SPOT’s histogram displays the red, green, and blue histograms on the same graph. It serves two main purposes:

- It is a point of reference for examining the distribution of brightness levels for the red, green, and blue components in an image.
- It can be used to reset the zero and full-scale points for an image. This is known as stretching. Like the aforementioned Stretch Bright and Dark Level function, the Adjust Histogram option enables you to stretch the darker areas of your image to pure black and at the same time lighten the brighter areas of the image.

Note: Full scale for 8 bit monochrome and 24 bit RGB images is 255. Full scale for 12 bit monochrome and 36 bit RGB images is 4,095. Full scale for 14 bit monochrome and 42 bit RGB images is 16,383.

To adjust an RGB histogram, follow these steps:

From the Edit menu, select Adjust RGB, Adjust Histogram. The RGB Histogram window appears.

Set the display parameters for the histogram:

- Determine the color or colors that you want to display brightness values for. As a default, the histogram displays all three values. To display a different combination of colors, deselect the Show box for the unwanted color(s).
- To display the histogram according to a logarithmic scale (as opposed to a linear scale), check the Log Scale box. This makes the vertical axis more sensitive to small numbers and compresses the range for larger numbers.

To display the histogram according to a logarithmic scale (as opposed to a linear scale), check the Log Scale box. This makes the vertical axis more sensitive to small numbers and compresses the range for larger numbers.

From the RGB Histogram screen you have three viewing/editing options.

- Examine the number of pixels at each brightness level.
  Do one of the following:
    - Move the cursor along the graph to display the number of pixels with red, green, and blue values at each brightness level and the total number of pixels at that level.
    - Type the same brightness level into both boxes under Number of Pixels. The histogram readouts display the number of pixels with red, green, and blue values at that brightness level, as well as the total number of pixels at that level.
  - Examine the number of pixels between two brightness levels.
    Do one of the following:
Position the cursor over one brightness level on the graph, and left click and drag the cursor to the second brightness level. The histogram readouts display the number of pixels with red, green, and blue values between the two brightness levels as well as the total number of pixels.

Type the two brightness levels into the boxes under Number of Pixels. The histogram readouts display the number of pixels with red, green, and blue values between the two brightness levels, as well as the total number of pixels.

- **Stretch the image.**
  Follow these steps
  - Either drag the left triangle (on the X axis) to the brightness level that you want to define as zero, or enter the value in the **Bottom** box. All red, green, and blue values that are less than or equal to this level are now reset to zero.
  - Either drag the right triangle (on the X axis) to the brightness level that you want to define as full scale, or type in the value in the **Top** box. All red, green, and blue values that are greater than or equal to this level are now reset to full scale.
    
    The program automatically multiplies all red, green, and blue values between the new zero point and full scale values by the factor necessary to make the new full scale setting equal to actual full scale after the new zero point setting (if you have defined one) has been subtracted.
  - Click on OK to save the image with the new zero point (Bottom) and full scale (Top) values.

**Adjust Histogram (HSL)**

**Adjust Histogram (HSV)**

HSL and HSV histograms are identical to RGB histograms, except that instead of displaying the number of pixels for the RGB components, they display the number of pixels at each luminance or value level. As with the RGB histogram, HSL and HSV histograms are typically used for two purposes:

- Examining the distribution of luminance or value levels in an image.
- Resetting the zero and 100% luminance/value points in an image. This is known as stretching. The Adjust Histogram (HSL) and Adjust Histogram (HSV) options allow you to stretch the darker areas of your image to pure black and lighten the brighter areas to either pure white, if using the HSL color space, or the brightest version of the hue, if using the HSV color space.

To Adjust Histogram (HSL) or Adjust Histogram (HSV), follow these steps:

1. From the Edit menu, select Adjust HSL, Adjust Histogram or Adjust HSV, Adjust Histogram. The Luminance Histogram or Value Histogram window appears.
2. If you want to display the image's histogram according to a logarithmic scale, check the Log Scale box. Checking the Log Scale box makes the vertical axis more sensitive to small numbers and compresses the range for larger numbers.

From the Luminance/Value Histogram window you have three viewing/editing options.

- Examine the number of pixels at each Luminance/Value level.
  Do one of the following:
    - Move the cursor along the graph to display the number of pixels at each Luminance/Value level.
Type the same Luminance/Value level into both boxes under Number of Pixels. The histogram readouts display the number of pixels at that Luminance/Value level.

- Examine the number of pixels between two brightness levels.

Do one of the following:

Position the cursor over one luminance or value level on the graph, and left click and drag the cursor to the second Luminance/Value level. The histogram readouts display the number of pixels between the two levels. Type the two Luminance/Value levels into the boxes under Number of Pixels. The histogram readouts display the number of pixels between the two Luminance/Value levels.

**Stretch the image.**

Follow these steps:

- Either drag the left triangle (on the X axis) to the Luminance/Value level that you want to define as black (0 % Luminance/Value), or enter the Luminance/Value number in the **Bottom** box. All Luminance or Value values that are less than or equal to this level are now reset to black (0 % Luminance/Value).

- Either drag the right triangle (on the X axis) to the Luminance/Value level that you want to define as full scale (100 % Luminance/Value), or enter the Luminance/Value number in the **Top** box. All Luminance/Value values that are greater than or equal to this level are now reset to full scale (100 % luminance/value). The program automatically multiplies all Luminance/Value values between the new black and full scale values by the factor necessary to make the new full scale value equal to 100 % Luminance/Value after the new black value (if you have defined one) has been subtracted. The thumbnail sample image updates automatically so you can gauge the effect of your adjustments.

- Click on OK to save the image with the new black and white Luminance/Value values.

**Filter**

The Filter menu option contains five options for modifying images:

- Smooth
- Sharpen
- Unsharp Mask
- Filter Noise
- Median Filter

**Smooth**

Use Smooth to smooth out grainy images. The smooth option works by lightening the darker side of contrast boundaries and darkening the lighter side. Because the Smooth option removes the high frequency details from an image, some fine image detail is also lost.

To smooth the appearance of an image, follow these steps:

1. From the Edit menu, select **Filter > Smooth**.
   
   To preview images on the thumbnail image only; deselect the Modify Main Image box.

2. Either use the slider bar to select a Strength value between one and 100, or enter the value in the box.

3. When you have determined a suitable value, click on OK. The smoothed image appears.
Sharpen

Use Sharpen to improve the appearance of soft or blurry looking pictures. The Sharpen option works by darkening the darker side of a contrast boundary and brightening the brighter side of a contrast boundary. To sharpen the appearance of an image, follow these steps:

1. From the Edit menu, select **Filter > Sharpen**.
   To preview changes on the thumbnail image only, deselect the Modify Main Image box.
2. Either use the slider bar to select a Strength value between one and 100, or enter the value in the box.
3. When you have determined a suitable value, click on OK. The sharpened image appears.

Unsharp Mask

Use the Unsharp Mask filter to improve the appearance of an image’s high frequency details. The Unsharp Mask option sharpens an image by subtracting a brightness-scaled, low-pass-filtered image from the original image. To apply the Unsharp Mask filter, follow these steps:

1. From the Edit menu, select **Filter > Unsharp Mask**.
2. To preview changes on the thumbnail image only, deselect the Modify Main Image box.
3. Either use the slider bar to select a Strength value between one and 100, or enter the value in the box.
4. When you have determined a suitable value, click on OK. The sharpened image appears.

Filter Noise

The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with lengthy exposure times, the noise filter acts as a “virtual cooler” for the Insight camera, eliminating “hot pixels.” The Noise Filter checks each pixel on the CCD chip as described below:

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels.
2. If none of the eight neighboring red pixels has a value within ±X % (X being the threshold value that the SPOT user specifies) of the value for the red pixel being checked, the value for the red pixel being checked is replaced with the average value of the eight neighboring red pixels.
3. The program repeats this procedure for the values of the green and blue pixels being checked.

To filter noise, follow these steps:

1. From the Edit menu, select **Filter > Filter Noise**.
2. Enter a value between **10%** and **100%**. The Threshold value is set to a default of 50%, but will default to the last used setting thereafter. Refer to the procedure described at the start of the Filter Noise section for an explanation of the Threshold value.
3. Click on OK. The filtered image appears on-screen.

**Note:** Image setups can be defined to automatically use the noise filter when capturing an image. Refer to Ch. 5 – Preparing to Take a Picture for details.
**Median Filter**

The Median Filter corrects for the effects of shot noise. This filter functions by considering a sample pixel and its surrounding 8 pixels. The values of all nine pixels are compared and the median value of the group is substituted for the sample pixel. In this process, all pixels are always being modified, unless, of course, the sample pixel is the median value of the group.

Unlike the Filter Noise function, there is no need for any user inputs regarding the median filter process. This approach negates any impact that a hot pixel might have on the filtered value of another neighboring (sample) hot pixel.

---

Note: Filtering algorithms always utilize original data for each sample pixel being considered. In other words, filtered (substituted) pixel data is not used in the filtering process.

**Make Negative**

Make Negative to make a color negative (with complimentary colors) of an image. From the Edit menu, select Make Negative. The Program automatically converts the image to a negative.

**Convert to Gray Scale**

Use Convert Gray Scale to convert images from color to gray scale. The Convert to Gray Scale option works only with color images.

---

The Convert to Gray Scale option is available only for RGB images that have been opened with the SPOT software. For monochrome image captures, the Convert to Gray Scale option is unavailable.

From the Edit menu, select the Convert to Gray Scale option. The program converts the color image to a gray scale image.

**Set Palette (monochrome images)**

The Set Palette option enables you to apply a specific color palette to a captured monochrome image. There are four pre-defined color options: **Grayscale**, **Red**, **Green**, and **Blue**. To define a custom palette, use the Pallettes option (Setup>Palettes). Refer to Ch. 4 – The Advanced Program Mode for more details. **Monochrome camera** users can also apply palettes as part of the image capture process using the Palette option on the Image Setup window.

**Match Color**

The Match Color feature is typically used in two situations:

- You want to change the colors of an image on the screen to match the way that you think the specimen looks.
- You want to set the white balance for pictures taken with a microscopic technique that never has white in its images. A prime example of this situation is fluorescence microscopy.

---

Note: The Match Color white balance adjustment can be used as an alternative to the Compute White Balance Values option.

To use the Match Color feature, follow these steps:

1. From the Edit menu, select Match Color.
2. Click on OK. The cursor becomes an eye-dropper.

3. Use the mouse to move the eye-dropper to the pixel location of the color that you want to match. Refer to the status bar at the bottom of the window to ensure that each of the R, G, and B values are less than full scale.

   **Note:** If you select a pixel with a red, green and/or blue value that is saturated at full scale, the SPOT program prompts with a warning message indicating that you need to choose a pixel with RGB values less than 255 (24 bit RGB), 4,095 (36 bit RGB, or 116,383 (42 bit RGB). Saturated pixels do not provide a good reference point for correctly determining the RGB ratios needed for this function.

4. Click on the pixel. The Match Color window appears.

   The window displays information about the pixel that you selected:
   - **Hue** – This the actual color, as distinguished from others in the color spectrum. Hue is derived from a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees).
   - **Saturation** - The proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 equals pure hue (i.e., “day glow”).
   - **Original Color** – A sample “swatch” of the color that you selected. The cross hairs on the color wheel indicate the relative position of the color.

   The **Modify Main Image** box is checked as a default.

   Set the new color. This can be done in one of two ways, depending on whether the image should contain white:
   - If you are trying to make the selected pixel in your image appear as white (or gray if the pixel is darker), click on the Make White/Gray button.
   - If you are working with an image that does not have any white, modify the Hue and Saturation values so that the New Color “swatch” shows up as the color that you want. You can do this either by entering specific Hue and Saturation values, or dragging the cross-hairs on the color wheel to the desired location.

   At this point there are three options:
   1. Click on **OK** to save the image with the new color rendition.
   2. Click on **Reset** to return the image to the original color rendition.
   3. For images that have not yet been saved and closed, click on **Set White Balance** to set the values so that colors are rendered correctly for future image captures. When you click on Set White Balance, a dialog box displays the white balance values. As a default, the values are saved to the current setup. If desired, you can select a different Setup and then click on OK.

   If you reset the White Balance, you can now recapture the image with the new settings.

**Customizing Images**

In addition to the image editing features described in this chapter, the SPOT software offers several options for customizing images.

- **Change Pixel Bit Depth** – Change from one bit depth to any of the other three options without having to recapture an image.
- **Subtract Image** – Subtract an image from a selected open image.
- **Merge Images** – Merge two or three images, assigning red, green, or blue to each image. The Merge Images feature is mainly used to combine two or three monochrome images into an artificially colored composite image.


### Change Bit Depth

Use Change Bit Depth to change the bit depth of the currently open image. To change the pixel bit depth for an image, follow these steps:

1. From the Edit menu, select the Change Bit Depth option. The Change Bit Depth window displays the current Bit Depth for image.
2. Select the pixel bit depth that you want to change the image to. Changing from one monochrome bit depth to another or from one RGB bit depth to another does not require the addition of any color channeling information. In this case, select the new pixel bit depth and click on OK.

**CAUTION!**

If you are changing an image to 12 bit monochrome, 14 bit monochrome, 36 bit RGB or 42 bit RGB, you must save the image in TIFF or JPEG 2000 format before you can close it. Refer to step four for further instructions.

Changing from an RGB color image to a monochrome image requires the entry of color channeling information. When you select the new pixel bit depth, the color channeling information appears. Select the color channel(s) that you want to use. Select either a single color or the All Channels option, which is the default.

- If you select a single color channel, the program uses only the values for that color (in the original image) when it creates the monochrome image.
- If you select All Channels, the program uses a mathematical algorithm to combine the red, green, and blue values from the original image when it creates the monochrome image.

Click on OK to save the image with the new pixel bit depth.

If you changed the original pixel bit depth to 12 bit, 14 bit, 36 bit, or 42 bit, follow these steps before trying to save the image to disk:

a) From the File menu, select the Save As option. The Save As window appears.

b) The Save as type drop-down box options depend on the bit depth selection. If you selected 12 or 36 bit, there are three choices:
   - **TIFF Uncomp (12-bit/channel) (TIFF)** – Select the 12 bit per channel option if you want to save the image as 36 bpp.
   - **TIFF Uncomp (16-bit/channel) (TIFF)** – Select the 16 bit per channel option if you want to save the image as 48 bpp. This allows you to edit images with Adobe Photoshop, which cannot read 36 bpp images
   - **JPEG2000** – Select for the improved JPEG2000 compression algorithm that saves file space.

If you selected 14 or 42 bit, there are two choices:

- **TIFF Uncomp (16-bit/channel) (TIFF)** – Select the 16 bit per channel option if you want to save the image as 48 bpp. This allows you to edit images with Adobe Photoshop, which cannot read 36 bpp images
- **JPEG2000** – Select for the improved JPEG2000 compression algorithm that saves file space.

Enter the desired file name and location, and click on the Save button.

### Subtract Image

Use Subtract Image to subtract an image from a selected, open image. Follow these steps:

1. From the Edit menu, select **Subtract Image**.
2. Select the Source of the image that you want to subtract from the currently open, selected image. The image can come from one of the following three sources:

- **A Currently Open Document** – Subtract an image from a currently open image. If the path for the image you are editing does not appear in the Title box, select it from the Title drop-down list, which lists all open images. If the file is an image sequence, specify the number of the image in the sequence (the Sequence Index).

  Note: It is possible to subtract an image from itself.

- **An Image File** – Subtract a file from disk from the currently open, selected image. Either enter the file path in the box, or click on the browse button to the right of the box to search for and select the file. If the file is an image sequence, specify the number of the image in the sequence (the Sequence Index).

- **A Database (Windows only)** – Subtract a file from a SPOT database from the currently open, selected image. To subtract an image from a SPOT database you must enter the Image ID for that image. You can determine the eight-digit Image ID number by searching the database for the image that you want to add. The search results display the Image ID number.

Note: To subtract a database file, the database must be open. For more information on using SPOT databases, refer to Chapter 9, Using SPOT Databases.

3. Enter a Scale Factor between .01 and 5. The Scale factor adjusts the brightness of the image that you are subtracting:

- Numbers between .01 and 1 darken the image.
- Numbers between 1 and 5 lighten the image.

Click on OK to add or subtract the image. The combined image replaces the original.

**Merge Images**

Use Merge Images to combine two or three monochrome images into a single composite image. The Merge Images option is used primarily in fluorescence imaging when specimens have been stained with more than one dye, and a triple filter cube is not available. In this circumstance, each dye can be excited individually, and a monochrome image can be captured for each excitation. The Merge Images feature then allows you to combine these images to create a composite image that shows all the dyes.

To merge images, follow these steps:
Annotation – Custom Image Annotation

**Annotate**

Image annotation is useful when you want to prepare captures for formal presentation, or inclusion in an article or reference work. Using SPOT’s image annotation features, you can:

- Add text to an image.
- Use an arrow, line, rectangle, or ellipse to emphasize a particular area in an image.
- Add a graphic stamp such as a company logo to an image.
- Add freehand lines to an image.
- Number objects in an image.
- Add the current user name to an image.

Other annotations are also available. To annotate an image, select Annotation from the Edit menu. Several changes take place in the SPOT image-editing environment:

- The **Object** menu appears with options for inserting drawing objects, text, images, and image related information onto an image. Cursor functionality in SPOT reports varies according to which **Object** menu option is selected.

  If **None** is selected, the cursor is an editing tool for selecting, sizing, and positioning objects. When creating new reports, **None** is the default option.
• If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects on the grid. The View menu changes to reflect annotation mode:

  - **Show Pan Window** – Refer to the beginning of this chapter for a description of this function.
  - **Show Tools** – This option displays the Tools dialog box, which contains shortcuts for inserting annotation drawing objects. Refer to *Adding Annotation Objects to SPOT Images* (below) for more details on using the Tools dialog box.

• The Attributes menu appears with options for specifying annotation qualities.

• The Done! Menu allows you to switch back to the image capture/edit mode. The Done menu has only one option, End Annotation Mode. When you select this option the SPOT program reverts back to the standard SPOT image-editing environment.

### Adding Annotation Objects to SPOT Images

Annotation objects can be added to images in one of two ways:

• Through the Object menu.

• Through the Tools dialog box. To access the Tools dialog box, select the Show Tools option on the View menu. The Tools dialog box, as illustrated below, displays shortcut buttons to the eleven drawing objects on the Object menu:

  Before discussing the individual objects, review the following general procedure for inserting an annotation object into an image:

  **Note:** In some cases, the procedure varies to fit the object’s characteristics. The specifics are noted in the descriptions of the individual objects.

1. From the Object menu, select the type of item (i.e., Lines, Connected Lines, etc…) that you want to add to the image. The cursor’s functionality varies according to whether an object type (i.e., line, text) is selected.

   If an object type is selected, the cursor changes to a cross-hair icon that is used to add new report objects to the grid.

   If None is selected, the cursor is an editing tool that is used to select and position objects.

2. Use the mouse to move the cross hair to the location where you want to insert the object.

3. Left-click at the insertion point.

   If you selected a line, box, or other shape, hold down the mouse button and drag the object to the desired size.

   If you selected one of the other objects, the object will either appear (e.g., Image Time) or the program will prompt you to enter the associated information (e.g., Text, Image Memo, etc…).

4. After you have added the object, there are three options:

5. Add another object of the same type, as described in step 3.

6. Add a different type of object - select from the Object menu options, the toolbox.

7. Resize, reposition, or edit an object. To do so, select None from the Object menu.

   - **Resize** - Select (click on) the object and drag the handles in the direction of the resize.

   - **Reposition** – Left click and drag the object the new area.

   - **Edit** – Select the object and choose an option from either the Edit menu or the Attributes menu. You can also edit an object by right clicking on it.

8. When finished, choose End Annotation Mode from the Done! Menu.
9. To merge the annotation into the image so that they can be displayed when the image is opened in other applications, access the **Edit** menu, choose **Merge**, and then **Merge Annotations**. The annotations will then be merged into the pixel data.

The following sections describe each of the annotation objects.

**None**
- Select **None** when you want to use the cursor to edit and position the objects.

**Lines**
- **Unconstrained Line** - Add a straight line annotation to the image
- **Horizontal Line** - Add a horizontal line annotation to the image.
- **Vertical Line** - Add a vertical line annotation to the image.
- **Arrow** – Add an arrow to the image. Either select Lines>Arrow from the Object menu, or click on the Tools box button. Left click on the image and drag toward the area that the arrowhead will point to.

**Connected Lines**
- **Polygon** – Add a closed polygon to an image. Either select Polygon from the Object menu, or click on the Tools box button. Left click and release, and then drag the mouse to create a side. Left click again to start a new side. Double click to finish the polygon. The program automatically adds any additional lines needed to close the figure.
- **Polyline** – Add an open polygon to an image. Either select Polyline from the Object menu, or click on the Tools box button. Left click and release, and then drag the mouse to create a side. Left click again to start a new side. Double click to finish the polyline.
- **Freehand** - Add a freehand line to the image

**Shapes**
- **Rectangular Box** – Add a square cornered box to the image.
- **Rounded Box** - Add a round cornered box to the image.
- **Ellipse** – Add an elliptical object to the image. Ellipses are drawn inside of the rectangular area that you define. Ellipses touch the top, bottom, right and left sides of this rectangle.
  - Either select Ellipse from the Object menu, or click on the Tools box button. To draw an ellipse, left click at the point where you want to position one vertex of the rectangle and drag the cursor to the point of the opposite vertex.
- **Circle** – Add a circle to the image.

**Images**
- **Image** – Add an image.
  1. From the Object menu, select Image.
  2. Left click at the point on the display grid where you want to insert the Image box, and holding down the mouse button, drag the cursor to create the desired shape and size for the image (it can also be resized/re-positioned at a later point). When you release the mouse button, the Select Image dialog box appears.
  3. Specify the file source for the image:
     - **Currently Open Image** – Add a currently open image. If you have one or more open images, SPOT lists the file name(s) and path(s) in the drop-down box. Select from the list.
     - **Image File** – Add an image from disk. Specify the file name and location either by entering the path in the Name box, or clicking on the selection box to the right.
     - **Database (Windows only)** – Add an image from a SPOT database. In order to insert a database image, the database must be open. Enter the Image ID for the file. If you do not know the database image ID, search the database – the display table indicates the Image ID for each file.
   - Click on OK. The image appears on your report grid.
- **Stamp** – Insert a selected bitmap image onto the image capture. From the Object menu, select Stamp. The last selected bitmap appears on your image. To select a new bitmap image to insert, choose the Stamp Bitmap option from the Attributes menu.

Because the Mac edition does not yet have database functionality, Mac users will not be able to use the Database option. Diagnostic Instruments provides free software updates via the Web to all SPOT camera owners. Check the Diagnostic Instruments web site (www.diaginc.com) for the most recent update. For details on finding and downloading the latest version of the software, refer to the **Free Software Updates** section in “About This Manual.”
Text - Add text to the image.
   1. Either select Text>Text from the Object menu, or click on the Tools box button.
   2. Left click at the point where you want to insert the text. The Text window appears.
   3. Enter the text.
   4. Click on OK. The text box appears.
   5. Resize the box as needed to display the text.

Current Date - Add the current date to the image. This date defaults to the date set on the computer you are using.

Current Time - Add the current time to the image. This time defaults to the time set on the computer you are using.

Current User Name – Add the current user’s name to the image. This defaults to the user who is logged on the computer.

Image User Name – Add the name of the person who captured the image to the image. This will be blank when added to the image if the image user name was not recorded with the image when it was taken.

Image Date - Add a date to the image. This date defaults to the date that the image was captured. To change the date, double click on the box, and enter the desired date.

Image Time - Add the image capture time to the image. This time defaults to the time that the image was captured. To change the time, double click on the box, and enter a new time. The time that appears here varies according to whether the file was transferred across a network, and whether the file is a SPOT database image. Refer to the Image Date/Time section of this chapter for more details.

Image Title - Add a title to the image. The title automatically defaults to the file name and location of the open image, e.g., C:\images\cells\fluor1. To change the title, double click on the box and enter a new title.

Image Memo – Add a previously defined TIFF image memo. Click at the point where you want to insert the text box. To change the memo, double click on the box and modify the text as needed. Changing the text in the memo annotation does not affect a memo that is attached to the image file.

Image Sequence Index (sequence images) - Add the Sequence Index (number) to the image. This is the number of the image within the sequence – i.e., the Sequence Index for the first image in the sequence is “1,” the second image “2,” etc…

Image Sequence Size (sequence images) – Add the total number of images in the sequence to the image.

Image Sequence Elapsed Time (sequence images) – Add the elapsed time between the image being annotated and an image that you specify. After selecting Object>Text>Image Sequence Elapsed Time, the program prompts you to enter the Reference Image Index Number. If you specify a number that comes after the image being annotated, the elapsed time will be negative. For instance, if you are annotating image number five in a sequence of 10, and you specify a Reference Image… of eight, the elapsed time will be a negative value.

AutoNumber – Adds numbering to the image starting at 1 and incrementing by 1 for each click of the mouse. Good for counting and tracking objects in an image. You may elect to change the starting number to a value greater than one by defining Autonumber’s attributes (see section below).

Defining Annotation Attributes

All of the general style and appearance options can be accessed from the Attributes menu. Annotation attributes can be defined for an entire report or on an object-by-object basis (see the Adding Annotation Objects to SPOT Images section above).

- When an annotation object is selected, the attribute is defined for the selected object(s) only. In addition, when you right click on an object, the menu displays the attribute options for that object.
- When nothing is selected, the attribute is defined for all future, relevant objects.

The following table details each of the annotation attributes and the report objects that they affect.
Colors

Define the foreground and background colors for all objects. Follow these steps:

1. From the Attributes menu, select Colors.
2. Define the Text/Lines color. This is the color of the text, the line, or the border around a text/image box. The default foreground color is black. To select a color click on Color.
3. The next window varies, depending on whether you are using a Windows or a Mac system. Windows allows you to select from a palette of colors or enter specific HSL or RGB color values. Mac OS allows you to select from a palette of colors, enter specific RGB, CMYK, HLS, or HSV values, and enter Internet specific colors.
4. Define the Background/Fill color. This is the color that appears behind text and in boxes. Lines and images do not display a background color.

Line Thickness

Determine line thickness for the following objects: Line, Horizontal Line, Vertical Line, Arrow, Box, Rounded Box, Ellipse, Freehand, Polygon, and Polyline.

1. From the Attributes menu, select Line Thickness.
2. Enter a Thickness value between 1 and 5 pixels.
3. Click on OK.

Note: In order to define a background/fill color for a Box or a Rounded Box, a fill must be selected. Similarly, in order to define a background/fill color for a text box, the background (see Text Border, Justification, and Background below) must be set to Opaque.

Box/Ellipse Options

Define the appearance of the Box and Ellipse objects. Specify whether you want a fill for the object.

1. If you do not want the box to be filled (i.e., you want a transparent box), click on OK.
2. If you want to specify a fill for the box, check the Fill Box/Ellipse.
3. Click on OK. The background will fill with the color selected in the Attributes/Colors/Background/Fill selection.

Arrow Size and Direction

Specify the size of the arrowhead and define the direction that the arrow points.

1. To specify the size of the arrowhead, enter a value between 1 and 10.
2. Specify the direction of the arrow:
   - To draw an arrow starting tail first and finishing with the point (head), select Tail to Head.
   - To draw an arrow starting point (head) first and finishing with the tail, select Head to Tail.
3. Click on OK.

The Arrow Size and Direction attribute is not available for Mac users. For Mac users, arrows are always drawn Tail to Head.
Text Font

Define the appearance of the text for the Text, Image Date, Image Time, Image Title, Image Memo objects.

1. Select a Font, a Font Style, and a point Size. The Sample box displays a preview of the font.
2. Define any Underline effects.
3. Click on OK.

Text Options

Define the appearance of the text boxes for the Text, Image Date, Image Time, Image Title, Image Memo objects.

1. Specify whether the text box should have a border. To add a border, click on the Border box, and enter a Thickness value between .05 and 10.
2. Define the Justification of the text. This justification applies to the position of the text in the box, not the position of the text on the page.
3. Define the Background. Select either Transparent or Opaque.
4. Define the orientation at which the text should be displayed relative to the text box. Select 0, 90, -90 or 180 degrees.
5. Click on OK.

Title Options

Define the appearance of the title associated with the captured image(s).

1. Specify whether the title should include the computer file storage path as part of the image title.
2. Specify whether the title should include the computer file name extension as part of the image title.

Click on OK.

Time Options

Define the appearance of the Time stamp associated with the image(s).

1. Specify whether the time stamp should include seconds.
2. Specify whether the time stamp should include milliseconds.

Click on OK.
Stamp Image

Use the Stamp Image option to select the image that you want to use for the Stamp option. To select the image, choose Stamp Image. The Stamp Image dialog box prompts you to enter a file name and path:

- If you know the name and location of the image file, enter it in the File box.
- If you do not know the name and location of the image, click on the browse button to search for the file.

After you have selected the image file, click on OK.

AutoNumber Value

Define the starting number used in the AutoNumber feature.

1. Select a whole number that sets the beginning value once the AutoNumber feature is activated. (Numbers subsequent to the initial number will increment by 1).
2. Click on OK.

Save as Defaults

Save the current attributes for future annotations.

Editing Annotation Objects

Once you have annotated an image, you can edit the annotation objects as needed. There are three ways to edit objects:

- **Use the Attributes menu** - The Attributes menu, as noted in the Defining Annotation Attributes section of this chapter, allows you to either set the attributes for adding specific types of objects, or to select existing objects and modify them as needed. Refer to the Defining Annotation Attributes section for more details.

- **Use the Edit dropdown menu** - The Edit menu contains general editing features such as Undo, Copy, Cut, Send to Back, etc.

- **Right-click on the report object** - Right clicking on a report object brings up a customized editing menu that contains both general editing commands and the attributes that can be edited for that object.

You can also move and size annotation objects:

- To move an object, left click on it and drag the item to a new location. When you drag the item, the cursor becomes a four-pointed arrow.
- To size an object, left click on it and drag the handles to resize the object as needed.

The following sections describe the available editing options from the editing dropdown menu.

**Undo**

Undo the last action. Unlike the image capture/editing Undo feature, the annotation Undo undoes up to ten changes.

**Bring to Front**

Bring the selected annotation in front of all other annotations.

**Move Forward**

Bring the selected annotation one layer forward.

**Move Backward**

Send the selected annotation one layer back.
Ch. 8 – Viewing, Editing, and Annotating Images

Send to Back
Send the selected annotation behind all other annotations.

Select All
Select all annotation objects.

Unselect All
Unselect all annotation objects.

Delete
Delete the selected annotation object(s).

(Windows)

Clear
Delete the selected annotation object(s).

(Mac)

Delete All
Delete all of the annotations on the image.

Copy to
Copy the selected annotation clipboard.

Clipboard

Cut
Remove the selected annotation and place it on the clipboard.

Paste
Place the cut or copied annotation from the clipboard into the image.

Annotation – Calibration Marks and Measurements

Set Calibration
The Set Calibration option allows you to select or modify the calibration setup to be used for subsequent calibration mark insertions and measurements on this image/image sequence. If there are no calibration setups available in the drop-down list, or if your objective magnification isn’t listed, refer to Ch. 4 – The Advanced Mode for instructions for creating calibration setups for your microscope.

Add/Edit Calibration Marks
The Add/Edit Calibration Marks feature allows you to insert a calibration mark into an image capture and to edit its display properties. To add a calibration mark, follow these steps:

1. If you have not already calibrated the objectives on your microscope, do so. Refer to Ch. 4 – The Advanced Program Mode for details.
2. From the Edit menu, choose Set Calibration and select a Calibration Setup (e.g., 10x) for the objective that you are using.
3. From the Edit menu, select Add/Edit Calibration Marks. The Calibration Mark window appears with the selected calibration at the top.
4. Move the cursor to the point in the image where you want to insert the calibration mark and click at that point. The calibration mark appears with the default appearance settings.

Note: If you are not satisfied with the placement of the calibration mark, you can click on and drag the mark to a new position. Clicking on and dragging the bar moves both the bar and the number. Clicking on and dragging the number moves only the number.
5. Using the on-screen mark as a reference, modify the Appearance options:

- **Orientation** – Check the appropriate box to select either a horizontal or vertical display for the calibration mark.
- **Line Thickness** – Select a line thickness between 1 (thinnest) and 5 (thickest).
- **End Length** – Select the size in pixels of the bars at the ends of the calibration lines.
- **Show Text** – Select this checkbox if you would like the calibration measurement text to be shown along with the calibration line.
- **Decimals** – Select the number of decimals that appear in the calibration mark number. Choose from a range of zero decimals (1) to five decimals (1.00000)
- **Font** – Define the font, point size, and appearance.
- **Rotation** – Specify the orientation of the calibration measurement text relative to the calibration line.
- **Color** – Click on the Color button to define the color of the calibration mark. You can either choose from a palette of basic colors or define a custom color to provide the best display.
- **Size** - Enter the size of the calibration mark. You can modify the size either by entering the number in the Size box, or by using the cursor to stretch the on-screen calibration bar. To adjust the size of the calibration mark, move the cursor to the end of the calibration bar line. The standard cursor changes to a two-headed arrow. Drag the end of the bar to adjust the length. The calibration mark number changes to reflect the new length.

6. Select **Save As Defaults** if you would like these display properties to be the defaults when adding calibration marks in the future.

If you would like to add additional calibration marks, click New and follow the steps above again. If you would like to delete calibration marks, select them individually and select Delete. Click Close when you are finished adding calibration marks to the image.

---

### Add/Edit Measurements

The Add/Edit Measurements option enables you to incorporate measurements into an image capture and to edit their display properties.

To add a measurement, follow these steps:

1. If you have not already calibrated the objectives on your microscope, do so. Refer to Ch. 4 – The Advanced Program Mode for details.
2. From the Edit menu, choose **Set Calibration** and select a **Calibration Setup** (e.g., 10x) for the objective that you are using.
3. From the Edit menu, select **Add/Edit Measurements**. The Measurement window appears with the selected calibration at the top.
4. Check the type of measurement that you want.

---

**Note:** Added calibration marks will need to be merged into the image pixel data in order to be displayed by other applications. Choose Edit/Merge/Merge Calibration Marks to merge them into the image.

**Note:** When adding calibration marks or measurements to images in a sequence, if one of the images doesn’t have a calibration setup saved with it, the SPOT software will assign it the same calibration setup as the first image that was edited.
• **Straight Line** – Point to point distance measurement
• **Curve** – Length of a freehand curve
• **Region** – Area and perimeter of a freehand outline
• **Angle** – Angle measurement
• **Fixed Rectangle** – Length, width, area and perimeter of a software-generated rectangle
• **Arbitrary Rectangle** – Length, width, area and perimeter of a rectangle based on user-drawn line
• **Circle from Diameter** – Radius, diameter, area, and circumference of a circle based on user-drawn diameter
• **Circle from Radius** – Radius, diameter, area, and circumference of a circle based on user-drawn radius
• **Circle from Three Points** – Radius, diameter, area, and circumference of a circle based on three user-selected points
• **Ellipse** – Major axis, minor axis, area and perimeter of an ellipse

5. Move the cross-hair cursor to the point in the image capture where you want to begin the measurement.
6. Single click to activate the drawing function.
   • **Straight Line**, move the cross-hair cursor to the end point of the measurement. Single click to deactivate the drawing function and display the length of the line.
   • For a **Curve**, use the cross-hair cursor to trace a freehand line on an image. Single click to deactivate the drawing function and display the length of the freehand line.
   • For a **Region**, use the cross-hair cursor to trace a freehand outline around the area that you want to measure. Single click to deactivate the drawing function and display the measurement. If the area is not completely enclosed by the outline, the SPOT program automatically completes the path by connecting the end point to the starting point with a straight line.
   • For an **Angle**, use the cross-hair cursor to specify the three points that define the angle. Single click to mark the end point of the first side. Move the cross hairs to the vertex and single click again. Move the cross hairs to the end point of the second side, and single click. This last click deactivates the drawing function and displays the angle measurement.
   • For a **Fixed Rectangle**, use the cross-hair cursor to specify where one corner of the rectangle should be positioned. Move the cross hair diagonally to draw the rectangle. Single click to deactivate the drawing function and display the length, width, area, and perimeter of the rectangle.
   • For an **Arbitrary Rectangle**, move the cross-hair cursor to the end point of a line that the rectangle will be based on. Single click and move the cross-hair cursor to draw the rectangle. Single click to deactivate the drawing function and display the length, width, area, and perimeter of the rectangle.
   • For a **Circle from Diameter**, use the cross-hair cursor to specify the diameter of the circle. Single click to deactivate the drawing function and display the radius, diameter, area, and circumference of the circle.
   • For a **Circle from Radius**, use the cross-hair cursor to specify the radius of the circle. Single click to deactivate the drawing function and display the radius, diameter, area, and circumference of the circle.
   • For a **Circle from Three Points**, use the cross-hair cursor to specify the three points that define the circle. Single click to mark the second point. Move the cross hair to the third point and single click again. This last click deactivates the drawing function and displays the radius, diameter, area, and circumference of the circle.
   • For an **Ellipse**, move the cross hair cursor to the end point of a line that the ellipse will be based on. Single click and move the cross-hair to draw the ellipse. Single click to deactivate the drawing function and display the major axis, minor axis, area and perimeter of the ellipse.

After you have completed steps one through six, you can modify the measurement as needed, using the Appearance options:
• **Line Thickness** – Select a line thickness between 1 (thinnest) and 5 (thickest).
• **Decimals** – Select the number of decimals that appear in the measurement. Choose from a range of zero decimals (1) to five decimals (1.00000)
• **Color** – Click on the Color button to define the color of the measurement. You can either choose from a palette of basic colors or define a custom color to provide the best display. If you are editing a monochrome image, you can select either black or white.
• **Font** – Define the font, point size, and appearance.
• **Text Rotation** - Specify the orientation of the measurement text relative to the shape drawn.

You can also choose to hide the measurement values or to change their labels:
• Select the measurement values to be hidden by de-selecting the checkboxes next to them in the **Show** column.
• Select new labels by typing them into the **Label** column.
• After adjusting the appearance and display of your measurements, at this point you can:
  • Re-position the measurement labels and values. When you position the cursor over the number, it changes to a four-point arrow. Click and drag on the number to move it to a new location.
  • Erase measurements. Click on the measurement and choose **Delete**.
  • Add new measurements. Click on **Create**, select the measurement type and add additional measurements.
  • Save the appearance and display options selected as the defaults. Click on **Save As Defaults**.

7. Click on **Close** when you are finished adding and editing measurements.

---

Note: Added measurements will need to be merged into the image pixel data in order to be displayed by other applications. Choose **Edit/Merge/Merge Measurements** to merge them into the image.

Note: When adding calibration marks or measurements to images in a sequence, if one of the images doesn’t have a calibration setup saved with it, the SPOT software will assign it the same calibration setup as the first image that was edited.

---

**Merge**

Use **Merge** to merge annotations, calibration marks, and measurements into the image pixel data in order for other applications to display them. If the merge is not done, only the Spot software will display the annotations, calibration marks, and measurements.

**Memo**

In the SPOT software, you can attach a memo to image files. To use the Memo option, follow these steps. From the **Edit** menu, select **Memo**. The Image Memo window appears for you to enter a new memo or edit an existing memo.

1. Enter the message.
2. Click on **OK** to attach the memo to the image.

**Insert Variable**

You may insert a variable in your memo from a variety of preprogrammed options. Once the variable has been selected, the next time the memo box is opened. The variables value will be displayed as part of the memo message.

1. Select **Insert Variable** on the Memo Text box.
2. Choose a variable from the dropdown list. The variable box may change to reflect characteristics of or more information required to define that specific variable.
3. Input any additional information or directions as required.
4. Click on OK to insert the variable

As an example, if we wanted to insert the current time in the memo, the development of the memo may be as follows:

1. Select Memo from the dropdown menu and begin typing your text message.

2. When you get to the point where the variable is to be inserted, select Insert Variable.

3. From the dropdown menu next to variable, select the appropriate variable. In this case, we select ImgDate (Image Date).

4. The Variable window changes to match the variable selected. In this case, no other information is required for this selection.
5. Select OK and the variable is inserted into the text memo in its shorthand form.

6. Click OK to accept the memo

The next time you access this memo, the variable value is displayed in lieu of the variable shorthand form.
Ch. 9 – Using SPOT Databases

Introduction

In addition to the numerous image capture and editing features, the SPOT software provides you with an easy to use, fully featured image archiving database.

Note: If you are using SPOT databases from an earlier version of the SPOT software, you will need to convert the old databases to work with the latest version of the software. Refer to Appendix E: Converting Previous Version SPOT Databases for detailed steps.

SPOT’s image archiving database features are not yet available for the Mac edition of the program. As soon as this functionality is available, you will be able to download the updated version of the software from Diagnostic Instruments’ web site, www.diaginc.com. Check the site periodically to determine the most recent update. For detailed steps on downloading the software, refer to the Free Software Updates section in “About this Manual”.

This chapter is divided into the following sections:

- The Database Menu
- The SPOT Sample Database
- Creating and Modifying Databases
- Searching Databases

The Database Menu

The Database menu contains all of the options for accessing, creating, modifying, and searching SPOT databases. When you first open the SPOT program, only the first two options, New and Open are active. The other options remain inactive (grayed) until you either create a new database or open an existing database. In addition, Edit Database Record does not appear on the menu unless a database image is open. Each option is described below.

- New – Create a new SPOT database. Refer to the “Creating and Modifying Databases” section for details.
- Open – Open or delete an existing SPOT database.
- Close – Close a SPOT database.
- Password – Define a password to protect a SPOT database.
- Fields – Define the text and numeric fields, look-up lists, and default options for your database.
- Preferences – Define the location and format of the image files in your database.
- Search – Define parameters for database searches.
- Edit Database Record - Edit information associated with a database image, including field data, time and date information, file save location, and memo text.

Note: Only one database can be opened per session. If you try to open a second database, the program prompts you to close the open database.
The SPOT Sample Database

For your reference, a fully functional sample database is included with your software. We recommend that you browse through this database to familiarize yourself with the features and functionality. The following section is a “visual tour” of the SPOT Sample Database.

Open the SPOT Sample Database

1. From the Database menu, select Open. The SPOT program prompts you to select the database.
2. Select SPOT Sample Database, and click on Open. SPOT prompts you for a password.

Note that the SPOT database icon appears at the bottom of your Windows screen, indicating that the database is open.

View the Database Structure

From the Database menu, select Fields. The Database Fields window illustrates the different types of fields that you can define for a SPOT database:
Click on the **Items** button for the **Sample Type** lookup field to view a list of the sample type options for the SPOT Sample Database.

From the **Lookup Field Items** window, you can Add, Modify, or Delete items in the lookup list.

### View Database Preferences

From the Database menu, select **Preferences**

The Preferences window is the starting point for defining:

- Image file/database location
- Image file format
- Thumbnail save options

Refer to the **Defining File and Save Preferences** section of this chapter for details.

### Search the Database

From the Database menu, select **Search**. The Database Search window allows you to:

- Define search and sort parameters
- Save a specific set of search parameters
- Choose display options for search results (i.e., tabular or thumbnail display).

Refer to the **Searching Databases** section of this chapter for details.
Click on Search. Clicking on Search without entering any conditions results in a display of all the records in the database:

Save an Image to the Database

Open an image file, and from the File menu, select Save to Database:

All of the required fields must be entered before the image can be saved.

Creating and Modifying Databases

The following sections outline the details involved in creating and/or modifying SPOT databases.

- Setting Up the Database
- Defining Database Fields
- Defining File and Save Preferences
- Saving Images
- Editing Database Image Records
- Moving Existing Database Images

Setting Up a New Database

The initial set up for a new database consists of two steps:

- Naming the database (required)
- Defining a password for the database (optional)

Note: If you do not define a password during the initial definition, you can use the Password option on the Database menu to add a password at a later point.
To set up your database, follow these steps:

1. From the Database menu, select **New**.
2. Enter a **Name** for the database.
3. Define a password for the database, if needed. Follow these steps:
   a) Check the Require Password box. The Password and Enter Again boxes are activated.
   b) Enter a 1-10 character alphanumeric password.
   c) Re-enter the password.
4. Click on **OK**. The **Database Preferences** window appears. At this point, you can:
   Define the database preferences. Refer to the next section, **Defining File and Save Preferences**, for details.
   Click on **OK** to skip defining **Database Preferences** and proceed directly to defining the database fields and lookup lists (i.e., the **Database Fields** window). Refer to the **Defining Database Fields** section of this chapter for details.

**Note:** **Database Preferences** can be defined/modified at any future time by selecting the **Preferences** option on the **Database menu**.

### Defining File and Save Preferences

Before saving images to a database, you should specify your file and save preferences for the database. This includes:

- Location and path for database images
- Image file format
- Thumbnail save preference

All of the file and save preferences are defined from a single point, the **Database Preferences** window. The Database Preferences window automatically appears when defining a new database. If you want to define the file and save preferences at a later point, select the **Preferences** options from the Database menu.

### Storing Archived Images – An Important Consideration

Before proceeding to define the file and save parameters for your database, you should carefully plan how and where you will store archived images, as well as how you will accommodate future images. Because each uncompressed image file ranges from between 1.3 Mb to 8 Mb, saving and storing large quantities of images requires planning. There are a number of options for storing/archiving images including your computer’s hard drive and external storage devices including Zip, Jaz, DVD RW, external hard drives, mini-drives, and your system network. For more details on storage planning, contact your MIS department or a qualified computer or network specialist.
Location and Path of Database Images

SPOT databases are structured so that the database and the images stored in that database do not have to reside in the same location. This structure allows you to keep the relatively small database program files on your hard drive, while storing the larger image files in a different location. The name and location of the database - SPOT Sample Database in the illustration above - appears under the path for the database images; it cannot be changed from this window. The database always resides in the default location, C:\SpotCam\DBImages. Although the default location for image files is also C:\SpotCam\DBImages, we recommend that you define an alternative location such as a Jaz drive or a network drive. If you plan to save images to removable media such as ZIP or Jaz drives, you should, at this point, define the volume label for the disk. Because a single database of images can span more than one disk, defining unique volume labels for each disk provides a reference so that you can conveniently access images in the future.

To define a volume label for a disk, follow these steps:

Ensure that the ZIP or Jaz disk is in the drive.
From the Windows 98SE, ME, and XP Explorer, single click on the ZIP or Jaz drive icon.
From the File menu, select the Properties option; or, right click on the drive and select the Properties option. The Properties window appears. If you do not see a view similar to that in the illustration at right, click on the General tab.
Enter a name in the Label box. For ease of reference, you should name the volume so that it tells you both the name of the database and the disk number.
Click on OK.
Write the volume label on the ZIP or Jaz disk. This way, when you search a multi-disk image database, and the program prompts you to enter the disk number, you will be able to find the information.
Repeat steps 1 – 6 for each disk of images associated with a database.

If you are saving images to an existing database, you can click on the Current Image File Locations button to display the location of the saved image files and change the location and/or volume label for the disk. The Database Image File Locations window appears.

To change the File Path and/or the Volume label, either double click on the File Path/Volume information, or select the information and click on Modify. The Image File Location dialog box appears.
From this window you can:

- Enter a new location for the database images in the Path box; or, click on the button next to the Path box to browse for a new location.
- Enter a new Volume label for the disk.

**Image File Format**

From the Preferences window, you can define the graphic format of the images saved to a database. There are six options:

- Windows Bitmap
- JPEG (allows for image compression)
- JPEG2000 (allows for image compression)
- Mac PICT
- TIFF Uncompressed
- TIFF JPEG

Windows Bitmap is the default option. To define image file format, select one of the formats from the drop-down list. Selecting either the JPEG or the TIFF JPEG option activates the JPEG Quality box. This option allows you to compress images (i.e., lower their resolution) so that you can save disk space in cases where high-resolution images are not needed.

To define JPEG Quality, select a value between 1 and 100:

- A value of 1 represents the lowest resolution and the smallest file size.
- A value of 100 represents the highest resolution and the largest file size.
- For JPEG2000 Quality, select between lossless (minimal compression) and lossy. Select a ratio for lossy compression. A higher number equates to greater compression with greater chance of data loss.

**Thumbnail Save Preference**

- Determine whether you will Save Image Thumbnails for the database. The Save Image Thumbnails option saves a thumbnail of each image in the database. This allows you to visually browse through the images in a database. You can also open a database image from a thumbnail.

**CAUTION!**

When you select the Save Image Thumbnails option, the thumbnail images are saved to the SPOT database file, which resides on your hard drive at C:\Spotcam\Database\[name of your database].db. Each thumbnail increases the size of the database file by approximately 6 Kb.

**Defining Database Fields**

The Database Fields window is a centralized point for defining the details associated with a database. There are three processes associated with the definition of database fields:
• Naming and defining **Text/Numeric Fields** – The textual/numeric fields that you define represent the data you want to be associated with an image. Typical text fields include patient name and ID number. Typical numeric fields include height and weight.

• Naming and defining **Lookup Fields** – Lookup fields also represent data that you want to be associated with an image. Lookup fields are used in cases where the data item has a limited number of discrete options (e.g., blood type). Each lookup field is associated with a user-defined list of items, enabling you to select an option from a list, as opposed to manually entering it each time an image is saved to the database.

• Setting **Default Values** for the fields – To speed the process of saving images to a database, you can define default values to automatically appear for a field. This helps you to avoid multiple entries of the same item when numerous images have the same data for a particular field.

**Text/Numeric Fields**

To define a textual/numeric field, follow these steps.

1. On the Database Fields window, enter the name of the field in the Text/Numeric Fields box. You can use up to 30 alphanumeric characters. Entering information in the box activates (un-grays) the four variables to the right of the box.

2. Define the four variables associated with each field.
   - **Required** – Check (click on) the Required box to make the field a required entry when saving images to the database. When this box is checked, images can not be saved until the field has an entry.
   - **Title** – Check the Title box to ensure that the data from the text field appears in the title of the image window and under any thumbnail of the image.
   - **Text** – Click on the Text button to define the field as a text field. This is the default setting for the field type.
   - **Numeric** – Click on the Numeric button to define the field as a numeric field.

The field type (i.e., text or numeric) is important in terms of how the program searches the database. Text field searches look for textual strings of information while numeric field searches look for a range of values. So, a database field that contains numbers should not automatically be defined as a numeric field. For instance, if your field is a number such as a patient ID, it should be defined as a Text field because it is not a measurement and it is not within a specific range of values.

**CAUTION!**

After you have defined the Text/Numeric fields, you cannot change the Text or Numeric setting. Although you can make changes to an existing field name (i.e., to correct a spelling error or make a more intuitive name), you should not change the meaning of the field. This will render the field useless for searches performed on all previously stored images.

**Lookup Fields and Lists**

Defining a Lookup Field consists of three actions:

- Naming the Lookup Field
- Selecting the Required and Title variables
- Creating the items in the Lookup Field list
The SPOT database allows you to perform these actions in different orders, depending on your situation. Consider the following scenarios:

- You are the database administrator, and you want to define a new database with multiple Lookup Fields for others to use when saving images to the database. You know ahead of time which Lookup Fields you want to define, and you also know all of the items that will be associated with each Lookup Field.
- In this scenario, you can define the Lookup Fields, the Required and Title options, and some or all of the items in Lookup Field list.
- You are an end user and know which Lookup Fields you want to define, but prefer to add items for each field, as needed, when saving images to the database.

You can define one or more Lookup Fields without adding any of the Lookup Field list items. The Lookup Field items can be added either at a later time, or during the process of saving images to the database.

To define a Lookup Field and the associated list, follow these steps:

1. Enter the name of the first Lookup Field.
2. Select the Required and Title options.

   **Required** – Check (click on) the Required box to make the field a required entry when saving images to the database. When this box is checked, images can not be saved until the field has an entry.

   **Title** – Check the Title box to ensure that the data from the text field appears in the title of the image window and under any thumbnail of the image. You can also leave one or both options unchecked. If you do not want to enter the Lookup Field list items at this time, you can enter any remaining Lookup Fields and click on OK to save the database.

3. Click on the Items button. The **Lookup Field Items** window appears with the name, as shown at right.
4. Click on Add. The **Lookup Item** dialog window appears for you to enter the list item.
5. Enter the name of the list item in the box.
6. Click on OK. The program returns you to the Lookup Field Items window. In the illustration to the right, the user has added the A+ item to the Blood Type Lookup Field.

   From the Lookup Field Items window, you can:
   - Click on Add to add additional items to the Blood Type lookup list.
   - Select a lookup list item and click on Modify to edit the item or Delete to remove the item from the list.
   - Click on OK to save the lookup list and the associated items. The program returns you to the Database Fields window.

7. Follow steps 1-7 to enter additional Lookup Fields. You can enter up to four per database.
Setting Default Values

As part of the process of defining database fields, you have the option to define default values for each field. The values that you define will appear as default field entries each time you save an image to the database. If desired, you can edit the default entries before saving the image. To enter default values for a field, follow these steps:

1. After you have defined your text/numeric and lookup fields, click on Default Values (at the bottom of the Database Fields window). The Default Field Entries window appears, as shown at right. Unless specified, the SPOT database uses the Last Value for each field. To change this default for a Field, check the box next to the field name. Checking the box activates the Use: options.

2. Select the option that you want:

   **Last Value**
   When saving an image to a database, the program uses the data entered for the last image as the entry for the same field in the current image. The last entered data always appears in the entry box for the image that you are saving. Thus, if you select Use: Last for the physician field, and you select Dr. Jarvis for the first image, Dr. Jarvis appears in all subsequent images until you make a different selection.
   To select the Use: Last option, click on the Last button for that field and click on OK to save the settings.

   **Default**
   When saving an image to a database the program uses the entry that you make (in the box next to the Default button). If desired, you can edit the default entries before saving the image.
   To select the Use: Default option, click on the Default button for the field and enter/select the default entry. Click on OK to save the settings.

   If you do not specify a default value option for a field, all of the fields must be entered/selected each time an image is saved to the database.

Saving Images

Once you have acquired the images that you want to store in your database, the SPOT program makes it easy to save the information. To save an image to a database, follow these steps:

1. From the File menu, select the Save to Database option. The Save Image to Database window appears. The program automatically displays the date and time that you first saved the image. This information can be modified as needed.

2. Enter the information associated with the image in the database fields.
To enter data for a lookup field that is not contained in the drop-down list options, simply type the information into the field.

Note: When you save an image to a SPOT database, the program automatically creates an image ID that is stored in the image path folder. This is a reference number that the program uses to access images and associated data.

Note: If you defined a data field as Required on the Database Fields window, the program will not let you save the image without the information.

3. Click on the Memo button to associate a memo with an image. The Image Memo window appears.

4. Enter the text for the memo, and click on OK to save the memo.

5. Click on OK at the Save Image to Database window. If you entered a lookup list item that was not in the drop-down list of options, as described in step 2, the program prompts you to add the item to the list.

6. Click on Yes to add the new item to the lookup list.

Editing Database Image Records

Once you have created a database and saved images to that database, you can edit records as needed. To edit a database image record, follow these steps:

1. Ensure that the database is open.

2. From the File menu, select Open Database Image. The dialog box prompts you to enter the Image ID. If you do not know the Image ID, you can search the database, as described in the Searching the Database section that follows.

3. Click on OK to open the database image.

4. From the Database menu, select the Edit Database Record option. The Image Database Record window appears.

5. Change the Date/Time settings as needed. Use the following format: mm/dd/yy.

6. Edit the Fields data as needed. For the text and numeric fields, simply enter the new data. For the lookup fields, either select an item from the drop-down list or enter a new item. When you close the Image Database window, the program prompts you to add the new lookup list item.

Edit the Image Memo, if necessary. Click on Memo, enter the information, and click on OK.
In addition to the data associated with a database image, the Image Database Record window also allows you to modify the image file location/path information. For example, if you have moved a database image to a new file location, you would need to modify the record to reflect this.

To modify the location/path information for a database image, click on Modify. The Image File Location window appears. Either enter the new file path in the Path box, or click on the button to browse for the information. Enter the new Volume label. Click on OK. Click on OK at the Image Database Record window to save the changes.

Note: The image itself cannot be edited while the Image Database Record window is open.

Moving Database Images

When saving images to a database, the default save location is your computer’s hard drive – \C:\SpotCam\DBImages\ (or wherever you installed the SPOT software). To move images in a database from your hard drive to a removable storage medium such as a zip disk or a CD, follow these steps.

1. **Determine the file space needed for the database images.**
   a) Open the Windows Explorer.
   b) Navigate to the database image files. In the example at right, you can see that the image files associated with the Histology SPOT database are located in the \C:\SPOTCam\DBImages\Histology\ directory. Note that the status bar at the bottom of the screen displays the number of objects in the Histology folder (45) and the disk space used by these objects (58.2 MB).

2. **Define the volume label for your zip disk.**
   In some cases, you will be able to store all of a database’s images on one disk. At a future point, you might want to add additional images to the database that will not fit on the same disk. Defining a volume label enables you to access SPOT databases that span more than one Zip disk (or any other removable media). To define a volume label, follow these steps:
   a) Insert the Zip disk (or other removable media) in the drive.
   b) In Windows Explorer, right click on the drive letter for the Zip disk.
   c) Select the Properties option. You should see a view similar to that shown at right. If you do not see the pie shape, click on the General tab.
d) Enter a name for the Volume Label in the Label box. You should use a name that indicates both the name of the database and the disk number (e.g., HISTO1).

e) Click OK.

f) For future reference, label the disk or CD.

3. Move the database images to the Zip disk.

a) If it is not already open, open the SPOT program.

b) Open the database that contains the images that you want to move. From the Database menu, select Preferences.

c) At the Database Preferences window, click on Current Image File Locations. The Database Image File Locations window displays the current file path and volume, as shown at right.

d) Click on the Modify button. The Image File Location window appears, with the current path and volume information for the database images, c:\SpotCam\DBImages\Histology.

e) Either click on the square box next to the file path to navigate to the folder that you want to move the images to, or enter the file path in the box. When you click on the square box next to the Path box, the SPOT program prompts you with an Explorer view. Navigate to the D: drive (or whichever letter is used by your PC).

f) Click on the Create New Folder tab, as shown at right.

Note: If you simply enter the Path D:\Histology on the Image File Location dialog (above), the SPOT program will not create the folder. You must create the folder manually, either from the Windows Explorer, or from the Select Folder dialog.

g) Enter the name of the new folder, e.g., Histology.

h) Click on Select. The Image File Location dialog reappears.

i) Enter the Volume label that you defined for the Zip disk in step 2, e.g., HISTO1.

j) Click on OK. The Database Image File Locations window reappears.
k) **Close** the Database Image File Locations window. The Database Preference window reappears. Note that the **Image Files Saved To** path has not changed—it is still C:\SpotCam\DBImages\Histology. Unless you change this setting, new images added to the database will still be saved to this location.

l) Click on **OK**.

4. From the Windows Explorer, cut and paste the image(s) from the original location (e.g., C:\SpotCam\DBImages\Histology) to the new location (e.g., D:\Histology).
   a) Navigate to the C:\SpotCam\DBImages\Histology folder, and click on Histology.
   b) From the **Edit** menu, choose **Select All**.
   c) Cut the images [Ctrl X].
   d) Click on the D:\Histology folder.
   e) Paste the images [Ctrl V].

Steps one through four describe how to move an entire database of images. However, it is possible to move individual images or groups of images. When moving individual or groups of images from a SPOT database, you must change the path of each image file that you want to move.

To do so, follow these steps:

1. Search the database to find the image(s) that you want to move. For details on entering search conditions, refer to the Searching Databases section below.

2. From the search results display table (the Images window), select an image that you want to move, and click on **Edit**. You can select only one image at a time for editing. The Image Database Record window appears.

   **Note:** You can also access the Image Database Record window by opening a database image (i.e., File>Open Database Image) and then selecting the Edit Database Record option from the Database menu.

   3. Note down the Image ID number—the first item in the Image Information section.
   4. Click on the **Modify** button. The Image File Location dialog appears.
   5. Enter the Path and Volume information as described in steps 2d–2i above.
6. Repeat steps two through five for each image that you want to move.
7. From the Windows Explorer, cut and paste the images from their original location to the new location defined in step five.

Searching Databases

The SPOT program offers a robust, yet easy to use database search function. The **Database Search** window is the central point from which search and display parameters are entered. From this window, you:

- Define search conditions
- Order search results
- Display and edit search results
- Save search criteria
- Load previously saved search criteria

To access the Database Search window, select Search from the Database menu.

Defining Search Conditions

To define database search conditions, follow these steps.

1. Click on the Add button (for Search Conditions) on the Database Search window. The Search Condition window appears.
2. Select the database field that you want to base the search on. The left drop-down box contains a list of all the textual/numeric and lookup fields that you defined for the database. In addition to the fields that you defined, the Date associated with the image and the Image ID appears in the list.
3. Select the criteria for the search from the center drop-down box. The list options vary according to the type of field that you selected, as shown below:

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>is not</td>
</tr>
<tr>
<td></td>
<td>is before</td>
</tr>
<tr>
<td></td>
<td>is after</td>
</tr>
<tr>
<td></td>
<td>is on or before</td>
</tr>
<tr>
<td></td>
<td>is on or after</td>
</tr>
<tr>
<td></td>
<td>is between</td>
</tr>
<tr>
<td></td>
<td>is not between</td>
</tr>
<tr>
<td></td>
<td>is one of</td>
</tr>
<tr>
<td></td>
<td>is not one of</td>
</tr>
<tr>
<td>Numeric</td>
<td>is equal to</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>is between</td>
</tr>
<tr>
<td></td>
<td>is not between</td>
</tr>
<tr>
<td></td>
<td>is one of</td>
</tr>
<tr>
<td></td>
<td>is not one of</td>
</tr>
</tbody>
</table>
4. Enter the final search parameter in the right hand box. This entry will vary according to the search criteria that you selected. For Text and Numeric field searches, you are required to enter the information, while for Lookup field searches, you can select from a list of the lookup items.

For Text fields, asterisks (*) and question marks (?) can be used as “wild card” characters with the is like and is not like options.

* - The asterisk wild card tells the program that any number of characters can be used with this text field. For example, if you want to search all patients with “smith” in their name, you can enter *smith*. This search will bring up names such as John Smith, Jane Smithfield, and Joe Hammersmith.

? - The question mark wild card tells the program that any single character can be used where the question mark appears. For example, if you want to search for patients with either the name Smith or Smyth, you can enter *sm?th*. The asterisk and space in the front of sm?th tells the program to find all first names associated with sm?th. The question mark tells the program to search for one-letter difference variations on the name Smith. This search will bring up names such as John Smith, Anne Smyth, and Fred Smoth, but it will not bring up Jane Smithfield, Harry Hammersmith, or Abigail Smythe.

5. Click on OK to save the search parameters. The Database Search window reappears with the search conditions in the box.

After you have entered a search condition, you can:
- Click on Add to add another search condition.
- Select a condition and click on Modify to change it.
- Select a condition and click on Delete to remove it from the search.
- Define how the search results will be ordered. Refer to the next section for details.

### Ordering Search Results

After you have defined the search conditions, the Order by options allow you to set the display order of the search results.

To order search results, follow these steps:

1. Click on the Add button to the right of the Order by box. The Record Ordering window appears.
2. Select from the list of drop-down list options to determine how the database search results will be ordered. In addition to the database fields that you defined, the options include Date/Time and Image ID.
3. Check either the Ascending or Descending option:

   - Ascending lists display results beginning with the lowest value and progressing to the highest value.
   - Descending lists display results beginning with the highest value and descending to the lowest value.

4. Click on OK. The options that you selected appear in the Order by box:
After you have entered an ordering condition, you can:
Click on Add to add another ordering condition.
Select a condition and click on Modify to change it.
Select a condition and click on Delete to remove it from the search.

5. Choose the display options. Refer to the next section for details.

Displaying Search Results

The SPOT software allows you to display database searches either in tabular form or as thumbnails. From the Send Results to box, select either Table or Thumbnails. When all the search conditions have been entered, click on Search. The following sections detail the display and editing functionality.

**Send Results to: Table**

- Display the search results in a table. From left to right, the column headings for the table are:
  - The user-defined database fields
  - Date/Time
  - Image ID
  - Image Format
  - Bits per Pixel
  - Size (in bytes)

The illustration at right shows a search that resulted in one record.

From the table window, you can:

- **Open a database image** – Select the database record item, and click on the thumbnail at the bottom of the window. The image opens for viewing and modification.
- **Edit a database record** – Either select the database record item and click on Edit, or double-click on the database record item. The Image Database Record window appears. Refer to the Editing Database Image Records section below for details.
- **Delete a single database record** – Select the database record item and click on Delete.
- **Delete all of the database records** - Select a database record item and click on Delete All.
- **Switch to the thumbnail view** – Click on the Show as Thumbnails button.
- **Perform another search** – Click on the Search Again button to return to the Database Search window, where you can add or modify search conditions.

**Send Results to: Thumbnails**

Display the search results in the form of image thumbnails. The illustration to the right shows the thumbnail view of a database search that produced eleven records.

- **Double-click** on a thumbnail to open an image for viewing or modification.
• **Right-click (Windows) / [Ctrl] Click (Mac)** on a thumbnail to display a list of options, as shown at right. The right-click menu enables you to perform a variety of actions directly from the thumbnail window. You can:

- **Select** an image.
- **Open** a database image.
- **Delete** an image from the database.
- **Print** an image.
- **Edit Database Record** - Edit the database image record.
- **Add Image to Image Sequence** – Add a database image to an image sequence or create a new image sequence.
- **Add Image to Report Template** – Add a database image to a selected report template. When you select this option, SPOT prompts you to select from a list of reports. If you have not defined a report, SPOT automatically creates a new report for you and inserts the image as a **Static Image** object. Refer to the **Creating Reports** section of Ch. 10 - Reporting for more details.
- **Select all images** in the thumbnail view. When you use this option, the right-click menu expands to include the above options for multiple images.

**Click and drag with the mouse** to select two or more images.

**Send Results to: Exported File**

Display the search results as fields exportable to a database.

- Include field information from the selected database to a list of information that is to be exported to another database application.
- Select a filename and one of the file type options from the dropdown menu.

- When you click on Begin, the export will take occur, placing the file in the location defined by your path. Use the browse option to quickly define a path. You may also choose to either overwrite or append an existing document with the same path and filename.

  **Note:** The file you export will be created as a delimited file as selected by you in the dropdown menu. Once the file has been created with the exported data, it may be opened with a variety of applications, depending upon the preferences defined in your operating system.

**Saving and Reusing Search Criteria**

After you have defined the search and display parameters, you can save that set of criteria to be used for future searches on that database. Once saved, you can then reuse the search criteria clicking on the **Load** button.

To save a search, follow these steps:
1. Enter the search and ordering parameters.
2. Click on Save. The program prompts you to name the database query.
3. Name the query.
4. Click on OK. At this point, you can:
   - Run the search by clicking on Search.
   - Close the Database Search window and reopen the search at a future time.
   - To reopen the search at a later time, click on the Load button, and select a search (.qry) file. Click on Open. The Database Search window displays the parameters for that search query.

## Editing Database Image Records (from a search)

The SPOT program provides two ways to access and edit database image records:
- Via the Edit Database Record option on the Database menu
- Via the display windows of database search results

In both cases, the Image Database Record window allows you to change the information associated with the database image record.

However, the functionality differs slightly, depending on how the window is accessed:

<table>
<thead>
<tr>
<th>Accessed via the Database Menu</th>
<th>Accessed via a Search Results Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify data/time, database field entries, image memo, and file/path information.</td>
<td>Modify the database record for any image in the database.</td>
</tr>
<tr>
<td>Modify the database record for the open image only.</td>
<td>Edit the database record only.</td>
</tr>
<tr>
<td>Edit the database record only.</td>
<td>Edit the database record and/or the image itself.</td>
</tr>
</tbody>
</table>

To edit a database image record from a search results display window, follow these steps:

1. Open the Image Database Record window.
2. If your results are displayed in a table, either double-click on the record in the table, or select the record and click on Edit.
3. If your results are displayed as thumbnails, right-click on the thumbnail.
4. The Image Database Record window appears. Notice that navigational arrows appear above the thumbnail.
5. Change the Date/Time settings as needed. Enter the information in mm/dd/yy format
6. Edit the Fields data as needed.
7. For the text and numeric fields, simply enter the new data.
   - For the lookup fields, either select an item from the drop-down list or enter a new item. When you close the Image Database window, the program prompts you to add the new lookup list item.
   - Edit the Image Memo, if necessary. Click on the Memo button, enter the information, and click on OK.

In addition to the data associated with a database image, the Image Database Record window also allows you to modify the image file location/path information. For example, if you have moved a database image to a new file location, you would need to modify the record to reflect this.
To modify the location/path information for a database image, click on Modify. The Image File Location window appears. Either enter the new file path in the Path box, or click on the button to browse for the information. Enter the new Volume label. Click on OK.

At this point, you can either save the changes to the image record or proceed to make changes to another database record. To save the changes and return to the search results display, click on OK. To edit another database record without closing the Image Database Record window, use the navigational arrows at the top of the window to browse for the record.

- Use the two middle arrows to scroll one image at a time through the database.
- Use the left arrow to go back to the first image in the database.
- Use the right arrow to go forward to the last image in the database.
Introduction

The SPOT software includes a built-in reporting functionality that can be used either by itself or in conjunction with a SPOT database (Windows) to collect, organize, and present information related to your image captures. This chapter discusses the process of creating and running reports. It is divided into the following sections:

- Overview: The SPOT Sample Report (Windows)
- Creating a Report
- Running a Report
- Distributing Reports

Overview: The SPOT Sample Report

When you create a report in SPOT, you are building a template to be applied to specific situations. Running the report applies the template to an image or images. For example, you might have one template called Histology Report to document histology samples and another template called Cell Pathology Report to document different cell cultures. Similarly, you might want to produce reports for production line analysis. In this case, you could define different templates for different parts, such as Part A Analysis Report, Part B Analysis Report, etc…

For your reference, a fully functional sample report is included with the SPOT software. This report can be used:

- As an introduction to SPOT’s reporting features
- As a basis from which to build additional reports

The following section is a “visual tour” of the SPOT Sample Report.

Open the SPOT Sample Report

The SPOT Sample Report, Pathology Report, is a database report: it is based on the information associated with the images in the SPOT Sample Database. To open the SPOT Sample Report, follow these steps:

1. Because the SPOT Sample Report is based on the SPOT Sample Database, you must first open this database:
   a. From the Database menu, select Open.
   b. Select SPOT Sample Database.
   c. Click on Open.

Open an image from the SPOT database.
a. From the Database menu, select Search. The Database Search window appears. Do not enter any search conditions at this point.
b. In the Send Results to box, select Thumbnail Window.
c. Click on Search. The search results display.
d. Click on the John Rowland colon thumbnail to open a database image to report on.

2. Open the SPOT Sample Report. From the File menu, select Open Report. The Open window appears for you to select the file. The file path and name for the SPOT sample report is C:\Spotcam\reports\sampleDBreport.rpt. The report appears in a new window and the menus and menu options in the main window change to reflect SPOT’s report editing functions.

View the SPOT Sample Report Objects

When you open the SPOT Sample Report (or any SPOT rpt file), you are actually opening a template of user-defined report objects that the program uses to create the report output. The call outs on the following illustration of the SPOT Sample Report template identify the different objects used in the design of this report. Refer to the Defining Report Objects section for descriptions of each object.

Run the SPOT Sample Report

To run the Pathology Report for the John Rowland – colon image from the SPOT Sample Database, select Run Report from the File menu. The report sequence is as follows:

1. The Run Report window prompts you to define the Output destination for the report. Select Preview Window.
2. Click on Run.
3. The report then prompts you with the run-time text prompts that have been defined for this report. Because there are three run-time text prompts for the SPOT Sample Report (i.e., to enter the information for the Description, Analysis, and Recommendation fields), you will be prompted to enter run-time text for each field. In the illustration at right, the run-time text has already been entered, but if you were reporting on the image for the first time, you would see only the prompt. Click on OK at each window. When you click on OK at the third Run-Time text window, the report appears, as shown below.

4. Click on Close to close the report without saving or printing it. Refer to the Running Reports section for more details.

Creating a Report

To create a new SPOT report, select New Report from the File menu. The following changes take place in the main window:

- The report definition window appears as a separate window. If an image or image(s) were open, they remain open.
- The Object menu appears. Use these options to specify the fields, text, and images that appear in the report.
- The Attributes menu appears. Use these options to define the appearance and style of the report.
- The View menu options change to reflect report definition function.
- The Edit menu options change to reflect report-editing functions. These options are available only after one or more report objects has been added to the New Report window.

Note: When you move between an image window and the report definition window, the menu options change accordingly.
• **Editing Report Objects** – edit options for the report objects

### Working in Report Mode

The report mode contains functionality that differs from the image capture and editing functionality. The following is a brief overview of these features.

#### Cursor Functionality

Cursor functionality in SPOT reports varies according to which **Object** menu option is selected.

- If **None** is selected, the cursor is an editing tool for selecting, sizing, and positioning objects. When creating new reports, **None** is the default option.
- If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects to the grid.

#### Sizing and Positioning Report Objects

When sizing and positioning a report object in the report window, you must first select the object by single clicking on it. When an object has been selected, handles appear at the corners; for line objects, the handles appear at each end. You can select multiple report objects by holding the mouse button down and dragging the cursor around the objects. Handles appear around both objects. When selected, report objects can be sized or positioned as needed.

- To size objects, move the cursor either to a point on the object’s border or to one of the handles. The cursor changes to a two pointed arrow.
  - To resize one dimension of a box, position the cursor on a vertical or horizontal line; click and drag the side to the new size.
  - To proportionally resize a box, position the cursor on a handle; click and drag the box to the new size.
- To position objects, move the cursor over the selected object. The cursor changes to a four point arrow. Click and drag the object to a new location. If an object is selected, you can use the arrow keys to fine tune its position.

**Note:** When multiple objects are selected, they can be sized and positioned as a single object.

### Using Right-click and Double-click Functionality

When you are in report mode, you can use the right-click and double-click mouse functions as editing shortcuts.

- Double clicking on a report object enables you to edit the object’s attributes – e.g., the thickness of a line.
- Right clicking (Windows)/ [Ctrl] clicking (Mac) on a report object calls an object specific edit menu that contains both general editing options and attribute editing options specific to that object. Right clicking on an Image object, for example, gives you a list of editing options, as shown at right.
Right clicking (Windows)/ [Ctrl] clicking (Mac) on the report grid gives you three options: **Paste** an object that you copied or cut; **Select All** of the objects on the grid, or **Delete All** of the objects on the grid.

Refer to the Defining Report Attributes and Editing Report Objects sections for more details.

**Defining View Options**

The **View** menu provides you with eight options, each of which is described on the following pages.

**Zoom Level**

Zoom in or out to six different sizes. From the View menu, select Zoom and enter the desired percentage.

**First Page**

Go to the first page in the report. (only available when multiple report pages have been created)

**Previous Page**

Go back one page in the report. (only available when multiple report pages have been created)

**Next Page**

Go forward one page in the report. (only available when multiple report pages have been created)

**Last Page**

Go to the last page in the report. (only available when multiple report pages have been created)

**Set Display Grid Size**

The report definition window includes an adjustable grid (i.e., the dots on the screen) to assist you in placing and aligning report objects on the report page. By default, the grid is turned on. To turn off or modify the grid, follow these steps:

1. From the View menu, select Set Display Grid Size.

   ![Display Grid](image)

   To turn off the display grid, deselect the Show Grid box.

   To modify the spacing follow steps two through four.

2. Select either inches or millimeters.

3. Enter the spacing for the display grid. The number that you enter represents the space in inches or millimeters between the dots on the grid.

   If the measurement is **inches**, enter a number between **0.04** and **10**.
   If the measurement is in **millimeters**, enter a number between **1** and **25**.

   Click on OK. The display grid appears.
In addition to the display grid, you can define a second grid specific to report objects. The object grid controls the movement of objects as you work with them on the display grid. When you select a report object and move it, the object automatically “snaps” to the nearest line in the object grid, allowing you to more precisely align and arrange the objects on your report page.

1. From the View menu, select Set Object Grid Size.

2. If desired, check the Snap to Grid option.

3. Define the spacing for the object grid. In many cases, the object grid and the display grid will have the same spacing. In other cases, you might not want the display grid to be as finely spaced as the object grid (i.e., so the dots do not interfere with the view of the report definition window).

   If the measurement is **inches**, enter a number between .04 and 10.
   If the measurement is in **millimeters**, enter a number between 1 and 25.

   *(The measurement values will convert automatically as you toggle between English and metric units)*

   *The default spacing value for the Object Grid is the last entered value.*

4. Click on OK.

**Show Tools**

Click on the Show Tools option to display a floating palette of navigation buttons and report objects, as shown here. Refer to the Defining Report Objects section of this chapter for more details.

**Defining Report Attributes**

All of the general style and appearance options (report attributes) can be accessed from the Attributes menu. Report attributes can be defined for an entire report or on an object by object basis (see the Defining Report Objects section below).

- When a report object is selected, the attribute is defined for the selected object(s) only.
- When nothing is selected, the attribute is defined for all future, relevant objects.

The following sections detail each of the report attributes and the report objects that they affect.
Colors

Define the foreground and background colors for all objects. Follow these steps:

1. From the Attributes menu, select Colors.
2. Define the Text/Lines color. This is the color of the text, the line, or the border around a text/image box. The default foreground color is black. To select a color click on Color.
3. The next window varies, depending on whether you are using a Windows or a Mac system.

Windows allows you to select from a palette of colors or enter specific HSL or RGB color values.

Mac OS allows you to select from a palette of colors, enter specific RGB, CMYK, HLS, or HSV values, and enter Internet specific colors.

Define the Background/Fill color. This is the color that appears behind text and in boxes. Lines and images do not display a background color.

Note: In order to define a background/fill color for a Box or a Rounded Box, a fill must be selected. Similarly, in order to define a background/fill color for a text box, the background (see Text Border, Justification, and Background below) must be set to Opaque.

Line Thickness

Determine line thickness for the following report objects: Line, Horizontal Line, Vertical Line, Arrow, Box, Rounded Box, Ellipse, Freehand, Polygon, and polyline.

1. From the Attributes menu, select Line Thickness.
2. Enter a Thickness value between .05 and 10 points.
3. Click on OK.

Box/Ellipse

Define the appearance of the Box, Rounded Box, and Ellipse objects.

1. Specify whether you want a fill for the object.
   If you do not want the box to be filled (i.e., you want a transparent box), click on OK.
   If you want to specify a fill pattern for the box, check the Fill Box/Ellipse. The Pattern options appear.
2. Specify a pattern by clicking on one of the seven options.
3. Click on OK.

Image Options

Determine the line thickness for image borders; define the justification of the image within the display box, and display annotations, calibration marks, and measurements. This option applies only to the Image report object.

1. To create a border around the image, click on the Border box, and enter a Thickness value between .05 and 10.
2. Select the Justification for the image. This value is the justification of the image within its display box, not the justification on the report page.
3. Select Show Annotations if you would like to display annotations that have been added to the image.
4. Select Show Calibration Marks if you would like to display annotations that have been added to the image.
5. Select Show Measurements if you would like to display annotations that have been added to the image.
**Arrow Size and Direction**

Specify the size of the arrow head and define the direction that the arrow points.

1. To specify the size of the arrow head, enter a value between 1 and 10.
2. Specify the direction of the arrow:
   - To draw an arrow starting tail first and finishing with the point (head), select **Tail to Head**.
   - To draw an arrow starting point (head) first and finishing with the tail, select **Head to Tail**.
3. Click on OK.

**Text Font**

Define the appearance of the text for the **Text**, **Date**, and **Time** objects.

1. Select a **Font**, a **Font Style**, and a point **Size**. The Sample box displays a preview of the font.
2. Define any Underline effects.
3. Click on OK.

**Text Options**

Define the appearance of the text boxes for the **Text**, **Date**, and **Time** objects.

1. Specify whether the text box should have a border. To add a border, click on the **Border** box, and enter a Thickness value between 0.05 and 10.
2. Define the **Justification** of the text. This justification applies to the position of the text in the box, not the position of the text on the page.
3. Define the Background. Select either **Transparent** or **Opaque**.
4. Click on OK.

**Title Options**

Specify how the title of an image will appear on a report. This attribute applies only to the **Image Title** report object. If you have not added an image title to your report, the Title Options do not matter.

- To display only the file name – e.g., Healthy1 – leave both options unselected.
- To display the entire path for an image – e.g., C:\My Images\Cells\Healthy1 – check the **Show Path for File Names** box.
- To display the file name with the file type extension – e.g., Healthy1.jpg – check the **Show Extension for File Names** box.
- To display the file path and the file name with the extension – e.g., C:\My Images\Cells\Healthy1.jpg – check both boxes.
**Time Options**

Specify whether the Image Time report object will include seconds and milliseconds in addition to the hour and minute.

- To display only seconds, check the **Show Seconds** box.
- To display seconds and milliseconds, check both the **Seconds** and **Milliseconds** boxes.

To save the attributes you’ve selected for future report objects, choose **Save as Defaults**.

**Defining Report Objects**

All of the components of your report, including the formatting, text, images, and fields are known as objects. Using the objects, you can specify the information that your report will contain, as well as how the report will work.

- You can, using run-time images, produce reports for images as they are captured. This is a good option for situations where you are capturing many images in one sitting.
- You can produce reports for images that are saved to a SPOT database. Refer to Ch. 9 – Using SPOT Databases for details on creating and modifying SPOT databases.
- You can produce ad-hoc reports for single or multiple saved images.

Before discussing the individual report objects, review the following general procedure for inserting an object into a report:

- From the Object menu or by clicking on the appropriate Toolbox button, select the type of item (i.e., Lines, Connected Lines, etc…) that you want to add to the image. The cursor’s functionality varies according to whether a report object type (i.e., line, text) is selected.
  - If a report object type is selected, the cursor changes to a cross-hair icon that is used to add new report objects to the grid.
  - If **None** is selected, the cursor is an editing tool that is used to select and position objects.
- Use the mouse to move the cross hair to the location where you want to insert the object.
- Left-click at the insertion point.
- If you selected a **Line** (unconnected line) or a **Shape**, hold down the mouse button and drag the line/box to the desired size.
- If you selected any of the other report objects, the object will appear and you will be prompted to enter the associated information (e.g., static text, the location of an image file, the database field, etc…).
- Once it appears on screen, you can resize, reposition, and edit an object as needed.

- **Resize** - Select (click on) the object and drag the handles in the direction of the resize.
- **Reposition** – Left click and drag the object the new area.
- **Edit** – Select the object and choose an option from either the Edit menu or the Attributes menu. You can also edit an object by **right clicking** (Windows)/ **[Ctrl] clicking** (Mac) on it.

For **Connected lines** use the following procedure. Select the appropriate **Connected Lines** object from the Object menu, or on the Tools box button. Move the cursor to your first location. Left click and release, and then move the mouse to create a side. Left click again to start a new side. Double click to finish the polyline, polygon, or freehand shape.
Refer to the table below for descriptions of the SPOT report objects.

Select None when you want to use the cursor to edit and position the objects in your report.

### Lines
- **Unconstrained Line** – Add a straight-line annotation to the report.
- **Horizontal Line** - Add a horizontal line annotation to the report.
- **Vertical Line** – Add a vertical line annotation to the report.
- **Arrow** - Add an arrow to the report. Either select Arrow from the Object menu, or click on the Tools box button. Left click on the report and drag toward the area that the arrowhead will point to.

### Connected Lines
- **Polygon** – Add a closed polygon to the report.
- **Polyline** – Add an open polygon to the report.
- **Freehand** - Add a freehand line to the report.

### Shapes
- **Rectangular Box** - Add a square cornered box to the report.
- **Rounded Box** – Add a round cornered box to the report.
- **Ellipse** - Add an elliptical object to the report. Ellipses are drawn inside of the rectangular area that you define. Ellipses touch the top, bottom, right and left sides of this rectangle.
- **Circle** - Add a circle to the report.

### Images
A static image is an image that you want to appear on all productions of the report. A logo is a good example of a static image. To define a static image, follow these steps:

1. From the Object menu, select Images>Static Image.
2. Left click at the point on the display grid where you want to insert the Static Image box. As you insert the box, you can also size it by dragging a corner or side.
3. The Static Image box then prompts you to enter the source for the image file.
   - **Currently Open Image**
     If you have more than one image open, select the image from the drop-down list.
   - **Image File**
     A file from disk. Either enter the file name and path, or click on the browse button (to the right of the Image File box) to search for the file. If you select a sequence file, specify the image number (i.e., the order in the sequence) in the Sequence Index box. Note that, if the Store Image in Report Template is selected, you can view the image from within the report template as well as in the report itself. This feature allows you to quickly generate printed reports, without having to first save the report to file and/or run a preview report. Refer to Instant Reports in the Running a Report section of this chapter for details.
   - **Database (Windows)**
     An image file from a SPOT database. In order to use an image from a database, that must be open. If you are not sure of the Image ID, search the database and view the results table – the image ID appears there.

Click on **OK**. The static image object (or the actual image if you checked the Store Image in Report Template box) appears on the display grid, where you can move or resize the box.

When you run the report, the image is automatically proportioned to fit the dimensions of the box.
Run-Time Image
A run-time image is an image that is open at the time that you run the report. Run-time image objects allow you to report on images as you capture them, without having to save the images to file or to a database.

To define a run-time image, follow these steps:

1. From the Object menu, select Images>Run-Time Image.
2. Left click at the point the on the display grid where you want to insert the Run-Time Image box. As you insert the box, you can also size it by dragging a corner or side. The Run-Time Image window prompts you to specify the image.
3. Specify which image (if you have multiple open images) will be the run-time image. The entry in the Offset from Top Image Window box defaults to 0. If you have only one image open, click on OK.

If you have more than one open image, you will need to specify the number for that image. For example, if you have five open images, there are five values, from 0 – 4 that correspond to the images, as illustrated in this cascaded view of multiple image windows: If you have multiple open images, selecting a cascade view of the images can help you to determine the proper number. To do this, select the Cascade option from the Window menu.

4. Click on OK. The Run-Time image box appears on the display grid, where you can move or resize the box. When you run the report, the image is automatically proportioned to fit the dimensions of the box.

Note: Offset is related to the current order of any cascaded images. In other words, if you select an offset value, and then change the order of the image cascade (i.e. which image lies on top of another) the offset value will not reset. Instead, a different image may be selected by virtue of the offset.
Selected Image

The Selected Image options allows you to select one or multiple images to be included on a report at the time that you run the report. Selected images can be:

- Single or multiple open images
- Single or multiple images from file
- Single or multiple database images

To define a selected image or images, follow these steps:

1. From the Object menu, select Images>Selected Image.
2. Left click on the point in the display grid where you want to insert the selected image.
3. Size and position the image box as desired.
4. Add any additional report objects needed to complete the report.
5. From the File menu, select Run Report.
6. Select the report template either from the Currently Open Template, or from File.
7. Select the Output format. The default choice for running a report is to use the Preview Window, which allows you to view the report before saving or printing it. For more details on the Run Reports options, refer to the Running Reports section of this chapter.
8. Click on Run. The Selected Images window appears.
   - **Top Open Image** – The report displays only the top-most image, if multiple images are open.
   - **All Open Images** – The report displays all open images.
   - **Image File(s)** – The report displays the image file or files selected from disk. When you check the Image File(s) option, and click on OK, the Report Images window appears for you to select one or more images to be included in the report. To individually select multiple image files, hold the [Ctrl] key and click on each file.
   - **Database (Windows)** – The report displays one or more images from a database. When you check the Database option and click on OK, the Database Search window appears. Add search conditions and ordering criteria, as needed, and click on Search. The report displays the Search Results. Refer to Ch. 9 – Using SPOT Databases for detailed steps on how to define search and order conditions.
10. Click on OK.
**Static Text**

Use the Static Text option to add text that will be the same for all of the images in a report. Typical static text fields include:

- The title of the report
- Report field headings

To define Static Text, follow these steps:

1. From the Object menu, select Text>Static Text.
2. Left click at the point where you want to insert the text. The program prompts you to enter the text. You may also include variables in the Static Text box that will be recalled when the report is run.
3. After you have entered the text, click on OK. The Static Text appears in a box.
4. To edit the text, double-click on the box. The Static Text box reappears for you to modify the text.

**Run-Time Text**

Use the Run-Time Text option to define the data entry prompts that will appear when you run an image report, or to define text that will appear only when you run the report. To prompt the user for data when the report is run, follow these steps:

1. From the Object menu, select Text>Run-Time Text.
2. Left click at the point where you want to insert the text. Check the Prompt User checkbox.
3. Enter the Prompt. When you run a report on an image, you will be prompted to enter information for the prompt. If you would like to use a variable as part of your prompt, click where you would like the variable to be, choose Insert Variable, and select your preferred variable from the drop-down menu.
4. Enter the Default Text, if desired. The Default Text field is useful in cases where the same item is entered for multiple image reports. For example, one lab technician might have drawn the sample for numerous blood samples. In this case, you could enter this technician’s name as the Default Text. You may also include variables in the Run-Time Text box that will be recalled when the report is run.
5. Click on OK. The object displays on the report grid.
6. To edit the text, double-click on the box. The Run-Time Text dialog box reappears for you to modify the text.

To simply display text on the image when it is run, follow these steps:

1. From the Object menu, select Text>Run-Time Text.
2. Left click at the point where you want to insert the text.
3. Type in the text you would like to display on the report. If you desire, you can insert variables in the text box that will be recalled when the report is run.

**Page Number**

Add a page number to a report page.

**Page Count**

Add a display of the total number of pages in your report.

**Record Number**

Add the number of the record (selected image/s) to the report. When you run the report, the number for each record is displayed on the page.

**Record Count**

Add the total number of records (selected image/s) in the report. When you run the report, the Record Count appears on each page.
**Report Date**
Insert the current date in your report.

**Report Time**
Insert the time that you ran the report.

**Current User Name**
Add the user name to the report. This name defaults the user that is logged into the computer.

**Image Date**
Include the date that an image was captured.
1. After you have inserted an image in the Report, select **Text>Image Date** from the Object menu.
2. Left click at the point where you want the Image Date to appear. The ImgDate box appears on the display grid.
   
   The number following ImgDate is associated with the image or images in your report. Thus, if the report has more than one image, the program prompts you to define the image that the date should be associated with.
3. Enter the Report Image Number. When you insert images, the program automatically assigns it a number. The first image you insert is 1, the second image 2, etc...
4. Click on OK. When you run the report, the image date displays.

**Image Time**
Include the time of day that an image was captured.
1. After you have inserted an image in the Report, select **Text>Image Time** from the Object menu.
2. Left click at the point where you want the Image Time to appear.
   
   The number following ImgTime is associated with the image or images in your report. If the report has more than one image, the program prompts you to define the image that the time should be associated with.
3. Enter the Report Image Number.
4. Click on OK. When you run the report, the Image Time displays.

**Image User Name**
Add the name of the user who was logged in when the image was captured.

**Image Title**
Insert the file path and name that is associated with an image.

To insert the Image Title, follow these steps:
1. After you have inserted an image in the Report, select **Text>Image Title** from the Object menu.
2. Left click at the point where you want the Image Title to appear.
   
   The number following ImgTitle is associated with the image or images in your report. If the report has more than one image, the program prompts you to define the image that the title should be associated with.
3. Enter the Report Image Number.
4. Click on OK. When you run the report, the file and path for the image displays.

You might have to resize the ImgTitle box to display the entire file path.

**Image Memo**
Insert the memo that you entered for a TIFF, JPEG, or SPOT database image. Follow these steps:
1. After you have inserted an image in the Report, select **Text>Image Memo** from the Object menu.
2. Left click at the point where you want the Image Memo to appear. The number following ImgMemo is associated with the image or images in your report. If the report has more than one image, the program prompts you to define the image that the memo should be associated with.
3. Enter the Report Image Number.
4. Click on OK. When you run the report, the memo displays.

**Image Sequence Index**
Insert the number of a specific image when reporting on an image sequence file.
Image Sequence Size
Add the total number of images in the sequence to the image.

Image Sequence Elapsed Time
Insert the elapsed time between two images. When you run a report that contains the Image Sequence Elapsed Time, the program prompts you to specify both the Reference Image Index Number and the sequence number of the image you are reporting on. The Reference Image Index number is any number within the image sequence, typically one that precedes the image being reported on. If you specify a number that comes after the image that you are reporting on, the elapsed time will be a negative value.

Database Record ID (Windows)
Include the record number of a database image in your report. The Database Record ID can only be used with run-time or selected images.
To insert the database record ID for a database image, follow these steps:
1. After you have inserted a database image in the Report (either as a run-time image or a selected image), select Text>Database Record ID from the Object menu.
2. Left click at the point where you want the record ID to appear. The DBRecID box appears on the display grid. The number following DBRecID is associated with the image or images in your report. If the report has more than one image, the program prompts you to define the image that the database record should be associated with.
3. Enter the Report Image Number.
4. Click on OK. When you run the report, the record ID of the database image displays.

Database Field Name (Windows)
The Database Field Name and Database Field Entry objects allow you to run reports that parallel some or all of the information from a SPOT database. Use the Database Field Name object to insert a text/numeric or lookup field from an open database.
1. After you have inserted a database image in the Report (either as a run-time image or a selected image), select Text>Database Field Name from the Object menu.
2. Left click at the point where you want the field name to appear. The program prompts you to select the field that you want in the report.
3. Select an entry from the Field drop-down list. The drop-down list options are generic i.e., Text/Numeric – 1, Text/Numeric – 2, etc....
4. Click on OK.
5. If the report has more than one image, the Image Number dialog box prompts you to define the image that the database field name should be associated with.
6. Enter the Report Image Number.
7. Repeat steps one through seven to add additional database fields to the report.
Database Field Entry (Windows)
The Database Field Name and Database Field Entry objects allow you to run reports that parallel some or all of the information from a SPOT database. Use the Database Field Entry object to insert the data from a text/numeric or lookup field.

To insert a Database Field Entry in your report, follow these steps:
1. After you have inserted a database image in the Report (either as a run-time image or a selected image), select Database Field Entry from the Object menu.
2. Left click at the point where you want the field name to appear. The program prompts you to select the field that contains the entry (data) that you want to appear in the report:
3. Select an entry from the Field drop-down list.
4. Click on OK. The box at right appears.
5. If the report has more than one image, the program prompts you to define the image that the database field entry should be associated with.
6. Enter the Report Image Number.
7. Click on OK. When you run the report, the database field entry displays.
8. Repeat steps one through seven to add additional database field entries to the report.

User Name – Add the user’s name to the image. This defaults to the user who is logged on the computer.

Save as Defaults

Editing Report Objects

Once you have created a report, you can edit the report objects as needed. There are three basic ways to edit a report object:

- **Use the Attributes menu** - The Attributes menu, as noted in the Defining Report Attributes section of this chapter, allows you to either set the attributes for adding specific types of objects, or to select existing objects and modify them as needed. Refer to the Defining Report Attributes section for more details.

- **Use the Edit menu** - The Edit menu contains general editing features such as Undo, Copy, Cut, Send to Back, etc…

- **Right-click (Windows)/[Ctrl] click (Mac) on the report object** - Right clicking/[Ctrl] clicking on a report object brings up a customized editing menu that contains both general editing commands and the attributes that can be edited for that object. Refer to the Working in the Report Mode section for more information on the right click function.

The Edit Menu

The Edit menu provides general editing features for arranging, copying, and sizing report objects. Edit menu options are active only when a report object is selected. The following sections describe each of the Edit menu options. As is explained in the sections below, not all of the options are available at all times.

**Undo**

Undo the last action. The Undo feature allows you to undo up to ten actions.

**Bring to Front**

Bring a selected object in front of all other objects.

**Move Forward**

Bring a selected object one layer forward.
Move Backward
Send the selected object one layer back.

Send to Back
Send a selected object behind all other objects.

Select All
Select all report objects.

Unselect All
Unselect all report objects.

Delete
Delete the selected object(s).

Delete All
Delete all of the objects in the report.

Copy to Clipboard
Copy the selected object(s) to the Windows clipboard. You can then paste the object(s) into:
• A new SPOT report
• A different location in the same report
This feature is particularly useful when you are creating a new report and want to use objects from an existing report.

Cut
Cut the selected object(s) for pasting into a new report or to a new location in the existing report.

Paste
Paste the object that you cut or copied to its new location.

Duplicate
Create additional copies of a report object. To duplicate a report object, follow these steps:
5. Select the object(s) that you want to duplicate.
6. Select Duplicate from the Edit menu. The program prompts you to enter the number of duplicate copies.
7. Enter the number of copies, and click on OK.
8. The duplicate object(s) appear at the top of report window.

Set Position, Alignment, and Size
The Set Position, Alignment, and Size option allows you to specify precise sizing and position values for single or multiple selected report and annotation objects.

The Position options enable you to:
• Align top/bottom edges of multiple objects.
• Align left/right edges of multiple objects.
• Align the centers of multiple objects.
• Center an object(s) on the page.
• Enter exact values in inches or millimeters to position the object.

The Size options enable you to enter:
• Exact width/height in inches or millimeters for one or more objects.
• Set the width/height dimension for multiple objects to the smallest or largest object’s value in inches or millimeters.
Add Page
Add a page to your report. When you add a page, the program prompts you with the Add Page dialog box:
4. Specify whether the page that you want to add will be inserted Before or After a specified page.
5. Specify the Page Number that the additional page will precede or follow.
6. Click on OK.

Delete Page
Delete a page from your report. When you select the Delete Page option, the program prompts you to specify the page number.

Add Static Images
Add a static image object to the report. Refer to the Static Image object description in the Defining Report Objects section above for details on this process.

Order Run-Time Text Prompts
When you run a report with multiple run-time text prompts (see the Defining Report Objects section), the prompts, by default, appear in the order that you defined them. Use the Order Run-Time Text Prompts option to rearrange the order as needed. To re-order the run-time text prompts for a report, follow these steps:
1. From the Edit menu, select Order Run-time Text Prompts. The current order of the run-time text prompts displays.
2. Click and drag the prompts to rearrange them in the desired order.
3. Click on OK. When you run the report, you will be prompted to enter the run-time text in the newly defined order.

Set Image Number
Change the report image number of the image.

Set Image Source
Change the source of the image.

Set Image Options
Determine the line thickness for image borders; define the justification of the image within the display box, and show/hide annotations, calibration marks, and measurements.

Set Colors
Define the foreground and background colors for all objects.

Running a Report
To run a SPOT report, follow these steps:
1. From the File menu, select Run Report. You can either run an open report or a report from file:
   • **Currently Open Template**
     If more than one report template is open, select from the drop-down list.
• **File**
  Either enter the file name and path for the report that you want to run, or click on the Browse button to the right of the Name box to search for the report file.

• **Select the output format for the report.**
  • **Printer** – The report is sent directly to the printer. The program first prompts you to select a printer/define print settings. Refer to Ch. 11 – Printing Images for details on printing from the SPOT program.

  ![Run Report dialog box](image)

  The output options are discussed in more detail in the sections below.

2. **Specify the Allow Multiple Records Horizontally and Allow Multiple Records Vertically options.**
   When a report contains multiple Selected Image objects, SPOT separates each image with a page break: the report displays only one image per page. The Allow Multiple Records Horizontally and Allow Multiple Records Vertically options allow you to display multiple images on a page for cases such as a report on a database or a sequence image file.

   To display multiple images in a row, check **Allow Multiple Records Horizontally.**

   ![Image display example](image)

   To display the multiple images in a column, check **Allow Multiple Records Vertically.**

   ![Image display example](image)

   To display the images in rows and columns, check both options.
In addition to selecting these options from the Run Report dialog, you can select them from the Preview window (see Previewing a Report below).

3. Click on Run. The prompts that you see depend on the type of report objects that you defined. Refer to the Defining Report Objects section in this chapter for more information.

Previewing a Report

When you run a report in the Preview Window, the report appears with a navigation toolbar at the bottom of the preview window, as shown here:

From left to right, the toolbar buttons are as follows:

- **Navigation arrows** - Move forward or backward in a multi-page report, or to the first page or last page in the report.
- **Page display** – See which page of the report you are viewing.
- **Allow Multiple Records Horizontally** – Display multiple selected images in a row.
- **Allow Multiple records Vertically** – Display multiple selected images in a column.
- **Zoom** – Zoom in or out on the report. There are six options.
- **Print** – Print the report without saving it.
- **Save** – Save the report as a Run Report (.rpd) file.
- **Close** – Close the report preview without printing or saving it.

Printing a Report

When you run a report with an output to Printer, the program prompts you to enter print information:

Follow these steps:

1. Select the printer.
2. Click on Properties to define the printer’s properties, if needed.
3. Specify the page range if you are not printing an entire report.
4. Specify the number of copies.
5. Click on OK.

Please note:

On Mac computers (only), it is also necessary to follow these steps before printing a report in order to ensure your specified margins print properly:

1. Choose Printer Setup from the File menu.
2. Choose Custom Paper Size from the Settings drop-down menu.
3. Select New, name the custom paper size, and set up a custom paper size with all four printer margins set to 0.
4. Select Save, and then choose OK to close out of the Page Setup dialogue.
5. Choose Printer Setup again from the File menu, and select the named custom paper size from the Paper Size drop-down menu and choose OK.
Spot Software User Guide

Saving a Report to File

When you run a report with an output to File, the program prompts you to save the file. Follow these steps:

- When saving a new report (.rpd file type), SPOT prompts you with the default file location – i.e., C:\SpotCam\Reports folder (Windows) or Users\Shared\SPOT Files\Reports (Mac). Either save to the default location or specify a new location. If you plan to save many reports without compressing the image files, you should save them to a Jaz drive or to a network drive.

  
  [Note: Mac users will see the .rpd file type extension only if the Add Extensions to File Names on Save option is selected on the Preferences window.]

- Enter a file name for the report.

- Define the JPEG Compression for the image(s) in the report. The Use JPEG2000 Compression for Images box is checked as a default. To select any other compression format, check its corresponding box.

For JPEG2000 format,

- Lossless will give you the truest reproduction of data, but will also create the largest file size for any JPEG2000 compression scheme. Typical compression ratios range from 2:1 to 3:1.

- Lossy will compress the file to a level specified by the user through a compression ratio. The larger this ratio, the smaller the file, but also the greater chance that some digital information will be compromised. Lossy compression can achieve file compressions of up to 100 times smaller file size than lossless, yet still provide good resolution. (see examples at end of chapter)

For JPEG format,

- A value of 1 is the most compressed. File size and image resolution are decreased to the maximum extent.

- A value of 100 is non-compressed. File size remains large and the image resolution remains high.

- Click on Save. You can now use the SPOT program to open and view the report at a later time.

Instant Reports

To quickly preview and print a simple report, without first running a preview report or saving the report to file, use the new Store Image in Report Template feature. The Store Image in Report Template feature allows you to view a Static Image report object in the report template: you do not need to run a preview report to see what the final printed product will look like.

Follow these steps:

2. Add a report image that to the template. From the Object menu, select Images>Static Image. Left-click and drag the cross-hairs cursor to size and position the Static Image box. When you release the button, the Static Image window appears.
3. Select File for the Image Source. Click on the button to the right of the Name box to select an image.
4. If you have selected a sequence file, specify the Sequence Index – i.e., the number of the image in the sequence.
5. Ensure that the Store Image in Report Template box is checked.
6. Click on OK. The Static Image appears in your report, where it can be sized, positioned, or annotated as needed.

7. Add additional static images as needed. Follow steps one through seven.

8. From the File menu, select Run Report.

9. For the Output Destination, select Printer.

10. Click on Run.

**Distributing Reports**

If you intend to distribute SPOT image reports to people who do not have the SPOT program, we recommend that you purchase Adobe Acrobat. Using Acrobat, you can convert the SPOT report (.rpd) files to PDF files, which can be distributed to users who do not have the SPOT software. They can view the reports with the free Acrobat Reader software, which is included on the SPOT software CD. The latest version of the Acrobat Reader can also be downloaded from the Adobe’s web site www.Adobe.com.
Introduction

The printing features in the SPOT program fall into two categories:

Printer Setup - The standard Windows dialog boxes that are used to specify:
  - Printer and setup
  - Page setup
  - Orientation
  - Paper size and source.

Print - The SPOT printing options allow you to print one or multiple diagrams on a page.

Printer Setup

After you have installed and setup your printer, the procedure for setting up and configuring a printer in SPOT is the same as in any other Windows program.

Note: Because the information contained in this section is standard Windows functionality, the options are not discussed in detail. For more information on Windows printing features, refer to the Windows on-line help.

To choose and configure a printer, follow these steps:

1. Choose a printer. From the File menu, select Printer Setup. The Page Setup window appears. To select the printer you want to use, click on the Printer button at the bottom of the window. The program prompts you to select a printer.

2. Modify the default settings of the printer, if necessary. Click on Properties. From this point you can modify printer specific options such as color settings, fonts, graphic settings, etc… The printer properties window and the available options will vary according to the printer that you are using. Refer to the on-line help or your printer’s manual for more information. When you finish entering the property settings, click on OK.

3. Click on OK. The program returns you to the original Page Setup window.

4. Define the page setup that you want to use for the image(s). This includes the page orientation (portrait or landscape), paper size, paper source, and margins.

5. Save the page layout specifications that you entered. Click on OK.

Note: You can also access the Page Setup screen from the Print screen (i.e., From the File menu, select Print, and click on the Setup button).

Print

After you have defined the printer and page layout, you are ready to print. With the SPOT software, you can print a single image to a page or you can print multiple images on a page for comparison or display.
Printing a Single Image

To print a single image from the SPOT software, follow these steps:

1. Either select Print from the File menu, or click on the Print toolbar button. The Print window appears with a preview of the active image.

   The Print window displays the following information:

   **Printable Area:** The printable dimensions of the page.
   **Top Image:** The position and size of the top-most image (if more than one image will be printed on the page). They are:
   - **Left** - The distance between the left side of the printable area and the left side of the image.
   - **Top** - The distance between the top of the printable area and the top of the image.
   - **Width** - The width of the image.
   - **Height** - The height of the image.

2. Check either **Inches** or **Millimeters** to specify the units of measurement.

3. Adjust the size of the image:
   a) Position your cursor on a side or a corner of the image. The cursor turns into a two-ended arrow.
   b) Using the two-ended arrow cursor, drag a side or corner to enlarge or reduce the image. The resized image maintains the height to width ratio of the original image.

4. Adjust the position of the image:
   a) Position the cursor on the image. When on the image, it appears as a four pointed arrow.
   b) Left click and drag the image to the desired location.

5. Check the box to show Annotations, Calibration Marks, and/or Measurements if these have been added to the image.

6. Click on the Print button. The Printing dialog box displays the job. To stop the print job, click on the Abort button.

Printing Multiple Images on a Page

The SPOT program also enables you to print multiple images on a single page. The additional images do not need to be open; you can add additional images from a file directory or a SPOT database.

To add and arrange multiple images for printing, follow these steps:
1. From the File menu, select the Print option. The currently open, selected image appears in the Print window.

2. Add an image to the page for printing. Follow these steps:
   Click on the Add button. The Add Image window appears.
Select the image that you want to add. Images can be added from one of three places:

   • From a **Currently Open Image** – Add one or all of the currently open images. Select either the desired image or *<All Images>* from the Title drop-down list. Ensure that you enter the **Sequence Index** (i.e., the number of the image in the sequence) if you are adding an image from a sequence file.

   • From an **Image File** – Add a file from disk. Check the **Image File** option, and click on the square next to the box. Browse for the desired image, and click on Select. Ensure that you enter the **Sequence Index** (i.e., the number of the image in the sequence) if you are adding an image from a sequence file.

   • From a SPOT Database – Add an image file from an open SPOT database. To add an image file from a SPOT database, you must know its Image ID number. After you have determined the number, check the Database option, and enter the ID number.

   Set the auto-arrange option. If you check the Auto-Arrange Images box, the SPOT program automatically sizes and positions the images to fit on the print page.
Click on OK. The program adds the images to the print page and returns to the Print window. The images appear in the preview box.

   • **If you selected the Auto-Arrange Images option**, the images will be arranged in a print-ready format. Click on Print to print the page.

   • **If you did not use the Auto-Arrange Images option**, the images will be stacked on top of each other for you to arrange. Go to step 3 in the Printing a Single Image section for details on manually arranging the images.

3. Check the box to show Annotations, Calibration Marks, and/or Measurements if these have been added to the image.

4. Add multiple images by repeating step 2.
To arrange how multiple images will appear on the page, follow these steps:
   a) Click on the Arrange button. The Arrange Images window appears.
Select the number of row(s) and column(s).
Enter the Spacing between the images on the printout in inches or millimeters.
Select **Apply to all pages** to make the arrangement applicable to every page of a multi-page report (This checkbox will not appear for a single page report).
Click on OK. The Print screen reappears with a preview of your print arrangement. The screen capture at right illustrates four images arranged in a two row, two-column format.

The SPOT program automatically resizes images to fit on the page, so you can add multiple images without having to resize them. For example, if you add five images, the preview will show six images (the original and five added) of equal size, distributed proportionally across the page.

From the print screen, you can:

- Click on **Print** to print the page.
- **Add** an image as described in step two.
- Delete an image by selecting it and clicking on **Remove**.
- Reposition and/or resize the images as described in the previous section.
- Use the **Page** drop-down list to navigate to a different page view (when printing multiple pages).

**Printing Sequential Images**

The procedures for printing sequential images in the SPOT software are identical to those described in the **Printing Multiple Images on a Page** section (see above), with one exception. When you select the **Print** option for a sequential image file, the program prompts you to specify the image(s) in the sequence that you want to print, as shown at right.

- If you select **All Images in Sequence** and click on OK, the program prompts you to specify the number of images per page.

- If you select **Specified Images**, you can select either a single image or multiple images. Separate multiple images with commas and/or dashes — e.g., 1, 2, 3; 1-3; or 1, 2, 3-6.
Introduction

SPOT software allows you to customize your program by developing Floating Taskbars containing timesaving onscreen buttons that can initiate functions or start a macro. The Taskbars serve as an onscreen repository of the functions or Macros that you commonly use in your imaging/post processing work, where, with a single click, those functions can be easily initiated without searching through dropdown menus.

As an example, let’s assume that you commonly need to open image files, save image files, add image borders, cut objects from images, use Annotation Tools, and/or run your favorite Macro program.

You can develop a taskbar with buttons that give you quick access to all of these functions and Macro programs. It might look like the taskbar below.

If you have several users who operate the SPOT software at different times, you can also set up customized taskbars for each user. Each user can display their individual taskbar when they are working with the software.

Developing a Taskbar

From the Setup menu, choose Taskbars, and then select Add to create a new taskbar. The Taskbar Editor will open. When you name your taskbar and choose Add in the Taskbar editor, all of the functions that can be applied to the Taskbar are listed. It also allows for the selection of a previously developed Macro as a Button on the Taskbar.
For example, the first function added to the taskbar might be the image rotation function. In order to add this function to the taskbar, select “Rotate Image Left” from the Edit Image menu in the Taskbar button window.

Note that the button text box defaults to Rotate Image Left. You may customize this button name to whatever you choose without changing the function of the button itself.

Next, select the color of the button background and the text along with the font size and style from the options available at the bottom of the taskbar button screen.

Click the OK button and the first function will be added to the Taskbar Editor window.

Continue to add buttons to the taskbar in the same fashion until you are satisfied that you have added all of your favorite functions.

Enter a name for your Taskbar and choose OK. Access the Edit menu, choose View, and select your Taskbar from the drop-down menu to display your taskbar.

Repeat this process to add multiple taskbars.

Note: The Macro taskbar pushbutton uses a defined computer path to search for the stored Macro file. If you decide to relocate the Macro file, you must update the taskbar button by redefining the path.

Note: You are limited to a taskbar with 50 buttons.

Modifying Taskbar Appearance

After developing taskbars, you may choose to modify their appearance by changing button colors, button names, text fonts, the position of the buttons on the taskbar, or the appearance of the taskbar.
Any of these changes can be easily accomplished through the Taskbar Editor window. Simply select the function or macro that you wish to change by highlighting it from the list. Then select the modify button, make the changes using the same procedures you used to develop the buttons originally. Click the OK button when you are finished and the Taskbar will be immediately modified.

You can change the relative position of the buttons on the taskbar by simply highlighting the function and moving its position up or down on the Taskbar Editor screen. Additionally, you may change the number of columns that the taskbar window is divided into using the column feature in the taskbar setup window.

Note: If you choose a number of columns that does not divide equally into the number of functions and macro buttons you have developed, the grid of the floating taskbar window will automatically fill the “extra boxes” with non-functional buttons in the default beige color.

You will notice, at times, that the font on certain buttons will appear faded. This indicates that the particular function is not available due to other circumstances present at the time. For example, if an image has not been captured yet, certain edit features will not be available. However, as soon as an image is acquired, the font on those buttons will become more contrasted to the button color, indicating that the function is now available.

Note: Until you select annotate, any buttons that relate to annotation will not be functional, even after you have captured an image. Once you select annotate from the drop down menu or as a taskbar button of its own, the annotation function buttons will become functional.

Taskbar Size and Location
As an onscreen tool, the taskbar window can “float” on the screen in front of any open image windows (captured or live images) or other taskbars. The position of taskbars is not arbitrary, but instead can be set by the user. If a taskbar hinder your viewing of any images, you can do one of four things: modify its size, change its location, “roll it up”, or make it disappear from the screen.

Modify Taskbar Size
Like most windows, simply highlight the taskbar and resize it by dragging one of its handles to make it larger or smaller. A side handle will change the width of the taskbar, a top or bottom handle will change the height of the taskbar, and a corner handle will change both height and width proportionately.

Change Taskbar Location
Simply grab the taskbar’s title bar by placing the cursor over it and holding down the mouse button (left button on a PC). Then move the taskbar around the screen until you are satisfied with its location. Release the mouse button.

Roll up a Taskbar
Double click on the taskbar’s title bar and the buttons will roll up under the title bar. You may also right click on the title bar and select roll up from the pop up menu.

Repeating these procedures will roll out the buttons from under the title bar.

Make a Taskbar disappear
Click on the close box in the right upper corner of a taskbar. Alternately, right click on the title bar and select close from the pop up menu. In either case, you will need to access the View drop down menu, select Show Taskbar, and re-select the Taskbar to make it reappear on the screen.
Importing/Exporting Taskbars

You can move your taskbars to and from another computer. To import taskbars, follow these steps:

1. Choose Taskbars from the Setup menu.
2. Click on Import.
3. Select the taskbar export that you would like to import. This will be a file of type SPOT Export (spx).
4. Choose Open. The taskbar export will appear in the Import menu.
5. Select the taskbar export and choose Import. The taskbar(s) will now be ready for you to use.

To export taskbars, follow these steps:

1. Choose Taskbars from the Setup menu.
2. Select the taskbars you would like to export. To select multiple taskbars, hold down the Control button while selecting them.
3. Click on Export.
4. Select a File name and location and choose Save.
Chapter 13 - Macro Scripting

Introduction

A new feature of the SPOT software is the addition of Macros Scripting (hereafter referred to as Macros). Macros offer the user the ability to automate many of the repetitive tasks associated with image capture and processing. As a result, the user can spend more time evaluating and analyzing results, and less time manipulating test set-ups, variables and other settings.

**Macro** – a program to automate a task or set of tasks that you perform repeatedly or on a regular basis. It is a series of commands and actions that can be stored and run whenever you need to perform that task.

Benefits

A robot benefits an industrial user by accurately repeating redundant procedures. Macros can provide the same benefits to researchers and scientists for capturing images. Like a robot, a Macro requires the preparation of a program of commands that perform an operation. Once saved, that program can be modified and supplemented to create multiple procedures that do not require the researcher to replicate all of the program steps again and again.

Benefits of using Macros

- Time savings
- Accurate reproduction of image capture techniques
- Macros are modifiable, allowing the user to maintain an original macro while modifying it for a slightly different result, with minimal effort

We will begin by discussing directions for accessing, navigating, and using the Macro Window. New commands introduced in the Macro menu will be discussed.

Creating a Macro

There are two methods for creating a macro. The first involves utilizing a Macro Window to develop a macro program by adding commands line-by-line. The second involves using a record feature within Macros that develops a macro by monitoring and recording, on-the-fly, the individual commands that the user selects while in the process of carrying out an imaging procedure.

After your first macro is completed and saved, further macros can be developed as new, recorded, or can be developed by modifying an existing macro and saving it under a new filename (see Edit).

Both methods of macro development can be initiated through the Macro drop down menu. We will begin by discussing the first method, line-by-line development, in order to gain a greater understanding of the Macro Window.

Let’s get started.

Accessing and Navigating the Macro Window

From the drop down menu on the Spot Advanced Software Screen, select Macro. The drop down menu will offer four choices. They include the following:

- New
You can access the Macro Window directly by selecting the New option. You may also access it by selecting Edit and then selecting a macro file to edit from your computer (Once you have created and saved a macro).

**New**

Select New from the Macro menu. The Macro Window will open.

**Macro Window**

You will note that the Macro Window is a split into two active panes. The pane to the left includes a selection menu and provides all of the available commands that can be incorporated into any macro. The pane on the right represents the active macro development pane or a reflection of the Macro program, command line by command line. When “New Macro” is selected, the screen will open with the default commands of Begin Macro and End Macro on the right window. All commands are placed in between these commands when developing your personal macro.

The menu screen on the left can be formatted in two different ways. The first is logically grouped into seven main functions. They include:

1. Camera
2. Image
3. Sequence
4. View
5. Window
6. Macro
7. Other

Each of the main topics can be expanded by clicking on the [+] next to the topic name, similar to an expandable Windows menu. For example, the Camera topic expands as indicated below.
Macro Commands Available

The menu expands to show all of the available macro commands related to the main topic. Table A. indicates all of the commands available under each main topic.

Table A. Expanded Menu with Command Selections

<table>
<thead>
<tr>
<th>Topic</th>
<th>Command</th>
<th>Interactive Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Camera</td>
<td>Select Camera</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select Image Setup</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get Sequential Images</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Compute Exposure</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Recall Previous Exposure</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Get White Balance</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Get Bias Frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get Background Image</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Get Background Image</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Stop Live Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Start Live Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set TTL Output Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set TTL Output Inactive</td>
<td></td>
</tr>
<tr>
<td>2. Image</td>
<td>Open Image File</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Save Image File</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save Image File As</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Save Image to Database</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Print Images</td>
<td>Yes</td>
</tr>
<tr>
<td>Topic</td>
<td>Command</td>
<td>Interactive Mode</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Resize</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Rotate Right</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Rotate Left</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Flip Horizontally</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Flip Vertically</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Crop</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Additive Brightness</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Multiplicative Brightness</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Contrast</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Gamma</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Bright and Dark Level</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust RGB Histogram</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust Hue Saturation and Luminance</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSL Multiplicative Luminance</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSL Contrast</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSL Gamma</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSL Bright and Dark Level</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSL Histogram</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust Hue Saturation and Value</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSV Multiplicative Value</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSV Contrast</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSV Gamma</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSV Bright and Dark Level</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Adjust HSV Histogram</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Smooth</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Sharpen</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Unsharp Mask</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Filter Noise</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Median Filter</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Make Image Negative</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Make Grayscale</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Set Palette</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Change Bit Depth</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Subtract Image</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Merge Images</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Duplicate Image</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Add Annotation</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Topic</td>
<td>Command</td>
<td>Interactive Mode</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>Set Calibration</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Add Calibration Mark</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Add Measurement</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Merge Annotations</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Merge Calibration Marks</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Merge Measurements</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Set Image Memo</td>
<td>Yes</td>
</tr>
<tr>
<td>3. Sequence</td>
<td>Create New Image Sequence</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Extract Sequence Images</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Append Sequence Images</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Play Sequence Forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play Sequence Reverse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Step Sequence Forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Step Sequence Reverse</td>
<td></td>
</tr>
<tr>
<td>4. View</td>
<td>Set Fit To Window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set Zoom Level</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Show Pan Window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Show Image Date/Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set Full Screen</td>
<td></td>
</tr>
<tr>
<td>5. Window</td>
<td>Cascade Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrange Windows Horizontally</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrange Windows Vertically</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close Image Window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bring Image Window to Front</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close Image Window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close all Image Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close all Image Sequence Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close all Document Windows</td>
<td></td>
</tr>
<tr>
<td>6. Macro</td>
<td>Block</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Loop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Escape Block/Loop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delay</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wait Until</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wait for Sensor Temperature (Xplorer and Pursuit only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Else</td>
<td></td>
</tr>
</tbody>
</table>
### Interactive Mode

As listed in the previous table, many of the accessible commands in the Macro Command Selection Pane include an option that is used to prompt the user to provide input during the playback of the Macro. This is referred to as an Interactive Mode.

When a command with an interactive mode option is selected, the command window will appear with an unchecked box in the upper left corner. The user must select the Interactive feature of the command in order to be asked for data (in the case below, the filename) during the playback of the Macro program. When the interactive mode is not selected, the Macro Window may require immediate input before it can accept the command as part of the macro being constructed.

In the example below, if the interactive mode is not selected, a filename must be input before this window can be closed and added to the Macro program.
Developing a Macro in the Macro Window

To begin developing your macro, you will want to copy commands from the left command selection pane into your active macro development screen in the right pane. You may do this by highlighting the command you would like to add from the left command selection pane and then clicking the Add button just below the pane. The first added command will be copied between Begin Macro command and the End Macro command.

As a second option, Windows users may double click on the command in the command selection pane. The command will be placed into the Macro in the development pane on the right.

After the first command has been added, you will note that the Modify, Copy, and Delete buttons become active on the right side of the Macro Window. The default Begin Macro and End Macro commands cannot be modified or deleted, however, all commands added in between them can be.
You will also note that any subsequent commands you add will be placed just below the highlighted command in the development pane. When a command is in a position and you would like to change its position, simply highlight that command and use the up and down arrow buttons to the right of the development pane to reposition it. You will note in the case above, that the Get Image command can only be repositioned upward. A downward reposition would place it outside of the End Macro command, which is not allowed.

Other Options on the Macro Window

Comment – The user may also add comments to the Macro through the use of the comment button located just above the development pane on the right.

Once a comment is placed with the Macro, it remains hidden during editing and playback and can be accessed only when the comment button is pushed. It is associated with the Macro, and not any particular command lines in the Macro. It is simply a virtual notepad for the user to add a reminder that becomes part of the specific Macro program. It can be edited at any time by accessing the Macro comment window, modifying the comment, and saving the updated Macro program.
- **Modify** – This command allows the user to modify any of the settings associated with any command in the development pane. The modify command can only be accessed with commands that have underlying user defined settings.

- **Copy** – This command allows you to copy individual or multiple commands within a macro.

- **Paste** – This command allows you to paste the copied commands at specified places in your macro.

- **Delete** – The delete button will delete any and all highlighted commands within the Macro development pane. The only exception to this is deletion of the Begin Macro and last End Macro command in the Macro. These cannot be deleted.

- **Disable** – The disable command box located just below the development pane allows the user to selectively turn off (disable) any commands located between the Begin Macro and End Macro commands. This allows a user to temporarily remove certain procedures from a Macro without having to delete them.

If you would like to select a group of commands, highlight the first in the group in the development pane, hold the control key (Windows) and continue to highlight all other commands you would like to disable. Once all commands are selected, activate the Disabled box. All selected commands will be placed in parentheses, thus indicating that they are no longer commands that will be executed as part of the Macro.

For example, in the following Macro, the Rotate Left and Sharpen commands have been selected and disabled.

This macro can still be played, however, the Rotate Left and Sharpen commands will be ignored.

- **Save** – The user may save the macro at any time by selecting this button. Like any program or application being developed, this saves all modifications being made to limit the loss of data in the event of a program interruption or crash. The user will be prompted for a filename only once when a new macro is being developed. After that, Save automatically saves to the active filename.

- **Save As** – Like the save command, this allows the user to actively save the modified program at any time. However this command is best utilized for saving the modified file under a new file name, thus maintaining the original file structure with the original filename.

  In this case, the user will be prompted to select a filename for the Macro to be saved. The default filename will be the current filename of the open Macro.

- **Record** – This allows the user to quickly exit the Macro Window and begin developing the macro through use of the record feature. This feature is explained in greater detail in the following pages.

- **Play** – This command allows the user to immediately begin playing the active macro or any other macro without having to manually close the macro Window.

- **Close** – This command allows the user to close the Macro Window. If commands have been added to a new macro or if an existing macro has been modified, a window will appear and ask if the user would like to save the macro.

- **Help** – This command allows the user to access the online help area of the SPOT software without closing the macro window.
Ch. 13 – Macro Scripting

Comment – allows for the addition of a stored comment to the macro program

Add – adds a command to the macro from the command selection pane

Modify – allows modification of the settings associated with the selected command in the macro development pane

Copy - copies the selected command(s)

Paste - pastes the copied command(s)

Delete – deletes the selected command in the macro development pane

Disable – makes the selected command(s) inactive when the macro plays

Save – saves the macro program immediately under the current filename

Save As – saves the macro program under a modified filename

Record – activates the macro recording mode of macro development

Play – plays the active macro immediately

Close – closes the active macro

Help – activates the help window in the SPOT program

Record

This handy feature allows the user to develop a macro without using the macro window to add commands line-by-line. Instead, the user selects record from the macro dropdown menu, a taskbar button, or from within the Macro Window. A window will appear informing the user that a new macro is recording.
Once this has been indicated, all commands selected from the Spot Software menus, toolbar, or taskbar (except other macro programs) are sequentially added to the developing macro. While the macro is being recorded, the Macro Recorder dialogue box will be displayed. To roll up this dialogue box to conserve space, double click on the Macro Recorder toolbar. Repeating this procedure will roll out the dialogue box again.

**Developing a Macro Using the Record Feature**

For example, if the first command is to be Get Image, the Camera dropdown would be opened, and the user would select the Get Image command.

This command would automatically be added as the first command following the Begin Macro command in the macro development.

Thereafter, all selected commands would be added after the Get Image command, in sequence, until you choose to end the macro. To end the macro, simply choose the stop button on the Macro Recorder window.

When you choose to end the macro recording, another window will prompt you by asking whether you would like to save the recorded macro. If you select yes, a subsequent window will appear asking you to name and save the macro.

Recording a macro is an excellent way for developing a “rough draft” of a macro program. Once the macro is recorded, you can use the edit macro command to review all of the commands you recorded and modify the macro program in order to refine it.

Spot software users who are use to developing their imaging procedures using the dropdown menus may find this to be a comfortable and expedient method for initially developing a macro.

**Edit**

This command is used to review and edit an existing macro that has been saved. When the user selects the edit option from the macro dropdown menu, an Open Macro Window will appear, prompting the user to select a stored macro or browse for a stored macro.

Once the macro is found, it can be opened by double clicking on the name (Windows users), single clicking on the name (which places the name in the File Name box) followed by clicking the open button, or by typing the name into the File Name box followed by clicking the open button. SPOT macros can be identified by their “.spm” filename extension.
Once selected, the Macro Window will open and the Macro program will show in the development pane on the right.

At this point, the user can choose to simply review the program or choose to edit any or all of the available commands. The range of editing options includes adding new commands or deleting existing commands, disabling (but not deleting) commands, modifying commands (available only when subcommand windows are attached to the command), re-sequencing commands, defining or redefining variables, and adding or revising comments.

You can also choose to simply play the macro from this window. This allows the user to review the macro to verify that it is the proper procedure prior to setting up an experiment, playing the macro, and obtaining resulting images.

Play

The play option automatically initiates the macro program. For the user who knows which macro is the exact procedure to use to get the desired results, this is the fastest way to gain them (short of setting up a taskbar button to play the specific macro – See Taskbars). Once Play is selected from the macro dropdown menu, a window will appear prompting the user to select the desired macro to be played. Once the macro is selected, it begins to play immediately, without further prompting or warning.
A Macro Playing window will appear anytime the macro is processing commands. You may interrupt the macro program at anytime by selecting the Stop button on the Macro Playing screen. You can also roll up the Macro Player dialogue box by double-clicking on the Macro Player toolbar. Repeating this procedure will roll it out again.

When the macro has completed playing on its own, the Macro Player window Status changes to Done, and the stop button changes to a Play button. If you would like the Macro Player window to close after the macro is completed in the future, select the Close this Dialog When Done checkbox.

New Macro-specific Commands

The Macro feature in the Spot program introduces a number of new commands specific to the development of the macro program. In the following section we will review and further explain the commands. The following approach will be used with each command:

[COMMAND NAME]

- Purpose and Use
- The Macro Window and [Command Name]
- Windows specific to [Command Name]
- Generic Example using [Command Name]

Purpose and Use – Explains the basic function of the command and why and when it is most useful in developing a macro program.

The Macro Window and [Command Name] – Describes what happens on-screen in the macro development pane when the command is selected in the command selection pane.

Windows specific to [Command Name] - Describes the appearance, function, and how to input data for any window that results from selecting one of the new macro commands. Note that some, but not all, new commands have a data input window associated with the command.

Generic Example using [Command Name] - Provides one or more examples of the use of the specified command in conjunction with other generic commands.

The new commands associated with the Macro Scripting feature can be classified into four groups. They include the following:

- Conditional Commands .......................IF, ELSE, LOOP, BLOCK, ESCAPE BLOCK/LOOP
- Variable Commands .........................SET VARIABLE, INCREMENT VARIABLE
- Timing Commands .............................DELAY, WAITUNTIL, END MACRO
- Communication Commands ..................PLAY SOUND, PROMPT USER, RUN REPORT, EXECUTE OS COMMAND
Conditional Commands

Conditional Commands arise from the IF Command and relate to what the Macro program will do next, once it has evaluated whether an IF Command is true or not true.

**IF**

*Purpose and Use*

The IF Command is used to write a conditional statement, otherwise known as a test statement. The result of the IF Command test is always yes (true) or no (false). When the result of the IF test proves to be true, the macro program will continue by executing the next program line after the IF Command. When the result of the IF Command proves to be false, the macro program will skip the subsequent command (or command set – see BLOCK and LOOP) and continue with the next command following the subsequent command.

The IF Command is a powerful tool when your macro program contains a number of different options as part of your imaging routine, but you only want to complete certain options for a given experiment condition.

*The Macro Window and IF*

When the IF Command is selected from the command screen, it is added to the development pane below the highlighted command in the pane.

*Window specific to IF*

When the IF Command is chosen from the command selection pane (left pane of the Macro Window), another window will open on top of the Macro Window. It will appear as shown below.

The purpose of this window is to develop the IF Command that will be proven true or false when evaluated. You will note the following features of the IF window.
When a name is entered in the second variable name box, you will note that the corresponding operator and variable value boxes become active. Additionally, the and/or option becomes available. This allows for an expansion of the IF Command to include two conditions that must both be met (if “and” is used) or two conditions, either of which can be met (if “or” is used) for the IF Command to be proved true.

**Example X**

<table>
<thead>
<tr>
<th>IF Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
<tr>
<td>Command C1</td>
</tr>
<tr>
<td>Command…</td>
</tr>
</tbody>
</table>

When the IF Command is true, the program will execute Command A1, followed by Command B1, Command C1, etc.

Should the IF Command prove to be false, the macro will skip the next command line or command set following the IF Command, and will continue with the first command following that command or command set.

In the preceding Example X, when the IF Command is false, the program will skip Command A1 and will execute Command B1, followed by Command C1, etc.

If a group of commands are to be executed after the IF Command is evaluated, the user should use the BLOCK Command to execute the group (see BLOCK Command).

**Example Z**

<table>
<thead>
<tr>
<th>IF Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Block</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command A2</td>
</tr>
<tr>
<td>Command A3</td>
</tr>
<tr>
<td>End Block</td>
</tr>
<tr>
<td>Begin Block</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
</tbody>
</table>
In Example Z, when the IF Command is true, the program will execute the block of commands including A1, A2 and A3. It will follow by executing the block of commands including B1, B2, and B3. Once that block is completed, the program will execute Command C1, etc.

When the IF Command is false, the program will skip the block of commands including A1, A2 and A3 and will execute the block of commands including B1, B2, and B3. Once that block is completed, the program will execute Command C1, etc.

**ELSE**

*Purpose and Use*

The Else Command is used in conjunction with an IF Command, allowing a choice between two subsequent commands depending upon the outcome of the IF Command evaluation.

*The Macro Window and ELSE*

When the ELSE Command is selected from the command screen, an Else command is placed in the macro program below the existing highlighted command.

*Window specific to ELSE*

No specific window appears to further define the ELSE Command.

*Generic Example using Else*

When the ELSE Command follows an IF Command, it is the default command should the IF Command turn out to be false. In this “false” case, the command following the ELSE Command is executed. Interestingly, Example X, cited earlier (and below), includes an implicit ELSE Command. When the IF Command was proven false, Command A1 was omitted, and Command B1 was carried out. Could the program just as well been written as the following Example X.1?

**Example X**

| IF Command |
| Command A1 |
| Command B1 |
| Command C1 |
| Command… |

**Example X.1**

| IF Command |
| Command A1 |
Else
Command B1
Command C1

The answer is no! There is a difference. In Example X, Command B1 is carried out after Command A1 when the IF Command is true or when it is false. In the Example X.1, Command B1 will not get carried out if the IF Command proves to be true. Instead, Command A1 will be carried out, followed by Command C1, etc. In Example X.1, with the Else Command, the subsequent command (Command B1) is only carried out if the IF Command is false. Therefore, in Example X.1, a choice between Commands A1 and B1 is made. In Example X, the only choice is whether to carry out Command A1 or not. Command B1 will always be implemented.

The same use of the Else Command can be applied with blocks.

Example Z

<table>
<thead>
<tr>
<th>IF Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Block</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command A2</td>
</tr>
<tr>
<td>Command A3</td>
</tr>
<tr>
<td>End Block</td>
</tr>
<tr>
<td>Begin Block</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
<tr>
<td>Command B2</td>
</tr>
<tr>
<td>Command B3</td>
</tr>
<tr>
<td>End Block</td>
</tr>
<tr>
<td>Command C1</td>
</tr>
<tr>
<td>Command…</td>
</tr>
</tbody>
</table>

≠

Example Z.1

<table>
<thead>
<tr>
<th>IF Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Block</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command A2</td>
</tr>
<tr>
<td>Command A3</td>
</tr>
<tr>
<td>End Block</td>
</tr>
<tr>
<td>Else</td>
</tr>
</tbody>
</table>

≠
We already know from an earlier discussion of Example Z that the only choice is whether to carry out Command Block A1-A3. Block B1-B3 will be carried out regardless of the result of the IF Command.

However, in Example Z.1, when the IF Command is true, the program will execute the block of commands including A1, A2 and A3. It will skip the following block of commands including B1, B2, and B3 and will continue the program by executing Command C1, etc.

When the IF Command is false, the program will skip the block of commands including A1, A2 and A3 and will execute the block of commands including B1, B2, and B3. Once that block is completed, the program will execute Command C1, etc.

**LOOP**

*Purpose and Use*

The LOOP Command instructs the Macro program to complete a series of commands (within the loop) and then repeat those commands a defined number of times (iterations) before continuing the Macro program.

This can be quite helpful when a repetitive procedure defined by a series of commands must be completed.

*The Macro Window and LOOP*

When the LOOP Command is selected from the command selection pane in the Macro Window a Begin Loop and an End Loop command will be inserted into the Macro program in the development pane. The Begin Loop command will be highlighted in the development pane, indicating that the next selected command will be placed just below the Begin Loop command. Other commands to be carried out as part of the loop must be placed between the Begin Loop and End Loop commands.

After all commands are added between the Begin Loop and End Loop commands, the loop procedure is defined. Upon playing the Macro, the program will proceed through the series of Loop commands until it reaches the End Loop command. It will then return to the Begin Loop command and repeat the Series of commands for as many times as defined.
Window specific to LOOP

When LOOP is selected a Loop window will appear over the Macro Window. It will ask the user to define the number of loop iterations that will be carried out prior to the continuation of the remainder of the Macro program. The Loop window will look like this:

The Loop window includes a drop down menu that allows for 5 user-defined variables (NUMVAR1 through NUMVAR5). Additionally, any integer number may be placed in the Number of Iterations box in the Loop window. The value in the box defaults to 1 when the Loop window appears. When selecting the user-defined variables, the SET VARIABLE Command would be placed before The LOOP Command.

Generic Example using LOOP

Once you have selected the LOOP Command in the Macro Development pane, the command sequence entered might be:

```
Begin Macro (automatically added when the window is opened)
Begin Loop
Command A1
```
This macro would process Commands A1, B1, C1 and D1 in sequence, repeating the sequence for as many iterations as were specified in the LOOP Command. Once that number of iterations is completed, the program will move on and process Command E1.

**BLOCK**

*Purpose and Use*

The BLOCK Command is used to group a series of commands together, to be performed sequentially prior to any further commands being performed.

The BLOCK Command is very useful in conjunction with IF Commands (see IF Command) as it allows for a group of commands to be skipped should the IF Command prove to be false.

Essentially, the BLOCK Command is similar to the LOOP Command with an implied iteration value of one (see LOOP Command).

*The Macro Window and BLOCK*

When the BLOCK Command is selected from the command screen, both a Begin Block and an End Block command are simultaneously added, and the Begin Block command will be shaded in the development pane, indicating that the next command selected will be placed below the Begin Block command.

*Window specific to BLOCK*

No specific window appears to further define the BLOCK Command.

*Generic Example using BLOCK*

A simple command sequence using BLOCK might be:

```sql
Begin Macro (automatically added when the window is opened)  

Command B1  
Command C1  
Command D1  
End Loop  
Command E1  
End Macro (automatically added when the window is opened)
```
In this example, the macro would process Commands A1, B1, C1 and D1 in sequence prior to any other subsequent commands being processed. Once the block A1 through D1 is completed, the program will move on and process Command E1.

This is not a terribly effective use of the BLOCK Command. Why? Because even without the Begin Block and End Block commands, the macro would process Commands A1 through E1 in the same sequence.

The real power of the BLOCK Command can be seen when used in conjunction with an IF Command.

Example Z

```
Begin Macro (automatically added when the window is opened)
IF Command
Begin Block
Command A1
Command A2
Command A3
End Block
Begin Block
Command B1
Command B2
Command B3
End Block
Command C1
Command...
```

In this example, the program evaluates the IF Command to determine whether it is true or not true. Should the IF Command prove true, the block of commands A1 through A3 will be carried out, followed by B1 through B3. Should the IF Command prove to be false, the program will skip block A1-A3, and the command block B1 through B3 will be carried out. In either event, the next command processed will be C1.

Using the Else Command between the command blocks provides a different option (See ELSE).

**ESCAPE BLOCK/LOOP**

*Purpose and Use*
The ESCAPE BLOCK/LOOP command is used to leave a programmed block or loop prior to completion of the block or loop.

The ESCAPE BLOCK/LOOP Command can be useful when placed in a block following an IF Command, allowing the program to exit the loop should a predetermined condition be met.

The Macro Window and ESCAPE BLOCK/LOOP

When the ESCAPE BLOCK/LOOP Command is selected from the command screen, it is added to the development pane below the highlighted command in the development pane.

Window specific to ESCAPE BLOCK/LOOP

No specific window appears to further define the ESCAPE BLOCK/LOOP Command.

Generic Example using ESCAPE BLOCK/LOOP

```
Begin Macro (automatically added when the window is opened)
Begin Loop
   Command A1
   Command B1
   IF Command
      Escape Block/Loop
      Command C1
      Command D1
      End Loop
   End Loop
   Command E1
End Macro (automatically added when the window is opened)
```

In the generic example, the macro will begin the loop series by completing Command A1 and B1. Once the IF Command proves to be true, the ESCAPE BLOCK/LOOP Command will be carried out. At that point, it will leave the loop series and will continue by processing Command E1. Should the IF Command be false, Command C1 and D1 are carried out before the loop ends.
Variable Commands

**SET VARIABLE**

*Purpose and Use*

The SET VARIABLE Command allows the user to associate a variable label with a text or numeric value.

This can be useful when the value of a variable changes from one imaging procedure to another and the user wants to be able to modify that value without modifying the remainder of the macro program.

The SET VARIABLE Command can also be used to assign the values of text and numeric variables to each other.

*The Macro Window and SET VARIABLE*

When the SET VARIABLE Command is selected from the command selection pane in the Macro Window a SET VARIABLE Command will be inserted into the Macro program in the development pane below the highlighted command.

*Window specific to SET VARIABLE*

When SET VARIABLE is selected a Set Variable window will appear over the Macro Window. It will ask the user to select the variable to be defined and also to place an initial value on that variable.

The Variable label box on the left has a drop down menu allowing you to select from a list of preset variable labels: TextVar1…TextVar5 or NumVar1…NumVar5. Select from the list.

The right hand box allows the user to define the initial value of the Variable label selected. If a text variable is selected, the user can assign a text or numeric value in the right side box. The numeric value will be treated as text. If the user selects a numeric label on the left hand box, the user may only assign a numeric value in the right hand box.

The right hand box also allows the user to choose from a drop down menu of variables in order to allow the user to assign the values of variables to each other.

*Text Label Example*
Numeric Label Example

The value in the box defaults to TextVar1 when the Set Variable window appears.

Generic Example using SET VARIABLE

Please refer to the Generic Example that follows in the discussion of the INCREMENT VARIABLE Command

INCREMENT VARIABLE

Purpose and Use

The INCREMENT VARIABLE Command instructs the program to reset the value of a specified variable by an incremental amount equal to 1. The only variable that can be incremented using this command is a NumVar.

This can be quite helpful when the user wants the program to automatically keep track of (and/or record) the number of times a procedure has been carried out by the macro (such as a loop iteration), or to automatically rename images as they are collected. This latter use is more directly available in the Save As window using the Increment option.

The INCREMENT VARIABLE window is only of value after the SET VARIABLE Command has been utilized.

The Macro Window and INCREMENT VARIABLE

When the INCREMENT VARIABLE Command is selected from the command selection pane in the Macro Window an INCREMENT VARIABLE Command will be inserted into the Macro program in the development pane.

Window specific to INCREMENT VARIABLE

When INCREMENT VARIABLE is selected an Increment Variable window will appear over the Macro Window. It will ask the user to define which variable label is to be incremented. The drop down menu will only offer numeric value variables (NumVar1 through NumVar5). NumVar1 is placed in the box as the default value. The Increment Variable window will look like this:

Generic Example using Increment Variable:

An example of the use of the SET VARIABLE and INCREMENT VARIABLE Commands is presented in the following generic macro.

```
Begin Macro (automatically added when the window is opened)
SetVariable (set NumVar1=1)
Begin Loop
```
In this example, NumVar1 becomes part of the name of the images saved by the macro. The macro initially defines NumVar1 to be equal to 1. Commands A1 through D1 are carried out and the resulting image is saved as “Bob’sImage1”. The variable NumVar1 is then incremented by 1 and now becomes 2. The loop is then repeated and the second image is saved as “Bob’sImage2”. This process is repeated for as many iterations as were set when the loop was defined. Once the iterations are completed, Command E1 is carried out.

Timing Commands

**DELAY**

*Purpose and Use*

The DELAY Command is used to pause the playing of the macro program for a set period of time.

The DELAY Command can be useful when the user needs a prescribed delay period between commands being carried out and may be especially useful when carrying out a repeating series of commands within a loop where there is a desire for a time delay between loop iterations (for example, in order to manually move a stage).

*The Macro Window and DELAY*

When the DELAY Command is selected from the command screen, it is added to the development pane below the highlighted command in the development pane.

*Window specific to DELAY*

When the DELAY command is selected, in addition to the Macro Window command insertion noted above, a Delay window will appear over the Macro Window. It will require the user to define the amount of time that the macro program should wait before carrying out the next command in the sequence.

*Generic Example using DELAY*

```
Begin Macro (automatically added when the window is opened)
Begin Loop
Command A1
Command B1
```
Command C1
Command D1
Delay
End Loop
Command E1
End Macro (automatically added when the window is opened)

In the generic example, the macro will begin the loop series by completing Command A1 through D1 on the first iteration of the loop. At that point, the program will pause for a prescribed period of time before initiating loop iteration #2. The delay will also occur prior to the program leaving the loop and processing Command E1, once all of the loop iterations have been completed.

**WAITUNTIL**

*Purpose and Use*

The WAITUNTIL Command is used to pause the playing of the macro program until a specific restart date and time.

The WAITUNTIL Command can be useful when the user needs to prescribe a defined start time for a series of commands that follow the WAITUNTIL command. This command can allow a user to automatically start an imaging sequence even while he/she is away from the imaging set-up.

*The Macro Window and WAITUNTIL*

When the WAITUNTIL Command is selected from the command screen, it is added to the development pane below the highlighted command in the development pane.

*Window specific to WAITUNTIL*

When the WAITUNTIL Command is selected, a window specific to this command opens over the Macro Window. The user is required to define a date and time.

![Wait Until Window](image)

The date format can be entered in various numerical formats as long as the month, date, and year are separated by spaces, dashes, forward slashes, commas, or periods in that order. Other formats will generate an

*Note:*

The WAITUNTIL Command is referenced to the time and date set in your computer's operating system. Please make sure that the operating system time and date are accurate before using this function.

*Generic Example using WAITUNTIL*

Begin Macro (automatically added when the window is opened)

WaitUntil
Begin Loop
Command A1
Command B1
Command C1
Command D1
End Loop
End Macro (automatically added when the window is opened)

In the generic example, the macro will begin running, but will pause until the date and time specified by the WAITUNTIL command. Once that time is achieved, the loop series will begin for the prescribed number of iterations before completing the macro.

**WAIT FOR SENSOR TEMPERATURE (Pursuit and Xplorer only)**

*Purpose and Use*

The WAIT FOR SENSOR TEMPERATURE command is used to pause the macro until the CCD sensor has reached a specified temperature. Since the amount of dark current noise present is proportional to the CCD sensor temperature, using the WAIT FOR SENSOR TEMPERATURE command allows the user to capture pictures with similar noise characteristics.

*The Macro Window and WAIT FOR SENSOR TEMPERATURE*

When the WAIT FOR SENSOR TEMPERATURE Command is selected from the command selection pane in the Macro Window the command will be inserted into the Macro program in the development pane, just below the previously highlighted command.

*Window specific to WAIT FOR SENSOR TEMPERATURE*

When the WAIT FOR SENSOR TEMPERATURE Command is selected, a window specific to this command opens over the Macro Window. The user is required to define a target temperature range.

*Generic Example using END MACRO*

Begin Macro (automatically added when the window is opened)
Wait for Sensor Temperature
Get Image
Delay
Wait for Sensor Temperature
Get Image
End Macro (automatically added when the window is opened)

In the generic example, the macro will take two pictures with the same noise characteristics, regardless of ambient temperature changes and how long the delay is.
**END MACRO**

*Purpose and Use*

The END MACRO Command defines an endpoint to the Macro subroutine. This command is automatically placed as the macro endpoint when a new macro is created. This END MACRO command is supplemental and can be added anywhere throughout the macro program.

This command can be effective when the user would like to end a macro before it has completed all of its program steps. This is useful as a temporary interrupt to a rather large and complex macro that can yield effective results by just running a portion of the macro. The intermediate END MACRO Command can be switched on and off using the disable feature. This allows the flexibility during playback without significant modification to the base complex macro.

More commonly, however, the intermediate END MACRO Command can be used following an IF statement. This allows the user to exit a macro once a specific condition has been met.

*The Macro Window and END MACRO*

When the END MACRO Command is selected from the command selection pane in the Macro Window the command will be inserted into the Macro program in the development pane, just below the previously highlighted command.

*Window specific to END MACRO*

There is no window specific to this command.

*Generic Example using END MACRO*

```
Begin Macro (automatically added when the window is opened)
Begin Loop
Command A1
Command B1
Command C1
Command D1
End Loop
IF Command
End Macro
Command E1
Command F1
Command …
End Macro (automatically added when the window is opened)
```

In the generic example, the macro will begin the loop series by completing Command A1 and D1 for as many iterations as were defined. If a condition is proved true for the IF Command, the macro will end prior to carrying out Commands E1, F1, etc.

**Communication Commands**

**PLAY SOUND**

*Purpose and Use*

The PLAY SOUND Command instructs the computer to play an audible sound.
This can be quite useful in notifying the user when a point in the macro program has been reached. This point might indicate a need for user input (interactive mode) or may simply indicate that a portion of the imaging process has been completed.

The Macro Window and PLAY SOUND
When the PLAY SOUND Command is selected from the command selection pane in the Macro Window the command will be inserted into the Macro program in the development pane just after the previously highlighted command.

Window specific to PLAY SOUND
When PLAY SOUND is selected a Play Sound window will appear over the Macro Window. It will ask the user to define the sound file (.wav) to be used during playback. The Play Sound window will look like this:

The user may define the path used to access the sound file, or may use the browse button to search for a particular sound file located on the computer or the network, selecting it from the browsing window.

Generic Example using PLAY SOUND

```plaintext
Begin Macro (automatically added when the window is opened)
Begin Loop
Command A1
Command B1
Command C1
Command D1
End Loop
Command E1
Play Sound
End Macro (automatically added when the window is opened)
```

In the generic example, the PLAY SOUND command will access and play an audio file to indicate to the user that the macro program has been completed.

PROMPT USER

Purpose and Use
The Prompt User Command prompts the user to take an action and/or to input data at a certain point in the macro program playback. Entered data is then stored in one of the pre-defined data labels (NumVar or TextVar) for use later in the program.

The Macro Window and PROMPT USER

When the PROMPT USER Command is selected from the command selection pane in the Macro Window the command will be placed just below the previously highlighted command in the Development pane of the Macro Window.

Window specific to PROMPT USER

When PROMPT USER is selected, a Prompt User window will appear over the Macro Window. It will ask the user to define a number of inputs needed to make the PROMPT USER functional during playback. The Prompt User window has many different looks and may appear like the following, depending upon the Input Type selected from the dropdown menu.

The Prompt User window includes a drop down menu that allows for 6 predefined options. These options include OK, Yes/No Buttons, User Text, User Numeric, Push Buttons, or Choice List (see Table B. Prompt User Options for more details about this feature).

The Prompt User window also includes a Play Sound checkbox. Select the Play Sound option if you would like a sound to play after the user has been prompted and/or until they have responded. The sound will help notify the user that a response is necessary. To use this feature, follow these steps:

1. Check the box next to Play Sound.
2. Define the path to access the sound file, or use the browse button to locate a sound file.
3. If you would like the sound to repeat until the user has responded, select the Repeat checkbox and specify a time interval between the sounds.

Generic Example using PROMPT USER

<table>
<thead>
<tr>
<th>Begin Macro (automatically added)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Loop</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
<tr>
<td>Command C1</td>
</tr>
<tr>
<td>Command D1</td>
</tr>
<tr>
<td>End Loop</td>
</tr>
<tr>
<td>Command E1</td>
</tr>
<tr>
<td>Prompt User</td>
</tr>
<tr>
<td>End Macro (automatically added)</td>
</tr>
</tbody>
</table>
In the generic example, the PROMPT USER command will generate an on-screen message associated with an OK button and play a sound that repeats every second. Once the OK has been pushed, the sound will stop playing and the macro will move on to the next command, in this case, to end the macro.

### Table B. Prompt User Options

<table>
<thead>
<tr>
<th>Prompt Type</th>
<th>Records your response?</th>
<th>General Use</th>
<th>General Response on Macro Playback</th>
<th>Selectable Default Response Available with this command?</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK Button</td>
<td>No</td>
<td>To confirm that an action or point in time has occurred in the macro. Allows for a customized message (Prompt Text) to indicate the action or point in time.</td>
<td>Click OK</td>
<td>None</td>
</tr>
<tr>
<td>Yes/No button</td>
<td>Yes</td>
<td>Asks a question (Prompt Text) that requires a yes or no answer.</td>
<td>Click Yes or No</td>
<td>Yes - Selectable between yes and no as the default.</td>
</tr>
<tr>
<td>User Text</td>
<td>Yes</td>
<td>Allows for a statement or question (Prompt Text) and a place to add a comment or an answer.</td>
<td>Add a comment or answer and click OK</td>
<td>Yes - Allows for a default answer to be placed in the response area that can be overwritten.</td>
</tr>
<tr>
<td>User Numeric</td>
<td>Yes</td>
<td>Allows for a statement or question (Prompt Text) and a place to add a numeric response.</td>
<td>Add a numeric value</td>
<td>Yes - Allows for a default value to be placed in the response area that can be overwritten.</td>
</tr>
<tr>
<td>Push buttons</td>
<td>Yes</td>
<td>Allows for a statement or question (Prompt Text) and a user-defined response via pushbuttons.</td>
<td>Click on one of the user-defined pushbuttons</td>
<td>Yes - Selectable between any of the user-defined buttons as the default.</td>
</tr>
<tr>
<td>Choice List</td>
<td>Yes</td>
<td>Allows for a statement or question (Prompt Text) and a user-defined response from a dropdown list.</td>
<td>Click on one of the user-defined choices in the dropdown list</td>
<td>Yes - Selectable between any of the user-defined choices in the dropdown list as the default.</td>
</tr>
</tbody>
</table>
as the default.
RUN REPORT

Purpose and Use
The RUN REPORT Command instructs the program to automatically execute a report file.

The Macro Window and RUN REPORT
When the RUN REPORT Command is selected from the command selection pane in the Macro Window the command will be inserted just below the previously highlighted command in the development pane of the Macro Window.

Window specific to RUN REPORT
When RUN REPORT is selected, a Run Report window will appear over the Macro Window. It will ask the user to define a number of inputs needed to define the report to be accessed.

Generic Example using RUN REPORT

<table>
<thead>
<tr>
<th>Begin Macro (automatically added when the window is opened)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Loop</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
<tr>
<td>Command C1</td>
</tr>
<tr>
<td>Command D1</td>
</tr>
<tr>
<td>End Loop</td>
</tr>
<tr>
<td>Command E1</td>
</tr>
<tr>
<td>Run Report</td>
</tr>
<tr>
<td>End Macro (automatically added when the window is opened)</td>
</tr>
</tbody>
</table>

In the generic example, the RUN REPORT Command will initiate the opening and display (or printing) of the specified report.

SEND PERIPHERAL DEVICE COMMAND

Purpose and Use
The SEND PERIPHERAL DEVICE COMMAND instructs the program to automatically execute a peripheral device command. In order to use this macro command, it is necessary to first input the commands for your external device. For instructions on entering external device commands, see Chapter 4- The Advanced Program Mode.

The Macro Window and SEND PERIPHERAL DEVICE COMMAND
When SEND PERIPHERAL DEVICE COMMAND is selected from the command selection pane in the Macro Window the chosen command will be inserted just below the previously highlighted command in the development pane of the Macro Window.

Window specific to SEND PERIPHERAL DEVICE COMMAND
When SEND PERIPHERAL DEVICE COMMAND is selected, the user will need to select the external device and desired command.
**EXECUTE OS COMMAND**

**Purpose and Use**

The EXECUTE OS COMMAND instructs the program to run an executable file from outside of the SPOT program, and allows the user to automatically open that file as part of the macro program. Users who are familiar with DOS will recognize this as a DOS command line.

**The Macro Window and EXECUTE OS COMMAND**

When the EXECUTE OS COMMAND is selected in the command selection pane, the command will be placed just below the previously highlighted command in the development pane of the Macro Window.

**Window specific to EXECUTE OS COMMAND**

When this command is selected, a window will appear over the Macro Window. It will ask the user to define a path to access the executable file. There is a browsing feature that allows the user to search the computer for the appropriate executable filename. Selecting from the browse window automatically determines the path for the macro program.

If the name of the file includes a variable, insert it into the path by using the Insert Variable button and selecting the appropriate variable. Select the Pause Macro until Done checkbox to pause the macro program until the executable file has been completed.
Generic Example using EXECUTE OS COMMAND

<table>
<thead>
<tr>
<th>Begin Macro (automatically added when the window is opened)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Loop</td>
</tr>
<tr>
<td>Command A1</td>
</tr>
<tr>
<td>Command B1</td>
</tr>
<tr>
<td>Command C1</td>
</tr>
<tr>
<td>Command D1</td>
</tr>
<tr>
<td>End Loop</td>
</tr>
<tr>
<td>Execute OS command</td>
</tr>
<tr>
<td>End Macro (automatically added when the window is opened)</td>
</tr>
</tbody>
</table>

In the generic example, the EXECUTE OS COMMAND opens a program after the loop command series has been completed.
Ch. 14 – Using Other Windows Imaging Applications in Advanced Mode

Introduction

The SPOT software is TWAIN compliant. The TWAIN interface, as an alternative to the stand-alone SPOT software, allows Windows users to use other imaging programs (e.g., Photoshop or Image Pro) to view, and edit images that were captured using the SPOT camera and software. For example, using the TWAIN interface and the SPOT camera, you can capture an image from within Photoshop and then transfer the image into PhotoShop to be edited and saved. The following chapter details the use of the SPOT TWAIN interface via Adobe Photoshop 7.0.

Note: Adobe Photoshop was selected as the example to illustrate SPOT’s TWAIN features because it is one of the most commonly used “TWAIN capable” image editing programs.

This chapter is divided into two sections.
• Preparing to Take a Picture
• Taking a Picture

Note: Because the image setup and image capture functionality is identical in the stand-alone and TWAIN interface versions of the software, these sections reference other chapters in the manual.

Preparing to Take a Picture

The TWAIN interface provides you with the same image setup options as the stand-alone version of the SPOT software. There are two main tasks in preparing to capture an image.
• Establishing the TWAIN Interface
• Defining an Image Setup

Establishing the TWAIN Interface

To use the SPOT camera and software via Photoshop, establish the TWAIN interface by defining the SPOT software as the default TWAIN source. Follow these steps:

1. Open Photoshop.
2. Define the source of the program that you want to interface with (in this case the SPOT software). From the File menu, select Import.
3. Select SPOT Camera (Advanced) Camera, and click on it.

Note: To work in the Basic mode TWAIN interface, select SPOT Camera (Basic). Refer to Ch. 15 – Using Other Windows Imaging Applications in Basic Mode.

4. The SPOT Camera window appears within Photoshop, as shown at the right. You are now ready to capture images using the TWAIN interface in Photoshop.

Refer to the next sections, Defining Live Image Preferences and Defining Image Setups, for details on how to define imaging settings using the TWAIN interface.
Defining Live Image Preferences

The TWAIN window includes a Preferences button, which allows you to define live image viewing, exposure and other preferences. The window includes the following options:

- Image Capture Section
- Make Shutter Sound
- Monitor Camera Color Filter Position (Slider only)
- Set Exposure Conversion Factor (RT only)
- Live Images Section
- Always Show Full Chip
- Maximum Exposure time
- Do Post-processing on Snapped Images
- Close window on snap option
- Bus Section (Firewire cameras only)
- Bandwidth size
- Temperature Readout Section (Pursuit and Xplorer cameras only)
- Sensor Temperature Readout Timing

Image Capture Section

Make Shutter Sound

The user may select whether to utilize the audible shutter sound when capturing an image.

Monitor Camera Color Filter Position

(Slider Cameras Only)

Determine whether to monitor the position of the color filter. The Monitor Camera Color Filter Position box is checked as a default. If this option is left checked, the SPOT program displays error messages when the sensors in the camera head detect that the color filter is not in the correct position. This option does not monitor the position of the filter slider in Live Image mode. In Basic mode, the program will give you an error message if you are capturing an image and the sliding color filter is in the B/W position.

Set Exposure Conversion Factor (RT Cameras only)

RT camera users may have noticed in the past, that image brightness differences existed between Live Images and Captured Images when using the Snap method of capturing an image in the Advanced program mode. The SPOT program now allows for users to correct for this difference by using the Set Exposure Conversion Factor function.

This function is used to adjust the relative image brightness between the Live Image and the captured image. You may elect to have the SPOT program compute the conversion factor or you may select the conversion factor yourself.
If you choose to have the SPOT program compute the conversion factor, program will prompt you with a window asking you to “move to sample”. You should set the imaging area to a moderately bright sample. Once you have done so and select OK, the SPOT program does the rest and places the computed exposure factor in the Conversion Factor window.

If you choose to set the factor yourself, you may want to open a Live Image window, set the conversion factor, and then use Snap to capture an image. Compare the two images. If you are satisfied that the two are at a similar brightness level, leave the conversion factor. If you are not satisfied, reset the conversion factor and Snap another image. Repeat this process until you are satisfied.

Setting a conversion factor less than 1 will decreases the brightness of the captured image when compared to the live image. Setting a conversion factor greater than one will increase the brightness of the captured image relative to the live image.

Live Images Section

Always Show Full Chip

Always display the full chip in live image mode. If you select a region, it will be displayed in a rectangular outline within the full-chip view.

Maximum Exposure

The Maximum Exposure option helps you to avoid unnecessarily long exposures when viewing a live image. Consider the following situation: When you change from a lower resolution objective to a higher resolution objective, the camera detects a brief interval of blackness and compensates by modifying the exposure time to maintain a constant brightness level. This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the Maximum Exposure option, you can limit this exposure time. For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path selector is incorrectly set.

Do Post-Processing on Snapped Images

Specify whether to apply the Post Processing options for the current Image Setup to images captured using the Snap option. When selected, all of the Post Processing options from the current Image Setup will be applied except for Background Subtraction and Flatfield Correction.

Close Window on Snap

Selecting this option will close the Live Image Window each time you capture an image using the Snap button in that window. If this option is not selected, captured images from snap will “stack up” behind the live image window.
Bus Section (Firewire cameras only)

**Bandwidth**

For the Firewire cameras, you can select the relative amount of bandwidth that your system will utilize to capture and transfer images between the camera and your computer. Choices are High, Medium, and Low.

Temperature Readout Section (Xplorer and Pursuit cameras only)

This section allows you to specify the time interval between temperature readouts. The default time interval is 30 seconds. The CCD temperature is displayed in the upper left corner of the Twain window.

**Keep TWAIN window on top**

The Keep TWAIN Window on Top option allows you to preview and transfer or acquire multiple images without having to re-open the SPOT window.

- If the Keep This Window on Top box is checked, the SPOT window remains open.
- If the box is not checked, the SPOT window automatically closes after each image is transferred or acquired.

**Device**

The Device option allows you to select from a variety of image acquisition devices for previewing and capturing images through the TWAIN interface. These can be selected and changed “on the fly”. Once you have selected a different device, the TWAIN window will update automatically to include options consistent with the selected device.

**The Palettes option (Monochrome and Slider cameras only)**

The Palettes option allows you to define new palettes and edit existing palettes.

SPOT color palettes allow you to apply specific hue and saturation values to monochrome images. Palettes are useful in fluorescence applications where a sample is fluorescing at a single wavelength, and you want the acquired image to have the correct color. For such a case, you could create a palette to represent the color of the fluorescent dye and then apply that palette to the captured image. There are two ways to apply a palette to an image:

- You can associate a palette with an Image Setup, as discussed in Ch. 5 - Preparing to Take a Picture.
- You can apply a palette to a captured image by selecting the Set Palette option from the Edit menu. Refer to Ch. 8 – Viewing, Editing, and Annotating Images for more details.
To define a new palette, follow these steps:

1. From the Setup menu, select Palettes.
2. Click on Add. The Color Palette dialog appears as shown here:
3. Use the Hue and Saturation selection lists, select a Wavelength, or move the cross hairs on the color wheel to enter the values.
   - Wavelength allows the user to specify the exact wavelength ranging in value from 400nm to 700 nm. Wavelengths will automatically correspond to various Hues at full (100%) saturation.
   - Hue is the designation for the actual color, as distinguished from others in the color spectrum. Hue is derived from the color wheel and is expressed in the color's angular location (in degrees) on the wheel. (e.g., 0° to 360°).
   - Saturation is the proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero is pure gray and 100 is pure hue (e.g., day glow).
4. Click on OK.

Defining Image Setups

An image setup serves two crucial purposes:
- It defines the way a picture will be taken.
- It defines the way the program automatically modifies a picture after it is taken.

Image setups are defined to optimize the picture taking process for different types of images or microscopy techniques. They can be created, saved, and recalled as needed. To define a new image setup, you may select one of 11 pre-defined image types as a template for defining the new setup (auto-exposure) or define the settings yourself (manual exposure). The 11 pre-defined image types (in addition to the Factory Defaults setting) correspond to commonly used microscopy techniques.

The Image Setup window is now comprised of 7 separate windows. Refer to Ch. 5- Preparing to Take a Picture for a table of the different image types.

- To modify the current image setup, click on the Modify button.
- To delete an image setup, select the image setup from the list, and click on the Delete button.
- To define a new image setup, click on the Add button. The New Image Setup window appears with a list of pre-defined and user-defined templates (image types). Brackets indicate pre-defined image types < >. Select a template, and click on OK.
- When you add a new image setup or modify an existing setup, the Image Setup window appears, as shown at right. Refer to Ch. 5 – Preparing to Take a Picture for a detailed explanation of the Image Setup options.

| B/W and Color Mosaic Cameras only | B/W and Color Mosaic camera users will not see the fluorescence – red, fluorescence – green, and fluorescence – blue Image Type options. |

Taking a Picture

From the SPOT TWAIN interface, you can perform both initial image captures (i.e., for computing exposure, white balance, etc…) and final image captures.

Capturing Initial Images

The toolbar at the left of the SPOT Camera window enables you to quickly access the functions that are used prior to the capture of the final image.
Monochrome camera users will not see the Compute White Balance Values toolbar button.

Capturing Final Images

From the SPOT TWAIN interface, you can capture an image in two different ways. You can preview the image and transfer it to Photoshop, or you can acquire the image, which sends the captured image directly to Photoshop.

- **Preview** – Capture an image and preview it within the SPOT TWAIN window.
- **Transfer** – Transfer a captured image to Photoshop.
- **Acquire** - Capture an image and have it automatically transfer to (open in) Photoshop.
Introduction

The SPOT software is TWAIN compliant. The Basic TWAIN interface, as an alternative to the stand-alone SPOT software, allows Windows users to use other imaging programs (e.g., Photoshop or Image Pro) to view, and edit images that were captured using the SPOT camera and software. For example, using the Basic TWAIN interface and the SPOT camera, you can capture an image from within Photoshop and then transfer the image into Photoshop to be edited and saved. As with the stand-alone version of the SPOT software, the TWAIN interface can be used in both Basic and Advanced modes. The following chapter describes only the Basic TWAIN Interface.

Establishing the TWAIN Interface

To use the SPOT camera and software via a TWAIN compliant imaging application (e.g., Photoshop, Image-Pro, etc…), you must first set the SPOT software as the default TWAIN source.

Follow these steps:

1. Open the TWAIN compliant application e.g., Photoshop, Image-Pro, etc…
2. Specify the source of the program that you want to interface with (i.e., the SPOT software). The procedure for this step will vary according to the software you are using, but you should see a list of TWAIN devices. In many cases, the application asks you to specify a scanning device.
3. Choose SPOT camera (Basic Mode). This establishes the SPOT software as the default TWAIN source.
4. Open the TWAIN interface. Again, this step varies according to the software you are using. The SPOT Camera window appears within the application, as shown at right.

Refer to the next sections for descriptions of the available options on the TWAIN interface.

Working in the Basic TWAIN Interface

The Basic TWAIN interface is a one-stop point for previewing and capturing images. For example, using the Basic TWAIN interface, a typical image capture session might involve the following steps, as illustrated below:
Preview your specimen

Use the live image as a point of reference to focus and position the image and to scan for areas of interest.

Create a Profile

Profiles allow you to create, modify, and reuse specific exposures settings that are tailored to your image capture needs. To create a new profile, right click on the Profile box.
Define Settings

Define exposure settings for live and captured images. Each of these settings is discussed later in this chapter.

Capture an Image

All of the image capture options are located on the bottom portion of the window, as illustrated here.

Defining Preferences

The TWAIN window includes a Prefs button, which allows you to define live image viewing, exposure and other preferences. The window includes the following options:

- Image Capture Section
- Captured Image Bits per Channel
• Make Shutter Sound
• Live Images Section
• Always Show Full Chip
• Bus Section (Firewire cameras only)
• Bandwidth size
• Temperature Readout Section (Xplorer and Pursuit cameras only)
• Sensor Temperature Readout Timing

Image Capture Section

**Captured Image Bits per Channel**

This option enables you to specify a different image bit depth when saving an image captured in the SPOT program.

- **8 Bits per Channel** – The 8 bits per channel option provides 256 gray levels per color:
  
  With B/W cameras, captured images are 8 bits per pixel monochrome.
  With Color cameras, captured images are 24 bits per pixel RGB color.
  
  This option results in smaller, more manageable image sizes, and is best for images that do not require extensive modification.

- **12 Bits per Channel** – The 12 Bits per channel option provides 4,096 gray levels per color.
  
  With B/W cameras, captured images are 12 bits per pixel monochrome.
  With Color cameras, captured images are 36 bits per pixel RGB color.
  
  This option reduces banding problems that can result with modified images, but also results in larger file sizes.
  
  When saving 12 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 bits per channel. If you use Adobe’s Photoshop for image editing, you should select the 16 bit per channel option because Photoshop cannot read 12 bit per channel images.

- **14 Bits per Channel** – The 14 bits per channel option provides 16,384 gray levels per color. This option is available only with some camera models.
  
  With B/W cameras, captured images are 14 bits per pixel monochrome.
  With Color cameras, captured images are 42 bits per pixel RGB color.
  
  This option further reduces banding problems that can result with modified images, but also results in larger file sizes.
  
  When saving 14 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 bits per channel. If you use Adobe’s Photoshop for image editing, you should select the 16 bit per channel option because Photoshop cannot read 12 bit per channel images.

**Make Shutter Sound**

The user may select whether to utilize the audible shutter sound when capturing an image.
Monitor Camera Color Filter Position (Slider cameras only)

Determine whether to monitor the position of the color filter. The Monitor Camera Color Filter Position box is checked as a default. If this option is left checked, the SPOT program displays error messages when the sensors in the camera head detect that the color filter is not in the correct position. This option does not monitor the position of the filter slider in Live Image mode. In Basic mode, the program will give you an error message if you are capturing an image and the sliding color filter is in the B/W position.

Set Exposure Conversion Factor (RT Cameras Only)

The Set Exposure Conversion Factor function enables you to match the light intensity in the live mode with what is present in the capture mode. This compensates for the differences due to the use of different electronic circuitry in the live mode as compared to the capture mode. To use Set Exposure Conversion Factor, follow these steps:

1. From the Camera menu, select Set Exposure Conversion Factor. The Set Exposure Conversion Factor dialogue box appears with a default conversion factor displayed.
2. Select Compute. A dialogue box will prompt you to “Move to sample for exposure computation”. Ensure that your sample is in field of view and click OK.
3. The SPOT software will compute the appropriate conversion factor. Click OK to finish.

Live Images Section

Always Show Full Chip

Always display the full chip in live image mode. If you select a region, it will be displayed in a rectangular outline within the full-chip view.

Bus Section (Firewire cameras only)

Bandwidth

For the FireWire cameras, you can select the relative amount of bandwidth that your system will utilize to capture and transfer images between the camera and your computer. Choices are High, Medium, and Low.

Temperature Readout Section (Pursuit and Xplorer cameras only)

This section allows you to specify the time interval between temperature readouts. The default time interval is 30 seconds. The CCD temperature is displayed in the upper left corner of the Twain window.

Keep TWAIN window on top

The Keep TWAIN Window on Top option allows you to preview and transfer or acquire multiple images without having to re-open the SPOT window.

• If the Keep This Window on Top box is checked, the SPOT window remains open.
• If the box is not checked, the SPOT window automatically closes after each image is transferred or acquired.
F-Keys

The following function keys are available as shortcuts in the Basic TWAIN interface:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Action</th>
<th>TWAIN Interface Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F 4]</td>
<td>Restart the live image view.</td>
<td>Live</td>
</tr>
<tr>
<td>[Alt] + [F 4]</td>
<td>Close the SPOT Camera window.</td>
<td>Close</td>
</tr>
<tr>
<td>[F 9]</td>
<td>Capture an image and automatically transfer it to the imaging application.</td>
<td>Acquire</td>
</tr>
<tr>
<td>[Ctrl] + [F 10]</td>
<td>Compute white balance values.</td>
<td>White Balance</td>
</tr>
<tr>
<td>[Alt] + [F 10]</td>
<td>Compute white balance values without displaying the informational dialog.</td>
<td>Not available from the window</td>
</tr>
</tbody>
</table>

Using the Live Image to Define Image Capture Settings

When you open the Basic mode TWAIN Interface, the Live Image window is, by default, running, as indicated by the **Live Mode Running** message in the status bar. The settings options in the TWAIN interface window enable you to optimize the live image view, and then capture an image using these settings. In the TWAIN interface, you can:

- Create profiles to use as pre-defined image capture settings.
- Modify exposure settings.
- Define a specific portion of the chip to be used in the image capture.
- Modify the screen orientation of the specimen.

The following sections describe all of the Live Image/Image Capture Settings.

Profile

The **Profile** option allows you to create and re-use sets of live image/image capture settings. When you open the TWAIN interface, the **Default** Profile is selected. When you make changes to any of the live image/image capture settings, these changes can be saved to a Profile – either the Default or one that you have defined. For example, if you gamma adjust a live image and then decide that the result is ideal for the type of specimen you are working with, you could create a new Profile with the gamma and exposure values and name it for that type of specimen – i.e., “Diseased Cells.”

To add, edit, or delete Profiles, **right-click** on the Profile box. Right clicking gives the following options:

- **Add** – Add a new Profile. When you add a new Profile, the program prompts you to name it.
- **Save** – Save a Profile that you have modified.
- **Rename** – Rename an existing Profile.
- **Delete** - Delete a Profile. This option appears only after you have defined a second Profile in addition to the Default Profile.

Each profile is divided into three windows:

- Exposure/Brightness
- Area/Orientation
- Image Processing
- The options available in these windows are detailed below.
Exposure/Brightness Window

**Exposure: Auto or Manual**

The **Exposure** option gives you the choice of having the camera calculate exposure time (**Auto**), or setting the exposure on your own (**Manual**). The exposure options will vary according to whether you select **Auto** or **Manual**, as illustrated below.

When you enter one of the above exposure settings, note that it applies **both** to the live image that you are viewing and the captured image.
Auto Exposure-specific options

Image Type

An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 available Image Types (see below) corresponds to a microscopy technique: select the Image Type that matches the technique you are using. The camera will capture the image accordingly. The table below describes typical situations for each image type.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-reflected light</td>
<td>Polished metallurgical specimens and semi-conductors using a microscope with a vertical illuminator.</td>
</tr>
<tr>
<td>Brightfield-transmitted light</td>
<td>Stained specimens on glass slides using transmitted light microscopes.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Bright areas of specimens being viewed with darkfield, reflected light techniques.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Bright specimens on dark backgrounds using transmitted light darkfield technique.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Fluorescence specimens not fluorescing in a single red, green, or blue primary color</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>Specimens being viewed with either Nomarski DIC or Hoffman techniques.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Specimens being viewed using the phase contrast technique.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Specimens being viewed with polarized light techniques.</td>
</tr>
<tr>
<td>Stereo/macro-metallic glints</td>
<td>Metallic specimens with intense glints.</td>
</tr>
<tr>
<td>Stereo/macro–no glints</td>
<td>Matte specimens without bright glints.</td>
</tr>
<tr>
<td>Stereo/macro–shiny glints</td>
<td>Shiny specimens with bright glints.</td>
</tr>
</tbody>
</table>

Brightness

Enter a Brightness value between 0.24 and 3.4. A brightness value of 1, the default value, gives you the correct image brightness for most images. The Brightness control allows you to overexpose or underexpose (darken or lighten) the image area. In many cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or darken the image. When using the Brightness control, the SPOT camera uses an algorithm that combines gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode:

- When overexposing images to make them brighter (i.e., entering values greater than one), the camera first selects the highest possible gain before lengthening the exposure time. Because gain also brightens an image, less exposure time is needed.
- When underexposing images to make them darker (i.e., entering values less than one) the camera uses the lowest possible exposure time before lowering the gain.

Quality/Speed (Auto)

Use the slider to balance speed and quality when previewing dim images.

- Moving the slider toward the Quality side increases image quality and decreases frame rates.
- Moving the slider toward the Speed side increases frame rates and decreases image quality.

The Quality/Speed measurement corresponds to the Auto-Gain limit setting, which allows you to set an upper limit on the gain options that will be available during the Auto-Exposure process.

- When the slider is at the left-most point, the Auto-Gain Limit gives you higher quality pictures, but lengthier exposure times.
• When the slider is at the right-most point, the Auto-Gain Limit allows the camera to select from all available gain options. This shortens exposure times, but decreases image quality.

Refer to the “Auto-Gain Limit” section in Ch. 5 – Preparing to Take a Picture for a detailed explanation of gain and exposure.

Live Image Auto-Brightness

Available only when you are using Auto exposure and viewing a live image, the Live Image Auto-Brightness option enables you to maintain a consistent brightness level for changing specimens.

Manual Exposure-Specific Options

Exposure Time(s)

Use the slider-bar to specify an exposure time (or times). When you specify an exposure time, the camera skips the automated exposure sequence that takes place when you open the live image view – i.e., the TWAIN interface. This is very useful in cases where exposure times are lengthy, as with fluorescence samples.

Gain

Use the slider-bar to select one of the gain options. The gain value displays to the right of the slider-bar. Refer to the “Auto-Gain Limit” and “Gain” sections of Ch. 5 – Preparing to Take a Picture for details on gain and exposure.

Other Exposure/Brightness Options

Binning

Binning combines adjacent pixels on the CCD chip, thereby reducing the number of pixels used in the image capture. Binning is useful when you have dim images and want to increase sensitivity and reduce download time. This gives you higher frame rates and less noisy images. But, as binning level increases, image resolution decreases. All of these factors should be considered when you select a binning option.

The binning options vary depending on the camera model. Here are some possible choices:

- None 1 pixel = 1 pixel
- 2 x 2 4 pixels = 1 pixel
- 3 x 3 9 pixels = 1 pixel
- 4 x 4 16 pixels = 1 pixel
- 8 x 8 64 pixels = 1 pixel

Note: If your camera is a color mosaic version, binning will collapse the color data, resulting in a monochrome image.

Exposure Limits – Minimum

Because SPOT cameras are capable of extremely short exposure times, light sources with intensities that vary with the waveform of the 60 Hz line supply (e.g., fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps) can cause the Live Image window to flicker and result in incorrect brightness and color balance readings in captured images. This option allows you to correct for these problems by limiting the camera to a minimum exposure time that is greater than the pulse interval of the light source.
Exposure Limits – Live Image Maximum

The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing a live image. Consider the following situation: When you change from a lower resolution objective to a higher resolution objective, the camera detects a brief interval of blackness. When the Auto-Brightness option (see above) is enabled, it compensates by modifying the exposure time to maintain a constant brightness level. This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the Live Image Maximum option, you can limit this exposure time. For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path selector is incorrectly set.

Filter Color (3-Shot Color, Slider Cameras)

The Filter Color option specifies the color or colors that will be exposed in the live image preview/image capture.

- **Red** – Preview/capture a monochrome preview of your specimen using the red state of the LCD filter.
- **Green** – Preview/capture a monochrome preview of your specimen using the green state of the LCD filter.
- **Blue** – Preview/capture a monochrome preview of your specimen using the blue state of the LCD filter.
- **Clear** – Preview/capture a monochrome preview of your specimen using the clear state of the LCD filter.

Display Images in Grayscale (3-Shot Color, Slider Cameras)

To counter the difficulty of viewing, focusing, and adjusting monochrome images in live mode, the Display Images in Grayscale option enables you to view a monochrome image in grayscale, as opposed to with the red, green, or blue filter. This option applies only when the Filter Color (see above) is set to Red, Green, or Blue.

Area/Orientation Window

Chip Imaging Area

SPOT allows you to use any rectangular portion of the CCD chip for image capture. Using a portion of the chip is helpful in cases where you want to:

- Keep file sizes small.
- Shorten download times.
- Avoid areas of the image with optical problems (e.g., vignette areas).
- There are three image area options:
  - **Full Chip** – Capture the entire area of the CCD chip.
• **Center** – Capture a rectangular part of the CCD chip’s area that has the same height-to-width ratio as the full chip, and is centered on the center of the full chip. The percentage that you enter is the percentage of full chip width that the new area’s width will be.

• To capture a centered proportion of an image, follow these steps:
  
  Check the Center option.
  Enter the percentage of the image that you want to capture. The minimum percentage is 10 and the maximum is 100.
  Capture the image.

• **Selection** – Capture a specific part of the CCD chip.
  
  Check the Selection option.
  Use the mouse to select a region for capture. Click and drag to define the selection. Note that the new pixel dimensions display in the status bar.
  Capture the image.

When you are viewing a live image **Selection**, how this selection is displayed, depends on two other settings: the **Fit to Window** option (see below) and the **Always Show Full Chip in Live Mode** preference (see above). The following table illustrates the possibilities:

<table>
<thead>
<tr>
<th>Fit to Window Checked?</th>
<th>Always Show Full Chip in Live Mode Checked?</th>
<th>Selection Display</th>
<th>Live or Captured Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a <strong>yellow rectangle</strong>.</td>
<td>LIVE</td>
</tr>
<tr>
<td>YES</td>
<td>NO</td>
<td>When you select a portion of the chip the cursor is a <strong>zoom tool</strong>. To zoom in on a portion of a live or captured image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the <strong>Full Chip</strong> option.</td>
<td>BOTH</td>
</tr>
<tr>
<td>NO</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a yellow rectangle. However, because <strong>Fit to Window</strong> is not checked, you will not see the entire chip in the window.</td>
<td>LIVE</td>
</tr>
<tr>
<td>NO</td>
<td>NO</td>
<td>When you select a portion of the image, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the <strong>Full Chip</strong> option.</td>
<td>BOTH</td>
</tr>
</tbody>
</table>

**Flip**

Specify whether images will be flipped in the live image view and during the image capture process.

• Select **Horizontal** to flip the image from left to right.

• Select **Vertical** to flip the image from top to bottom.

• Select both options to flip the image from left to right and from top to bottom.

**Rotate 90°**

Specify whether images will be rotated in the live image view and during the image capture process.

• Select **None** if you do not want the image to be rotated.
• Select **Left 90°** to rotate the image counterclockwise 90 degrees
• Select **Right 90°** to rotate the image clockwise 90 degrees.

**Faster Readout (Live Images) (Insight 2 MP)**

Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

**Acceleration (Live Images) (Insight 4 MP, Flex, Pursuit, Xplorer cameras)**

Acceleration enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

**Image Processing Window**

**Gamma**

Enter a **Gamma** value between .1 and 4. Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for capturing/editing images with a wide range of brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., printed circuitry).

- Values between 1 and 4 lighten the darker areas of the image.
- Values between .1 and 1 darken the mid-tones of the image.

- Gamma adjustments on live images are made in the RGB color space, the only color space where adjustments can be made quickly enough to keep up with live imaging. Refer to Ch. 5 – Preparing to Take a Picture for more details on gamma adjustment and color spaces.

**Correct Color Enhancement (Correct Color Technology™) (Color Cameras only)**

The Correct Color Enhancement option utilizes camera dependent color correction profiles that optimize the matching of colors between your microscope specimen, the live image you view on the screen of your monitor, and the image you capture with your SPOT camera. This is done by transforming the raw camera color data allowing it to be adjusted to display the closest approximation of the same color on your monitor.

In order to get the best results using this feature, you should make sure you set up your imaging system including your computer monitor appropriately. See Appendix F for more information on system set-up.

Be aware that the color correction transformations that occur when you use Correct Color Enhancement will be applied to the raw image data, leaving a modified image file. If you will require the raw data for further analysis of your image, you should uncheck the Color Enhancement checkbox.
**Noise Filter**

The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with lengthy exposure times, the noise filter acts as a “virtual cooler” for the Insight camera, eliminating “hot pixels.”

The Noise Filter checks each pixel on the CCD chip as described below:

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels.
2. If none of the eight neighboring red pixels has a value within ±15% (i.e., the threshold value that the SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being checked is replaced with the average value of the eight neighboring red pixels.
3. The program repeats this procedure for the values of the green and blue pixels being checked.

To activate the Noise Filter, check the Noise Filter box. The program runs the noise filter each time an image is captured using the **Preview** or **Acquire** options.

**Flatfield (Captured Images)**

The Flatfield Correct option is used to correct for display problems associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system.

---

**Note:** Flatfield correction with the SPOT camera refers only to the correction of uneven lighting. It should not be confused with the correction of optical field flatness.

---

To use the **Flatfield** option, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.
2. Right click on the **Flatfield** drop-down list and click on the **Add** option. The **Get Flatfield** dialog appears as shown at right.
3. Choose a number of frames to average. Larger numbers of frames will increase the accuracy of the flatfield correction, but will also increase the length of time it takes to create the flatfield image. The default number of frames to average is 3.
4. Remove the slide from the field of view.
5. Click on **Begin**. The program will acquire the number of frames that you specified.
6. When the program finishes acquiring the frames, it will prompt you to block all of the light to the camera. This can be accomplished by installing the dust cap that was supplied with the camera or by adjusting the microscope’s optical path. After the light is blocked, click on **OK**. The program computes another frame.
7. After the program computes this frame, it prompts you to name and save the resulting flatfield correction file:
   
   Enter a name. Because flatfield image files are different for each objective, you might want to name the file according to the objective's magnification (e.g., 10x).
   
   **a)** Click on **OK**. If you do not specify a location, the program automatically saves the flatfield file to the `c:\SpotCam\Fltflds` directory.
8. Move the specimen back into the field of view, and perform the image capture, using either the Preview or the Acquire option.

White Balance (Color cameras only)

White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for an image. Many factors impact the coloration of an image capture, including lamp voltage, the coloration of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s objectives. To minimize the impact of these factors, use the White Balance feature. When you perform a white balance calculation, SPOT samples the color of the light from your light source after it has passed through the slide and the objective, and then calculates the red, green, and blue gains needed to produce images where the white areas are white and the color areas are true.

You should perform a new white balance calculation when:
- Starting a new image capture session.
- Changing the lamp voltage.
- Switching to a different objective on the microscope.

To perform a white balance, follow these steps:
1. Set the illumination and the objective that you will use for the image capture.
2. If you have not done so, select your Image Type (see above). Each Image Type has its own set of white balance values. Any white balance values that you compute for an image type remain linked to that image type until you compute new values. When selecting a new image type, remember that you will be using the white balance values linked to that image type.
3. Click on the White Balance button.
4. Show the camera a sample of white light. This step varies according to microscopy technique and Image Type (sample), as shown in the table below:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>White Balance Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Perform the white balance using the brightfield mode on your microscope. See Brightfield–transmitted light above.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Use the Match Color feature (see above)</td>
</tr>
</tbody>
</table>
| Nomarski DIC/Hoffman        | For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the “gray scale” view.  
                                | For Hoffman: Perform the white balance directly on the Hoffman image.                   |
| Phase contrast              | Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen. |
| Polarized light             | Pull all polarizers and compensators out of the light path and then position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen. |
| Brightfield-reflected light | Replace your sample with a mirror.                                                      |
| Darkfield-reflected light   | Perform the white balance using the brightfield mode on your microscope. See Brightfield–reflected light above. |
| Stereo/Macro (all three options) | Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace your sample with a white sheet of paper. |
5. Click on **Begin** to start the calculation. The camera computes the white balance values, and they are automatically saved to the image settings for the image type that you selected.

**Match Color**

The Match Color feature is typically used in two situations:

- You want to change the colors of an image on the screen to match the way that you think the specimen looks.
- You want to set the white balance for pictures taken with a microscopic technique that never has white in its images. A prime example of this situation is fluorescence microscopy.

To use the Match Color feature, follow these steps:

1. Click on the **Preview** button to capture an image. The Match Color option remains inactive until a preview image is captured.
2. Select **Match Color**. The cursor becomes an eyedropper.
3. Using the mouse to move the eyedropper, position it on the pixel location of the color that you want to match. The R, G, and B values of the pixel that you select must all be less than 255.
4. Click on the pixel. The **Match Color** dialog appears with information about the pixel that you selected:
   - **Hue** – The actual color, as distinguished from others in the color spectrum. Hue is derived from a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees).
   - **Saturation** - The proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 equals pure hue (e.g., “day glow”).
5. Move the cross hairs to the desired color either by clicking on the new location or clicking and dragging. As you move the cross hairs, the color in the image changes accordingly, allowing you to preview the color before you save the image. Alternatively, you can click on the **Make White/Grey** button to automatically white balance the image.
6. Click on **Ok**.

**Fit to Window**

In addition to automatically resizing images to fit within the live image window, the Fit to Window option also determines cursor behavior in the live image view.

- When the **Fit to Window** option is checked, the live image window cursor becomes a **zoom tool**. To zoom in on a portion of a live image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the **Full Chip** option.
- When the **Fit to Window** option is not checked, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the **Full Chip** option.

These points apply only when the **Always Show Full Chip in Live Mode** (see above) is not selected. For more details, refer back to the **Chip Imaging Area** section (see above).

Note: Due to a flaw in the Windows operating system, monitors that are set to higher resolutions cannot zoom to very high magnification levels. If zoomed in to a high magnification, the monitor displays white instead of the zoomed image.
Device

Clicking on the device button allows you to select the camera that you would like to use (or switch to) for the next image capture. This window is identical to the device selection window that appears when you open the SPOT software program.

Taking a Picture

From the SPOT TWAIN Interface, you can capture images in different ways:

- **Preview** - You can capture a Preview image. Preview images remain available in the TWAIN window for basic editing and serve as the basis for the final image capture. When you click on the Preview button, the Get Image dialog displays the capture status as it is captured, and the captured image then replaces in the Live Image in the window. Note that the status bar indicated that you are viewing a Preview image.

- **Transfer** - If you like the Preview image, you can Transfer it image directly to the third party application that you are using. The Transfer button is active only for Preview image captures.

- **Acquire** - Capture an image and have it automatically transfer to (open in) the third party imaging application.
Introduction

The SPOT 3rd Party Interface Adv is a stand-alone mini-application that is designed for Mac users who want to use the SPOT camera to capture images, and then edit the images in a third party imaging application (e.g., Photoshop, Image-Pro). Using the 3rd Party Interface Adv, you can:

- View a live image preview
- Create and/or modify a SPOT image setup
- Capture an image and have it automatically open in another application
- Capture an image and save it to file (i.e., the image is not associated with a specific application)
- Transfer captured images into the image editing software

You cannot, however, use the 3rd Party Interface to open images from file.

Preparing to Take a Picture

Before taking a picture via the 3rd Party Interface Adv, you can set the following parameters as needed:

- The SPOT 3rd Party Interface Adv File and Save Options
- The SPOT 3rd Party Interface Adv live image viewing preferences
- The Image Setup, which defines how the camera will take pictures

Setting File and Save Options

Before using the 3rd Party Interface Adv program, you can specify file format, open, and save options. This includes the following information:

- File format for captured images
- Imaging application to edit captured images
- Location for saved image files
- File naming conventions
- File opening conventions

To specify this information, follow these steps:

1. Open the 3rd Party Interface Adv from your Spot folder. The Camera window appears.
2. Click on the Acquisition Settings button. The Preferences window appears.
3. If you have selected 12, 14, 36, or 42 pixel bit depth in your image setup, and you use an imaging application that saves files in 16 bpp and 48 bpp format (e.g., Photoshop), ensure that the **Save 12/36 bit images in 16/48 bit files (best for Photoshop)** box is checked.

4. Click on the **Set Application** button to specify the imaging application (e.g., Photoshop) that you will use with the SPOT camera and the 3rd Party Interface.

5. Specify how files are named and where they are saved. There are two options.
   - **Automatically name images** – The program automatically names and saves images according to the parameters that you specify.
   - **Ask for filename each time** - Have the program prompt you to enter the name and file location each time.

6. If you choose the **Automatically name images** option, specify the Root name for the image files and the folder that they will be saved to.

7. Enter a name in the **Root name** box. The Root name is the first part of the file name. If the root name is test, for example, the first image that you save will be test0001, the second image test0002, etc... If you do not specify a Root name, the files are saved with the numerical names (e.g., 0001, 0002, etc...).

8. To display the file type extension for image files, check the **Add filename extensions** box.

9. Click on the browse button to specify where you will save the file. If you do not specify a location, the 3rd Party Interface program creates a folder on the desktop called SPOT Images; captured images are automatically saved to this location.

10. Specify the file open options. You can select one, both, or neither of the two options:
   - **Open images automatically in selected application** – When you Acquire or Transfer images, the images open automatically in the application that you specified in step 4 above.
   - **Bring the selected image to the foreground each time** – When you Acquire or Transfer images, the imaging application window opens in front of the SPOT Camera window, which is sent to the background.

11. Click on **OK**. The file type and application that you specified appear next to the Change button on the SPOT Camera window.

### Defining Preferences

The 3rd Party Interface Adv window includes a **Preferences** button, which allows you to define live image viewing, exposure and other preferences. The window includes the following options:

- Image Capture Section
- Make Shutter Sound
- Monitor Camera Color Filter Position (Slider only)
- Set Exposure Conversion Factor (RT only)
- Live Images Section
• Always Show Full Chip
• Maximum Exposure time
• Do Post-processing on Snapped Images
• Close window on snap option
• Bus Section (Firewire cameras only)
• Bandwidth size
• Temperature Readout Section (Pursuit and Xplorer cameras only)
• Sensor Temperature Readout Timing

Image Capture Section

**Make Shutter Sound**

The user may select whether to utilize the audible shutter sound when capturing an image.

**Monitor Camera Color Filter Position**

*(Slider Cameras Only)*

Determine whether to monitor the position of the color filter. The Monitor Camera Color Filter Position box is checked as a default. If this option is left checked, the SPOT program displays error messages when the sensors in the camera head detect that the color filter is not in the correct position. This option **does not** monitor the position of the filter slider in Live Image mode. In Basic mode, the program will give you an error message if you are capturing an image and the sliding color filter is in the B/W position.

**Set Exposure Conversion Factor (RT Cameras only)**

RT camera users may have noticed in the past, that image brightness differences existed between Live Images and Captured Images when using the Snap method of capturing an image in the Advanced program mode. The SPOT program now allows for users to correct for this difference by using the **Set Exposure Conversion Factor** function.

This function is used to adjust the relative image brightness between the Live Image and the captured image. You may elect to have the SPOT program compute the conversion factor or you may select the conversion factor yourself.

If you choose to have the SPOT program compute the conversion factor, the program will prompt you with a window asking you to “move to sample”. You should set the imaging area to a moderately bright sample. Once you have done so and select OK, the SPOT program does the rest and places the computed exposure factor in the Conversion Factor window.

If you choose to set the factor yourself, you may want to open a Live Image window, set the conversion factor, and then use Snap to capture an image. Compare the two images. If you are satisfied that the two are at a similar brightness level, leave the conversion factor. If you are not satisfied, reset the conversion factor and Snap another image. Repeat this process until you are satisfied.

Setting a conversion factor less than 1 will decreases the brightness of the captured image when compared to the live image. Setting a conversion factor greater than one will increase the brightness of the captured image relative to the live image.
Live Images Section

**Always Show Full Chip**
Always display the full chip in live image mode. If you select a region, it will be displayed in a rectangular outline within the full-chip view.

**Maximum Exposure**
The Maximum Exposure option helps you to avoid unnecessarily long exposures when viewing a live image. Consider the following situation: When you change from a lower resolution objective to a higher resolution objective, the camera detects a brief interval of blackness and compensates by modifying the exposure time to maintain a constant brightness level. This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the **Maximum Exposure** option, you can limit this exposure time. For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path selector is incorrectly set.

**Do Post-Processing on Snapped Images**
Specify whether to apply the Post Processing options for the current Image Setup to images captured using the Snap option. When selected, all of the Post Processing options from the current Image Setup will be applied except for Background Subtraction and Flatfield Correction.

**Close Window on Snap**
Selecting this option will close the Live Image Window each time you capture an image using the Snap button in that window. If this option is not selected, captured images from snap will “stack up” behind the live image window.

Bus Section (Firewire cameras only)

**Bandwidth**
For the Firewire cameras, you can select the relative amount of bandwidth that your system will utilize to capture and transfer images between the camera and your computer. Choices are High, Medium, and Low.

Temperature Readout Section (Xplorer and Pursuit cameras only)
This section allows you to specify the time interval between temperature readouts. The default time interval is 30 seconds. The CCD temperature is displayed in the upper left corner of the Twain window.

**Keep TWAIN window on top**
The **Keep TWAIN Window on Top** option allows you to preview and transfer or acquire multiple images without having to re-open the SPOT window.
- If the Keep This Window on Top box is checked, the SPOT window remains open.
- If the box is not checked, the SPOT window automatically closes after each image is transferred or acquired.
Device

The Device option allows you to select from a variety of image acquisition devices for previewing and capturing images through the 3rd Party Interface. These can be selected and changed “on the fly”. Once you have selected a different device, the 3rd Party Interface window will update automatically to include options consistent with the selected device.

Defining an Image Setup

An image setup serves two crucial purposes:

• It defines the way a picture will be taken.
• It defines the way the program automatically modifies a picture after it is taken.

Image setups are defined to optimize the picture taking process for different types of images or microscopy techniques. They can be created, saved, and recalled as needed. To define a new image setup, you must also select one of 11 pre-defined image types as a template for defining the new setup. The 11 pre-defined image types (in addition to the Factory Defaults setting) correspond to commonly used microscopy techniques. Refer to Ch. 5- Preparing to Take a Picture for a table of the different image types. Brackets around the title indicate pre-defined image types, while the user defined image setups appear without brackets.

• To modify the current image setup, click on the Modify button.
• To delete an image setup, select the image setup from the list, and click on the Delete button.

• To define a new image setup, click on the Add button. The New Image Setup window appears with a list of pre-defined and user-defined templates (image types). Brackets indicate pre-defined image types < >. Select a template, and click on OK. The New Image Setup window appears, as shown at right:

When you add a new image setup or modify an existing setup, the Image Setup window appears. The options available in the image setup vary with the camera model, but an example is shown here. Switching between the options in the list on the left side of the image setup will cause different options to appear on the right side.
Refer to Ch. 5 – Preparing to Take a Picture for a detailed explanation of the Image Setup options.

**Taking a Picture**

Using the 3\textsuperscript{rd} Party Interface Adv, you can perform both initial image captures (e.g., for computing exposure, white balance, etc…) and final image captures.

**Capturing Initial Images**

The toolbar at the left of the SPOT Image Capture window enables you to quickly access the image capture functions that are used prior to the capture of the final image.
Capturing Final Images

From the 3rd Party Interface Adv program, you can capture an image in two different ways. You can both preview the image and then transfer it to another imaging application (e.g., Photoshop), or you can Acquire the image, which sends the captured image directly to the application.

• **Preview** – Capture an image and preview it within the 3rd Party Interface Adv window.
• **Transfer** – Transfer a captured image to the imaging application.
• **Acquire** - Capture an image and have it open/save according to the parameters that you specified (see Setting File and Save Options). The one-step process of Acquiring an image is identical to previewing and then transferring an image.
Introduction

The 3rd Party Interface is a stand-alone mini-application that is designed for Mac users who want to use the SPOT camera to capture images, and then edit the images in a third party imaging application (e.g., Photoshop, Image-Pro). The 3rd Party Interface is a basic version of the 3rd Party Interface Adv application. Using the 3rd Party Interface, you can:

- View a live image preview
- Capture an image and have it automatically open in another application
- Capture an image and save it to file (i.e., the image is not associated with a specific application)
- Transfer captured images into the image editing software

You cannot, however, use the 3rd Party Interface to open images from file.

Working in the 3rd Party Interface

The 3rd Party interface is a one-stop point for previewing and capturing images. For example, using the 3rd Party interface, a typical image capture session might involve the following steps, as illustrated below:

1. Preview your specimen
   Use the live image as a point of reference to focus and position the image and to scan for areas of interest.
2. Create a Profile
Profiles allow you to create, modify, and reuse specific exposures settings that are tailored to your image capture needs. To create a new profile, control-click on the Profile box.

3. Define Settings
Define exposure settings for live and captured images. Each of these settings is discussed later in this chapter.
4. Capture an Image

All of the image capture options are located on the bottom right portion of the window, as illustrated here.

Defining Preferences

In the Basic 3rd Party Interface, you can define capture and viewing preferences. Click on the Prefs button to modify these preferences. The preferences vary depending on the camera model:

- Image Capture Section
- Captured Image Bits per Channel
- Make Shutter Sound
- Monitor Camera Color Filter Position (Slider only)
- Set Exposure Conversion Factor (RT only)
- Live Images Section
- Always Show Full Chip
- Bus Section (Firewire cameras only)
- Bandwidth size
- Temperature Readout Section (Pursuit and Xplorer cameras only)
- Sensor Temperature Readout Timing

Image Capture Section

Captured Image Bits per Channel

This option enables you to specify a different image bit depth when saving an image captured in the SPOT program.

- **8 Bits per Channel** – The 8 bits per channel option provides 256 gray levels per color:
  - With B/W cameras, captured images are 8 bits per pixel monochrome.
  - With Color cameras, captured images are 24 bits per pixel RGB color.

  This option results in smaller, more manageable image sizes, and is best for images that do not require extensive modification.

- **12 Bits per Channel** – The 12 Bits per channel option provides 4,096 gray levels per color.
  - With B/W cameras, captured images are 12 bits per pixel monochrome.
  - With Color cameras, captured images are 36 bits per pixel RGB color.
This option reduces banding problems that can result with modified images, but also results in larger file sizes.

When saving 12 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 bits per channel. If you use Adobe’s Photoshop for image editing, you should select the 16 bit per channel option because Photoshop cannot read 12 bit per channel images.

- **14 Bits per Channel** – The 14 bits per channel option provides 16,384 gray levels per color. This option is available only with some camera models.
- With B/W cameras, captured images are 14 bits per pixel monochrome.
  - With Color cameras, captured images are 42 bits per pixel RGB color.

This option further reduces banding problems that can result with modified images, but also results in larger file sizes.

When saving 14 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 bits per channel. If you use Adobe’s Photoshop for image editing, you should select the 16 bit per channel option because Photoshop cannot read 12 bit per channel images.

**Make Shutter Sound**

The user may select whether to utilize the audible shutter sound when capturing an image.

**Monitor Camera Color Filter Position (Slider)**

Determine whether to monitor the position of the color filter. The Monitor Camera Color Filter Position box is checked as a default. If this option is left checked, the SPOT program displays error messages when the sensors in the camera head detect that the color filter is not in the correct position. This option does not monitor the position of the filter slider in Live Image mode. In Basic mode, the program will give you an error message if you are capturing an image and the sliding color filter is in the B/W position.

**Set Exposure Conversion Factor (RT Cameras Only)**

The Set Exposure Conversion Factor function enables you to match the light intensity in the live mode with what is present in the capture mode. This compensates for the differences due to the use of different electronic circuitry in the live mode as compared to the capture mode. To use Set Exposure Conversion Factor, follow these steps:

a) From the Camera menu, select Set Exposure Conversion Factor. The Set Exposure Conversion Factor dialogue box appears with a default conversion factor displayed.

b) Select Compute. A dialogue box will prompt you to “Move to sample for exposure computation”. Ensure that your sample is in field of view and click OK.

c) The SPOT software will compute the appropriate conversion factor. Click OK to finish.

**Live Images Section**

**Always Show Full Chip**

Always display the full chip in live image mode. If you select a region, it will be displayed in a rectangular outline within the full-chip view.
Bus Section (Firewire cameras only)

**Bandwidth**

For the FireWire cameras, you can select the relative amount of bandwidth that your system will utilize to capture and transfer images between the camera and your computer. Choices are High, Medium, and Low.

**Temperature Readout Section (Xplorer and Pursuit cameras only)**

This section allows you to specify the time interval between temperature readouts. The default time interval is 30 seconds. The CCD temperature is displayed in the upper left corner of the Twain window.

**Keep TWAIN window on top**

The Keep TWAIN Window on Top option allows you to preview and transfer or acquire multiple images without having to re-open the SPOT window.

- If the Keep This Window on Top box is checked, the SPOT window remains open.
- If the box is not checked, the SPOT window automatically closes after each image is transferred or acquired.

**F-Keys**

The following function keys are available as shortcuts in the 3rd Party Interface:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Action</th>
<th>TWAIN Interface Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F 4]</td>
<td>Restart the live image view.</td>
<td>Live</td>
</tr>
<tr>
<td>[Alt] + [F 4]</td>
<td>Close the SPOT Camera window.</td>
<td>Close</td>
</tr>
<tr>
<td>[F 9]</td>
<td>Capture an image and automatically transfer it to the imaging application.</td>
<td>Acquire</td>
</tr>
<tr>
<td>[Ctrl] + [F 10]</td>
<td>Compute white balance values.</td>
<td>White Balance</td>
</tr>
<tr>
<td>[Alt] + [F 10]</td>
<td>Compute white balance values without displaying the informational dialog.</td>
<td>Not available from the window</td>
</tr>
</tbody>
</table>

*Note: If some of the Function keys don’t work as noted above and you are running OS 10.3, the keys may have been reserved by the Mac operating system for their Exposé window navigation program. To correct this, choose Exposé from System Preferences and reassign the shortcut keys to ones not used by the 3rd Party Interface.*

**Using the Live Image to Define Image Capture Settings**

When you open the Basic mode 3rd Party Interface, the Live Image window is, by default, running, as indicated by the Live Mode Running message in the status bar. The settings options in the 3rd Party interface window enable you to optimize the live image view, and then capture an image using these settings. In the 3rd Party Interface, you can:

- Create profiles to use as pre-defined image capture settings.
- Modify exposure settings
Define a specific portion of the chip to be used in the image capture.

Modify the screen orientation of the specimen.

The following sections describe all of the Live Image/Image Capture Settings.

### Profile

The **Profile** option allows you to create and re-use sets of live image/image capture settings. When you open the 3rd Party interface, the **Default** Profile is selected. When you make changes to any of the live image/image capture settings, these changes can be saved to a Profile – either the Default or one that you have defined. For example, if you gamma adjust a live image and then decide that the result is ideal for the type of specimen you are working with, you could create a new Profile with the gamma and exposure values and name it for that type of specimen – i.e., “Diseased Cells.”

To add, edit, or delete Profiles, **control-click** on the Profile box. This gives the following options:

- **Spot Help** – Bring up the online Spot help.
- **Add** – Add a new Profile. When you add a new Profile, the program prompts you to name it.
- **Save** – Save a Profile that you have modified.
- **Rename** – Rename an existing Profile.
- **Delete** - Delete a Profile. This option appears only after you have defined a second Profile in addition to the Default Profile.

Each profile is divided into three windows:

- Exposure/Brightness
- Area/Orientation
- Image Processing

The options available in these windows are detailed below.

### Exposure/Brightness Window

#### Exposure: Auto or Manual

The **Exposure** option gives you the choice of having the camera calculate exposure time (**Auto**), or setting the exposure on your own (**Manual**). The exposure options will vary according to whether you select **Auto** or **Manual**, as illustrated below.
When you enter one of the above exposure settings, note that it applies both to the live image that you are viewing and the captured image.

**Auto Exposure-specific options**

**Image Type**

An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 available Image Types (see below) corresponds to a microscopy technique: select the Image Type that matches the technique you are using. The camera will capture the image accordingly. The table below describes typical situations for each image type.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Stained specimens on glass slides using transmitted light microscopes.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Bright specimens on dark backgrounds using transmitted light darkfield technique.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Fluorescence specimens not fluorescing in a single red, green, or blue primary color</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>Specimens being viewed with either Nomarski DIC or Hoffman techniques.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Specimens being viewed using the phase contrast technique.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Specimens being viewed with polarized light techniques.</td>
</tr>
<tr>
<td>Brightfield-reflected light</td>
<td>Polished metallurgical specimens and semi-conductors using a microscope with a vertical illuminator.</td>
</tr>
<tr>
<td>Darkfield-reflected light</td>
<td>Bright areas of specimens being viewed with darkfield, reflected light techniques.</td>
</tr>
<tr>
<td>Stereo/macro–no glints</td>
<td>Matte specimens without bright glints.</td>
</tr>
<tr>
<td>Stereo/macro–shiny glints</td>
<td>Shiny specimens with bright glints.</td>
</tr>
<tr>
<td>Stereo/macro-metallic glints</td>
<td>Metallic specimens with intense glints.</td>
</tr>
</tbody>
</table>
Brightness

Enter a **Brightness** value between 0.24 and 34.
A brightness value of 1, the default value, gives you the correct image brightness for most images. The Brightness control allows you to overexpose or underexpose (darken or lighten) the image area. In many cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or darken the image. When using the Brightness control, the SPOT camera uses an algorithm that combines gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode:

- When overexposing images to make them brighter (i.e., entering values greater than one), the camera first selects the highest possible gain before lengthening the exposure time. Because gain also brightens an image, less exposure time is needed.
- When underexposing images to make them darker (i.e., entering values less than one) the camera uses the lowest possible exposure time before lowering the gain.

Quality/Speed (Auto)

Use the slider to balance speed and quality when previewing dim images.
- Moving the slider toward the **Quality** side increases image quality and decreases frame rates.
- Moving the slider toward the **Speed** side increases frame rates and decreases image quality.

The Quality/Speed measurement corresponds to the Auto-Gain limit setting, which allows you to set an upper limit on the gain options that will be available during the Auto-Exposure process.
- When the slider is at the left-most point, the Auto-Gain Limit gives you higher quality pictures, but lengthier exposure times.
- When the slider is at the right-most point, the Auto-Gain Limit allows the camera to select from all available gain options. This shortens exposure times, but decreases image quality.

Refer to the “Auto-Gain Limit” section in Ch. 5 – Preparing to Take a Picture for a detailed explanation of gain and exposure.

Live Image Auto-Brightness

Available only when you are using **Auto** exposure and viewing a live image, the **Live Image Auto-Brightness** option enables you to maintain a consistent brightness level for changing specimens.

Manual Exposure-Specific Options

Exposure Time(s)

Use the slider-bar to specify an exposure time (or times). When you specify an exposure time, the camera skips the automated exposure sequence that takes place when you open the live image view – i.e., the 3rd Party interface. This is very useful in cases where exposure times are lengthy, as with fluorescence samples.

Gain

Use the slider-bar to select one of the gain options. The gain value displays to the right of the slider-bar. Refer to the “Auto-Gain Limit” and “Gain” sections of Ch. 5 – Preparing to Take a Picture for details on gain and exposure.
Other Exposure/Brightness Options

Binning (3-Shot Color, Slider, Monochrome cameras)

Binning combines adjacent pixels on the CCD chip, thereby reducing the number of pixels used in the image capture. Binning is useful when you have dim images and want to increase sensitivity and reduce download time. This gives you higher frame rates and less noisy images. But, as binning level increases, image resolution decreases. All of these factors should be considered when you select a binning option.

The available binning options depend on your camera model.

- None 1 pixel = 1 pixel
- 2 x 2 4 pixels = 1 pixel
- 3 x 3 9 pixels = 1 pixel
- 4 x 4 16 pixels = 1 pixel
- 8 x 8 64 pixels = 1 pixel

Note: Some color mosaic model cameras also have the option to do binning. However, when binning is selected, the color data is converted to monochrome and the image displayed will appear black and white.

Exposure Limits – Minimum

Because SPOT cameras are capable of extremely short exposure times, light sources with intensities that vary with the waveform of the 60 Hz line supply (e.g., fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps) can cause the Live Image window to flicker and result in incorrect brightness and color balance readings in captured images. This option allows you to correct for these problems by limiting the camera to a minimum exposure time that is greater than the pulse interval of the light source.

Exposure Limits – Live Image Maximum

The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing a live image. Consider the following situation: When you change from a lower resolution objective to a higher resolution objective, the camera detects a brief interval of blackness. When the Auto-Brightness option (see above) is enabled, it compensates by modifying the exposure time to maintain a constant brightness level. This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the black interval. Using the Live Image Maximum option, you can limit this exposure time. For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path selector is incorrectly set.

Filter Color (3-Shot Color, Slider Cameras)

The Filter Color option specifies the color or colors that will be exposed in the live image preview/image capture.

- Red – Preview/capture a monochrome preview of your specimen using the red state of the LCD filter.
- Green – Preview/capture a monochrome preview of your specimen using the green state of the LCD filter.
- Blue – Preview/capture a monochrome preview of your specimen using the blue state of the LCD filter.
- Clear – Preview/capture a monochrome preview of your specimen using the clear state of the LCD filter.
Display Images in Grayscale (3-Shot Color, Slider cameras)

To counter the difficulty of viewing, focusing, and adjusting monochrome images in live mode, the Display Images in Grayscale option enables you to view a monochrome image in grayscale, as opposed to with the red, green, or blue filter. This option applies only when the Filter Color (see above) is set to Red, Green, or Blue.

Area/Orientation Window

Chip Imaging Area

SPOT allows you to use any rectangular portion of the CCD chip for image capture. Using a portion of the chip is helpful in cases where you want to:

• Keep file sizes small.
• Shorten download times.
• Avoid areas of the image with optical problems (e.g., vignette areas).
• There are three image area options:
  • Full Chip – Capture the entire area of the CCD chip.
  • Center – Capture a rectangular part of the CCD chip’s area that has the same height-to-width ratio as the full chip, and is centered on the center of the full chip. The percentage that you enter is the percentage of full chip width that the new area’s width will be.
  • To capture a centered proportion of an image, follow these steps:
    Check the Center option.
    Enter the percentage of the image that you want to capture. Capture the image.
  • Selection – Capture a specific part of the CCD chip.
    Check the Selection option.
    Use the mouse to select a region for capture. Click and drag to define the selection. Note that the new pixel dimensions display in the status bar.
    Capture the image.

When you are viewing a live image Selection, how this selection is displayed, depends on two other settings: the Fit to Window option (see below) and the Always Show Full Chip in Live Mode preference (see above). The following table illustrates the possibilities:

<table>
<thead>
<tr>
<th>Fit to Window Checked?</th>
<th>Always Show Full Chip in Live Mode Checked?</th>
<th>Selection Display</th>
<th>Live or Captured Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a yellow rectangle.</td>
<td>LIVE</td>
</tr>
<tr>
<td>YES</td>
<td>NO</td>
<td>When you select a portion of the chip the cursor is a zoom tool. To zoom in on a portion of a live or captured image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the Full Chip option.</td>
<td>BOTH</td>
</tr>
<tr>
<td>NO</td>
<td>YES</td>
<td>When you select a portion of the chip, the selection is outlined with a yellow rectangle. However, because Fit to Window is not checked, you will not see the entire chip in the window.</td>
<td>LIVE</td>
</tr>
</tbody>
</table>
When you select a portion of the image, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the **Full Chip** option.

### Flip

Specify whether images will be flipped in the live image view and during the image capture process.

- Select **Horizontal** to flip the image from left to right.
- Select **Vertical** to flip the image from top to bottom.
- Select both options to flip the image from left to right and from top to bottom.

### Rotate 90°

Specify whether images will be rotated in the live image view and during the image capture process.

- Select **None** if you do not want the image to be rotated.
- Select **Left 90°** to rotate the image counterclockwise 90 degrees.
- Select **Right 90°** to rotate the image clockwise 90 degrees.

### Faster Readout (Live Images) (Insight 2 MP)

Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

### Acceleration (Live Images) (Insight 4 MP)

Acceleration enables you to “speed up” the live image display (higher frame rates) in cases where you are willing to sacrifice some resolution for a higher frame rate.

### Image Processing Window

#### Gamma

Enter a **Gamma** value between 0.1 and 4. Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or lightening black areas. This is especially useful for capturing/editing images with a wide range of brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., printed circuitry).

- Values between 1 and 4 lighten the darker areas of the image.
- Values between 0.1 and 1 darken the mid-tones of the image.
- Gamma adjustments on live images are made in the RGB color space, the only color space where adjustments can be made quickly enough to keep up with live imaging. Refer to Ch. 5 – Preparing to Take a Picture for more details on gamma adjustment and color spaces.
Correct Color Technology™ (Color cameras)

The Correct Color Technology option utilizes camera dependent color correction profiles that optimize the matching of colors between your microscope specimen, the live image you view on the screen of your monitor, and the image you capture with your SPOT camera. This is done by transforming the raw camera color data, allowing it to be adjusted to display the closest approximation of the same color on your monitor.

When the checkbox for Correct Color Technology is selected, the color transformations are applied to the live and captured images.

In order to get the best results using this feature, you should make sure you set up your imaging system including your computer monitor appropriately. See Appendix F for more information on system set-up.

Be aware that the color correction transformations that occur when you use Correct Color Technology will be applied to the raw image data, leaving a modified image file. If you will require the raw data for further analysis of your image, you should uncheck the Correct Color Technology checkbox.

Noise Filter

The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with lengthy exposure times, the noise filter acts as a “virtual cooler” for the camera, eliminating “hot pixels.”

The Noise Filter checks each pixel on the CCD chip as described below:

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels.
2. If none of the eight neighboring red pixels has a value within ±15% (i.e., the threshold value that the SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being checked is replaced with the average value of the eight neighboring red pixels.
3. The program repeats this procedure for the values of the green and blue pixels being checked.

To activate the Noise Filter, check the Noise Filter box. The program runs the noise filter each time an image is captured using the Preview or Acquire options.

Flatfield (Captured Images)

The Flatfield Correct option is used to correct for display problems associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system.

Note: Flatfield correction with the SPOT camera refers only to the correction of uneven lighting. It should not be confused with the correction of optical field flatness.

To use the Flatfield option, follow these steps:

1. Ensure that the specimen is under the desired objective and in focus.
2. Control click on the Flatfield drop-down list and click on the Add option. The Get Flatfield dialog appears as shown at right.
3. Choose a number of frames to average. Larger numbers of frames will increase the accuracy of the flatfield correction, but will also increase the length of time it takes to create the flatfield image. The default number of frames to average is 3.
4. Choose a flatfield file name. Because flatfield image files are different for each objective, you might want to name the file according to the objective’s magnification (e.g. 10x).

5. Remove the slide from the field of view.

6. Click on Begin. The program will acquire the number of frames that you specified.

7. If you are running a monochrome camera or a 3-shot camera in monochrome mode, when the program finishes acquiring the frames, it will prompt you to block all of the light to the camera. This can be accomplished by installing the dust cap that was supplied with the camera or by adjusting the microscope’s optical path. After the light is blocked, click on OK. The program computes another frame.

8. The program saves the file and it becomes the current Flatfield file.

9. Move the specimen back into the field of view, and perform the image capture, using either the Preview or the Acquire option.

White Balance (Color cameras only)

White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for an image. Many factors impact the coloration of an image capture, including lamp voltage, the coloration of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s objectives. To minimize the impact of these factors, use the White Balance feature. When you perform a white balance calculation, SPOT samples the color of the light from your light source after it has passed through the slide and the objective, and then calculates the red, green, and blue gains needed to produce images where the white areas are white and the color areas are true.

You should perform a new white balance calculation when:

- Starting a new image capture session.
- Changing the lamp voltage.
- Switching to a different objective on the microscope.

To perform a white balance, follow these steps:

a) Set the illumination and the objective that you will use for the image capture.

b) If you have not done so, select your Image Type (see above). Each Image Type has its own set of white balance values. Any white balance values that you compute for an image type remain linked to that image type until you compute new values. When selecting a new image type, remember that you will be using the white balance values linked to that image type.

c) Click on the White Balance button.

d) Show the camera a sample of white light. This step varies according to microscopy technique and Image Type (sample), as shown in the table below:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>White Balance Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightfield-transmitted light</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Darkfield-transmitted light</td>
<td>Perform the white balance using the brightfield mode on your microscope. See Brightfield-transmitted light above.</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>Use the Match Color feature (see above)</td>
</tr>
<tr>
<td>Nomarski DIC/Hoffman</td>
<td>For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the “gray scale” view. For Hoffman: Perform the white balance directly on the Hoffman image.</td>
</tr>
<tr>
<td>Phase contrast</td>
<td>Position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
<tr>
<td>Polarized light</td>
<td>Pull all polarizers and compensators out of the light path and then position the slide so that the specimen is not in the field of view, but light is going through the slide near the specimen.</td>
</tr>
</tbody>
</table>
Brightfield-reflected light | Replace your sample with a mirror.
--- | ---
Darkfield-reflected light | Perform the white balance using the brightfield mode on your microscope. See Brightfield – reflected light above.
Stereo/Macro (all three options) | Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace your sample with a white sheet of paper.

e) Click on **Begin** to start the calculation. The camera computes the white balance values, and they are automatically saved to the image settings for the image type that you selected.

**Match Color**

The Match Color feature is typically used in two situations:

- You want to change the colors of an image on the screen to match the way that you think the specimen looks.
- You want to set the white balance for pictures taken with a microscopic technique that never has white in its images. A prime example of this situation is fluorescence microscopy.

To use the Match Color feature, follow these steps:

1. Click on the **Preview** button to capture an image. The Match Color option remains inactive until a preview image is captured.
2. Select **Match Color**. The cursor becomes an eyedropper.
3. Using the mouse to move the eyedropper, position it on the pixel location of the color that you want to match. The R, G, and B values of the pixel that you select must all be less than 255.
4. Click on the pixel. The **Match Color** dialog appears with information about the pixel that you selected:
   - **Hue** – The actual color, as distinguished from others in the color spectrum. Hue is derived from a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees).
   - **Saturation** - The proportion of perceived pure hue in the color. Saturation (in the SPOT software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 equals pure hue (e.g., “day glow”).
5. Move the cross hairs to the desired color either by clicking on the new location or clicking and dragging. As you move the cross hairs, the color in the image changes accordingly, allowing you to preview the color before you save the image. Alternatively, you can click on the **Make White/Grey** button to automatically white balance the image.
6. Click on **Ok**.

**Fit to Window**

In addition to automatically resizing images to fit within the live image window, the Fit to Window option also determines cursor behavior in the live image view.

- When the **Fit to Window** option is checked, the live image window **cursor** becomes a zoom tool. To zoom in on a portion of a live image, click and drag over the area that you want to zoom in on. To return to the non-zoomed image, click on the **Full Chip** option from the Area/Orientation section.
- When the **Fit to Window** option is not checked, the cursor is a cropping tool. If you select a portion of an image, the program displays only the selected area and discards the rest of the image. To return to the non-cropped image, click on the **Full Chip** option from the Area/Orientation section.

These points apply **only** when the **Always Show Full Chip in Live Mode** (see above) is **not selected**. For more details, refer back to the **Chip Imaging Area** section (see above).
Taking a Picture

From the SPOT 3rd Party Interface, you can capture images in different ways:

- **Preview** - You can capture a **Preview** image. Preview images remain available in the 3rd Party window for basic editing and serve as the basis for the final image capture. When you click on the **Preview** button, the **Get Image** dialog displays the capture status as it is captured, and the captured image then replaces in the Live Image in the window. Note that the status bar indicated that you are viewing a Preview image.

- **Transfer** - If you like the Preview image, you can **Transfer** it image directly to the third party application that you are using. The Transfer button is active only for Preview image captures.

- **Acquire** - Capture an image and have it automatically transfer to (open in) the third party imaging application.
Appendix A: Electronic Imaging Theory and SPOT Cameras

Introduction

This appendix is a brief overview of the operational theory behind SPOT digital cameras. The next two sections, Digital Photography and Color Images, provide a short introduction to electronic imaging theory; the following section describes how this theory applies to the SPOT cameras.

Digital Photography

Modern electronic imaging is based on the charged coupled device (CCD). All of today’s digital cameras have a CCD chip or chips. In digital cameras, the CCD chip/sensor replaces the film of traditional cameras as the means by which the camera records the image. The surface of the CCD chip is composed of light-sensitive cells arranged in a checkerboard pattern. Each cell of the checkerboard is known as a picture element, or more commonly, a pixel. The following is a simplified description of what happens when you take a picture with a digital camera:

1. The camera’s optical system forms images on the “checkerboard” of pixels.
2. The CCD is exposed to the image for a period of time.
   During this period, each photosensitive cell receives photons of light, converts the photons to electrons, and then stores the electrons in the cell. The process by which each cell accumulates electrons can be compared to a well filling with water. As more light hits a cell, the electron level in the well rises. The more electrons that are in the cell, the more voltage it will have when read by the digital camera.
3. Following the exposure, a digital camera does three things:
   a. It measures the voltage of each cell.
   b. It converts the voltage to a binary number.
   c. It transmits this number down a cable to your computer.
4. The computer reconstructs the image by assigning a brightness value to each pixel in the final image. Each brightness value is proportional to the voltage of the corresponding cell on the CCD chip.
Color Images

Because a CCD chip is inherently monochromatic (black and white), color filters must be used to extract the color information from the image. There are several basic design methodologies.

- **Single CCD design using color masked pixels (color mosaic cameras like the Insight Color Mosaic and RT KE Color Mosaic)**
  Digital cameras designed in this manner have one CCD chip with color filters physically bonded to each pixel on the chip. Some pixels get red filters, some pixels get green filters and some pixels get blue filters. Since each pixel is only able to measure the intensity of one color, the intensity of the missing two colors for this pixel must be estimated, based on nearby pixels that have precise measurements of the missing colors. For example, a pixel that has a green filter will have an exact measurement of the green color value, but the red and blue values must be estimated, based on the nearest red and blue pixels. This estimation is known as **interpolation**.

- **Pros and Cons**: A digital camera designed in this way is inexpensive and can freeze moving images with a single exposure. However, because they interpolate brightness values, such cameras cannot provide as high a resolution as that provided from a non-filtered CCD chip.

- **Three CCD design using color beam splitter**
  This design uses three CCD chips. The incoming image first goes through a color beam splitter which directs the red light to one chip, the green light to a second chip and the blue light to a third chip. The chips are very accurately aligned so as to achieve near perfect registration between the three chips. The red, green, and blue values for each point on an image are measured by the corresponding pixel on each of the three chips.

- **Pros and Cons**: This design produces an image that retains the high resolution of the individual chips. This type of camera can also freeze moving images with a single exposure. However, because most of the cost in a high resolution CCD camera is in the CCD chip itself, three chip cameras are far more costly than their single chip counterparts.

- **Single CCD design that takes three pictures (three pass method) (3-shot Color and Slider model cameras like the Xplorer Slider and RT KE 3-Shot Color)**
  Cameras designed in this way expose a single CCD chip three times, once to red light, once to green light, and once to blue light. One variant in this type of camera is how the chip is exposed to the different colors of light. Some cameras switch individual red, green and blue glass filters in front of the chip for each exposure. Others use a liquid crystal filter that changes from red to green to blue as different voltages are applied to it. By exposing the chip three times, each cell on the CCD is able to measure all three color values.

- **Pros and Cons**: This technique attains the high resolution of the three CCD design without the high cost associated with using three chips. However, because these cameras require three exposures, they cannot freeze moving images.

- **Single CCD design using color masked pixels with pixel-shifting (Flex cameras)**
  Cameras designed in this way use a motor to move the CCD in pixel or sub-pixel increments. This allows the camera to sample red, green and blue for each image while still using a color mosaic sensor.

- **Pros and Cons**: This technique attains the high resolution of the three CCD design without the high cost associated with using three chips. Since the motor can shift the CCD in sub-pixel increments, the spatial resolution can be increased. However, because these cameras require multiple exposures, they cannot freeze moving images. They also generate very large image files which require a computer with large storage capacity.
SPOT Digital Cameras

In order to provide you with an understanding of what happens when you take a picture, the following sections highlight some of the basic operating principles of SPOT cameras.

Pixel Digitization

Following each exposure, SPOT camera systems read the CCD chip and digitize each pixel data as it is transferred off of the CCD chip, and before it is sent through the cable into the computer. This technique minimizes noise and maintains the lack of distortion that is inherent with CCD chip geometry. The SPOT cameras use two methods of pixel digitization, one for live imaging, and one for image capture:

- **Live imaging**
  To provide the fastest possible frame rate; SPOT cameras use two separate circuits to digitize the left and right halves of the CCD simultaneously.

- **Pros and Cons:** This method provides an extremely fast display when using SPOT’s Live Image feature. The challenge comes in achieving a good brightness match between the two image halves. Our current algorithm achieves a good match with bright images. However, with dim images, mismatches can occur, resulting in a “split” appearance, where one half of the image is brighter than the other half. A “split” Live Image view **is not** indicative of what your image capture will look like.

- **Image capture**
  To provide the most accurate image captures, SPOT cameras use a single circuit to digitize the entire CCD chip.

- **Pros and Cons:** Because a single circuit is used to digitize the entire CCD chip, all pixels are inherently matched. However, this method provides a slower download than the two circuit method used for live imaging.

Gain

Normally an auto exposure routine in a digital camera sets the exposure time so that the brightest pixel on the CCD chip is completely “filled” with electrons, or is “full well” (see the Digital Photography section). This simple technique works well for bright images, but, as an image gets dimmer, exposure times can get uncomfortably long.

With the SPOT camera you can shorten exposure times by filling the brightest pixel on the CCD chip to less than full well, and then using this lower level as full scale. The inverse fraction of full well that the brightest pixel on the CCD is filled to is known as the gain. For example, filling a pixel to half of full well cuts the exposure time in half. Since the exposure time is cut in half, we call this a gain of 2.

The following table illustrates the relationship between gain, the fraction of full well that the brightest pixel is filled to, and the effect of gain on exposure time. Note that the camera model and selected pixel bit depth will determine the gain options available.

<table>
<thead>
<tr>
<th>Gain</th>
<th>Fraction of Full Well</th>
<th>Exposure Time (sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>80 seconds</td>
</tr>
<tr>
<td>2</td>
<td>1/2</td>
<td>40 seconds</td>
</tr>
<tr>
<td>4</td>
<td>1/4</td>
<td>20 seconds</td>
</tr>
<tr>
<td>8</td>
<td>1/8</td>
<td>10 seconds</td>
</tr>
<tr>
<td>16</td>
<td>1/16</td>
<td>5 seconds</td>
</tr>
<tr>
<td>32</td>
<td>1/32</td>
<td>3 seconds</td>
</tr>
<tr>
<td>64</td>
<td>1/64</td>
<td>1 second</td>
</tr>
</tbody>
</table>
An 80 second exposure at a gain of one turns into a 5 second exposure at gain 16. This is good in terms of the exposure time. Unfortunately, background noise is directly proportional to gain. It is 16 times higher at a gain of 16 than at a gain of one.

An Automated Exposure Process

Normally, for any given image, trial and error would have to be used to determine the optimal combinations of gain and exposure time. In order to eliminate the need for trial and error experimentation, the SPOT camera automatically determines this information by sampling light levels before each exposure. Based on the light levels and the user-determined Auto-Gain Limit, SPOT determines the optimal gain setting and exposure time for the image. For details on using the Auto-Gain Limit feature, refer to Ch. 5 – Preparing to Take a Picture.
# Appendix B: Keyboard and Toolbar Button Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Keystroke or F-key</th>
<th>Toolbar Button</th>
<th>Basic and/or Adv. Mode</th>
<th>Windows and/or Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Image File</td>
<td>[F3]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Show Image File Thumbnails</td>
<td>[F5]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Reload</td>
<td></td>
<td></td>
<td>Advanced</td>
<td>Windows</td>
</tr>
<tr>
<td>Save</td>
<td>[F2]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Save As</td>
<td>[Ctrl] + [A]</td>
<td></td>
<td>Both</td>
<td>Windows</td>
</tr>
<tr>
<td>Save to Database</td>
<td>[Ctrl] + [D]</td>
<td></td>
<td>Advanced</td>
<td>Windows</td>
</tr>
<tr>
<td>Save All</td>
<td>[Ctrl] + [F3]</td>
<td></td>
<td>Both</td>
<td>Windows</td>
</tr>
<tr>
<td>Close</td>
<td>[Ctrl] + [F4] + W</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Print</td>
<td>[Ctrl] + [P] + P</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Exit/Quit</td>
<td>[Alt] + [F4] + Q</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td><strong>Database menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td></td>
<td></td>
<td>Advanced</td>
<td>Windows</td>
</tr>
<tr>
<td><strong>Edit menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>[Alt] + Backspace + Z</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>[Ctrl] + [C] + C</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Add Measurement</td>
<td>[Alt] + [M] + M</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
</tbody>
</table>
## Appendix B: Keyboard and Toolbar Button Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Keystroke or F-key</th>
<th>Toolbar Button</th>
<th>Basic and/or Adv. Mode</th>
<th>Windows and/or Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sequence menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play Forward</td>
<td>[Ctrl] + [Space]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Play Reverse</td>
<td>[Ctrl] + [Space]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Stop Play/Resume Play</td>
<td>[Enter]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Step Forward</td>
<td>[Space]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Step Back</td>
<td>[Backspace]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td><strong>View menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fit to Window</td>
<td>[Ctrl] + [F]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Zoom</td>
<td>[Ctrl] + [Z]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Show Gridlines</td>
<td>[Ctrl] + [G]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Show Pan Window</td>
<td>[Ctrl] + [W]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Image Date/Time</td>
<td>[Ctrl] + [T]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Full Screen</td>
<td>[F 7]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Show Image Settings</td>
<td></td>
<td></td>
<td>Basic</td>
<td>Both</td>
</tr>
<tr>
<td><strong>Camera menu</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live Image</td>
<td>[F11]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Get Image (exposure from setup)</td>
<td>[F9]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
<tr>
<td>Get Image (last used exposure)</td>
<td>[F8]</td>
<td></td>
<td>Advanced</td>
<td>Both</td>
</tr>
<tr>
<td>Compute Exposure</td>
<td>[F10]</td>
<td></td>
<td>Advanced</td>
<td>Windows</td>
</tr>
<tr>
<td>Compute White Balance Values</td>
<td>[Ctrl] + [F10]</td>
<td></td>
<td>Both</td>
<td>Both</td>
</tr>
</tbody>
</table>
## Non-menu driven commands

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access the Image Setup window</td>
<td>[F12]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Ctrl] + [F 12]</td>
<td>Advanced</td>
</tr>
<tr>
<td>(OSX 10.1 and higher)</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Increase vertical scroll speed by factor of ten</td>
<td>[Ctrl] + scroll</td>
<td>Both</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows</td>
</tr>
<tr>
<td>Increase vertical scroll speed by factor of one hundred</td>
<td>[Shift] + scroll</td>
<td>Both</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows</td>
</tr>
<tr>
<td>Scroll horizontally</td>
<td>Right click + scroll</td>
<td>Both</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows</td>
</tr>
</tbody>
</table>
Appendix C: Converting Previous Version SPOT Databases

If you have SPOT databases that were created with an earlier version of the SPOT software (2.1 or earlier), these databases must be converted for use with the current version of the software. Follow these steps:

1. Access the files on the software CD that came with your camera. In addition to the documentation and program folders, you should see a Utilities folder.
2. Open the Utilities folder.
3. Double click on the `convdb.exe` icon. The program automatically converts your databases.
Appendix D: Third Party Software

The following table lists major third party imaging software systems and their compatibility levels with the SPOT cameras. New drivers are released regularly. Please see our website for the most current information.

<table>
<thead>
<tr>
<th>Company</th>
<th>Software</th>
<th>System</th>
<th>Flex</th>
<th>Xplorer</th>
<th>Pursuit</th>
<th>RT (RTKE and RTSE)</th>
<th>Insight FireWire</th>
<th>TWAIN (Windows)</th>
<th>3rd Party Interface (Mac)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe</td>
<td>Photoshop</td>
<td>PC/Mac</td>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td>NO</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Cerner</td>
<td>CoPathPlus</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td>NO</td>
<td>NO</td>
<td></td>
</tr>
<tr>
<td>Clemex</td>
<td>Vision</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>Compix</td>
<td>C-Imaging</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>NO</td>
<td>YES</td>
<td>N/A</td>
</tr>
<tr>
<td>Delta Sistemi</td>
<td>Biomed</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>Empix</td>
<td>Northern Eclipse</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td>NO</td>
<td>YES</td>
<td>N/A</td>
</tr>
<tr>
<td>IATIA</td>
<td>QPM</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>Improvision</td>
<td>Open Lab</td>
<td>Mac</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>N/A</td>
<td>YES</td>
</tr>
<tr>
<td>Intelligent Imaging Innovations</td>
<td>3i</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>NO</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>Media Cybernetics</td>
<td>Image-Pro (4.x or higher)</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>N/A</td>
</tr>
<tr>
<td>Midwest Info. Systems</td>
<td>Paxit</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td>PENDING</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>NIH - Public Domain</td>
<td>NIH Image</td>
<td>PC/Mac</td>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td>NO</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>Novovision</td>
<td>NovoPath</td>
<td>PC/Mac</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>QED</td>
<td>Camera Plugin</td>
<td>PC/Mac</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>Scanalytics</td>
<td>IP Labs</td>
<td>PC/Mac</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Soft Imaging System</td>
<td>AnalySIS</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>Universal Imaging</td>
<td>Metamorph</td>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>NO</td>
</tr>
</tbody>
</table>
Appendix E: Correct Color Technology

Introduction

In order to maximize the benefit of Correct Color Technology with your SPOT camera, you should set your microscope imaging system using the following approach.

Microscope Setup

Set your microscope to deliver light at 5000º K color temperature. This can be accomplished using a bulb of a known type and voltage combined with the appropriate daylight blue color filter in the light path. Consult your microscope manufacturer or dealer for advice on selecting and obtaining the correct light and filter products.

Camera Setup

You will want to set the white balance of your camera using the white balance feature in the SPOT program. This feature will allow you to save the white balance settings to your current image setup.

The SPOT program contains the ICC color correction profile as part of the Correct Color Technology system. The software will access this profile as appropriate for the type of SPOT camera that the software identifies upon startup. There is no need on your part to do anything here, except that you will need to enable Correct Color in the Image Setup window (Advanced mode – see the Post Processing menu, Basic mode is on the Image Settings window), and the live image control window (Advanced mode only). For advanced mode, you must enable Correct Color in the image setup first, to enable the setting in the live image window.

Display Monitor Setup

There are many different types of monitors that are provided as part of a computer system. Each has its own characteristics related to color. Additionally, the environment in which you view your monitor has a bearing on the colors that you will see on the screen (for example, white will look a bit bluer in a darkroom environment than it will look if you open the door and allow natural sunlight to enter the same room). There are a couple of different approaches to setting your display monitor to an optimum color matching display.

Simple Method - The SPOT Correct Color Technology system is designed to utilize the ICC profile that is assigned to your monitor. For most systems this profile is sRGB. This profile assumes a color temperature of 6500º K. If you do nothing to change this profile, you will need to simply change your monitor setting to 6500º K. You can do this by changing the color temperature setting using control buttons on your monitor (refer to the monitor User Guide or menu to make this change). This setting will provide color matching between the specimen and the screen that is a very good approximation to the image you see in microscope.
Appendix E: Correct Color Technology

On some display screens, this adjustment may not be available. However, they typically are set to 6500ºK as a default value.

If your monitor supplied a disk that included an ICC color profile for your particular monitor model, you should use this profile in place of the default profile assigned to your monitor. Check with the monitor supplier for downloadable releases of any new color correction files and follow their directions for their use.

Enhanced Method – For the best color matching, you will need to calibrate your monitor color and create your own ICC color profile for the display device. This profile will replace the default profile noted in the Simple Method above.

You will need to create the calibration profile using a 3rd party software or software/hardware package such as PANTONE® COLORVISION® Spyder™ or a similar product and follow the instruction provided in the package. You will need to acquire these packages separate from the SPOT imaging system.

Free Software Updates

Registered SPOT camera owners can download free software updates via the Internet. Free software is available for a 12-month period beginning on the purchase date of the camera or the purchase date of a software upgrade. Free software updates are also available to registered owners during valid extended warranty periods. (Please note that to be valid, extended warranties must be purchased prior to the expiration date of the original camera warranty or the expiration date of a prior purchased and valid extended warranty).

Please note the conditions of use of SPOT software as noted in the Single User Copyright and License Agreement found in an earlier section of this document.

After you register your product online, Diagnostic Instruments will provide you with a link to download the latest release of the software. User guides, software developer kits, and SPOT third party DLLs are also available for download. We will attempt to inform you of available updates via e-mail bulletins. You have the ability to opt out of this method of communication. To register, contact Diagnostic Instruments at 1 (586) 731-6000, or you can register online. You should periodically check Diagnostic Instruments’ web site for the latest release.

To download files, follow these steps:

2. Click on the link for your software/operating system. You are prompted for the serial number of your camera. This is a 6 digit number on the camera head. Type in this number and choose Submit.
3. A link to the latest version of the Spot software will be provided, as long as you’ve met the conditions listed above.
1

12 bpp (monochrome), 36, 80, 85

2

24 bpp (RGB color), 81

3

36 bpp (RGB color), 81

8

8 bpp (monochrome), 80

A

acquire images: SPOT 3rd Party Interface for Mac, 273; TWAIN interface, 250
Add Calibration Mark, 154
Add Measurement, 155
Add Page (report mode), 198
adding: a currently open file, 146; a SPOT database image, 146; an image from file, 146; file type extensions to file name for Mac users, 30, 75
Adjust Brightness (additive), 134
Adjust Brightness (multiplicative), 135
Adjust Contrast: HSL, 137; HSV, 137; RGB, 136
Adjust Gamma: HSL, 138; HSV, 138; RGB, 137
Adjust Hue, Saturation, and Luminance, 134
Adjust Hue, Saturation, and Value, 134
adjusting brightness/darkness of an image (Basic mode), 46
adjustment: gamma, 98; live image, 109
Adjustment Factor, 86
Adjust Image (Basic mode): Brightness, 46; Contrast, 46; Dark Level, 46; Gamma, 46
Advanced program mode, 21, 59
annotation: Add Calibration Mark, 154; adding to zoomed images, 42, 122; attributes, 150; images, Basic mode, 48, 147
annotation objects, 148; Connected Lines, 149; editing, 153; Images, 149; Lines, 149; Shapes, 149; Text, 150
area: defining for an image capture, 34, 93, 260, 284; defining for live image view, 108
artifacts in optical system, 37, 102, 118, 263, 286
attributes: annotation, 150; report, 186; Basic mode, 51
Auto-Arrange Images, 205
Auto-Gain Limit, 86
Auto-Save Images, 28, 103
avi file format: exporting SPOT sequence files to, 26, 63

B

Basic program mode, 21, 23; menu bar, 23; navigating in, 23; quick start, 15; reports, 49; status bar, 24; toolbar, 24; viewing and editing window, 23
Binning: live image option, 108
Binning (Insight 3-Shot): Basic mode, 33; Image Settings (Basic TWAIN), 259, 283
Binning (Insight B/W), 84
Black Level Subtract (12 BPP), 97
blurry images: sharpening, 142
borders: pixels, 42, 123
Brightness: adjusting additive, 134; adjusting for captured images (Basic mode), 46; adjusting multiplicative, 135; Image Setting for Basic 3rd Party Interface, 282; Image Setting for Basic mode, 32; Image Setting for Basic TWAIN, 258; live image Advanced mode exposure option, 109
brightness (multiplicative): adjusting, 135
Bring to Front: annotation mode, 153; report mode, 196
buttons, toolbar: file view, save, and edit, 60; image capture, 60

C

Cache Images During Play (image sequences), 28, 73
calibration and measurement: Basic mode, 47
calibration mark, 154
calibration of microscope objectives, 27, 65
camera: initializing, 38
capturing a region in an image, 114
capturing images: Get Image (exposure from setup), 111; Get Image (last used exposure), 112; Get Sequential Images, 41, 113; Set Chip Imaging Region, 114
capturing images (Basic mode): Get Image, 40
CCD chip, 291; design methodologies, 292
Change Pixel Bit Depth, 145
charged coupled device (CCD), 291
Chip Defect Correction, 97
Chip Imaging Area, 34, 93, 260, 284
Close: image file, 26, 63
color: mathematical representation of, 99
color matching: Advanced mode, 143; Basic 3rd Party Interface, 288; Basic mode, 47; Basic TWAIN, 265
color Order, 84
color palettes: defining, 66, 73, 248, 271
color rendition and white balance, 117
color space options, 99
color spaces, 132; HSL, 99, 132; HSV, 99, 132; RGB, 99, 132
colors: order in exposure process, 84
colors to be exposed: specifying, 83, 89
color: comparing of Basic and Advanced mode features, 21
compression: JPEG, 56, 167, 201
Compute White Balance Values menu option, 117
computing exposure times, 92, 116
computing white balance values, 39, 88
database search: defining, 175; saving and reusing, 178
database: configuring, 203
debugging: adjusting (HSL), 137; adjusting (HSV), 137; adjusting (RGB), 136; adjusting in Basic mode, 46
conventions: document, 11
Convert to Gray Scale, 143
copying: images to another program, 45, 129
Correct Color Technology, 303
cropping images, 45, 130
cut: annotation mode, 154; report mode, 197
Index

D
Dark Level: Basic mode brightness adjustment, 46
database: converting a previous version, 299; creating, 164;
displaying search results, 177; establishing a password
for, 165; ordering search results, 176; sample, 162; saving
images to, 170; search, 175; set up steps, 164
database fields: default values for, 170; defining, 167;
Lookup, 168; Textual/Numeric, 168
database images: location and file path, 166; moving, 172; on
multiple disks, 166; storage guidelines, 165
database records: editing, 171; editing from a search, 179
database search: conditions, 175; saving and reusing, 178;
tabular display, 177; thumbnail display, 177, 178
date and time: associating with an image, 43, 124, 125
default values, 170
defects: CCD chip, 97
Delete: annotation mode, 154; image file, 26, 63; report
mode, 197
Delete All: annotation mode, 154; report mode, 197
Delete Page (report mode), 56, 198
digital photography, 291
dim images: binning, 84
display grid: setting for report window, 185
Display Images in Grayscale: Basic TWAIN (Insight 3-Shot),
260, 284
Display Images in Grayscale (Insight 3-Shot), 108; Basic
mode, 33
distributing reports, 57, 202
document conventions, 11
download time for image captures: decreasing, 84

E
Edge Trigger, 92
Edit: database records, 171; database records (from a search),
179; image memo, 48, 157; images; Advanced mode, 128;
Basic mode, 44; report objects, 196; report objects (Basic
mode), 55
Edit menu: options (Advanced mode), 128; options (Basic
mode), 44
editing images (Basic mode): Undo, 129
Editing options for image sequences, 127
electrons and wells on CCD chip, 86
enlarging image size, 129
exporting SPOT sequence files to avi movie format, 26, 63
exposure: Bulb Trigger, 92; Edge Trigger, 92; specifying
color(s) for, 83, 89
exposure settings: Adjustment Factor, 86; Auto-Gain Limit,
86; Binning, 84; Color Order, 84; Exposure Times, 92;
Filter Color, 83; Gain, 92; Image Type, 86; Minimum
Exposure, 87; Use; Red Green Blue, 83, 89; Use Filter,
82; White Balance, 87; White Balance (Basic mode), 39,
287; White Balance (Basic TWAIN), 264
Exposure Time: limiting for live image, 34, 260, 283; live
image exposure option, 32, 110; reducing, 86
Exposure Time(s): automatically computing. See Compute
Exposure; Image Settings (Basic 3rd Party), 282; Image
Settings (Basic TWAIN), 259; recalling from previous
capture, 84. See Recall Previous Exposure
extensions (file type): adding to Mac file names, 30, 75
features: new, 19
fields: Lookup, 168
fields, database, 167; default values for, 170; Lookup, 168;
Textual/Numeric, 168
file format: images, 167
File menu options: Basic mode, 25
files: .rpb (Basic mode report), 56, 201; .rpd (Run Report),
199; database query (qry), 179; flatfield, 37, 263, 287; rpt
(report template); saving (Basic mode), 182
Filter (Edit menu options): Filter Noise, 142, 143; Sharpen,
142; Smooth, 141; Unsharp Mask, 142
Filter Color, 83; Basic TWAIN (Insight 3-Shot), 260, 283;
Live Image Controls, 107
Filter Color (Insight 3-Shot): Basic mode, 33
First Page (report mode), 185
Fit to Window, 41
flatfield correction: Advanced Program Mode, 102, 118;
Basic Program Mode, 37; Basic TWAIN, 263, 286
flicker: correcting for in Live Image mode, 87
flipping image display: as a menu option (Advanced mode),
45, 130
fluorescence images: adjusting in Basic mode, 46; lightening
dark areas of, 98
focusing images in real-time: Advanced mode, 105; Basic
mode, 38
framing images in real-time: Advanced mode, 105; Basic
mode, 38
to full scale, 86
Full Screen view option, 44, 125
full well: concept of, 293

G
Gain, 86, 92; Basic 3rd Party, 282; defined, 293; Image
Settings (Basic TWAIN mode), 259; live image exposure
option, 32; relationship to exposure time, 86
Gamma: adjusting in Advanced mode, 137; adjusting in
Basic mode, 46; applying during image capture, 98; Basic
mode, 36, 262, 285; curve (illustration), 99; live image
option, 109; types of adjustment; RGB, 137; types of
adjustment; HSL, 138; HSV, 138
Get Flatfield Image, 118
Get Image (Basic mode), 40
Get Image (exposure from setup), 111
Get Image (last used exposure), 112
Get Sequential Images, 41, 113
glints, 98; correcting, 86
grainy images: smoothing, 141
grey scale: converting color images to, 143
grids (report): display, 185; object, 186

H
halo effect: correcting on low contrast image captures, 102,
118; correcting on low contrast image captures, 37
histogram: HSL, 140; HSV, 140, RGB, 139
Horizontal Flip image setup option, 95
HSL color space, 99, 132
HSV color space, 99, 152
Hue, 132; adjusting, 134

I
ID: database image, 170
illumination: correcting for uneven, 37, 102, 263, 286
illumination correcting for uneven, 118
image: zooming, 41, 42, 122
image capture: Advanced mode, 111; Basic mode, 40; Get
Image (exposure from setup), 111; Get Image (last used
exposure), 112; Recall Previous Exposure, 116; status
messages, 112; TWAIN interface, 249
image capture status messages, 112
image displays: SPOT 3rd Party Interface for Macs, 272
image captures in other procedures, 114
Image Date/Time, 43, 124, 125
Spot Software User Guide
<table>
<thead>
<tr>
<th>J</th>
<th>JPEG Quality, 56, 167, 201</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>labels: volume, 166</td>
</tr>
</tbody>
</table>

---

**image files:** closing, 26, 63; deleting, 26, 63; opening, 25, 62; previewing thumbnails of, 62; printing, 27; saving, 26, 63; saving in different formats or locations, 26, 63; saving multiple, 63

**image IDs, 170**

**Image Index (image sequences), 127**

**image memo, 48, 157; associating with a database image, 171**

**image quality: enhancing, 131**

**image sequences: adding an open, non-sequence image to, 27, 64; creating new, 26, 63; opening, 62**

**image sequences: caching preferences, 28, 73; controls for playing, 127; Image Index, 127; Play Options, 127; previewing play controls, 124; editing, 127; Memory Usage Limit preference, 28, 73; printing, 206; Sequence menu options, 125**

**Image Settings (Basic 3rd Party): Brightness, 282; Exposure options; Exposure Time(s), 282; Gain, 282; Image Type, 281; Quality/Speed, 282**

**Image Settings (Basic mode), 30; Binning (Insight 3-Shot, 33; Brightness, 32; Color Enhancement, 36, 97, 262, 266; Display Images in Grayscale (Insight 3-Shot, 33; Filter Color (Insight 3-Shot, 33; Flatfield, 37; Gamma, 36, 262, 285; Image Flip, 35; Image Rotate, 35; Image Type, 31; Live Image Maximum, 34, 260, 283; Minimum Exposure, 34, 87; Noise Filter, 36**

**Image Settings (Basic TWAIN): Binning (Insight 3-Shot, 259, 283; Brightness, 258; Display Images in Grayscale (Insight 3-Shot), 260, 284; Exposure options; Quality/Speed, 258; Exposure Time(s), 259; Filter Color (Insight 3-Shot), 260, 283; Gain, 259; Image Flip, 261, 285; Image Rotate, 261, 285; Image Type, 258; Minimum Exposure, 259, 283; Noise Filter, 263, 286**

**Image Setup (Advanced mode): Flatfield, 118**

**Image setup options, 79**

**Image Setup window: accessing, 77; shortcuts to, 77**

**Image setups, 64, 77; adding, 77; defining in the SPOT 3rd Party Interface program, 271; defining in TWAIN interface, 249; deleting, 77; locking, 79; modifying, 77; naming, 79; pre-configured settings for, 78**

**Image Size Double, 100**

**Image Type, 86; selecting (in Basic mode), 31, 281; selecting (in Basic TWAIN), 258**

**images: annotating; Basic mode, 48, 147; arranging for printing, 205; changing pixel bit depth, 145; compressing, 56, 167, 201; converting to gray scale, 143; customizing, 144; editing, 128; flipping horizontally, 45, 130; flipping vertically, 45, 130; lightening and darkening, 134, 135; merging, 144; merging multiple monochrome, 146; previewing in real time, 105; Advanced mode, 105; Basic mode, 38; resizing, 129; rotating, 45, 95, 130; saving automatically, 28, 103; saving to a SPOT database, 170; sharpening appearance of, 142; smoothing grainy, 141; stretching, 140; subtracting from open, 146; too bright or too dark, 86; viewing, 121**

**Initialize Camera, 38**

**interface: Basic 3rd Party, 275; Basic TWAIN, 251; TWAIN, 245**

**interpolation, 100**

**J**

---

**L**

---

**Last Page (report mode), 185**

**light sensitivity of CCD chip: increasing, 84**

**light sources, 34, 87, 142, 263, 286**

**lightening dark areas (Basic mode), 46**

**Live Image Controls: Area, 108; Binning, 108; Display Images in Grayscale, 108; Exposure options; Brightness, 109; Exposure Time, 32, 110; Gain, 32; Quality/Speed, 32, 109; Filter Color (Insight 3-Shot), 107; Gamma, 109**

**Live Image Maximum, 34, 260, 280, 283**

**Live Image mode: and different light sources, 34, 87, 259, 283**

**live imaging: Advanced mode, 105; Basic mode, 38; Live Image Controls dialog, 107, 109, 110; split window appearance, 106; video card related problems, 105; view options, 106**

**locking: image setups, 79**

**Lookup fields, 168**

**low contrast image captures: halo effect on, 37, 102, 263, 286**

**low contrast images: increasing contrast in, 138**

**Luminance, 132; adjusting, 135**

---

**M**

**Mac 3rd Party Interface: background images, 272; defining image setups in, 59; flatfield images, 272; setting chip imaging region, 272**

**Mac 3rd party Interface: computing exposures, 272; defining file and save options, 267; live imaging, 272; preparing to take a picture, 267; recalling previous exposures, 272; white balance, 272**

**macropscopic objects with glints, 98**

**mages: printing, 64**

**magnified images: navigating, 43**

**Make Negative, 143**

**manual: organization of, 12**

**Match Color: Advanced mode, 143; Basic 3rd Party Interface, 288; Basic mode, 47; Basic TWAIN, 265**

**measurements: adding, 155; types of, 156**

**measuring specimens, 155**

**Memory Usage Limit for image sequences, 28, 73**

**memos: associating with a database image, 171; associating with an image, 48, 157; for image report objects, 194**

**menu bar: in the Basic program mode, 23**

**menus: Advanced program mode, 39; Basic program mode, 23; database, 161; Edit; Advanced mode, 128; Basic mode, 44; Sequence, 125; View; Advanced mode, 121; Basic mode, 41**

**Merge Images, 146**

**metallic objects, 86**

**microscopy techniques, 31, 258, 281; and image types, 78; table of, 78**

**modes: Advanced program, 59; Basic program, 23**

**monochrome images: applying a color palette to, 143**

**monochrome images: defining color palettes for, 66, 73, 248, 271**

**Move Backward: annotation mode, 153; report mode, 197**

**Move Forward: annotation mode, 153; report mode, 196**

**moving database images from your hard drive, 172**

---

**N**

**navigating in zoomed images, 123**

**negative: creating, 143**

**new features, 19**

**Next Page (report mode), 185**

**noise, electrical and thermal: reducing in images, 36, 97, 142, 263, 286**
Spot Software User Guide

SPOT RT camera operating principles: automated exposure process, 294; gain, 293; pixel digitization, 293
SPOT sample report, 181; opening, 181; running, 182; viewing objects in, 182
stage micrometer, 27, 65
status bar: Advanced program mode, 61; Basic program mode, 24
status messages (image capture), 40, 112
storage: options for database images, 165
Stretch Bright and Dark Level: HSL, 139; HSV, 139; RGB, 138
stretching images, 140
style: report, 186
Subtract Image, 146

T

taking a picture: Advanced mode, 111; Basic mode, 37; first time instructions, 15; SPOT 3rd Party Interface for Macs, 272; TWAIN interface, 249
techniques: microscopy, 31, 258, 281; white balance, 88; white balance (Basic 3rd Party Interface), 287; white balance (Basic mode), 40; white balance (Basic TWAIN), 264
Textual/Numeric fields, 168
toolbar: Advanced program mode, 60; appearance when an image is open, 60; appearance when SPOT program is first opened, 60; Basic program mode, 24
transfer: an image to another application via the TWAIN interface, 250; images from live image view to the editing window, 107
transfer images to another application: SPOT 3rd Party Interface for Macs, 273
Trigger: Bulb, 92; Edge, 92
TWAIN interface: background images, 249; computing exposures, 249; establishing, 245; flatfield images, 249; framing in, 249; live imaging, 249; recalling previous exposures, 249; setting chip imaging region, 249; white balance, 249
TWAIN interface (Basic): establishing, 251

U

Undo: annotation mode, 153; report mode, 196
Unsharp Mask, 142
Use: Red Green Blue, 83, 89
User Filter, 82

V

Value: adjusting, 135
Vertical Flip image setup option, 95
view full screen, 44, 125
View menu options: Advanced mode, 121; Basic mode, 41
viewing and editing window: in the Advanced program mode, 59; in the Basic program mode, 23
volume labels: defining for removable media, 166

W

wells on CCD chip, 291
White Balance, 87, 117; Basic mode, 39, 287; Basic TWAIN, 264; techniques, 88; techniques (Basic 3rd Party Interface), 287; techniques (Basic mode), 40; techniques (Basic TWAIN), 264
window, main viewing and editing: toolbar, 60

Z

Zoom: report mode, 185
zoom options: Zoom In/Out, 41, 122; Zoom Level, 42, 122
zoomed images: navigating around, 42
zoomed images annotating, 42, 122